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CHAPTER 1

Introductie voor de cursus

1.1 Voorwoord

1.1.1 Achtergrond

In 2008 brachten we :ref:‘‘Een kleine introductie in GIS <gentle_introduction_gis>‘, een volledig gratis, open
bron-inhoud voor mensen die wilden leren over GIS zonder te worden bedolven onder jargon en nieuwe termi-
nologie. Het werd gesponsord door de Zuid-Afrikaanse overheid en was een fenomenaal succes, met mensen van
over de gehele wereld die ons vertelden hoe zij het materiaal gebruikten voor het uitvoeren van trainingscursussen
op universiteiten, zichzelf GIS leerden enzovoort. ‘Een kleine introductie’ is geen handleiding voor de software
maar richt zich op een meer algemene tekst (hoewel we QGIS in alle voorbeelden gebruikten) voor iemand die
iets over GIS wil leren. Er is ook de handleiding voor QGIS die een gedetailleerd functioneel overzicht van de
toepassing QGIS verschaft. Die is echter niet gestructureerd als een leidraad, maar meer als een gids voor verwi-
jzingen. Bij Linfiniti Consulting CC. geven we frequent trainingscursussen en hebben we ons gerealiseerd dat een
derde bron nodig is - een die de lezer stapsgewijze leidt door het leren van de sleutel;aspecten van QGIS in een
formaat trainer-trainee - wat ons aanzette tot het maken van dit werk.

Deze trainingshandleiding is bedoeld om alle materiaal te verschaffen voor een 5-daagse cursus over QGIS, Post-
greSQL en PostGIS. De cursus is gestructureerd met een inhoud die gelijktijdig geschikt is voor nieuwe, gemid-
delde en gevorderde gebruikers en veel oefeningen heeft, compleet met geannoteerde antwoorden door de gehele
tekst.

1.1.2 Licentie

De gratis Quantum GIS Training Handleiding van Linfiniti Consulting CC is beschikbaar onder de Creative Com-
mons Attribution 4.0 International Licentie. Rechten buiten het bereik van deze licentie zouden beschikbaar
kunnen zijn op het hieronder vermelde.

We hebben deze QGIS trainingshandleiding gepubliceerd onder een liberale licentie die u toestaat dit werk gratis
te kopiëren, aan te passen en opnieuw te distribueren. Een volledige kopie van de licentie is beschikbaar aan het
einde van dit document. In eenvoudige woorden, de richtlijnen voor het gebuik zijn als volgt:

• U mag dit werk niet weergeven als uw eigen werk, of teksten met betrekking tot rechten van auteurs of
credits uit dit werk verwijderem.

• U mag dit werk niet opnieuw distribueren onder meer beperkende rechten dan die waaronder het aan u werd
verschaft.

• Als u een substantieel gedeelte toevoegt aan het werk en teruggeeft aan het project (tenminste één com-
plete module) mag u uw naam toevoegen aan de lijst van auteurs aan het einde van dit document (die zal
verschijnen op de voorpagina)
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• Als u kleine wijzigingen en correcties toevoegt mag u zichzelf toevoegen aan de lijst van deelnemers hi-
eronder.

• Als u dit document in zijn geheel vertaald mag u uw naam toevoegen aan de lijst van de auteurs in de vorm
“Translated by Joe Bloggs”.

• Als u een module of les sponsort, mag u de auteur verzoeken om een vermelding daarvan op te nemen aan
het begin van elke bijgedragen les, bijv.:

Notitie: Deze les werd gesponsord door MegaCorp.

• Als u er niet zeker van bent wat u onder deze licentie mag doen, neem dan contact met ons op via of-
fice@linfiniti.com en zullen we u adviseren of wat u van plan bent te doen acceptabel is.

• Als u dit werk publiceert onder een zichzelf publicerende site zoals http://lulu.com verzoeken we u de
winsten te doneren aan het project QGIS.

• U mag dit werk niet vercommercialiseren, tenzij met de uitdrukkelijke toestemming van de auteurs. Voor
de duidelijkheid: met vercommercialiseren bedoelen we dat u niet voor winst mag verkopen, geen afgeleide
werken mag maken (bijv. verkopen van inhoud om te gebruiken als artikelen in een tijdschrift). De uit-
zondering hierop is als alle winst wordt gegeven aan het project QGIS. U mag (en we moedigen u aan dat
te doen) dit werk gebruiken als een tekstboek bij het geven van trainingscursussen, zelfs als de cursus zelf
commercieel van nature is. Met andere woorden: het staat u vrij om geld te verdienen door het geven van
een trainingscursus dat dit werk als tekstboek gebruikt, maar u mag niet profiteren van de verkoop van het
boek zelf - alle dergelijke winsten zouden ten goede moeten komen aan QGIS.

1.1.3 Hoofdstukken over sponsoring

Dit werk is in geenszins bedoeld als een volledige verhandeling over alle dingen die u kunt doen met QGIS en we
moedigen anderen aan om nieuw materiaal toe te voegen om eventuele gaten te dichten. Linfiniti Consulting CC.
kan ook aanvullend materiaal voor u maken als een commerciële service, met dien verstande dat al dergelijk gepro-
duceerd werk onderdeel zou moeten worden van de broninhoud en moeten worden gepubliceerd onder dezelfde
licentie.

1.1.4 Auteurs

• Rüdiger Thiede (rudi@linfiniti.com) - Rudi heeft het materiaal met instructies voor QGIS geschreven en
delen van het materiaal over PostGIS.

• Tim Sutton (tim@linfiniti.com) - Tim was de leider van het project en begeleidde dat en is co-auteur voor
de delen over PostgreSQL en PostGIS. Tim is ook de auteur van het aangepaste thema van Sphinx dat is
gebruikt voor deze handleiding.

• Horst Düster (horst.duester@kappasys.ch ) - Horst is co-auteur van de delen over PostgreSQL en PostGIS

• Marcelle Sutton (marcelle@linfiniti.com) - Marcelle deed het proeflezen en gaf editoriaal advies gedurende
het maken van dit werk.

1.1.5 Individuele meewerkenden

Vul hier uw naam in!

1.1.6 Sponsoren

• Cape Peninsula University of Technology
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1.1.7 Gegevens

Notitie: De voorbeeldgegevens die bij het volgen van de handleiding worden gebruikt, kunnen hier worden
gedownload: https://github.com/qgis/QGIS-Training-Data/archive/QGIS-Training-Data-v1.0.zip. U mag de be-
standen opslaan in een map, genaamd exercise_data.

De voorbeeldgegevens die deze bron vergezellen zijn gratis beschikbaar en zijn afkomstig van de volgende bron-
nen:

• Gegevenssets van straten en plaatsen van OpenStreetMap (http://www.openstreetmap.org/)

• Eigendomsgrenzen (stedelijk en landschappelijk), watergebieden van NGI (http://www.ngi.gov.za/)

• SRTM DEM van de CGIAR-CGI (http://srtm.csi.cgiar.org/)

1.1.8 Laatste versie

U kunt altijd de laatste versie van dit document verkrijgen door de online versie te bezoeken die deel uitmaakt van
de website voor de documentatie voor QGIS (http://docs.qgis.org).

Notitie: Er zijn koppelingen naar online en PDF-versies van de documentatie en de trainingshandleiding.

Tim Sutton, mei 2012

1.2 Voorbereiden gegevens voor oefeningen

De voorbeeldgegevens die worden verschaft met de trainingshandleiding verwijzen naar de stad Swellendam en
de omgeving ervan. Swellendam bevindt zich op ongeveer 2 uur oostelijk van Kaapstad in de Westkaap van
Zuid-Afrika. De gegevensset bevat namen van objecten in zowel het Engels als Afrikaans.

Iedereen kan deze gegevensset zonder problemen gebruiken, maar het zou uw voorkeur kunnen hebben om
gegevens te gebruiken uit uw eigen land of stad. Als u daarvoor kiest, uw gelokaliseerde gegevens zullen worden
gebruikt in alle lessen van module 3 tot en met module 7.2. Latere modules gebruiken meer complexe gegevens-
bronnen, die al dan niet beschikbaar zouden kunnen zijn voor uw regio.

Notitie: Dit proces is bedoeld voor makers van cursussen, of meer ervaren gebruikers van QGIS die
gelokaliseerde voorbeeldgegevens voor hun cursus willen maken. Standaard voorbeeldgegevens worden met de
trainingshandleiding verschaft, maar u kunt deze instructies volgens als u de standaard gegevenssets wilt vervan-
gen.

Notitie: De voorbeeldgegevens die bij het volgen van de handleiding worden gebruikt, kunnen hier worden
gedownload: https://github.com/qgis/QGIS-Training-Data/archive/QGIS-Training-Data-v1.0.zip. U mag de be-
standen opslaan in een map, genaamd exercise_data.

1.2.1 Try Yourself

Notitie: Deze instructies gaan er van uit dat u goede kennis heeft van QGIS en zijn niet bedoeld te worden
gebruikt als lesmateriaal.

Als u voor uw cursus de standaard voorbeeldgegevens wilt vervangen door gelokaliseerde gegevens, kan dat
eenvoudig worden gedaan met behulp van de gereedschappen die zijn ingebouwd in QGIS. De regio die u kiest om
te gebruiken zou een goede mix moeten zijn van stedelijke en landschappelijk gebieden, wegen van verschillende
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significantie moeten bevatten, gebiedsgrenzen (zoals natuurreservaten of boerderijen) en oppervlaktewater, zoals
stromen en rivieren.

• Open een nieuw project in QGIS

• Selecteer, in het keuzemenu Vector, OpenStreetMap –> Download Data. U kunt dan handmatig de coördi-
naten invullen van de regio die u wilt gebruiken, of u kunt een bestaande laag gebruiken voor het instellen
van de coördinaten.

• Kies een locatie om het resulterende bestand .osm op te slaan en klik op Ok:

• U kunt dan het bestand .osm openen met behulp van de knop Vectorlaag toevoegen. U zou misschien Alle
bestanden moeten selecteren in het browservenster. Als alternatief kunt u het bestand in het venster van
QGIS slepen en neerzetten.

• Selecteer, in het dialoogvenster dat opent, alle lagen, behalve de lagen other_relations en
multilinestrings:

4 Chapter 1. Introductie voor de cursus
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Dit zal drie lagen, die relateren aan de conventies voor namen van OSM, in uw kaart laden (u moet misschien
in-/uitzoomen om de vectorgegevens te zien).

We moeten de bruikbare gegevens uit deze lagen halen, hernoem ze en maak overeenkomende shapefiles:

• Als eerste, dubbelklik op de laag multipolygons om het dialoogvenster Laag eigenschappen te openen.

• Klik, op de tab Algemeen, op Querybouwer om het venster Querybouwer te openen.

Deze laag bevat drie velden waaruit we de gegevens moeten halen omdat we die nodig hebben om ze te kunnen
gebruiken in de trainingshandleiding:

• building

• natural (specifiek water)

• landuse

1.2. Voorbereiden gegevens voor oefeningen 5



QGIS Training Manual, Release 2.14

U kunt een monster nemen van de gegevens die uw regio bevat om te zien welke resultaten uw regio zal opleveren.
Als u merkt dat “landuse” geen resultaten oplevert, dan staat het u vrij om die weg te laten.

U zult filterexpressies moeten schrijven voor elk veld waarvan we de gegevens willen extraheren die we nodig
hebben. We zullen het veld “building” hier als voorbeeld gebruiken:

• Voer de volgende expressie in in het tekstgebied: building != "NULL" en klik op Test om te zien
hoeveel resultaten de query zal teruggeven. Als het aantal resultaten klein is, wilt u misschien in de Attribu-
tentabel van de laag kijken om te zien welke gegevens OSM heeft teruggegeven voor uw regio:

• Klik op Ok en u zult zien dat de laagelementen die geen gebouwen zijn, uit de kaart zijn verwijderd.

We moeten nu de resulterende gegevens als een shapefile opslaan om te kunnen gebruiken gedurende de cursus:

• Klik met rechts op de laag multipolygons en selecteer Opslaan als...

• Overtuig u ervan dat het bestandstype ESRI-shape gegevens is en sla het bestand op in uw nieuwe
map exercise_data, in een map genaamd “epsg4326”.

• Zorg er voor dat Geen symbologie is geselecteerd (we zullen later, als deel van de cursus, symbologie
toevoegen).

• U kunt ook selecteren Voeg opgeslagen bestand toe aan kaart.

Als de laag buildings eenmaal is toegevoegd aan de kaart kunt u het proces herhalen voor de velden natural en
landuse met behulp van de volgende expressies:
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Notitie: Zorg er voor dat u het eerdere filter van de laag multipolygons verwijdert (via het dialoogvenster Laag
eigenschappen) voordat u doorgaat met de volgende filterexpressie!

• natural: “natural = ‘water”’

• landuse: “landuse != ‘NULL”’

Elke resulterende gegevensset zou moeten worden opgeslagen in de map “epsg4326” in uw nieuwe map
exercise_data (d.i. “water”, “landuse”).

U zou dan de volgende velden uit de lagen lines en points naar hun overeenkomende mappen moeten extra-
heren:

• lines: “highway != ‘NULL”’ naar roads en “waterway != ‘NULL”’ naar rivers

• points: “place != ‘NULL”’ naar places

Als u eenmaal het extraheren van de hierboven vermelde gegevens heeft voltooid, kunt u de lagen multipolygons,
lines en points verwijderen.

U zou nu een kaart moeten hebben die er ongeveer uitziet zoals deze (de symbologie zal zeker heel anders zijn,
maar dat is prima):

Het belangrijkste is dat u 6 lagen heeft die overeenkomen met die hierboven en dat al deze lagen enkele gegevens
hebben.

De laatste stap is om een bestand voor Spatiallite te maken uit de laag landuse om te gebruiken tijdens de
cursus:

• Klik met rechts op de laag landuse en selecteer Opslaan als...

• Selecteer SpatialLite als de indeling en sla het bestand op als landuse in de map “epsg4326”.

• Klik op Ok.

• Verwijder landuse.shp en de daaraan gerelateerde bestanden (indien gemaakt).

1.2. Voorbereiden gegevens voor oefeningen 7
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1.2.2 Try Yourself SRTM DEM tiff-bestanden maken

Voor module 6 (Vectorgegevens maken) en module 8 (Rasters), heeft u ook rasterfabeeldingen nodig (SRTM
DEM) die de regio bedekken die u heeft geselecteerd voor uw cursus.

De CGIAR-CGI (http://srtm.csi.cgiar.org/) verschaft enkele SRTM DEM die u kunt downloaden vanaf
http://srtm.csi.cgiar.org/SELECTION/inputCoord.asp.

U zult afbeeldingen nodig hebben die de gehele regio bedekken die u heeft gekozen om te gebruiken. Als u de
gegevens hebt behouden zoals in de trainingshandleiding, kunt u het bereik gebruiken dat wordt weergegeven
in de set_osm_region afbeelding hierboven, pas anders uw bereik aan. Behoude de indeling GeoTiff. Als
het formulier helemaal is ingevuld, klik dan op de knop Click here to Begin Search >> en download het/de
bestand(en).

Als u eenmaal de vereiste bestand(en) heeft gedownload, zouden zij moeten worden opgeslagen in de map “exer-
cise_data” in de submappen van “raster/SRTM”.

1.2.3 Try Yourself TIFF afbeeldingsbestanden maken

In module 6 toont les 1.2 close-up afbeeldingen van drie sportvelden van een school waarvan studenten wordt
gevraagd die te digitaliseren. U zult daarom die drie afbeeldingen dienen te reproduceren met behulp van uw
new SRTM DEM tiff-bestand(en). Het is geen verplichting om sportvelden van de school te gebruiken: alle
drie types landuse voor school kunnen worden gebruikt (bijv. verschillende schoolgebouwen, speelplaatsen of
parkeerplaatsen).

Ter verwijzing, de afbeeldingen in de voorbeeldgegevens zijn:
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1.2.4 Try Yourself Tokens vervangen

Nadat u uw gelokaliseerde gegevensset heeft gemaakt, is de laatste stap om de tokens in het bestand conf.py te
evrvangen zodat de toepasselijke namen zullen verschijnen in uw gelokaliseerde versie van de trainingshandleid-
ing.

De tokens die u dient te vervangen zijn de volgende:

• majorUrbanName: dit is standaard “Swellendam”. Vervang die door de belangrijkste stad in uw regio.

• schoolAreaType1: dit is standaard “athletics field”. Vervang die door de naam van het grootste type
schoolgebied in uw regio.

• largeLandUseArea: dit is standaard “Bontebok National Park”. Vervang dit door de naam van de
grootste polygoon landuse in uw regio.

• srtmFileName: dit is standaard srtm_41_19.tif. Vervang deze door de naam van uw SRTM DEM-
bestand.

• localCRS: dit is standaard WGS 84 / UTM 34S. U zou deze moeten vervangen door het juiste CRS
voor uw regio.

10 Chapter 1. Introductie voor de cursus



CHAPTER 2

Module: De interface

2.1 Lesson: Een korte introductie

Welkom bij onze cursus! De komende dagen zullen we laten zien hoe u QGIS eenvoudig en efficient kunt ge-
bruiken. Als GIS nieuw voor u is, dan vertellen we u wat u nodig heeft. Als een een ervaren GIS-gebruiker bent,
dan zult u zien dat QGIS alle functies bevat welke u van een GIS verwacht, en meer!

In deze module introduceren we het QGIS project zelf, en wordt uitgelegd hoe de gebruikers-interface van QGIS
in elkaar steekt.

Na het afronden van dit gedeelte kunt u de belangrijkste elementen in een QGIS scherm aanwijzen, vertellen wat
elk element doet en een shape-bestand in QGIS laden.

Waarschuwing: Deze cursus bevat instructies voor het toevoegen, verwijderen en aanpassen van GIS
datasets. We hebben hiervoor een test-dataset aangemaakt. Voordat u nu verder gaat, maakt u natuurlijk
even een back-up van uw eigen gegevens.

2.1.1 Hoe gebruikt u deze handleiding

Tekst die er zo uitziet heeft betrekking op iets op je scherm waar je op kunt klikken.

De volgende opmaak wordt gebruikt voor menu’s Hoofdmenu → Submenu → Dialoog ....

Voor een toetsencombinatie wordt het volgende formaat gebruikt Ctrl-Alt-Del.

2.1.2 Opbouw van cursusdoelen

Deze cursus is geschikt voor gebruikers met verschillende gebruikerservaringen. Afhankelijk van de categorie
waar je jezelf toe rekent, is het cursusresultaat ook anders. Elke categorie bevat informatie die essentieel is voor
het volgende cursusonderdeel, dus is het belangrijk om alle oefeningen te doen die jij kunt doen op basis van je
ervaring.

Basis

Voor deze categorie gaat de cursus er vanuit dat je geen of weinig ervaring hebt met GIS of met het werken met
een GIS-programma.

Beperkte theoretische achtergrond zal worden gegeven om het doel van een actie uit te leggen die u zult uitvoeren
in het programma, maar de nadruk ligt op leren door te doen.

Wanneer u de cursus hebt voltooid zult u een beter besef hebben van de mogelijkheden van GIS en hoe hun
krachten via QGIS te beheersen.

11
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Gemiddeld

Voor deze categorie wordt aangenomen dat u werkervaring en ervaring met alledaags gebruik van GIS hebt.

Als u de instructies voor het niveau van beginners volgt zult u bekende dingen tegenkomen, ook maken die u
bewust van de gevallen waarin QGIS dingen enigszins anders doet dan andere software die u misschien gewend
bent. U zult ook leren hoe u de functies voor analyses in QGIS gebruikt.

Wanneer u de cursus heeft voltooid zou u gewend moeten zijn aan het gebruiken van QGIS voor alle functies die
u gewoonlijk nodig hebt in een GIS voor dagelijks gebruik.

Gevorderd

In deze categorie wordt er van uitgegaan dat u ervaren bent met GIS, bekend bent met en kennis heeft van
ruimtelijke databases, gegevens kunt gebruiken op een server op afstand, misschien het schrijven van scripts
voor analyse-doeleinden, etc.

Als u de instructies voor de andere twee niveaus volgt zal dat u bekend laten worden met de benadering die de
interface van QGIS volgt, en zal er voor zorgen dat u toegang hebt tot de basisfuncties die u nodig hebt. Ook zal u
worden getoond hoe u gebruik kunt maken van het systeem van plug-ins van QGIS, het systeem voor toegang tot
databases, enzovoort.

Wanneer u de cursus voltooid zult u goed bekend moeten zijn met de dagelijkse werking van QGIS, als ook de
meer gevorderde functies ervan.

2.1.3 Waarom QGIS?

Omdat informatie steeds meer ruimtelijk bewust wordt is er geen gebrek aan programma’s die in staat zijn enkele
of alle gebruikelijke functies voor GIS uit te voeren. Waarom zou iemand QGIS gebruiken in plaats van enkele
andere GIS softwarepakketten?

Hier zijn slechts enkele van de redenen:

• Het is gratis, zoals in lunch. Installeren en gebruiken van het programma QGIS kost u het totale bedrag van
nul geld. Geen beginnerskosten, geen terugkerende kosten, niets.

• Het is vrij, als in vrijheid. Als u extra functionaliteit in QGIS nodig hebt, kunt u meer doen dan hopen dat
het in de volgende zal zijn opgenomen. U kunt de ontwikkeling van een mogelijkheid sponsoren, of het zelf
toevoegen als u bekend bent met programmeren.

• Het wordt doorlopend ontwikkeld. Omdat iedereen nieuwe mogelijkheden kan toevoegen en bestaande kan
verbeteren, stagneert QGIS nooit. De ontwikkeling van een gereedschap kan zo snel gebeuren als u dat
nodig vindt.

• Uitgebreide Help en documentatie is beschikbaar. Als u ergens mee vastloopt kunt u zich wenden tot de
uitgebreide documentatie, uw collega QGIS-gebruikers of zelfs tot de ontwikkelaars.

• Cross-platform. QGIS kan worden geïnstalleerd op MacOS, Windows en Linux.

Nu u weet waarom u QGIS wilt gebruiken, kunnen we u laten zien hoe. De eerste les zal u door het maken van
uw eerste kaart in QGIS leiden.

2.2 Lesson: Uw eerste laag toevoegen

We zullen de toepassing starten en een basiskaart maken om voor voorbeelden en oefeningen te gebruiken.

Het doel voor deze les: Beginnen met een voorbeeldkaart.
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Notitie: Vóór het beginnen van deze oefening moet QGIS zijn geïnstalleerd op uw computer. Download ook het
bestand training_manual_exercise_data.zip vanaf het gebied voor downloaden van gegevens voor
QGIS.

Start QGIS met de sneltoets op het bureaublad, menuitem, etc., afhankelijk van hoe u de installatie ervan heeft
geconfigureerd.

Notitie: De schermafdrukken voor deze cursus werden genomen in QGIS 2.0 dat werd uitgevoerd op MacOS.
Afhankelijk van uw instellingen zouden de schermafdrukken die u tegenkomt er misschien ietwat anders uit kun-
nen zien. Echter, al dezelfde knoppen zullen nog steeds beschikbaar zijn en de instructies zullen op elk OS werken.
U heeft QGIS 2.0 (de laatste versie op het moment van schrijven) nodig om deze cursus te gebruiken.

Laten we direct gaan beginnen!

2.2.1 Follow Along: Een kaart voorbereiden

• Open QGIS. U zult een nieuwe, blanco kaart hebben.

• Zoek naar de knop Vectorlaag toevoegen:

• Klik er op om het volgende dialoogvenster te openen:

• Klik op de knop Bladeren en navigeer naar het bestand exercise_data/epsg4326/roads.shp
(in de map van uw cursus). Klik, met dit bestand geselecteerd, op click Openen. U zult het originele
dialoogvenster zien, maar met de naam van het bestand ingevuld. Klik ook hier op Openen. De gegevens
die u heeft gespecificeerd zullen nu worden geladen.

Gefeliciteerd! U heeft nu een basiskaart. Het is nu een goed moment om uw werk op te slaan.

• Klik op de knop Opslaan als:

• Sla de kaart op onder exercise_data/ en noem hem basic_map.qgs.

Controleer uw resultaten
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2.2.2 In Conclusion

U heeft geleerd hoe een laag toe te voegen en een basiskaart te maken!

2.2.3 What’s Next?

Nu u bekend bent met de functie van de knop Vectorlaag toevoegen, maar wat met al die andere? Hoe werkt deze
interface? Vóórdat we doorgaan met de meer betrokken delen zullen we eerst eens goed kijken naar de algemene
lay-out van de interface van QGIS. Dat is het onderwerp van de volgende les.

2.3 Lesson: Een overzicht van de interface

We zullen de gebruikersinterface van QGIS verkennen zodat u bekend raakt met de menu’s, werkbalken, kaartven-
ster en lagenlijst die de basisstructuur van de interface vormen.

Het doel voor deze les: Begrijpen van de basisonderdelen van de gebruikersinterface van QGIS.

2.3.1 Try Yourself: De basisonderdelen

De elementen die kunnen worden geïdentificeerd in de bovenstaande afbeelding zijn:

1. Lagenlijst / paneel Browser

2. Werkbalken

3. Kaartvenster

4. Statusbalk

5. Werkbalk zijkant
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De lagenlijst

In de lagenlijst kunt u op elke moment een lijst zien van alle lagen die voor u beschikbaar zijn.

Uitbreiden van samengevouwen items (door te klikken op de pijl of het symbool plus ernaast) zal u meer informatie
verschaffen over het huidige uiterlijk van de laag.

Rechts-klikken op een laag zal u een menu geven met heel veel extra opties. U zult sommige ervan op korte
termijn gaan gebruiken, kijk dus even rond!

Sommige versies van QGIS hebben een afzonderlijk keuzevak Control rendering order net onder de lagenlijst.
Geen probleem als u het niet ziet. Als het er is, zorg er dan voor nu voor dat het is geselecteerd.

Notitie: Een vectorlaag is een gegevensset, gewoonlijk van een specifiek soort object, zoals wegen, bomen, etc.
Een vectorlaag kan bestaan uit punten, lijnen of polygonen.

Het paneel Browser

De Browser van QGIS is een paneel in QGIS waarmee u eenvoudig door uw database kunt browsen. U heeft
daarbij toegang tot algemene vectorbestanden (bijv. ESRI shapefiles of bestanden van MapInfo ), databases (bijv.
PostGIS, Oracle, Spatialite of MSSQL Spatial) en webservices WMS/WFS. U kunt ook gegevens van GRASS
data bekijken.

Werkbalken

Uw meest gebruikte gereedschappen kunnen worden gewijzigd naar werkbalken voor basis toegang. De werkbalk
Project, bijvoorbeeld, stelt u in staat een nieuw project op te slaan, te laden, af te drukken en te beginnen. U
kunt de interface eenvoudig aanpassen zodat u alleen de door u meest gebruikte gereedschappen ziet, indien nodig
werkbalken toevoegen of verwijderen via het menu :menuselection:‘Beeld–> Werkbalken.

Zelfs als zij niet zichtbaar zijn in een werkbalk blijven al uw gereedschappen toegankelijk via de menu’s. Als
u bijvoorbeeld de werkbalk Project verwijdert (die de knop Opslaan bevat), kunt u nog steeds uw kaart opslaan
door te klikken op het menu Project en dan te klikken op Opslaan.

Het kaartvenster

Dit is waar de kaart zelf wordt weergegeven.

De Statusbalk

Toont u informatie over de huidige kaart. Stelt u ook in staat de schaal van de kaart aan te passen en de coördinaten
van de muiscursor op de kaart te zien.

2.3.2 Try Yourself 1

Probeer de vier hierboven vermelde elementen te identificeren op uw eigen scherm, zonder naar het diagram
hierboven te kijken. Kijk of u hun namen en functies kunt identificeren. U zult meer bekend raken met deze
elementen als u ze in de komende dagen gaat gebruiken.

2.3. Lesson: Een overzicht van de interface 15
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Controleer uw resultaten

2.3.3 Try Yourself 2

Probeer elk van deze gereedschappen op uw scherm te vinden. Wat zijn hun doelen?

1.

2.

3.

4.

5.

Notitie: Als een van deze gereedschappen niet zichtbaar is op het scherm, probeer dan enkele werkbalken in te
schakelen die momenteel verborgen zijn. Onthoud ook dat als er te weinig ruimte is op het scherm, een werk-
balk verkleind kan zijn door enkele van zijn gereedschappen te verbergen. U kunt de verborgen gereedschappen
zichtbaar maken door te dubbelklikken op de pijlknop rechts in een dergelijke verkleinde werkbalk. U kunt een
Helptip zien met de naam van elk gereedschap door de muiscursor enige tijd boven het gereedschap te houden.

Controleer uw resultaten

2.3.4 What’s Next?

Nu u heeft gezien hoe de interface van QGIS werkt, kunt u de beschikbare gereedschappen gebruiken en beginnen
met het verbeteren van uw kaart! Dat is het onderwerp voor de volgende les.
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CHAPTER 3

Module: Een basiskaart maken

In deze module zult u een basiskaart maken die later zal worden gebruikt als basis voor meer demonstraties van
de functionaliteit van QGIS.

3.1 Lesson: Werken met vectorgegevens

Vectorgegevens zijn mogelijkerwijze de meest voorkomende soort gegevens die u zult tegenkomen bij het ge-
bruiken van een GIS. Het beschrijft geografische gegevens in termen van punten, die kunnen zijn verbonden in
lijnen en polygonen. Elk object in a vector-gegevensset wordt een object genoemd, en wordt geassocieerd aan
gegevens die dat object beschrijven.

Het doel voor deze les: De structuur van vectorgegevens te leren en hoe vector-gegevenssets in een kaart moeten
worden geladen.

3.1.1 Follow Along: Laagattributen bekijken

Het is belangrijk te weten dat de gegevens waarmee u gaat werken niet alleen weergeven waar objecten in de
ruimte staan, maar ook dat ze u vertellen wat die objecten zijn.

Uit de eerdere oefening zou u de laag roads moeten hebben geladen in uw kaart. Wat u nu kunt zien is slechts de
positie van de wegen.

Alle voor u beschikbare gegevens zien met de laag roads geselecteerd in het paneel Lagen:

• Klik op deze knop:

Het zal u een tabel laten zien met meer gegevens over de laag roads. Deze extra gegevens worden gegevens voor
attributen genoemd. De lijnen die u op uw kaart kunt zien geven weer waar de wegen lopen; dat zijn de ruimtelijke
gegevens.

Deze definities worden veel gebruikt in GIS, het is dus essentieel om ze te onthouden!

• U mag nu de attributentabel sluiten.

Vectorgegevens geven objecten weer in termen van punten, lijnen en polygonen op een vlak van coördinaten. Het
wordt gewoonlijk gebruikt om afzonderlijke objecten, zoals wegen en huizenblokken, op te slaan.

3.1.2 Follow Along: Vectorgegevens uit shapefiles laden

Het shapefile is een specifieke bestandsindeling die u in staat stelt uw gegevens voor GIS in een geassocieerde
groep bestanden op te slaan. Elke laag bestaat uit verschillende bestanden met dezelfde naam, maar verschillende
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typen bestanden. Shapefiles zijn eenvoudig te versturen en te ontvangen en de meeste software voor GIS kan ze
lezen.

Bekijk nog eens de oefening in de introductie in het vorige gedeelte voor instructies over hoe vectorlagen toe te
voegen.

Laad de gegevenssets uit de map epsg4326 in uw kaart volgens dezelfde methode:

• “places”

• “water”

• “rivers”

• “buildings”

Controleer uw resultaten

3.1.3 Follow Along: Vectorgegevens uit een database laden

Databases stellen u in staat een grote hoeveelheid geassocieerde gegevens in één bestand op te slaan. U zou
al bekend kunnen zijn met een beheerssysteem voor databases (DBMS) zoals Microsoft Access. Toepassingen
voor GIS kunnen ook gebruik maken van databases. GIS-specifieke DBMS-en (zoals PostGIS) hebben extra
functies,omdat zij ruimtelijke gegevens moeten behandelen.

• Klik op dit pictogram:

(Als u er zeker van bent dat u het helemaal niet kan zien, controleer dan of de werkbalk Kaartlagen bewerken is
ingeschakeld.)

Het zal u een nieuw dialoogvenster geven. In dit dialoogvenster:

• Klik op de knop Nieuw.

• In dezelfde map epsg4326 zou u het bestand landuse.sqlite moeten vinden. Selecteer het en klik
op Openen.

U zult nu opnieuw het eerste dialoogvenster zien. merk op dat het keuzemenu boven de drie knoppen nu leest als
“landuse.sqlite@...”, gevolgd door het pad van het databasebestand op uw computer.

• Klik op de knop Verbinden. U zou dit moeten zien in het eerder lege vak:
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• Klik op de laag landuse om die te selecteren, klik dan op Toevoegen

Notitie: Onthoud om de kaart regelmatig op te slaan! Het bestand van de kaart bevat niet direct de gegevens,
maar het onthoud welke lagen u in uw kaart geladen heeft.

Controleer uw resultaten

3.1.4 Follow Along: De lagen opnieuw schikken

De lagen in uw lijst Lagen worden in een bepaalde volgorde op de kaart getekend. De laag onder in de lijst wordt
als eerste getekend en de laan aan de bovenkant wordt als laatste getekend. Door de volgorde waarin zij in de lijst
zijn weergegeven te wijzigen, kunt u de volgorde wijzigen waarin zij getekend worden.

Notitie: Afhankelijk van de versie van QGIS die u gebruikt, zou u een keuzevak Volgorde renderen beheren
onder uw lijst met lagen kunnen hebben. Deze moet zijn geselecteerd (ingeschakeld) zodat het verplaatsen van
lagen naar boven of beneden in de lijst ze naar voren of naar achteren op de kaart zal brengen. Als uw versie van
QGIS deze optie niet heeft dan is hij standaard ingeschakeld en hoeft u zich er geen zorgen om te maken.

De volgorde waarin de lagen zijn geladen in de kaart is in dit stadium waarschijnlijk niet logisch. Het is mogelijk
dat de laag met wegen volledig is verborgen omdat andere lagen er bovenop liggen.

Deze volgorde van lagen bijvoorbeeld...
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... zou resulteren in verborgen wegen en plaatsen omdat zij onder stedelijke gebieden liggen.

Dit probleem oplossen:

• Klik en sleep een laag uit de lijst met Lagen.

• Schik ze opnieuw naar deze volgorde:

U zult zien dat de kaart visueel nu meer betekenis heeft, met wegen en gebouwen die bovenop de regio’s van
landuse verschijnen.

3.1.5 In Conclusion

Nu heeft u alle lagen toegevoegd die u nodig heeft uit verschillende bronnen.

3.1.6 What’s Next?

Door het automatisch toegewezen willekeurige palet bij het laden van de lagen is uw huidige kaart waarschijnlijk
niet eenvoudig te lezen. Het verdient aanbeveling om uw eigen keuzes aan kleuren en symbolen toe te voegen.
Dat is wat u zult leren te doen in de volgende les.
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3.2 Lesson: Symbologie

De symbologie van een laag is zijn visuele uiterlijk op een kaart. De basissterkte van GIS boven andere manieren
van het weergegeven van gegevens met ruimtelijke aspecten is dat met GIS u een dynamische visuele weergave
heeft van de gegevens waarmee u werkt.

Daarom is het visuele uiterlijk van de kaart (die afhankelijk is van de symbologie van de individuele lagen) zeer
belangrijk. De eindgebruiker van de kaarten die u maakt moet in staat zijn om eenvoudig te zien wat de kaart
weergeeft. net zo belangrijk is dat u in staat moet zijn de gegevens te verkennen terwijl u ermee werkt, en goede
symbologie helpt daar veel bij.

Met andere woorden: juiste symbologie hebben is geen luxe of leuk om te hebben. In feite is het essentieel voor
u om een GIS juist te gebruiken en kaarten en informatie te produceren die mensen kunnen gebruiken.

Het doel voor deze les: Symbologie te kunnen maken die u wilt gebruiken voor een willekeurige vectorlaag.

3.2.1 Follow Along: Kleuren wijzigen

De kleur van de symbologie van een laag wijzigen: open zijn Laag eigenschappen. Laten we beginnen met het
wijzigen van de kleur van de laag landuse.

• Klik met rechts op de laag landuse in de Lagenlijst.

• Selecteer het menuitem Eigenschappen in het menu dat verschijnt.

Notitie: Standaard kunt u ook toegang krijgen tot de eigenschappen van een laag door erop te dubbelklikken in
de Lagenlijst.

In het venster Eigenschappen:

• Selecteer de tab Stijl uiterst links:
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• Klik op de knop Kleur selecteren naast het label Kleur.

Een standaard dialoogvenster Kleuren zal verschijnen.

• Kies een grijze kleur en klik op OK.

• Klik opnieuw op OK in het venster Laag eigenschappen en u zult zien dat de wijziging van de kleur is
toegepast op de laag.

3.2.2 Try Yourself

Wijzig de laag water naar een lichtere kleur blauw.

Controleer uw resultaten

3.2.3 Follow Along: Symboolstructuur wijzigen

Dit gaat tot dusverre prima., maar er is meer symbologie op een laag dan alleen de kleur ervan. Vervolgens willen
we de lijnen elimineren die tussen de verschillende gebieden van landuse bestaan om de kaart visueel minder
rommelig te laten lijken.
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• Open het venster Laag eigenschappen voor de laag landuse.

Op de tab Stijl zult u hetzelfde dialoogvenster zien als eerder. Deze keer echter gaat u meer doen dan alleen snel
de kleur wijzigen.

• Vergroot, in het paneel Symboollaag, de keuzelijst Vulling ( indien nodig) en selecteer de optie Standaard
vulling:

• Klik op de keuzelijst Randstijl. Op dit moment zou die een korte lijn moeten laten zien en de woorden
Doorlopende lijn.

• Wijzig dit naar Geen Pen.

• Klik op OK.

Nu zal de laag landuse geen lijnen tussen gebieden meer hebben.

3.2.4 Try Yourself

• Wijzig de symbologie van de laag water opnieuw zodat het een meer donkerblauwe rand heeft.

• Wijzig de symbologie van de laag rivers naar een zinvolle weergave van waterwegen.

Controleer uw resultaten
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3.2.5 Follow Along: Op schaal gebaseerde zichtbaarheid

Soms zult u vinden dat een laag niet geschikt is voor een opgegeven schaal. Een gegevensset van, bijvoorbeeld,
alle werelddelen kan een laag detail hebben en niet heel nauwkeurig zijn op straatniveau. Wanneer dat gebeurt
wilt u in staat zijn de gegevensset te verbergen voor niet toepasselijke schaalgrootten.

In ons geval zouden we kunnen besluiten om de gebouwen te verbergen van weergave op kleine schaalgrootten.
Deze kaart bijvoorbeeld ...

... is niet erg nuttig. De gebouwen zijn moeilijk te onderscheiden op die schaal.

Inschakelen van renderen gebaseerd op schaal:

• Open het dialoogvenster Laag eigenschappen voor de laag buildings.

• Activeer de tab Algemeen.

• Schakel op schaal gebaseerd renderen in door te klikken op het keuzevak gelabeld Schaalafhankelijke zicht-
baarheid:
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• Wijzig de waarde Minimum naar 1:10.000.

• Klik op OK.

Test de effecten hiervan door in- en uit te zoomen op uw kaart, merk op wanneer de laag buildings verdwijnt en
weer verschijnt.

Notitie: U kunt uw muiswiel gebruiken om in stappen te zoomen. Als alternatief kunt de gereedschappen
Zoomen gebruiken om in een venster te zoomen:

3.2.6 Follow Along: Symboollagen toevoegen

Nu u weet hoe u eenvoudige symbologie voor lagen kunt wijzigen, is de volgende stap om meer complexe sym-
bologie te maken. QGIS stelt u in staat dit te doen met behulp van symboollagen.

• Ga terug naar de symbooleigenschappen van de laag landuse door te klikken op Standaard vulling in het
Symboollaag paneel.

In dit voorbeeld heeft het huidige symbool geen rand (d.i., het gebruikt de randstijl Geen Pen).
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Selecteer Vulling in het paneel Symboollaag. Klik dan op de knop Symboollaag toevoegen:

• Klik er op en het dialoogvenster zal wijzigen naar iets wat lijkt op dit:

26 Chapter 3. Module: Een basiskaart maken



QGIS Training Manual, Release 2.14

(Het zou er, bijvoorbeeld, qua kleur iets anders uit kunnen zien, maar u gaat dat toch wijzigen.)

Nu is er een tweede symboollaag. Omdat het een effen kleur is zal het natuurlijk het eerdere soort symbool
volledig bedekken. En het heeft de randstijl Doorlopende lijn, die we niet willen. Duidelijk is dat dit symbool
moet worden gewijzigd.

Notitie: Het is belangrijk de kaartlaag en een een symboollaag niet met elkaar te verwarren. Een kaartlaag is een
vector (of raster) die in de kaart is geladen. Een symboollaag maakt deel uit van het symbool dat wordt gebruikt
om een kaartlaag weer te geven. Deze cursus zal gewoonlijk naar een kaartlaag verwijzen als laag, maar een
symboollaag zal, om verwarring te voorkomen, altijd een symboollaag worden genoemd.

Met de nieuwe laag Standaard vulling geselecteerd:

• Stel, net als tevoren, de randstijl in op Geen Pen.

• Wijzig de stijl voor de vulling naar iets anders dan Doorgetrokken of Geen vulling. Bijvoorbeeld:
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• Klik op OK. Nu kunt u uw resultaten zien en ze aanpassen zoals u wilt.

U kunt zelfs meerdere extra symboollagen toevoegen en op die manier een soort textuur voor uw laag maken.
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Het is leuk! Maar het heeft vermoedelijk teveel kleuren om op een echte kaart te gebruiken...

3.2.7 Try Yourself

• Onthoud om in te zoomen als dat nodig is, maak een eenvoudige, maar niet te afleidende textuur voor de
laag buildings met behulp van bovengenoemde methoden.

Controleer uw resultaten

3.2.8 Follow Along: Niveaus van symbolen schikken

Wanneer symboollagen worden gerenderd, worden zij ook in een serie gerenderd, soortgelijk aan de manier
waarop verschillende kaartlagen worden gerenderd. Dit betekent dat, in sommige gevallen, als u veel symboolla-
gen in één symbool heeft dat onverwachte resultaten kan opleveren.

• Geef de laag roads een extra symboollaag (met de methoden voor het toevoegen van symboollagen zoals
hierboven gedemonstreerd).

• Geef de basislijn een Pendikte van 0.3, een witte kleur en selecteer Streepjes uit de keuzelijst Penstijl.

• Geef de nieuwe, bovenste laag een dikte van 1,3 en zorg er voor dat het een Doorgetrokken lijn is.

U zult zien dat dit gebeurd:

3.2. Lesson: Symbologie 29



QGIS Training Manual, Release 2.14

Nou, dat is helemaal niet wat we willen!

U kunt de niveaus van symbolen sorteren en daarmee beheren in welke volgorde de verschillende symboollagen
worden gerenderd om te voorkomen dat dit gebeurt,

Selecteer de laag Line in het paneel Symboollagen, klik dan op Geavanceerd –> Symboollagen... in de rechter
benedenhoek van het venster om de volgorde van de symboollagen te wijzigen. Dit zal een dialoogvenster openen
zoals dit:

30 Chapter 3. Module: Een basiskaart maken



QGIS Training Manual, Release 2.14

Selecteer Symboollagen tonen. U kunt dan de volgorde van de lagen van elk symbool instellen door het
overeenkomende nummer voor het niveau in te voeren. 0 is de onderste laag.

In ons geval willen we de volgorde omdraaien, zoals deze:
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Dit zal de gestreepte witte lijn bovenop de dikke zwarte lijn renderen.

• Klik tweemaal op OK om terug te keren naar de kaart.

De kaart zal er nu zo uitzien:
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Merk ook op dat de ontmoetingspunten van wegen nu zijn “samengevoegd”, zodat de ene weg niet bovenop de
andere is gerenderd.

Als u klaar bent, onthoud dan om het symbool zelf op te slaan om niet uw werk te verliezen als in de toekomst het
symbool opnieuw wijzigt. U kunt de huidige stijl van uw symbool opslaan door te klikken op de knop Stijl opslaan
... onder de tab Stijl van het dialoogvenster Laag eigenschappen. In het algemeen zou u het moeten opslaan als
QGIS Laagstijlbestand.

Sla uw stijl op onder exercise_data/styles. U kunt een eerder opgeslagen stijl op elk moment laden door
te klikken op de knop Stijl laden .... Onthoud, voordat u een stijl wijzigt, dat elke niet opgeslagen stijl die u
vervangt verloren gaat.

3.2.9 Try Yourself

• Wijzig het uiterlijk van de laag roads opnieuw.

De wegen moeten smal zijn en middengrijs, met een dunne bleekgele rand. Onthoud dat u misschien de volgorde
voor het renderen van de laag moet wijzigen via het dialoogvenster Geavanceerd → Symboollagen....
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Controleer uw resultaten

3.2.10 Try Yourself

Symboollagen werken ook voor geclassificeerde lagen (d.i., lagen die meerdere symbolen hebben). Omdat we
classificatie nog niet behandeld hebben, zult u werken met enige rudimentaire vooraf geclassificeerde gegevens.

• Maak een nieuwe kaart en voeg alleen de gegevensset roads toe.

• Pas de stijl advanced_levels_demo.qml, verschaft in exercise_data/styles toe.

• Zoom in op het gebied Swellendam.

• Zorg er met behulp van symboollagen voor dat de randen van lagen in elkaar vloeien zoals in de afbeelding
hieronder:
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Controleer uw resultaten

3.2.11 Follow Along: Typen symboollagen

In aanvulling op het instellen van vulkleuren en het gebruiken van vooraf gedefinieerde patronen, kunt u geheel
andere typen symboollagen gebruiken. het enige type dat we tot op heden hebben gebruikt, was het type Standaard
vulling. De meer geavanceerde typen symboollagen stellen u in staat uw symbolen nog verder aan te passen.

Elk type vector (punt, lijn en polygoon) heeft zijn eigen set van typen symboollagen. Eerst zullen we kijken naar
de typen die beschikbaar zijn voor punten.

Typen symboollagen voor punt

• Open uw project basic_map.

• Wijzig de eigenschappen voor de laag places:
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• Een symboollaag type kan worden gekozen door bij Standaard symbool in the paneel Symboollagen te
selecteren uit de keuzelijst Symboollaagtype:

• Onderzoek de verschillende opties die voor u beschikbaar zijn en kies een symbool met de stijl waarvan u
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denkt dat die toepasselijk is.

• Indien u twijfelt, gebruik dan een rond Standaard symbool met een witte rand en een bleke groene vulling,
met een Grootte van 3,00 en een Lijndikte van 0,5.

Typen symboollagen voor lijn

De verschillende beschikbare opties voor lijngegevens bekijken:

• Wijzig het type symboollaag voor de bovenste symboollaag van roads naar Symbolen-lijn:

• Selecteer de laag Standaard symbool in het paneel Symboollagen. Wijzig de eigenschappen voor het sym-
bool zodat ze overeenkomen met dit dialoogvenster:
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• Wijzig de interval naar 1,00:
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• Controleer of de symboolniveau’s correct zijn (in het dialoogvenster Geavanceerd –> Symboollagen dat we
eerder gebruikten) alvorens de stijl toe te passen.

Als u de stijl eenmaal heeft toegepast kijk dan even naar de resultaten op de kaart. Zoals u kunt zien wijzigen deze
symbolen van richting met de weg maar buigen er niet altijd mee. Dit is voor sommige doeleinden nuttig, maar
niet voor andere. Als u wilt kunt u de symboollaag terug veranderen naar de manier waarop het eerder was.

Typen symboollagen voor polygoon

De verschillende beschikbare opties voor polygoongegevens bekijken:

• Wijzig het type symboollaag voor de laag water, zoals eerder voor de andere lagen.

• Onderzoek wat de verschillende opties in de lijst kunnen.

• Kies er een die u geschikt vindt.

• Indien u twijfelt, gebruik dan de Puntpatroonvulling met de volgende opties:
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• Voeg een nieuwe symboollaag toe met een normale Standaard vulling.

• Maak hem hetzelfde lichte blauw met een donkerblauwe rand.

• Verplaats het tot onder de puntpatroonvulling-symboollaag met de knop Naar beneden:
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Als resultaat heeft u een symbool met textuur voor de laag met water, met het toegevoegde voordeel dat u de
grootte vorm en afstand van de individuele stippen die de textuur vormen kunt wijzigen.

3.2.12 Follow Along: Een aangepaste SVG-vulling maken

Notitie: U moet de gratis software voor het bewerken van vectoren Inkscape hebben geïnstalleerd om deze
oefening te kunnen doen,

• Start het programma Inkscape.

U zult de volgende interface zien:
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Dit zou u bekend kunnen voorkomen als u eerder andere programma’s voor het bewerken van vectorafbeeldingen„
zoals Corel, hebt gebruikt.

Eerst zullen we het werkvenster wijzigen naar een grootte die toepasselijk is voor een kleine textuur.

• Klik op het menuitem Bestand→ Documenteigenschappen. Dit zal u het dialoogvenster Documenteigen-
schappen tonen.

• Wijzig Eenheden naar px.

• Wijzig de Breedte en Hoogte naar 100.

• Sluit het dialoogvenster als u klaar bent.

• Klik op het menuitem Beeld→ Zoomen → Pagina om de pagina te zien waar u mee werkt.

• Selecteer het gereedschap Cirkel:
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• Klik en sleep op de pagina om een ellips te tekenen. Houd de toets Ctrl ingedrukt terwijl u tekent, om van
de ellips een cirkel te maken.

• Klik met rechts op de cirkel die u zojuist gemaakt hebt en open zijn opties Vulling en lijn. U kunt het
renderen aanpassen, zoals:

– Wijzig de laag Vulling naar een lichtere kleur blauw.

– Wijs, op de tab Lijnkleur, een donkerder kleur toe aan de rand.

– En verklein de dikte van der rand op de tab Lijnstijl.
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• Teken een lijn met behulp van het gereedschap Potlood:

– Klik eenmaal om de lijn te beginnen. Houd Ctrl ingedrukt om het te laten ‘snappen’ in stappen van
15 graden.

– Verplaats de aanwijzer horizontaal en plaats een punt met één enkele klik.

– Klik en snap aan het hoekpunt van de lijn en maak een verticale lijn, beëindig die met één enkele klik.

– Verbindt de twee eindpunten met elkaar.

– Wijzig de kleur en breedte van het symbool Driehoek om het overeen te laten komen met de rand van
de cirkel en verplaats het indien nodig, zodat u eindigt met een symbool zoals dit:
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• Als het symbool naar uw wensen is, sla het op als landuse_symbol in de map waar de cursus in staat, onder
exercise_data/symbols, als SVG-bestand.

In QGIS:

• Open Laag eigenschappen voor de laag landuse.

• Wijzig, op de tab Stijl, de structuur van het symbool door SVG-symbool te selecteren als optie voor
Symboollaagtype, zoals hieronder weergegeven.

• Klik op de knop Bladeren om uw SVG-afbeelding te selecteren. Het is toegevoegd aan de boom
met symbolen en u kunt nu de verschillende karakteristieken ervan aanpassen (kleuren, hoek, effecten,
eenheden...).
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U wilt misschien ook de rand van de laag SVG bijwerken (zie hieronder):
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Als u eenmaal het dialoogvenster het gevalideerd, zouden objecten op de laag landuse nu moeten zijn bedekt
door een verzameling symbolen, die een textuur weergeven zoals die op de volgende kaart. Als texturen niet
zichtbaar zijn, dient u misschien in te zoomen op het kaartvenster of een grotere Breedte voor de textuur in te
stellen in de eigenschappen van de laag.
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3.2.13 In Conclusion

Wijizgen van de symbologie voor de verschillende lagen heeft een collectie vectorbestanden getransformeerd in
een leesbare kaart. Niet alleen kunt u zien wat er gebeurt, het ziet er ook leuk uit!

3.2.14 Further Reading

Voorbeelden van mooie kaarten

3.2.15 What’s Next?

Wijzigen van symbolen voor gehele lagen is nuttig, maar de informatie die is opgenomen in elke laag is nog niet
beschikbaar voor iemand die deze kaart leest. Hoe heten de straten? Tot welke administratieve regio’s behoren
bepaalde gebieden? Wat zijn de relatieve oppervlaktegebieden van de boerderijen? Al deze informatie is nog
steeds verborgen. De volgende les zal uitleggen hoe u deze gegevens op uw kaart weergeeft.

Notitie: Heeft u onthouden om uw kaart regelmatig op te slaan?
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CHAPTER 4

Module: Vectorgegevens classificeren

Classificeren van vectorgegevens stelt u in staat verschillende symbolen aan objecten toe te wijzen (verschillende
objecten op dezelfde laag), afhankelijk van hun attributen. Dit stelt iemand die de kaart gebruikt in staat om de
attributen van de verschillende objecten te zien.

4.1 Lesson: Attributengegevens

Tot nu toe zijn geen van de wijzigingen, die wij aan de kaart hebben verricht, beïnvloed door de objecten die
worden weergegeven. Met andere woorden, alle gebieden van het gebruik van het land zien er hetzelfde uit, en
alle wegen zien er hetzelfde uit. Bij het kijken naar de kaart weten de kijkers niets over de wegen die zij zien;
alleen dat er een weg met een bepaalde vorm in een bepaald gebied ligt.

Maar de gehele kracht van GIS is dat alle objecten die zichtbaar op de kaart staan ook attributen hebben. Kaarten in
een GIS zijn niet slechts afbeeldingen. Zij vertegenwoordigen niet alleen objecten op locaties, maar ook informatie
over deze objecten.

Het doel van deze les: De gegevens van attributen van een object verkennen en begrijpen waar de verschillende
gegevens nuttig voor kunnen zijn.

4.1.1 Follow Along: Attribuutgegevens

Open de attributentabel voor de laag places (bekijk indien nodig het eerdere gedeelte “Werken met vec-
torgegevens”). Welk veld zou het meest nuttig zijn om weer te geven in de vorm van een label, en waarom?

Controleer uw resultaten

4.1.2 In Conclusion

U weet nu hoe u de attributentabel kunt gebruiken om te zien wat er echt in de gegevens staat die u gebruikt. Een
gegevensset zal alleen nuttig voor u zijn als het de attributen heeft waar het u om gaat. Als u weet welke attributen
u nodig heeft, kunt u snel beslissen of u een bepaalde gegevensset kunt gebruiken, of dat u naar een andere moet
zoeken die wel de vereiste gegevens voor de attributen heeft.

4.1.3 What’s Next?

Verschillende attributen zijn nuttig voor verschillende doeleinden. Sommige ervan kunnen direct als tekst worden
weergegeven om door de gebruiker van de kaart te worden gezien. Hoe dit te doen leert u in de volgende les.
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4.2 Lesson: Het gereedschap Label

Labels kunnen aan een kaart worden toegevoegd om elke soort informatie over een object weer te geven. Elke
vectorlaag kan labels met zich geassocieerd hebben. Deze labels zijn afhankelijk van de gegevens voor attributen
van een laag voor hun inhoud.

Notitie: Het dialoogvenster Laag-eigenschappen heeft een tab Labels, die nu dezelfde functionaliteit verschaft,
maar voor dit voorbeeld zullen we het gereedschap Label gebruiken, waar toegang toe te krijgen is via een knop
op de werkbalk.

Het doel voor deze les: Nuttige en goed uitziende labels toe kunnen passen op een laag.

4.2.1 Follow Along: Labels gebruiken

Voordat u toegang kunt krijgen tot het gereedschap Label, dient u zich er van te vergewissen dat dat is geactiveerd.

• Ga naar het menuitem Beeld → Werkbalken.

• Zorg er voor dat het item Label een vinkje voor zich heeft staan. Als dat niet zo is, klik dan op het item
Label en het zal worden geactiveerd.

• Klik op de laag places in de Lagenlijst, zodat die wordt geaccentueerd.

• Klik op de volgende knop op de werkbalk:

Dit geeft u het dialoogvenster Instellingen voor het labelen van Laag.

• Selecteer het vak naast Deze laag labelen met....

U zult moeten kiezen welk veld in de attributen zal worden gebruikt voor de labels. In de vorige les heeft u
besloten dat het veld NAME het meest geschikte voor dit doel was.

• Selecteer name uit de lijst:
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• Klik op OK.

De kaart zou nu labels koeten hebben zoals deze:
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4.2.2 Follow Along: Opties voor labels wijzigen

Afhankelijk van de stijlen die u in eerdere lessen voor uw kaart koos, zou u kunnen vinden dat de labels niet
toepasselijk zijn opgemaakt en ofwel elkaar overlappen of te ver af staan van hun markeringen voor het punt.

• Open het gereedschap Label opnieuw door, net als eerder, te klikken op de knop ervan.

• Zorg er voor dat Tekst is geselecteerd in de lijst met opties aan de linkerkant, werk dan de opties voor
tekstopmaak bij zodat die overeenkomen met die welke hier worden weergegeven:
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Het probleem met het lettertype is opgelost! Laten we nu kijken naar het probleem dat labels de punten overlappen,
maar voordat we dat doen, kijken we even naar de optie Buffer.

• Open het dialoogvenster Label.

• Selecteer Buffer uit de lijst met opties aan de linkerkant.

• Selecteer het keuzevak naast Teken tekstbuffer, en kies dan de opties, zodat die overeenkomen met die welke
hier worden weergegeven:
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• Klik op Apply.

U zult zien dat dit een gekleurde buffer of rand toevoegt aan de labels met plaatsen, wat het eenvoudiger maakt ze
te zien op de kaart:

56 Chapter 4. Module: Vectorgegevens classificeren



QGIS Training Manual, Release 2.14

Nu kunnen we de plaatsing van de labels in relatie tot hun punt markeringen aanpakken.

• In het dialoogvenster Label, ga naar de tab Plaatsing.

• Wijzig de waarde van Afstand naar 2mm en zorg er voor dat Rondom punt is geselecteerd:
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• Klik op Apply.

U zult nu zien dat de labels niet langer hun punt-markeringen overlappen.

4.2.3 Follow Along: Labels in plaats van symbologie voor lagen gebruiken

In veel gevallen hoeft de locatie van een punt niet heel specifiek te zijn. Bijvoorbeeld: de meeste punten in de
laag places verwijzen naar gehele steden of voorsteden, en het specifieke punt dat is geassocieerd met dergelijke
objecten is niet zo specifiek op een grote schaal. In feite is het opgeven van een punt dat te specifiek is vaak
verwarrend voor iemand die een kaart leest.

Een voorbeeld: op een kaart van de wereld zou het punt dat wordt opgegeven voor de Europese Unie bijvoorbeeld
ergens in Polen kunnen liggen. Voor iemand die de kaart leest zou het zien van een punt dat is gelabeld Europese
Unie in Polen, zou het kunnen lijken dat de hoofdstad van de Europese Unie daarom in Polen ligt.

Het is vaak nuttig om de symbolen voor punten uit te schakelen en ze compleet te vervangen door labels om dus
dit soort misverstanden te voorkomen.

In QGIS kunt u dit doen door de positie van de labels te wijzigen zodat ze direct worden gerenderd over de punten
waar zij naar verwijzen.

• Open het dialoogvenster Instellingen voor het labelen van Laag voor de laag places.

• Selecteer de optie Plaatsing uit de lijst met opties.

• Klik op de knop Op afstand van punt.
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Dit zal de opties Kwadrant onthullen die u kunt gebruiken om de positie van het label in relatie tot de punt-
markering in te stellen. In dit geval willen we het label centreren op het punt, dus kies het kwadrant in het
centrum:

• Verberg de symbolen voor de punten door zoals gewoonlijk de stijl van de laag te bewerken, en stel de
grootte van de breedte en hoogte van Standaard symbool in op 0:
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• Klik op OK en u zult dit resultaat zien:
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Als u zou uitzoomen uit de kaart, zou u zien dat sommige van de labels verdwijnen op grotere schalen om overlap-
pen te vermijden. Soms is dat wat u wilt wanneer u met gegevenssets werkt die veel punten hebben, maar andere
keren zult u op deze manier nuttige informatie verliezen. Er is een andere mogelijkheid voor het behandelen van
dit soort gevallen, die we in een latere oefening in deze les zullen behandelen.

4.2.4 Try Yourself De labels aanpassen

• Zet de instellingen voor label en symbool terug naar de punt-markering en een afstand tot punt van 2.00mm.
U zou in dit stadium misschien de opmaak van de punt-markering of labels willen aanpassen.

Controleer uw resultaten

• Stel de kaart in op de schaal 1:100000. U kunt dit doen door dit in te typen in het vak Schaal op de
Statusbalk.

• Pas uw labels zo aan dat zij geschikt zijn om te bekijken op deze schaal.

Controleer uw resultaten
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4.2.5 Follow Along: Lijnen labelen

Nu u weet hoe het labelen werkt is er een aanvullend probleem. Punten en polygonen zijn eenvoudig te labelen,
maar hoe gaat dat met lijnen? Als u ze op dezelfde manier labelt als de punten, zouden uw resultaten er als volgt
uitzien:

We zullen nu de labels voor de laag roads opnieuw opmaken zodat zij eenvoudiger te begrijpen zijn.

• Verberg de laag Places zodat die u niet afleidt.

• Activeer labels voor de laag roads zoals eerder.

• Stel de Grootte van het lettertype in op 10 zodat u meer labels kunt zien.

• Zoom in op het stadsgebied Swellendam.

• Kies, op de tab Geavanceerd in het dialoogvenster Label, de volgende instellingen:
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U zult waarschijnlijk merken dat de opmaak voor de tekst standaard waarden heeft gebruikt en dat de labels als
consequentie daarvan moeilijk te lezen zijn. Stel de opmaak voor de tekst van het label in op Kleur donkergrijs
of zwart en een lichtgele Buffer.

De kaart zal er ongeveer zoals deze uitzien, afhankelijk van de schaal:
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U zult zien dat sommige namen van wegen meerdere malen verschijnen en dat is niet altijd nodig. Dit voorkomen:

• Kies, in het dialoogvenster Instellingen voor het labelen van Laag, de optie Rendering en selecteer Aan
elkaar verbonden lijnen samenvoegen om labelduplicaten te voorkomen:
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• Klik op OK

Een andere nuttige functie is om te voorkomen dat labels die worden getekend voor objecten te kort worden om te
worden opgemerkt.

• Stel, in hetzelfde paneel Rendering, de waarde van Onderdruk labelen van objecten kleiner dan ... in op
5mm en bekijk de resultaten als u op Apply klikt.

Probeer ook de verschillende instellingen voor Plaatsing uit. Zoals we eerder hebben gezien, is de optie Horizon-
taal in dit geval geen goed idee, dus laten we in plaats daarvan de optie Gebogen gebruiken.

• Selecteer de optie Gebogen in het paneel Plaatsing van het dialoogvenster Instellingen voor het labelen van
Laag.

Hier is het resultaat:
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Zoals u kunt zien verbergt dit een groot aantal labels die eerder zichtbaar waren, wegens de moeilijkheid voor
sommige ervan om gebogen lijnen voor wegen te volgen en nog steeds leesbaar te zijn. U kunt beslissen om deze
opties te gebruiken, afhankelijk van wat u denkt dat nuttiger is of er beter uitziet.

4.2.6 Follow Along: Gegevensgedefinieerde instellingen

• Deactiveer het labelen voor de laag Roads.

• Activeer opnieuw het labelen voor de laag Places.

• Open de attributentabel voor Places via de knop .

Het heeft één veld wat nu voor ons van belang is: place wat het type stadsgebied definieert voor elk object. We
kunnen deze gegevens gebruiken om de stijlen voor labels te beïnvloeden.

• Navigeer naar het paneel Tekst in het paneel Labels van places.

• Selecteer, in de keuzelijst Cursief, kbd:Bewerken... om de Expressie-string bouwer te openen:
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In het vak voor tekstinvoer, type: "place" = ’town’ en klik tweemaal op OK:
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Kijk naar de effecten:
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4.2.7 Try Yourself Gegevensgedefinieerde instellingen gebruiken

Notitie: We springen hier een stukje vooruit om enkele geavanceerde instellingen voor labelen te demonstreren.
Op het niveau voor gevorderden wordt aangenomen dat u weet wat het volgende betekent. Als u dat niet weet, laat
dit gedeelte dan rusten en kom later terug als u de vereiste materialen heeft behandeld.

• Open de attributentabel voor places.

• Ga naar de modus Bewerken door te klikken op deze knop:

• Voeg een nieuwe kolom in:

• Configureer die als volgt:
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• Gebruik dit om aangepaste lettergrootten in te stellen voor elk verschillend type plaats d.(i.e., elke sleutel in
het veld PLACE).

Controleer uw resultaten

4.2.8 Meer mogelijkheden met labelen

We kunnen in deze cursus niet elk optie behandelen, maar onthoud dat het gereedschap Label nog veel meer
andere nuttige functies heeft. U kunt schaalafhankelijk renderen instellen, de prioriteit voor het afdrukken van
labels in een laag wijzigen, en elke optie voor labelen instellen met behulp van attributen van lagen. U kunt
zelfs de rotatie, XY-positie en andere eigenschappen van een label instellen (als u velden voor attributen voor dat
doel heeft toegewezen), en deze eigenschappen bewerken met behulp van de gereedschappen aansluitend aan het
hoofdvenster van Label:

(Deze gereedschappen zullen actief zijn als de vereiste velden voor attributen bestaan en u in de modus bewerken
bent.)

Het staat u uiteraard vrij om meer mogelijkheden van het systeem voor labelen te verkennen.

4.2.9 In Conclusion

U heeft nu geleerd hoe u attributen van lagen gebruikt voor het maken van dynamische labels. Dit kan uw kaart
veel informatiever maken en meer stijl geven!
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4.2.10 What’s Next?

Nu u weet hoe attributen een visueel verschil voor uw kaart kunnen maken, hoe zijn ze te gebruiken om de
symbologie van objecten zelf te wijzigen? Dat is het onderwerp voor de volgende les!

4.3 Lesson: Classificatie

Labels zijn een goede manier om informatie te communiceren, zoals de namen van individuele plaatsen, maar zij
kunnen niet overal voor worden gebruikt. Laten we bijvoorbeeld zeggen dat iemand wil weten waar elk gebied
van landuse voor wordt gebruikt. Met behulp van labels zou u dit krijgen:

Dit maakt het labelen van de kaart moeilijk te lezen en zelfs overweldigend als er onnoemelijk veel verschillende
gebieden voor het gebruik van land zijn op de kaart staan.

Het doel voor deze les: Leren om vectorgegevens effectief te classificeren.

4.3.1 Follow Along: Nominale gegevens classificeren

• Open het dialoogvenster Laag eigenschappen voor de laag landuse.

• Ga naar de tab Style.

• Klik op de keuzelijst genaamd Enkel symbool en wijzig het naar Categorieën:
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• Wijzig, in het nieuwe paneel, Kolom naar landuse en Kleurverloop naar Greens.

• Klik op de knop genaamd Classificeren:
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• Klik op OK.

U zult iets zien zoals dit:
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• Klik op de pijl (of plusteken) naast landuse in de Lagenl;ijst, u zult de categorieën zien uitgelegd:

Nu zijn onze polygonen voor het gebruik van land toepasselijk gekleurd en geclassificeerd zodat gebieden met
hetzelfde gebruik van het land dezelfde kleur hebben. U wilt misschien de zwarte rand uit de laag landuse verwi-
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jderen:

• Open Laag eigenschappen, ga naar de tab Stijl en selecteer Symbool.

• Wijzig het symbool door de rand te verwijderen van de laag Standaard vulling en klik op OK.

U zult zien dat de randen van de polygonen voor gebruik van het land zijn verwijderd, wat rest zijn de nieuwe
vulkleuren voor elke categorie.

• Als u wilt kunt de kleur voor elk gebied voor gebruik van het land wijzigen door te dubbelklikken op het
relevant kleurblok:

Merk op dat er één categorie is die leeg is:
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Deze lege categorie wordt gebruikt om objecten te kleuren die geen waarde voor het gebruik van het land
gedefinieerd hebben of een waarde NULL hebben. Het is belangrijk om deze lege categorie te behouden zo-
dat gebieden met een waarde NULL nog steeds worden weergegeven op de kaart. U wilt misschien de kleur
wijzigen naar een meer opvallende om een blanco of NULL-waarde weer te geven.

Onthoud om uw kaart nu op te slaan zodat u uw welverdiende wijzigingen niet verliest!

4.3.2 Try Yourself Meer classificatie

Als u alleen de inhoud voor het basisniveau volgt, gebruik dan de kennis die u hierboven hebt opgedaan om de
laag buildings te classificeren. Stel de categorie in op de kolom building en gebruik de kleurenbalk Spectraal.

Notitie: Onthoud om in te zoomen op een stadsgebied om de resultaten te zien.

4.3.3 Follow Along: Ratio-classificatie

Er zijn vier typen classificatie: nominaal, ordinaal, interval en ratio.
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Bij nominale classificatie zijn de categorieën waarin de objecten worden geclassificeerd gebaseerd op namen; zij
hebben geen volgorde. Bijvoorbeeld: namen van steden, codes voor buurten, etc.

Bij ordinale classificatie worden de categorieën geschikt in een bepaalde volgorde. Wereldsteden wordt bijvoor-
beeld een rang gegeven afhankelijk van hun belang voor de wereldhandel, reizen, cultuur, etc.

Bij classificatie op interval staan de getallen op een schaal met positieve, negatieve en nulwaarden. Bijvoorbeeld:
hoogte boven/onder zeeniveau, temperatuur boven/onder het vriespunt (0 graden Celsius), etc.

Bij ratio-classificatie staan de getallen op een schaal met alleen positieve en nulwaarden. Bijvoorbeeld: temper-
atuur boven absoluut nul (0 graden Kelvin), afstand vanaf een punt, de gemiddelde hoeveelheid verkeer in een
bepaalde straat per maand, etc.

In het voorbeeld hierboven gebruikten we nominale classificatie om elke boerderij toe te wijzen aan de stad waarin
hij administratief ligt. Nu zullen we ratio-classificatie gebruiken om de boerderijen per gebied te classificeren.

• Sla uw symbologie voor het gebruik van het land op (als u die wilt behouden) door te klikken op de knop
Stijl opslaan ... in het dialoogvenster Stijl.

We gaan de laag opnieuw classificeren dus zullen bestaande klassen verloren gaan indien zij niet zijn opgeslagen.

• Sluit het dialoogvenster Stijl.

• Open de attributentabel voor de laag landuse.

We willen de gebieden voor het gebruik van het land classificeren op grootte, maar er is een probleem: zij hebben
geen veld voor de grootte, dus zullen we er een moeten maken.

• Ga naar de modus Bewerken met deze knop:

• Voeg een nieuwe kolom toe met deze knop:

• Stel het dialoogvenster dat verschijnt als volgt in:
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• Klik op OK.

Het nieuwe veld zal worden toegevoegd (aan de uiterste rechterkant van de tabel; u zult misschien horizontaal
moeten scrollen om het te zien). Op dit moment bevat het echter geen gegevens, het heeft slechts veel waarden
NULL.

We moeten de gebieden berekenen om dit probleem op te lossen.

• Open het veld Veldberekening:

U krijgt dit dialoogvenster:
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• Wijzig de waarden aan de bovenzijde van het dialoogvenster zodat het er zo uitziet:

• In de Functielijst, selecteer Geometrie → $area:
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• Dubbelklik er op zodat het in het veld Expressie verschijnt.

• Klik op OK.

Nu is uw veld AREA gevuld met waarden (u moet misschien op de kolomkop klikken om de gegevens te
vernieuwen). Sla de bewerkingen op en klik op Ok.

Notitie: Deze gebieden zijn in graden. Later zullen we ze in vierkante meters berekenen.

• Open de tab Stijl van het dialoogvenster Laag eigenschappen.

• Wijzig de stijl voor de classificatie van Categorieën naar Gradueel.

• Wijzig de Kolom naar AREA:

• Kies, onder Kleurverloop, de optie Nieuw kleurverloop... om dit dialoogvenster te krijgen:
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• Kies Gradient (als het al niet geselecteerd is) en klik op OK. U zult dit zien:
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U zilt dit gebruiken om gebieden aan te duiden, met kleine gebieden als Kleur 1 en grote gebieden als Kleur 2.

• Kies toepasselijke kleuren.

In het voorbeeld ziet het resultaat er als volgt uit:
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• Klik op OK.

• Kies een geschikte naam voor het nieuwe kleurverloop.

• Klik op OK na het invullen van de naam.

Nu zult u iets zien zoals dit:
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Laat alles zoals het is.

• Klik op Ok:
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4.3.4 Try Yourself De classificatie verfijnen

• De lijnen tussen de klassen verwijderen.

• Wijzig de waarden van Modus en Klassen totdat u een classificatie heeft die zinvol is.

Controleer uw resultaten

4.3.5 Follow Along: Op regels gebaseerde classificatie

Het is vaak nuttig om meerdere criteria voor een classificatie te combineren, maar helaas houdt normale classifi-
catie slechts rekening met één attribuut. Dat is waar op regels gebaseerde classificatie handig is.

• Open het dialoogvenster Laag eigenschappen voor de laag landuse.

• Schakel naar de tab Stijl.

• Schakel de stijl voor de classificatie naar Regel-gebaseerd. U krijgt dit:
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• Klik op de knop Regel toevoegen: .

• Er verschijnt dan een nieuw dialoogvenster.

• Klik op de knop Ellipsis ... naast het tekstgebied Filter.

• Voer, met behulp van de querybouwer die verschijnt, het criterium "landuse" = ’residential’
AND "name" != ’ |majorUrbanName| ’ in , klik op OK en kies een bleek blauwgrijs voor de
rand:
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• Voeg een nieuw criterium toe "landuse" != ’residential’ AND AREA >= 0.00005 en kies
een gemiddelde groene kleur.

• Voeg nog een nieuw criterium "name" = ’ |majorUrbanName| ’ toe en wijs het een donkerder
grijsblauwe kleur toe om het belang van de stad in de regio aan te duiden.

• Klik en sleep dit criterium naar de bovenste plaats in de lijst.

Deze filters zijn exclusief, met dien verstande dat zij collectief enkele gebieden op de kaart uitsluiten (d.i. die
welke kleiner zijn dan 0.00005, geen woongebied zijn en niet ‘Swellendam‘ zijn). Dit betekent dat de uitgesloten
polygonen de stijl aannemen van de standaard categorie (no filter).

We weten dat de op onze kaart uitgesloten polygonen geen woongebieden kunnen zijn, dus geef de standaard
categorie een geschikte bleekgroene kleur.

Uw dialoogvenster zou er nu ongeveer zo uit moeten zien:
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• Pas deze symbologie toe.

Uw kaart zal er ongeveer zo uitzien:
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Nu heeft u een kaart met Swellendam als het meest prominente woongebied en andere gebieden die geen woonge-
bied zijn gekleurd overeenkomstig hun grootte.

4.3.6 In Conclusion

Symbologie stelt ons in staat de attributen van een kaart weer te geven op een eenvoudig te lezen manier. Het stelt
zowel ons als de lezer van de kaart in staat om de significantie van objecten te begrijpen, met behulp van relevante
attributen die we kiezen. Afhankelijk van de problemen die u tegenkomt, pas u verschillende technieken voor
classificatie toe om ze op te lossen.

4.3.7 What’s Next?

Nu hebben we een kaart die er goed uitziet, maar hoe krijgen we die uit QGIS en in een indeling die we kunnen
afdrukken, of waarvan we een afbeelding of PDF kunnen maken? Dat is het onderwerp van de volgende les!
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CHAPTER 5

Module: Kaarten maken

In deze module zult u leren hoe u de Printvormgeving van QGIS gebruikt om kwaliteitskaarten te maken met alle
vereiste kaartitems.

5.1 Lesson: Printvormgeving gebruiken

Nu u een kaart heeft, dient u in staat te zijn die af te drukken of het naar een document te exporteren. De reden
daarvoor is dat een kaartbestand in GIS geen afbeelding is. Het slaat meer de status van het programma van
GIS op, met verwijzingen naar alle lagen, hun labels, kleuren, etc. Dus voor iemand die niet de gegevens heeft
of hetzelfde programma voor GIS (zoals QGIS), zal het kaartbestand nutteloos zijn. Gelukkig kan QGIS zijn
kaartbestand exporteren naar een indeling die ieders computer kan lezen, als ook de kaart afdrukken als u met een
printer verbonden bent. Zowel exporteren als afdrukken wordt afgehandeld via de Printvormgeving.

Het doel voor deze les: De Printvormgeving van QGIS te gebruiken om een basiskaart te maken met alle vereiste
instellingen.

5.1.1 Follow Along: De Printvormgeving-manager

QGIS stelt u in staat meerdere kaarten te maken met behulp van hetzelfde kaartbestand. Om die reden heeft het
een gereedschap genaamd Printvormgeving-manager.

• Klik op het menuitem Project → Printvormgeving-manager om dit gereedschap te openen. U zult een
blanco dialoogvenster voor Printvormgeving-manager zien verschijnen.

• Klik op de knop Toevoegen en geef de nieuwe printvormgeving de naam Swellendam.

• Klik op OK.

• Klik op de knop Tonen.

(U zou ook het dialoogvenster kunnen sluiten en navigeren naar een printvormgeving via de menu’s Project →
Printvormgeving, zoals in de afbeelding hieronder.)
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Welke route u ook neemt om er te komen, u zult nu het venster Printvormgeving zien:

92 Chapter 5. Module: Kaarten maken



QGIS Training Manual, Release 2.14

5.1.2 Follow Along: Compositie basiskaart

In dit voorbeeld was de lay-out al zoals we die wilden hebben. Zorg er voor dat die van u dat ook is.

• Controleer, in het venster Printvormgeving, dat de waarden onder Lay-out→ Papier en kwaliteit zijn in-
gesteld op het volgende:

• Grootte: A4 (210x297mm)

• Oriëntatie: Liggend

• Kwaliteit: 300dpi

Nu heeft u de lay-out van de pagina zoals u die wilt hebben, maar deze pagina is nog steeds blanco. Er ontbreekt
duidelijk een kaart. Laten we dat repareren!

• Klik op de knop Nieuwe kaart toevoegen:

U zult, met dit gereedschap geactiveerd, in staat zijn een kaart op de pagina te plaatsen.

• Klik en sleep een vak op de blanco pagina:

De kaart zal verschijnen op de pagina.

• Verplaats de kaart door er op te klikken en rond te slepen:
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• Pas de grootte aan door op de vakken in de hoeken te klikken en te slepen:

Notitie: Uw kaart zou er natuurlijk heel anders uit kunnen zien! dat is afhankelijk van hoe uw eigen project is
opgezet. Maar geen zorgen! Deze instructies zijn algemeen, dus zij werken hetzelfde ongeacht hoe de kaart zelf
eruit ziet.

• Zorg er voor marges langs de randen te laten en een ruimte aan de bovenzijde voor een titel.

• Zoom in en uit op de pagina (maar niet de kaart!) met behulp van deze knoppen:

94 Chapter 5. Module: Kaarten maken



QGIS Training Manual, Release 2.14

• Zoom en pan de kaart in het hoofdvenster van QGIS. U kunt ook de kaart pannen met behulp van het

gereedschap Onderdeel inhoud verschuiven:

De weergave van de kaart zal bij het inzoomen zichzelf niet verversen. Dat is zo omdat het uw tijd niet verdoet
met het hertekenen van de kaart terwijl u aan het zoomen bent op de pagina tot waar u wilt zijn, maar het betekent
ook dat als u in- of uitzoomt, de kaart op de verkeerde resolutie zal staan en er lelijk of onleesbaar uitziet.

• Forceer de kaart om te vernieuwen door te klikken op deze knop:

Onthoud dat de grootte en positie die u voor de kaart heeft opgegeven niet bindend hoeven te zijn. U kunt altijd
terugkomen en het later wijzigen als u niet tevreden bent. Voor nu dient u zich er van te vergewissen dat u uw werk
aan deze kaart heeft opgeslagen. Omdat een Printvormgeving in QGIS deel uitmaakt van het hoofd-kaartbestand,
zult u uw hoofdproject moeten opslaan. Ga naar het hoofdvenster van QGIS (dat met de Lagenlijst en alle andere
bekende elementen waar u eerder mee werkte), en sla uw project vanuit daar op zoals gewoonlijk.

5.1.3 Follow Along: Een titel toevoegen

Nu ziet uw kaart er op de pagina goed uit, maar uw lezers/gebruikers wordt nog niet verteld wat er gaande is. Zij
hebben een soort context nodig, wat is wat u hen verschaft door middel van het toevoegen van kaartitems. Laten
we eerst een titel toevoegen.

• Klik op deze knop:

• Klik op de pagina, boven de kaart, en een label zal boven de kaart verschijnen.

• Pas de grootte aan en plaats het in het midden boven aan de pagina. Het kan op dezelfde manier worden
aangepast en verplaatst als waarop de grootte van de kaart aanpaste en die verplaatste.

Als u de titel verplaatst, zult u merken dat er hulplijnen verschijnen om u te helpen de titel in het midden van de
pagina te plaatsen.

Er is echter ook een gereedschap om u te helpen de titel relatief aan de kaart (niet de pagina) te plaatsen:

• Klik op de kaart om die te selecteren.

• Houdt shift ingedrukt op uw toetsenbord en klik op het label zodat zowel de kaart als het label zijn
geselecteerd.

• Zoek naar de knop Links uitlijnen en klik op de pijl voor het keuzemenu daarnaast om de opties voor
plaatsing weer te geven en klik op Midden uitlijnen:
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Er voor zorgen dat u niet per ongeluk deze items verplaatst nu ze uitgelijnd zijn:

• Klik met rechts op zowel de kaart als het label.

Een klein pictogram van een slot zal in de hoek verschijnen om aan te geven dat een item nu niet kan worden
versleept. U kunt echter op elk moment weer met rechts op het item klikken om het los te maken.

Nu is het label gecentreerd aan de kaart, maar niet de inhoud ervan. De inhoud van het label centreren:

• Selecteer het label door er op te klikken.

• Klik op de tab Item-eigenschappen in het zijpaneel van het venster Printvormgeving.

• Wijzig de tekst van het label naar “Swellendam”:

• gebruik deze interface om het lettertype en de optie voor uitlijning in te stellen:

• Kies een groot maar zinnig lettertype (het voorbeeld zal het standaard lettertype gebruiken met een grootte
van 36) en stel Horizontaal in op Centreren.
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U kunt ook de kleur van het lettertype wijzigen, maar het is waarschijnlijk het beste om die zwart te laten staan,
zoals de standaard is.

De standaard instelling is om geen kader toe te voegen rondom het tekstvak van de titel. Als u echter een kader
wilt toevoegen, kunt u dat zo doen:

• Scroll, op de tab Item-eigenschappen, naar beneden tot u de optie Frame ziet.

• Klik op het keuzevak Frame om het kader in te schakelen. U kunt ook de kleur en breedte van het kader
wijzigen.

In dit voorbeeld zullen we het kader niet inschakelen, dus is dit tot dusverre onze pagina:

5.1.4 Follow Along: Een legenda toevoegen

De lezer van de kaart moet ook in staat zijn te zien welke verschillende dingen op de kaart eigenlijk betekenen. In
sommige gevallen, zoals de plaatsnamen, is dit nogal duidelijk. In andere gevallen is het moeilijker te raden, zoals
voor de kleuren van de boerderijen. Laten we een nieuwe legenda toevoegen.

• Klik op deze knop:

• Klik op de pagina om de legenda te plaatsen en verplaatst die naar waar u hem wilt:
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5.1.5 Follow Along: Items voor legenda’s aanpassen

Niet alles op een legenda is noodzakelijk, dus laten we enkele niet gewenste items verwijderen.

• Op de tab Item eigenschappen vindt u het paneel Legenda-items.

• Selecteer het item buildings.

• Verwijder het uit de legenda door te klikken op de knop min:

U kunt ook items hernoemen.

• Selecteer een laag uit dezelfde lijst.

• Klik op deknop Bewerken:

• Hernoem de lagen naar Plaatsen, Wegen en straten, Oppervlaktewater, en Rivieren.

• Stel landuse in op Verborgen, en klik dan op de pijl naar beneden en bewerk elke categorie om ze op de
legenda te benoemen. U kunt de items ook opnieuw schikken:
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De legenda zal waarschijnlijk breder worden door de nieuwe namen voor de lagen, dus u wilt misschien de legenda
en of de kaart verplaatsen. Dit is het resultaat:

5.1.6 Follow Along: Uw kaart exporteren

Notitie: Heeft u onthouden om uw werk regelmatig op te slaan?

Tenslotte is de kaart gereed om te worden geëxporteerd! U zult de knoppen voor exporteren zien in de linker
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bovenhoek van het venster Printvormgeving:

De knop links is de knop Afdrukken, die verbonden is met een printer. Omdat de opties voor de printer zullen
verschillen, afhankelijk van het model printer waarmee u werkt, is het waarschijnlijk beter om de handleiding van
de printer of een algemene gids over afdrukken te raadplegen voor meer informatie over dit onderwerp.

De andere drie knoppen stellen u in staat de kaart te exporteren naar een bestand. Er zijn voor het exporteren drie
indelingen om uit te kiezen:

• Exporteren als afbeelding

• Exporteren als SVG

• Exporteren als PDF

Exporteren als een afbeelding zal u een selectie van verschillende algemene indelingen voor afbeeldingen geven
om uit te kiezen. Dit is waarschijnlijk de eenvoudigste optie, maar de afbeelding die het maakt is “dood” en
moeilijk te bewerken.

De twee andere opties zijn meer algemeen.

Als u uw kaart stuurt naar een cartograaf (die de kaart misschien vóór publicatie wil bewerken), is het het beste
om als een SVG te exporteren. SVG staat voor “Scalable Vector Graphic” en kan worden geïmporteerd in pro-
gramma’s als Inkscape of andere software voor het bewerken van vector-afbeeldingen.

Als u de kaart naar een cliënt moet sturen, is het het meest voorkomend om een PDF te gebruiken, omdat het een-
voudiger is om afdrukopties voor een PDF in te stellen. Sommige cartografen zouden ook PDF kunnen prefereren,
als zij een programma hebben dat hen in staat stelt deze indeling te importeren en te bewerken.

Voor onze doeleinden gaan we een PDF gebruiken.

• Klik op de knop Als PDF exporteren:

• Kies een locatie om op te slaan en een bestandsnaam, zoals gewoonlijk.

• Klik op Opslaan.

5.1.7 In Conclusion

• Sluit het venster Printvormgeving.

• Sla uw kaart op.

• Zoek naar uw geëxporteerde PDF met behulp van het systeem voor bestandsbeheer van uw besturingssys-
teem.

• Open het.

• Geniet van zijn glans.

Gefeliciteerd met uw eerste voltooide kaartproject van QGIS!

5.1.8 What’s Next?

Op de volgende pagina zal u een opdracht worden gegeven om uit te voeren. Die zal u in staat stellen de technieken
die u tot nu heeft geleerd in praktijk te brengen.

5.2 Opdracht 1

Open uw bestaande kaartproject en bekijk dat aandachtig. Als u kleine fouten ziet of dingen die u eerder had
willen repareren, doe dat dan nu.
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Stel uzelf, tijdens het aanpassen van uw kaart, steeds vragen. Is deze kaart eenvoudig te lezen en te begrijpen voor
iemand die niet bekend is met de gegevens? Als ik deze kaart op het internet zou zien, of op een poster, of in een
tijdschrift, zou hij dan mijn aandacht trekken? Zou ik deze kaart willen lezen als het niet de mijne was?

Als u deze cursus doet op het Basis of Gemiddelde niveau, lees de technieken van de meer gevorderde
gedeelten door. Als u iets ziet wat u in uw kaart zou willen hebben, waarom dan niet proberen om het te imple-
menteren?

Als deze cursus aan u wordt gepresenteerd, zou de cursusleider u kunnen vragen een uiteindelijke versie van uw
kaart in te leveren, geëxporteerd naar PDF, voor evaluatie. Als u deze cursus voor uzelf doet, wordt aanbevolen
dat u uw eigen kaart evalueert met behulp van dezelfde criteria. Uw kaart zal worden geëvalueerd op het algehele
uiterlijk en symbologie van de kaart zelf, als ook het uiterlijk en de opmaak van de kaartpagina en items. Onthoud
dat de nadruk voor evaluatie van het uiterlijk van kaarten altijd “gemak in gebruik* is. Hoe netter de kaart eruit
ziet en hoe eenvoudiger hij in een glimp is te begrijpen, des te beter.

Veel plezier bij het aanpassen!

5.2.1 In Conclusion

De eerste vier modules hebben u geleerd een vectorkaart te maken en op te maken. In de volgende vier mod-
ules zult u leren hoe u QGIS gebruikt voor een volledige analyse in GIS. Dit zal zijn inclusief het maken en
bewerken van vectorgegevens; analyseren van vectorgegevens; gebruiken en analyseren van rastergegevens en het
gebruiken van GIS om een probleem van begin tot eind op te lossen, met behulp van bronnen voor zowel raster-
als vectorgegevens.
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CHAPTER 6

Module: Vectorgegevens maken

Het maken van kaarten met behulp van bestaande gegevens is slechts het begin. In deze module zult u leren hoe u
bestaande vectorgegevens kunt aanpassen en geheel nieuwe gegevenssets te maken.

6.1 Lesson: Een nieuwe vector gegevensset maken

De gegevens die u gebruikt moeten ergens vandaan komen. Voor de meeste algemene toepassingen bestaan de
gegevens al; maar hoe meer bijzonder en specialer het project, hoe minder aannemelijk het is dat de gegevens al
beschikbaar zullen zijn, In dergelijke gevallen zult u uw eigen gegevens moeten maken.

Het doel voor deze les: Een nieuwe vector gegevensset maken.

6.1.1 Follow Along: Het dialoogvenster Laag maken

Vóór u nieuwe vectorgegevens kunt toevoegen dient u een vector gegevensset te hebben om ze aan toe te kunnen
voegen. In ons geval zult u beginnen door geheel nieuwe gegevens te maken, in plaats van het bewerken van een
bestaande gegevensset. Daarom dient u eerst uw eigen nieuwe gegevensset te definiëren.

U moet het dialoogvenster Nieuwe vectorlaag openen, dat u in staat stelt een nieuwe laag te definiëren.

• Navigeer naar en klik op op het menu-item Laag → Nieuw → Nieuwe shapefile-laag.

U zult het volgende dialoogvenster gepresenteerd krijgen:
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Het is belangrijk om in dit stadium te beslissen welk soort gegevensset u wilt. Elk verschillend type vectorlaag
wordt “anders gebouwd” op de achtergrond, dus als u de laag eenmaal hebt gemaakt, kunt u het type niet meer
wijzigen.

Voor de volgende oefening zullen we nieuwe objecten gaan maken die gebieden beschrijven. Voor dergelijke
objecten moet u een polygoon gegevensset maken.

• Klik op de keuzeknop Polygoon:
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Dit heeft geen invloed op de rest van het dialoogvenster, maar het zorgt er voor dat het juiste type geometrie zal
worden gebruikt als de vector gegevensset wordt gemaakt.

Het volgende veld stelt u in staat het Coördinaten Referentie Systeem of CRS te specificeren. Een CRS specificeert
hoe een punt op de Aarde moet worden beschreven in termen van coördinaten, en omdat er vele verschillende
manieren zijn om dit te doen, zijn er vele verschillende CRS-en. Het CRS voor dit project is WGS84, dus is het
standaard al juist ingevuld:

Vervolgens is er een collectie van velden gegroepeerd onder Nieuw attribuut. Standaard heeft een nieuwe laag
slechts één attribuut, het veld id (wat u zou moeten zien in de Attributenlijst) onderin. Echter, om de gegevens die
u gaat maken bruikbaar te maken, dient u in feite iets te zeggen over de objecten die u gaat maken in deze nieuwe
laag. Voor onze huidige doelen is het voldoende om één veld, genaamd name, toe te voegen.

• Repliceer onderstaande instellingen en klik op de knop Toevoegen aan attributenlijst:

• Controleer of uw dialoogvenster zou er nu ongeveer zo uit ziet:
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• Klik op OK. Een dialoogvenster om op te slaan zal verschijnen.

• Navigeer naar de map exercise_data.

• Sla uw nieuwe laag op als school_property.shp.

De nieuwe laag zou moeten verschijnen in uw Lagenlijst.
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6.1.2 Follow Along: Gegevensbronnen

Wanneer u nieuwe gegevens maakt, is het duidelijk dat het moet gaan over objecten die echt op de grond bestaan.
Daarom dient u uw informatie ergens vandaan te halen.

Er bestaan vele verschillende manieren om gegevens over objecten te verkrijgen. U zou bijvoorbeeld een GPS
kunnen gebruiken om punten vast te leggen in de echte wereld en dan later de gegevens in QGIS importeren. Of
u zou punten kunnen meten met behulp van een theodoliet, en de coördinaten handmatig kunnen invoeren om
nieuwe objecten te maken. Of u zou het proces voor digitaliseren kunnen gebruiken om objecten te traceren vanaf
gegevens die vanaf afstand zijn opgenomen, zoals satellietbeelden of luchtfotografie.

Voor ons voorbeeld zult u de benadering voor digitaliseren gebruiken. Voorbeelden van raster gegevenssets worden
meegeleverd, dus u dient ze te importeren als dat nodig is.

• Klik op de knop Rasterlaag toevoegen:

• Navigeer naar exercise_data/raster/.

• Selecteer het bestand 3420C_2010_327_RGB_LATLNG.tif.

• Klik op Openen. Een afbeelding zal in uw kaart worden geladen.

• Zoek de nieuwe afbeelding op in de Lagenlijst.

• Klik en sleep het naar de onderste plaats van de lijst zodat u nog steeds uw andere lagen kunt zien.

• Zoek en zoom naar dit gebied:

Notitie: Als de symbologie van uw laag buildings een deel of alles van de rasterlaag bedekt, kunt u die laag
tijdelijk uitschakelen door die te deselecteren in het paneel Lagen. U wilt misschien ook de symbologie van roads
verbergen als u vindt dat die u afleid.

U zult deze drie velden gaan digitaliseren:
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U moet naar de modus Bewerken gaan om te kunnen beginnen met digitaliseren. GIS-software vereist dit in het
algemeen om te voorkomen dat u per ongeluk belangrijke gegevens bewerkt of verwijdert. De modus Bewerken
wordt individueel in- of uitgeschakeld voor elke laag.

Modus bewerken inschakelen voor de laag school_property:

• Klik op de laag in de Lagenlijst om die te selecteren. (Wees er erg zeker van dat de juiste laag is geselecteerd,
anders zult u de verkeerde laag bewerken!)

• Klik op de knop Bewerken aan/uitzetten:

Als u deze knop niet kunt vinden, controleer dan of de werkbalk Digitaliseren is ingeschakeld. Er zou een vinkje
moeten staan naast het menu-item Beeld → Werkbalken → Digitaliseren.

Zodra u in de modus Bewerken bent, zult u zien dat de gereedschappen voor digitaliseren actief zien:

Vier andere relevante knoppen zijn nog steeds inactief, maar zullen actief worden wanneer we beginne n met
interacties op onze nieuwe gegevens:

Van links naar rechts op de werkbalk zijn dit:
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• Opslaan wijzigingen laag: slaat de wijzigingen die op de laag gemaakt zijn op.

• Object toevoegen: begint het digitaliseren van een nieuw object.

• Object(en) verplaatsen: verplaats een geheel object.

• Knooppunt-gereedschap: verplaatst slechts een gedeelte van een object.

• Geelecteerd object(en) verwijderen: verwijdert het/de geselecteerde object(en).

• Kaartobjecten knippen: knipt het geselecteerde object.

• Kaartobjecten kopiëren: kopieert het geselecteerde object.

• Kaartobjecten plakken: plakt een geknipt of gekopieerd object terug op de kaart.

U wilt een nieuw object toevoegen.

• Klik nu op de knop Object toevoegen om te beginnen met het digitaliseren van de velden van de school.

Het zal u opgevallen zijn dat uw muiscursor een kruisdraad is geworden. Dit stelt u in staat om de punten die u zult
digitaliseren nauwkeuriger te plaatsen. Onthoud dat u, zelfs wanneer u het gereedschap Digitaliseren gebruikt, op
uw kaart kunt in- en uitzoomen door het draaien van het muiswiel, en u kunt pannen door het muiswiel ingedrukt
te houden en over de kaart te slepen.

Het eerste object dat u zult digitaliseren is het athletics field:

• Start het digitaliseren door te klikken op een punt ergens langs de rand van het veld.

• Plaats meer punten door te klikken verder langs de rand, totdat de vorm die u tekent het veld volledig bedekt.

• Klik met rechts na het plaatsen van uw laatste punt om het tekenen van de polygoon te voltooien. Dit zal het
object voltooien en u het dialoogvenster Attributen laten zien.

• Vul de waarden in zoals hieronder:
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• Klik op OK en u heeft een nieuw object gemaakt!

Onthoud dat als u een vergissing maakte tijdens het digitaliseren van een object, kunt u dat altijd nog bewerken
als u het maken ervan voltooid heeft. Als u een fout maakte, ga dan door met digitaliseren totdat u klaar bent met
het maken van het object hierboven. Dan:

• Selecteer het object met het gereedschap Eén object selecteren:

U kunt gebruiken:

• het gereedschap Object(en) verplaatsen om het gehele object te verplaatsen,

• het Knooppunt-gereedschap om slechts één punt te verplaatsen waar u misschien foutief geklikt heeft,
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• Geselecteerd object(en) verwijderen om een object geheel te verwijderen zodat u opnieuw kunt beginnen,
en

• het menu-item:menuselection:Bewerken –> Ongedaan maken of de sneltoets voor het toetsenbord ctrl +
z om vergissingen ongedaan te maken.

6.1.3 Try Yourself

• Digitaliseer de school zelf en het bovenste veld. Gebruik deze afbeelding om u te helpen:

Onthoud dat elk nieuw object een unieke waarde id moet hebben!

Notitie: Wanneer u klaar bent met het toevoegen van objecten aan een laag, onthoud dan om de bewerkingen op
te slaan en de modus Bewerken te verlaten.

Notitie: U kunt de vulling opmaken, de omtrek en plaatsen van labels en school_property opmaken met be-
hulp van de technieken de werden geleerd in eerdere lessen. In ons voorbeeld zullen we een gestreepte omtrek
gebruiken van een lichtpaarse kleur zonder vulling.
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6.1.4 Try Yourself

• Maak een nieuw lijnobject genaamd routes.shp met de attributen id en type. (Gebruik de benadering
hierboven om u te leiden.)

• We gaan twee routes digitaliseren die nog niet zijn gemarkeerd op de laag roads; één is een pad de ander is
een spoor.

Ons pad loopt langs de zuidelijke rand van de wijk Railton, beginnend en eindigend op gemarkeerde wegen:

Ons spoor is iets meer naar het zuiden:
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Digitaliseer, één per keer, het pad en het spoor op de laag routes. Probeer de routes zo nauwkeurig mogelijk te
volgen met behulp van punten (links klikken) op elke bocht of koerswijziging.

Bij het maken van elke route, geef het attribuut type de waarde path of track.

U zult waarschijnlijk vinden dat alleen de punten zij gemarkeerd, gebruik het dialoogvenster Laag-eigenschappen
om stijl aan uw routes toe te voegen. Het staat u vrij verschillende stijlen te gebruiken voor het pad en het spoor.

Sla uw bewerkingen op en schakel met de modus Bewerken.

Controleer uw resultaten

6.1.5 In Conclusion

Nu weet u hoe u objecten kunt maken! Deze cursus behandelt niet het toevoegen van punt-objecten, omdat dat
niet echt nodig is als u eenmaal met meer gecompliceerde objecten heeft gewerkt (lijnen en polygonen). Het werkt
exact hetzelfde, behalve dat u slechts één keer klikt waar u het punt wilt plaatsen, geef het zoals gewoonlijk zijn
attributen en dan is het object gemaakt.

Weten hoe digitaliseren werkt is belangrijk omdat het een veel voorkomende activiteit in programma’s van GIS is.

6.1.6 What’s Next?

Objecten in een laag van GIS zijn niet slechts afbeeldingen, maar objecten in de ruimte. Bijvoorbeeld: aaneenslui-
tende polygonen weten waar zij in relatie tot elkaar staan. Dit wordt topologie genoemd. In de volgende les zult u
een voorbeeld zien van waarom dit handig kan zijn.

6.2 Lesson: Topologie voor objecten

Topologie is een handig aspect van vector gegevenslagen, omdat het fouten zoals overlappen of gaten mini-
maliseert.
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Bijvoorbeeld: als twee objecten een rand delen en u bewerkt de rand met behulp van topologie, dan hoeft u
niet eerst het ene object te bewerken, dan een ander en dan zorgvuldig de randen op elkaar af te stemmen zodat
zij overeenkomen. In plaats daarvan kunt u hun gedeelde rand bewerken en beide objecten zullen tegelijkertijd
wijzigen.

Het doel voor deze les: Topologie begrijpen door middel van voorbeelden.

6.2.1 Follow Along: Snappen

Het is het beste als u snappen inschakelt om het bewerken van topologie gemakkelijker te maken, Dit maakt
mogelijk uw muiscursor aan objecten te snappen terwijl u digitaliseert. Opties voor snappen instellen:

• Navigeer naar het menu-item Extra → ‘Snapping’-opties....

• Stel uw dialoogvenster Snapping opties in zoals weergegeven:

• Zorg er voor dat het vak in de kolom Voorkom kruisingen is geselecteerd (ingesteld op Waar).

• Klik op OK om uw wijzigingen op te slaan en het dialoogvenster te sluiten.

• Ga naar de modus Bewerken met de laag landuse geselecteerd.

• Controleer onder Beeld → Werkbalken om er zeker van te zijn dat uw werkbalk Geavanceerd Digitaliseren
is ingeschakeld.

• Zoom naar dit gebied (schakel indien nodig lagen en labels in):
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• Digitaliseer dit nieuwe (fictionele) gebied van het Bontebok National Park:

• Indien gevraagd, geef het een OGC_FID van 999, maar het staat u vrij de andere waarden ongewijzigd te
laten.

Als u voorzichtig bent tijdens het digitaliseren en de cursor toestaat te snappen aan de punten van aanliggende
boerderijen, zult u merken dat er geen gaten zijn tussen uw nieuwe boerderij en de bestaande boerderijen die
daarnaast liggen.

• Denk aan de gereedschappen Ongedaan maken/Opnieuw in de werkbalk Geavanceerd Digitaliseren:
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6.2.2 Follow Along: Juiste topologische objecten

Objecten van topologie moeten soms bijgewerkt worden. In ons voorbeeld heeft de laag landuse enige complexe
bosgebieden die recent zijn samengevoegd om één gebied te vormen:

In plaats van het maken van nieuwe polygonen om samen te voegen met de bosgebieden, gaan we het gereedschap
Knooppunt-gereedschap gebruiken om de bestaande polygonen te bewerken en ze samen te voegen.

• Ga naar de modus Bewerken, als die nog niet actief is.

• Selecteer het Knooppunt-gereedschap.

• Kies een bosgebied, selecteer een hoek en verplaats die naar een naastgelegen hoek, zodat de twee bosge-
bieden elkaar raken:
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• Klik en sleep de knopen totdat zij op hun plek snappen.

De juiste topologische rand ziet er uit zoals dit:
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Ga door een voeg nog een aantal gebieden samen met behulp van het Knooppunt-gereedschap. U kunt ook het
gereedschap Object toevoegen gebruiken als dat van toepassing is. Als u onze voorbeeldgegevens gebruikt zou u
een bosgebied moeten hebben dat er ongeveer uitziet zoals dit:

Maak u geen zorgen als u meer, minder of andere bosgebieden heeft samengevoegd.
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6.2.3 Follow Along: Gereedschap: Object vereenvoudigen

Dit is het gereedschap Object vereenvoudigen:

• Klik er op om het te activeren.

• Klik op één van de gebieden die u heeft samengevoegd met ofwel het Knooppunt-gereedschap of het gereed-
schap Object toevoegen. U zult dit dialoogvenster zien:

• Verplaats de schuifbalk van de ene zijde naar de andere om te zien wat er gebeurt:
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Dit stelt u in staat het aantal knopen in complexe objecten te reduceren.

• Klik op Ok

Merk op wat het gereedschap doet met de topologie. De vereenvoudigde polygoon raakt nu niet langer de aan-
liggende polygonen zoals het zou moeten. Dit toont aan dat dit gereedschap beter geschikt is om zelfstandige
objecten te generaliseren. Het voordeel is dat het u een eenvoudige, intuïtieve interface voor generalisatie biedt.

Vóórdat u doorgaat, zet de polygoon terug naar zijn originele status door de laatste wijziging ongedaan te maken.

6.2.4 Try Yourself Gereedschap: Ring toevoegen

Dit is het gereedschap Ring toevoegen:

Het stelt u in staat een gat in een object te maken, zolang het gat maar aan alle zijden wordt omringd door het
object. Als u bijvoorbeeld de buitengrenzen van Zuid-Afrika heeft gedigitaliseerd en u moet een gat toevoegen
voor Lesotho, zou u dit gereedschap gebruiken.

Als u experimenteert met dit gereedschap, zult u merken dat de huidige opties voor snappen voorkomen dat u
een ring in het midden van de polygoon kunt maken. Dit zou prima zijn als het gebied dat u wilt uitsluiten is
gekoppeld aan de grenzen van de polygoon.

• Schakel snappen uit voor de laag landuse via het dialoogvenster dat u eerder gebruikte.

• Probeer nu Ring toevoegen te gebruiken om een gat te maken in het midden van het Bontebok National
Park.
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• Verwijder uw nieuwe object met behulp van het gereedschap Ring verwijderen:

Notitie: U dient een hoek van de ring te selecteren om die te kunnen verwijderen.

Controleer uw resultaten

6.2.5 Try Yourself Gereedschap: Onderdeel toevoegen

Dit is het gereedschap Onderdeel toevoegen:

Het stelt u in staat een extra gedeelte voor het object te maken, niet direct verbonden met het hoofdobject. Als
bijvoorbeeld de grenzen van het vasteland van Zuid-Afrika heeft gedigitaliseerd, maar u heeft de Prince Edward
Islands nog niet toegevoegd, zou u dit gereedschap gebruiken om ze te maken.

• U moet eerst, met behulp van het gereedschap Eén object selecteren, de polygoon selecteren waaraan u het
gedeelte wilt toevoegen om dit gereedschap te kunnen gebruiken:

• Probeer nu met het gereedschap Onderdeel toevoegen een gebied toe te voegen dat buiten het gebied Bon-
tebok National Park ligt.

• Verwijder uw nieuwe object met behulp van het gereedschap Onderdeel verwijderen:

Notitie: U dient een hoek van het gedeelte te selecteren om dat te kunnen verwijderen.

Controleer uw resultaten

6.2.6 Follow Along: Gereedschap: Objecten vervormen

Dit is het gereedschap Objecten vervormen:

Het kan een uitstulping toevoegen aan een bestaand object. Met dit gereedschap geselecteerd:

• Klik met links binnen het Bontebok National Park om te beginnen met het tekenen van een polygoon.

• Teken een polygoon met drie hoeken, waarvan de laatste binnen de originele polygoon moet liggen, op deze
wijze een rechthoek met open zijde vormend.

• Klik met rechts om de markeringspunten te voltooien:
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Dit zal een soortgelijk resultaat geven als:

U kunt ook het tegenovergestelde doen:

• Klik buiten de polygoon.

• Teken een rechthoek tot in de polygoon.

• Klik met rechts opnieuw buiten de polygoon:
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Het resultaat van bovenstaande:

6.2.7 Try Yourself Gereedschap: Objecten splitsen

Het gereedschap Objecten splitsen is soortgelijk aan de manier waarop u een gedeelte van de boerderij wegnam,
met het verschil dat het geen van de twee gedeelten verwijdert. In plaats daarvan behoudt het beide.
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• Eerst, schakel snappen opnieuw in voor de laag landuse.

We zullen het gereedschap gebruiken om een hoek van het Bontebok National Park af te splitsen.

• Selecteer het gereedschap Objecten splitsen en klik op een punt om een lijn te tekenen. Klik op het punt aan
de tegenoverliggende zijde van de hoek die u wilt afsplitsen en klik met rechts om de lijn te voltooien:

• Op dit punt zou het lijken alsof er niet is gebeurd. Maar onthoud dat uw symbologie voor de laag landuse
geen rand heeft, dus de nieuwe lijn waarop wordt gedeeld wordt niet getoond.

• Gebruik het gereedschap Eén object selecteren om de hoek te selecteren die u zojuist heeft afgesplitst; het
nieuwe object zal nu worden geaccentueerd:
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6.2.8 Try Yourself Gereedschap: Objecten samenvoegen

Nu zullen we het object dat u zojuist heeft gemaakt opnieuw samenvoegen met de originele polygoon:

• Experimenteer met de gereedschappen Geselecteerde objecten samenvoegen en Attributen van geselecteerde
objecten samenvoegen.

• Let op de verschillen.

Controleer uw resultaten

6.2.9 In Conclusion

het bewerken van topologie is een krachtig gereedschap dat u in staat stelt objecten snel en gemakkelijk te maken
en aan te passen, er onderwijl voor zorgend dat zij topologisch juist blijven.

6.2.10 What’s Next?

Nu weet u hoe u gemakkelijk de vorm van objecten kunt digitaliseren, maar het toevoegen van de attributen is nog
steeds een ander verhaal! Hierna zullen we u tonen hoe u formulieren kunt gebruiken, zodat het bewerken van
attributen eenvoudiger en meer effectief is.

6.3 Lesson: Formulieren

Wanneer u nieuwe gegevens toevoegt via digitaliseren, zult u geconfronteerd worden met een dialoogvenster dat
u de attributen voor dat object laat invullen. Dit dialoogvenster is echter, als standaard, niet erg netjes om naar te
kijken. Dat kan gebruiksproblemen veroorzaken, in het bijzonder als u zeer grote gegevenssets heeft om te maken,
of als u wilt dat andere mensen u helpen digitaliseren en zij de standaard formulieren verwarrend vinden.

Gelukkig laat QGIS u uw eigen aangepaste dialoogvensters voor een laag maken. Deze les laat u zien hoe.
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Het doel voor deze les: Een formulier voor een laag maken.

6.3.1 Follow Along: QGIS’ functionaliteit formulierontwerp gebruiken

• Selecteer de laag roads in de Lagenlijst.

• Ga, zoals eerder, naar modus Bewerken.

• Open de Attributentabel.

• Klik met rechts op een willekeurige cel in de tabel. Een kort menu zal verschijnen, met als enige item
Formulier openen.

• Klik er op om het formulier te zien dat QGIS genereert voor deze laag.

Uiteraard zou het leuker zijn om dit te kunnen doen als we naar de kaart kijken, in plaats van altijd naar een
specifieke straat te moeten zoeken in de Attributentabel.

• Selecteer de laag roads in de Lagenlijst.

• Klik, met behulp van het gereedschap Objecten identificeren, op een straat in de kaart.

• Het paneel Identificatieresultaten opent en geeft een een boomweergave de waarden van de velden en andere
algemene informatie over het aangeklikte object weer.

• Selecteer, aan de onderzijde van het paneel, het keuzevak Auto openen formulier

• Klik nu opnieuw op een straat in de kaart. naast het eerdere dialoogvenster Identificatieresultaten, zult u het
nu bekende formulier zien:

• Elke keer als u nu op een enkel object klikt met het gereedschap Objecten identificeren, komt het formulier
naar voren tenzij het keuzevak Auto openen formulier niet meer is geselecteerd.
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6.3.2 Try Yourself Het formulier gebruiken om waarden te bewerken

Als u in de modus Bewerken bent kunt u dit formulier gebruiken om de waarden van de attributen van het object
te bewerken.

• Activeer de modus Bewerken (als die al niet actief is).

• Klik, met behulp van het gereedschap Objecten identificeren, op de hoofdweg die door Swellendam loopt:

• Bewerk zijn waarde highway naar secondary.

• Sla uw bewerkingen op.

• Verlaat de modus Bewerken.

• Open de Attributentabel en merk op dat de waarde is bijgewerkt in de attributentabel en daarom ook in de
brongegevens.

Notitie: Als u de standaard gegevensset gebruikt, zult u merken dat er meer dan één weg op deze kaart staan die
Voortrek Street heten.

6.3.3 Follow Along: Typen velden voor formulieren instellen

Het is aardig om dingen met behulp van een formulier te bewerken, maar u moet nog steeds alles met de hand
invoeren. Gelukkig hebben formulieren verschillende soorten zogenoemde widgets die u in staat stellen gegevens
op diverse verschillende manieren te bewerken.

• Open de Laag-eigenschappen van de laag roads .

• Schakel naar de tab Velden. U zult dit zien:
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• Klik op de knop Tekst bewerken op dezelfde rij als man_made en u zult een nieuw dialoogvenster zien.

• Selecteer Keuzevak uit de lijst met opties:
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• Klik op OK.

• Ga naar de modus Bewerken (als de laag roads al niet in de modus Bewerken staat).

• Klik op het gereedschap Objecten identificeren.

• Klik op dezelfde hoofdweg die u eerder al koos.

U zult nu zien dat het man_made een keuzevak ernaast heeft staan met de opties True (geselecteerd) of False
(niet geselecteerd).

6.3.4 Try Yourself

Stel een meer toepasselijk formulierwidget in voor het veld highway.

Controleer uw resultaten

6.3.5 Try Yourself Testgegevens maken

U kunt ook uw eigen aangepaste formulier volledig vanaf de grond opbouwen.

• Maak een enkele puntlaag genaamd test-data met twee attributen:

– Naam (tekst)

– Leeftijd (tekst)
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• Leg een aantal punten vast op uw nieuwe laag met behulp van de gereedschappen voor digitaliseren zodat
u enige gegevens heeft om mee te werken. U zou, elke keer dat u een nieuw punt vastlegt„ moeten worden
geconfronteerd met het standaardformulier voor QGIS voor gegenereerde attributen.

Notitie: U moet misschien Snappen uitschakelen als dat nog steeds is ingeschakeld vanuit eerdere taken.
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6.3.6 Follow Along: Een nieuw formulier maken

Nu willen we ons eigen aangepaste formulier maken voor de fase van het vastleggen van de attribuut-gegevens.
U moet Qt4 Designer hebben geïnstalleerd om dit te kunnen doen,(alleen nodig voor degene die de formulieren
maakt). Het zou moeten zijn verschaft als onderdeel van het cursusmateriaal, als u Windows gebruikt. U zou er
misschien naar moeten zoeken als u een andere besturingssysteem gebruikt. In Ubuntu, doe het volgende in de
terminal:

Notitie: Op het moment van schrijven was Qt5 de laatst beschikbare versie. Dit proces vereist echter specifiek
Qt4 en is niet noodzakelijkerwijze compatibel met Qt5.

sudo apt-get install qt4-designer

... en het zou automatisch moeten installeren. Zoek het anders op in het Software Center.

• Start Designer door zijn item in het Start Menu in Windows te openen (of elke andere manier die toepasselijk
is voor uw OS).

• Maak, in het dialoogvenster dat verschijnt, een nieuw dialoogvenster:
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• Zoek naar de Widget Box langs de linkerzijde van uw scherm (standaard). Het bevat een item genaamd Line
Edit.

• Klik en sleep dit item op uw formulier. Dit maakt een nieuw Line Edit in het formulier.

• Met het nieuwe element Line edit geselecteerd, zult u zijn properties zien langs de rand van uw scherm
(standaard aan de rechter zijde):
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• Stel zijn naam in op Naam.

• Maak, met behulp van dezelfde benadering, een nieuw draaiveld en stel zijn naam in op Leeftijd.

• Voeg een Label toe met de tekst Nieuwe persoon toevoegen in een vet lettertype (kijk in de prop-
erties van het object om te zien hoe deze in te stellen). Als alternatief wilt u misschien de titel van het
dialoogvenster zelf instellen (in plaats van het toevoegen van een label).

• Klik op een willekeurige plek in uw dialoogvenster.

• Zoek naar de knop Lay Out Vertically (standaard in een werkbalk langs de bovenzijde van het scherm). Dat
maakt automatisch uw dialoogvenster op.

• Stel de maximum grootte van het dialoogvenster (in zijn eigenschappen) in op 200 (breedte) bij 100
(hoogte).

• Sla uw nieuwe formulier op als exercise_data/forms/add_people.ui.

• Als het opslaan is voltooid kunt u het programma Qt4 Designer sluiten.

6.3.7 Follow Along: Het formulier associëren met uw laag

• Ga terug naar QGIS.

• Dubbelklik op de laag test-data in de legenda om toegang te krijgen tot de eigenschappen ervan.

• Klik op de tab Velden in het dialoogvenster Laag-eigenschappen.

• In de keuzelijst Attribuut editor layout, selecteer Geef een UI-bestand op.

• Klik op de knop ellipsis en kies het bestand add_people.ui dat u zojuist heeft gemaakt:
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• Klik op OK in het dialoogvenster Laag-eigenschappen.

• Ga naar de modus Bewerken en leg een nieuw punt vast.

• Wanneer u dat doet zult u worden geconfronteerd met uw aangepaste dialoogvenster (in plaats van het
algemene dat QGIS gewoonlijk maakt).

• Als u klikt op een van uw punten met behulp van het gereedschap Objecten identificeren, kunt u nu het
formulier oproepen door met rechts te klikken in het venster Identificatie-resultaten en te kiezen Object-
formulier bekijken uit het contextmenu.

• Als u in de modus Bewerken staat voor deze laag, zal dat contextmenu Formulier Object bewerken in plaats
daarvan weergeven, en u kunt dan de attributen aanpassen in het nieuwe formulier zelfs na het initiële
vastleggen.

6.3.8 In Conclusion

Met behulp van formulieren kunt u het leven voor uzelf eenvoudiger maken bij het bewerken of maken van
gegevens. Door typen widgets te bewerken of een geheel nieuw formulier uit het niets te maken, u kunt de ervaring
beheren van iemand die nieuwe gegevens voor die laag digitaliseert, daarbij het minimaliseren van misverstanden
en onnodige fouten.
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6.3.9 Further Reading

Als u het gevorderde gedeelte hierboven heeft voltooid en kennis hebt van Python, wilt u misschien dit blog-item
bekijken over het maken van eigen aangepaste objectformulieren met Python-logica, wat geavanceerde functies
mogelijk maakt inclusief validatie van gegevens, automatisch aanvullen, etc.

6.3.10 What’s Next?

Openen van een formulier bij het identificeren van een object is één van de standaard acties die QGIS kan uitvo-
eren. U kunt het echter ook opdragen aangepaste acties die u definieert direct uit te voeren. Dat is het onderwerp
van de volgende les.

6.4 Lesson: Acties

Nu u een standaard heeft gezien in de vorige les, is het tijd om uw eigen acties te definiëren. Een actie is iets
dat gebeurt wanneer u op een object klikt. Het kan zeer veel extra functionaliteit aan uw kaart toevoegen, wat u,
bijvoorbeeld, in staat stelt aanvullende informatie op te halen over een object. Toewijzen van acties kan een geheel
nieuwe dimensie aan uw kaart toevoegen!

Het doel voor deze les: Leren hoe aangepaste acties toegevoegd worden.

6.4.1 Follow Along: Open een afbeelding

Gebruik de laag school_property die u eerder maakte. Het cursusmateriaal bevat foto’s van elk van de drie eigen-
dommen die u digitaliseerde. Wat we vervolgens zullen gaan doen is elk eigendom associëren met zijn afbeelding.
Dan zullen we een actie maken die de afbeelding van het eigendom zal openen bij het klikken op het eigendom.

6.4.2 Follow Along: Een veld voor afbeeldingen toevoegen

De laag school_property heeft nog geen manier om een afbeelding met een eigendom te associëren. Voor dit doel
zullen we eerst een veld maken.

• Open het dialoogvenster Laag-eigenschappen.

• Klik op de tab Velden.

• Schakel naar modus Bewerken:
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• Voeg een nieuwe kolom toe:
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• Voer de waarden in zoals hieronder:
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• Klik op de knop Text edit naast het nieuwe veld nadat het veld is gemaakt,

• Stel het in voor een Bestandsnaam:
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• Klik op OK in het dialoogvenster Laag-eigenschappen.

• Gebruik het gereedschap Objecten identificeren om op één van de drie objecten te klikken in de laag
school_property.

Omdat u nog steeds in de modus Bewerken staat, zou het dialoogvenster actief moeten zijn en er uitzien zoals dit:
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• Klik op de knop Bladeren (de ... naast het veld afbeelding).

• Selecteer het pad naar uw afbeelding. De afbeeldingen staan in
exercise_data/school_property_photos/ en zij hebben dezelfde naam als de objecten
waarmee zij geassocieerd zouden moeten worden.

• Klik op OK.

• Associeer alle afbeeldingen met de juiste objecten met behulp van deze methode.

• Sla uw bewerkingen op en verlaat de modus Bewerken.

6.4.3 Follow Along: Een actie maken

• Open het formulier Acties voor de laag school_property.

• Voer, in het paneel Actie-eigenschappen, de woorden Afbeelding weergeven in in het veld
Naam:
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Wat vervolgens moet worden gedaan is afhankelijk van uw besturingssysteem, dus kies de toepasselijke koers om
te volgen:

Windows

• Klik op de keuzelijst Type en kies Open.

Ubuntu Linux

• Onder Actie, schrijf eog voor de Gnome Image Viewer, of schrijf display om ImageMagick te gebruiken.
Onthoud om een spatie achter de opdracht te plaatsen!

MacOS

• Klik op de keuzelijst Type en kies Mac.

• Onder Actie, schrijf :kbd:‘open ‘. Vergeet niet een spatie achter het commando te plaatsen!
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Ga door met het schrijven van de opdracht

U wilt de afbeelding openen en QGIS weet waar de afbeelding staat. Alles wat het moet doen is is de Actie
vertellen waar de afbeelding staat.

• Selecteer afbeelding uit de lijst:

• Klik op de knop Veld invoegen. QGIS zal de frase [% "afbeelding" %] toevoegen aan het veld Actie.

• Klik op de knop Toevoegen aan actielijst.

• Klik op OK in het dialoogvenster Laag-eigenschappen.

Nu zullen we de nieuwe actie testen:

• Klik op de laag school_property in de Lagenlijst zodat die wordt geaccentueerd.

• Zoek naar de knop Object-actie uitvoeren (op dezelfde werkbalk als de knop Attributentabel openen ):

• Klik op de pijl naar beneden aan de rechterkant van deze knop. Er is tot nu slechts één actie gedefinieerd
voor deze laag, welke die u zojuist gemaakt heeft is.

• Klik op de knop zelf om dit gereedschap te activeren.

• Klik, met behulp van dit gereedschap, op één van de de drie schooleigendommen.

• De afbeelding voor dat eigendom zal nu openen.

6.4.4 Follow Along: Zoeken op het internet

Laten we aannemen dat we naar de kaart kijken en meer willen weten over een gebied waar een boerderij in ligt.
Veronderstel dat u niets weet van het betreffende gebied en dat u algemene informatie erover wilt weten. Uw
eerste impuls, overwegende dat u op dit moment een computer gebruikt, zou waarschijnlijk zijn de naam van het
gebied te googelen. Laten we dus QGIS vertellen om dat automatisch voor ons te doen!

• Open de attributentabel voor de laag landuse.

We zullen het veld name gebruiken voor elk van onze gebieden voor grondgebruik om met Google te zoeken.

• Sluit de attributentabel.

• Ga terug naar Acties in Laag-eigenschappen.

• In het veld Actie-eigenschappen → Naam, schrijf Google zoeken.

Wat vervolgens moet worden gedaan is afhankelijk van uw besturingssysteem, dus kies de toepasselijke koers om
te volgen:
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Windows

• Kies, onder Type, Open. Dit zal Windows vertellen om een internetadres te openen in uw standaard browser,
zoals Internet Explorer.

Ubuntu Linux

• Onder Actie, schrijf xdg-open. Dit zal Ubuntu vertellen om een Internetadres te openen in uw standaard
browser„ zoals Chrome of Firefox.

MacOS

• Onder Actie, schrijf open. Dit zal MacOS vertellen om een Internetadres te openen in uw standaard
browser, zoals Safari.

Ga door met het schrijven van de opdracht

Welke opdracht u hierboven ook gebruikte, u moet het vervolgens vertellen welk internetadres geopend moet
worden. U wilt Google bezoeken en automatisch naar een frase zoeken.

Wanneer u gewoonlijk Google gebruikt, voert u uw zoekvraag in in de zoekbalk van Google. Maar
in dit geval wilt u dat uw computer dat voor u doet. De manier waarop u Google vertelt naar
iets te zoeken (als u niet direct de zoekbalk wilt gebruiken) is door uw internetbrowser het adres
http://www.google.com/search?q=ZOEK_FRASE op te geven, waar ZOEK_FRASE is waarnaar u wilt
zoeken. Omdat we nog niet weten naar welke frase we gaan zoeken, voeren we alleen het eerste gedeelte (zonder
de te zoeken frase) in.

• In het veld Actie, schrijf http://www.google.com/search?q=. Onthoud om een spatie toe te voe-
gen aan uw initiële opdracht, vóórdat u dit schrijft!

Nu wilt u dat QGIS aan de browser vertelt dat Google moet zoeken naar de waarde van name voor het object
waarop u klikt.

• Selecteer het veld name.

• Klik op Voer veld in:
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Dit zal QGIS vertellen om vervolgens de volgende frase toe te voegen:

Wat dit betekent is dat QGIS de browser gaat openen en het gaat verzenden naar het adres
http://www.google.com/search?q=[% "name" %]. Maar [% "name" %] vertelt QGIS om de in-
houd van het veld name te gebruiken als de frase om naar te zoeken.

Dus als, bijvoorbeeld, het gebied voor grondgebruik waarop u klikt is
genaamd Marloth Nature Reserve, dan zal QGIS de browser sturen naar
http://www.google.com/search?q=Marloth%20Nature%20Reserve, wat er voor zal zorgen dat
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uw browser Google bezoekt, dat op zijn beurt zal zoeken naar “Marloth Nature Reserve”.

• Als u dat nog niet gedaan heeft, stel dan alles in zoals hierboven is uitgelegd.

• Klik op de knop Toevoegen aan actielijst. De nieuwe actie zal in de lijst boven verschijnen.

• Klik op OK in het dialoogvenster Laag-eigenschappen.

Testen van de nieuwe actie.

• Klik, met de laag landuse actief in de Lagenlijst, op de knop Object-actie uitvoeren.

• Klik op een willekeurig gebied voor grondgebruik dat u kunt zien op de kaart. Uw browser zal nu openen
en zal automatisch een zoekactie van Google starten voor de stad die is opgenomen als de waarde name
voor dat gebied.

Notitie: Als uw actie niet werkt, controleer dan of alles juist is ingevoerd; typefouten komen veel voor bij dit
soort werk!

6.4.5 Follow Along: Een webpagina direct in QGIS openen

Hierboven heeft u gezien hoe u een webpagina opent in een externe browser. Er zijn enkele tekortkomingen aan
deze benadering met dien verstande dat het een onbekende afhankelijkheid toevoegt – hebben de eindgebruikers
de vereiste software om de actie op hun systeem uit te kunnen voeren? Zoals u heeft gezien hebben zij niet
noodzakelijkerwijze dezelfde soort basisopdracht voor hetzelfde soort actie, als u niet weet welk OS zij zullen
gebruiken. Met sommige versies van een OS, zouden de bovenstaande opdrachten mogelijk helemaal niet werken.
Dit zou een onoverkomelijk probleem kunnen zijn.

QGIS staat echter bovenop de ongelooflijk krachtige en veelzijdige bibliotheek Qt4. Ook kunnen acties van QGIS
willekeurige, getokeniseerde (d.i. variabele informatie gebruikend, gebaseerd op de inhoud van een veldattribuut)
opdrachten van Python zijn!

Nu zult u zien hoe u een actie van Python gebruikt om een webpagina weer te geven. Het is hetzelfde algemene
idee als het openen van een site in een externe browser, maar het vereist geen browser op het systeem aan de zijde
van de gebruiker omdat het de klasse Qt4 QWebView gebruikt (wat een op een webkit gebaseerd HTML-widget
is) om de inhoud in een pop-upvenster weer te geven.

Laten we, in plaats van Google, deze keer Wikipedia gebruiken. Dus de URL die u nodig heeft zal er uitzien als
deze:

http://wikipedia.org/wiki/ZOEK_FRASE

De laag-actie maken:

• Open het dialoogvenster Laag-eigenschappen en ga naar de tab Acties.

• Start een nieuwe actie met de volgende eigenschappen:

– Type: Python

– Naam: Wikipedia

– Action (op een regel): from PyQt4.QtCore import QUrl; from
PyQt4.QtWebKit import QWebView; myWV = QWebView(None);
myWV.load(QUrl(’http://wikipedia.org/wiki/[% "name" %]’));
myWV.show()
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Er gebeuren hier een aantal verschillende dingen:

• Alle code voor Python staat in één enkele regel met door punt-komma’s gescheiden opdrachten (in plaats
van nieuwe regels, de normale manier om opdrachten voor Python te scheiden).

• [% "name" %] zal worden vervangen door de feitelijke waarde van het attribuut wanneer de actie woordt
uitgevoerd (zoals eerder).

• De code maakt eenvoudigweg een nieuwe instance van QWebView, stelt de URL ervan in en roept dan
show() aan om het als een venster zichtbaar te maken op het bureaublad van de gebruiker.

Onthoud dat dit een ietwat bedrieglijk voorbeeld is. Python werkt met semantisch significant inspringen, dus het
scheiden van dingen door punt-komma’s is niet de beste manier om het te schrijven. Dus, in de echte wereld, zou
u meer waarschijnlijk uw logica importeren vanuit een module van Python en dan een functie aanroepen met een
veldattribuut als parameter.

U zou de benadering op dezelfde wijze kunnen gebruiken om een afbeelding weer te geven zonder het vereiste dat
de gebruiker een bepaald programma voor het bekijken van die afbeelding op zijn systeem heeft.

• Probeer de bovengenoemde beschreven methoden om een pagina van Wikipedia te laden met behulp van de
actie Wikipedia die u zojuist gemaakt heeft.
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6.4.6 In Conclusion

Acties stellen u in staat uw kaart extra functionaliteit te geven, handig voor de eindgebruiker die dezelfde kaart bek-
ijkt in QGIS. Wegens het feit dat u shell-opdrachten kunt gebruiken voor elk besturingssysteem, als ook Python,
is er geen limiet in termen van functies die u zou kunnen inbouwen!

6.4.7 What’s Next?

Nu u verschillende methoden voor het maken van vectorgegevens heeft gedaan, zult u leren hoe u deze gegevens
analyseert om problemen op te lossen. Dat is het onderwerp van de volgende module.
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Module: Vectoranalyse

Nu u een aantal objecten heeft bewerkt, zou u moeten willen weten wat er nog meer mee gedaan kan worden. het
hebben van objecten met attributen is aardig, maar als alles is gezegd en gedaan, vertelt dit u eigenlijk niet meer
of minder dan een normale, niet-GIS-kaart.

Het belangrijkste voordeel van een GIS is dit: een GIS kan vragen beantwoorden.

Voor de drie volgende modules, zullen we trachten een onderzoeksvraag te beantwoorden met behulp van functies
van GIS. Bijvoorbeeld; u bent een makelaar en u zoekt naar een woonhuis in Swellendam voor cliënten die de
volgende criteria hebben:

1. Het moet in Swellendam liggen.

2. Het moet op een redelijke rijafstand van een school (zeg 1km) liggen.

3. Het moet meer dan 100 vierkant meter in grootte zijn.

4. Dichter dan 50m vanaf een hoofdweg.

5. Dichter dan 500m vanaf een restaurant.

Binnen de volgende modules, zullen we de kracht van gereedschappen voor analyse in GIS optuigen om geschikte
boerderijen voor deze nieuwe ontwikkeling tot woonhuis te lokaliseren.

7.1 Lesson: Gegevens opnieuw projecteren en transformeren

Laten we het nog eens hebben over Coördinaten ReferentieSystemen (CRS-en). We hebben dit eerder kort behan-
deld, maar we hebben niet besproken wat het in de praktijk betekent.

Het doel voor deze les: Vector-gegevenssets opnieuw projecteren en transformeren.

7.1.1 Follow Along: Projecties

Het CRS waarin alle gegevens en ook de kaart nu staan wordt WGS84 genoemd. Dit is een vrij algemeen Ge-
ografisch CoördinatenSysteem (GCS) voor het weergeven van gegevens. Maar er is een probleem, zoals we zullen
zien.

• Sla uw huidige kaart op.

• Open dan de wereldkaart die u kunt vinden onder exercise_data/world/world.qgs.

• Zoom in naar Zuid Afrika met behulp van het gereedschap Inzoomen.

• Probeer een schaal in te stellen in het veld Schaal, dat in de Statusbalk staat, aan de onderzijde van het
scherm. Terwijl u boven Zuid Afrika bent, stel deze waarde in op 1:5000000 (één tot vijf miljoen).

• Schuif over de kaart terwijl u een oogje houdt op het veld Schaal.
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Ziet u dat de schaal verandert? Dat komt omdat u zich verplaatst vanaf het ene punt waarop u inzoomde met
1:5000000, dat in het midden van uw scherm stond. Voor alles rondom dat is de schaal anders.

Denk aan een wereldbol om dit te begrijpen. Die heeft lijnen lopen van Noord naar Zuid. Deze lijnen voor de
lengtegraad staan ver van elkaar af aan de evenaar, maar ontmoeten elkaar aan de polen.

In een GCS werkt u met deze bol, maar uw scherm is plat. Wanneer u de bol op een plat oppervlak probeert weer
te geven, treedt vervorming op, soortgelijk aan die welke zal optreden als u een tennisbal opent en die probeert
plat te maken. Wat dit betekent op een kaart is dat de lijnen voor de lengtegraad op gelijke afstand van elkaar
blijven, zelfs aan de polen (waar zij verondersteld worden samen te komen). Dit betekent dat, als u op uw kaart
vanaf de evenaar weg reist, de schaal van de objecten die u ziet groter en groter worden. Wat dit voor ons in de
praktijk betekent is dat er geen constante schaal op uw kaart is!

Laten we in plaats daarvan een geProjecteerd Coördinaten Systeem (PCS) gebruiken, om dit op te lossen. Een PCS
“projecteert” of converteert de gegevens op een manier die het mogelijk maakt dat de schaal wijzigt en corrigeert
die. Daarom, om de schaal constant te houden, zouden we onze gegevens opnieuw moeten projecteren en een
PCS gebruiken.

7.1.2 Follow Along: “Direct” opnieuw projecteren

QGIS stelt u in staat uw gegevens “direct” opnieuw te projecteren. Wat dit betekent is dat, zelfs als de gegevens
zelf in een ander CRS staan, QGIS ze kan projecteren alsof ze in een CRS van uw keuze staan.

• Klik op de knop CRS-status in de Statusbalk onder in het venster van QGIS om “direct” projecteren in te
schakelen:

• Selecteer, in het dialoogvenster dat verschijnt, het vak naast Gelijktijdige CRS-transformatie gebruiken.

• Type het woord global in het veld Filter. Eén CRS (NSIDC EASE-Grid Global) zou in de lijst eronder
moeten verschijnen.

• Klik op NSIDC EASE-Grid Global om die te selecteren, klik dan op OK.

• Merk op hoe de vorm van Zuid Afrika verandert. Alle projecties werken door de uiterlijke vormen van
objecten op aarde te wijzigen.

• Zoom opnieuw in naar een schaal van 1:5000000, zoals eerder.

• Schuif over de kaart.

• Merk op dat de schaal nu hetzelfde blijft!

“Direct” opnieuw projecteren wordt ook gebruikt voor het combineren van gegevenssets die in verschillende CRS-
en staan.

• Schakel “direct” opnieuw projecteren opnieuw uit:

– Klik opnieuw op de knop CRS-status.

– Deselecteer het vak Gelijktijdige CRS-transformatie gebruiken.

– Klik op OK.

• In QGIS 2.0 wordt ‘Gelijktijdige CRS-transformatie gebruiken’ automatisch geactiveerd als lagen met ver-
schillende CRS-en worden geladen in de kaart. Deactiveer deze automatische instelling om te begrijpen wat
opnieuw projecteren met ‘Gelijktijdige CRS-transformatie gebruiken’ doet.

– Ga naar Extra → Opties...

– Selecteer, in het linkerpaneel van het dialoogvenster, CRS.

– Deselecteer Automatisch ‘on the fly’-herprojectie inschakelen indien kaartlagen verschillen van CRS.
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– Klik op OK.

• Voeg een andere vectorlaag toe aan uw kaart die alleen gegevens voor Zuid Afrika heeft. U vindt dat als
exercise_data/world/RSA.shp.

Wat valt u op?

De laag is niet zichtbaar! Maar dat is eenvoudig op te lossen, toch?

• Klik met rechts op de laag RSA in de Lagenlijst.

• Selecteer Zoom naar laag.

OK, dus nu zien we Zuid Afrika... maar waar is de rest van de wereld?

het komt erop neer dat we tussen deze twee lagen kunnen zoomen, maar we kunnen ze nooit tegelijkertijd zien.
Dat komt omdat hun Coördinaten Referentie Systemen zo verschillend zijn. De gegevensset continents staat in
graden, maar de gegevensset RSA staat in meters. Dus, laten we zeggen dat een bepaald punt in Kaapstad in de
gegevensset RSA ongeveer 4.100.000 meters verwijderd is van de evenaar. Maar inde gegevensset continents
is datzelfde punt ongeveer 33.9 graden verwijderd van de evenaar.

Dit is dezelfde afstand - maar QGIS weet dat niet. U heeft het niet opgedragen de gegevens opnieuw te projecteren.
Dus, zover als het QGIS betreft, heeft de versie van Zuid Afrika die we zien in de gegevensset RSA Kaapstad op
de juiste afstand van 4.100.000 meter vanaf de evenaar. Maar in de gegevensset continents is Kaapstad slechts
33.9 meter verwijderd van de evenaar! U ziet waarom dit een probleem is.

QGIS weet niet waar Kaapstad verondersteld wordt zich te bevinden - dat is wat de gegevens het zouden moeten
vertellen. Als de gegevens QGIS vertellen dat Kaapstad 34 meter verwijderd ligt van de evenaar en dat Zuid
Afrika slechts ongeveer 12 meter van Noord tot Zuid groot is, dan is dat wat QGIS zal tekenen.

Dit corrigeren:

• Klik opnieuw op de knop CRS-status en schakel Gelijktijdige CRS-transformatie gebruiken opnieuw in
zoals eerder.

• Zoom naar het bereik van de gegevensset RSA.

Omdat zij nu opgedragen zijn om in hetzelfde CRS te projecteren, passen de twee gegevenssets perfect:
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Bij het combineren van gegevens uit verschillende bronnen is het belangrijk om te onthouden dat zij misschien
niet hetzelfde CRS hebben. “Direct” opnieuw projecteren helpt u ze tezamen weer te geven.

Vóórdat u verder gaat wilt u waarschijnlijk dat het ‘direct’ opnieuw projecteren automatisch wordt geactiveerd
wanneer u gegevenssets opent die verschillende CRS-en hebben:

• Open opnieuw Extra → Opties... en selecteer CRS.

• Activeer Automatisch ‘on the fly’-herprojectie inschakelen indien kaartlagen verschillen van CRS.

7.1.3 Follow Along: Een gegevensset opslaan in een anderCRS

Weet u nog dat u gebieden heeft berekend voor de gebouwen in de les Classificatie? U deed dat zo dat u de
gebouwen kon classificeren overeenkomstig het gebied.

• Open opnieuw uw gewone kaart (die de gegevens voor het gebied Swellendam bevat).

• Open de attributentabel voor de laag buildings.

• Scroll naar rechts totdat u het veld AREA ziet.

Merk op dat de gebieden zeer klein zijn; waarschijnlijk nul. Dat komt omdat de gebieden zijn vermeld in graden
- de gegevens staan niet in een geProjecteerd Coördinaten Systeem. De gegevens moeten ook in vierkante meters
zijn om het gebied voor de boerderij ook in vierkante meters te kunnen berekenen. We moeten ze dus opnieuw
projecteren.

Maar het helpt niet om alleen ‘direct’ opnieuw projecteren te gebruiken. ‘Direct’ doet wat het zegt - het wijzigt de
gegevens niet, het projecteert de lagen slechts opnieuw als zij op de kaart verschijnen. U moet ze naar een nieuw
bestand exporteren met behulp van een nieuwe projectie om de gegevens zelf opnieuw te projecteren,.

• Klik met rechts op de laag buildings in de Lagenlijst.

• Selecteer Opslaan als... in het menu dat verschijnt. U zult het dialoogvenster Vectorlaag opslaan als... te
zien krijgen.

• Klik op de knop Bladeren naast het veld Opslaan als.

• Navigeer naar exercise_data/ en specificeer de naam voor de nieuwe laag als
buildings_reprojected.shp.

• Laat Codering ongewijzigd.

• Wijzig de waarde van de keuzelijst Laag CRS naar Geselecteerd CRS.

• Klik op de knop Bladeren onder de keuzelijst.

• Het dialoogvenster Keuze Coördinaten ReferentieSysteem zal nu verschijnen.

• Zoek, in het veld Filter, naar 34S.

• Kies WGS 84 / UTM zone 34S uit de lijst.

• Laat Exporteren van symbologie ongewijzigd.

Het dialoogvenster Vectorlaag opslaan als... ziet er nu zo uit:
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• Klik op OK.

• Start een nieuwe kaart en laad de opnieuw geprojecteerde laag die u zojuist gemaakt heeft.

Bekijk de les over Classificatie nog eens om te zien hoe u gebieden berekent.

• Werk het veld AREA bij (of voeg dat toe) door dezelfde uitdrukking als eerst uit te voeren:

7.1. Lesson: Gegevens opnieuw projecteren en transformeren 153



QGIS Training Manual, Release 2.14

Dat zal een veld AREA toevoegen met de grootte van elk gebouw in vierkante meters

• Gebruik, om het gebied te berekenen in een andere maateenheid, bijvoorbeeld hectares, het veld AREA om
een tweede kolom te maken:
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Bekijk de nieuwe waarden in uw attributentabel. Dit is veel handiger omdat mensen in feite de grootte van
gebouwen beschrijven in meters, niet in graden. Dat is een van de redenen waarom het een goed idee is uw
gegevens, indien nodig, opnieuw te projecteren vóórdat u gebieden, afstanden en andere waarden berekent die
afhankelijk zijn van de ruimtelijke eigenschappen van de laag.

7.1.4 Follow Along: Uw eigen projectie maken

Er zijn nog veel meer projecties dan die welke standaard zijn opgenomen in QGIS. U kunt ook uw eigen projecties
maken.

• Begin een nieuwe kaart.

• Laad de gegevensset world/oceans.shp.

• Ga naar Extra → Aangepast CRS... en u zult dit dialoogvenster zien:

7.1. Lesson: Gegevens opnieuw projecteren en transformeren 155



QGIS Training Manual, Release 2.14

• Klik op de knop Nieuw CRS toevoegen om een nieuwe projectie te maken.

Een interessante projectie om te gebruiken is genaamd Van der Grinten I.

• Voer de naam ervan in in het veld Naam.

Deze projectie geeft de Aarde weer op een cirkelvormig veld in plaats van op een rechthoekig, zoals de meeste
andere projecties doen.

• Gebruik, voor de parameters ervan, de volgende tekenreeks:

+proj=vandg +lon_0=0 +x_0=0 +y_0=0 +R_A +a=6371000 +b=6371000 +units=m
+no_defs
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• Klik op OK.

• Schakel “direct” opnieuw projecteren in.

• Kies uw nieuwe gedefinieerde projectie (zoek naar de naam ervan in het veld Filter).

• Bij het toepassen van deze projectie, zal de kaart opnieuw geprojecteerd worden als:
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7.1.5 In Conclusion

Verschillende projecties zijn handige voor verschillende doeleinden. Door de juiste projectie te kiezen kunt u er
voor zorgen dat de objecten op uw kaart nauwkeurig worden weergegeven.

7.1.6 Further Reading

Materiaal voor het gedeelte Gevorderd van deze les is afkomstig uit dit artikel.

Meer informatie over Coördinaten ReferentieSystemen is hier beschikbaar.

7.1.7 What’s Next?

In de volgende les zult u leren hoe u vectorgegevens kunt analyseren met behulp van de verschillende gereed-
schappen voor vectoranalyse in QGIS.

7.2 Lesson: Vectoranalyse

Vectorgegevens kunnen ook worden geanalyseerd om te onthullen hoe verschillende objecten met elkaar omgaan
in de ruimte. Er zijn vele aan analyse gerelateerde functies in GIS, dus zullen we ze niet allemaal behandelen.
In plaats daarvan zullen we een vraag stellen en die proberen op te lossen met behulp van de gereedschappen die
QGIS verschaft.

Het doel voor deze les. Een vraag stellen en die beantwoorden met behulp van gereedschappen voor analyse.
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7.2.1 Het proces GIS

Vóór we beginnen zou het handig zijn om een kort overzicht te geven van een proces dat gebruikt kan worden om
elk probleem in GIS op te lossen. De manier om dat te doen is:

1. Benoem het probleem

2. Haal de gegevens op

3. Analyseer het probleem

4. Geef de resultaten weer

7.2.2 Het probleem

Laten we het proces beginnen door een probleem te benoemen om op te lossen. U bent bijvoorbeeld een makelaar
en u zoekt naar een woning in Swellendam voor cliënten die de volgende criteria hebben:

1. Het moet liggen in Swellendam.

2. Het moet binnen een redelijke rij-afstand van een school liggen (zeg maar 1 km).

3. Het moet groter zijn dan 100 m2.

4. Minder dan 50 m vanaf een hoofdweg.

5. Minder dan 500 m vanaf een restaurant.

7.2.3 De gegevens

We hebben de volgende gegevens nodig om deze vragen te kunnen beantwoorden:

1. De woningen (gebouwen) in het area.

2. De wegen in en rondom de stad.

3. De locaties van scholen en restaurants.

4. De grootte van gebouwen.

Al deze gegevens zijn beschikbaar via OSM en u zou kunnen besluiten dat ook de gegevensset die u voor deze
handleiding heeft gebruikt ook voor deze les kan worden gebruikt. Echter, om er voor te zorgen dat we de
volledige gegevens hebben, zullen we de gegevens opnieuw downloaden vanaf OSM met behulp van het in QGIS
ingebouwde gereedschappen voor het downloaden van gegevens van OSM.

Notitie: Hoewel downloads van OSM consistente velden voor de gegevens hebben, kunnen de bedekking en de
details variëren. Als u ziet dat de door u gekozen regio, bijvoorbeeld, geen informatie bevat over restaurants, zou
u misschien een andere regio moeten kiezen.

7.2.4 Follow Along: Een project beginnen

• Begin een nieuw project binnen QGIS.

• Gebruik het gereedschap om gegevens van OpenStreetMap te downloaden , te vinden in het menu Vector
→ OpenStreetMap om de gegevens voor de door u gekozen regio te downloaden.

• Sla de gegevens op als osm_data.osm in uw map exercise_data.
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• Onthoud dat de indeling osm een type vectorgegevens is. Voeg deze gegevens op de nnormale manier toe
als een vectorlaag KaartLagen → Laag maken → Vectorlaag toevoegen..., blader naar het nieuwe bestand
osm_data.osm dat u zojuist hebt gedownload. U moet misschien Alle bestanden selecteren als de be-
standsindeling.

• Selecteer osm_data.osm en klik op Open

• Selecteer, in het dialoogvenster dat opent, alle lagen, behalve de lagen other_relations en
multilinestrings:

Dit zal de gegevens van OSM als afzonderlijke lagen in uw kaart importeren.

De gegevens die u zojuist hebt gedownload vanaf OSM staat in een geografisch coördinatensysteem, WGS84, wat
coördinaten met breedtegraad en lengtegraad gebruikt, zoals u weet uit de vorige les. U heeft ook geleerd dat, om
afstanden in meters te kunnen berekenen, we moeten werken met een geprojecteerd coördinatensysteem. Begin
met het instellen van het coördinatensysteem van uw project op een geschikt CRS voor uw gegevens, in het geval
van Swellendam, WGS 84 / UTM zone 34S:

• Open het dialoogvenster Projectinstellingen, selecteer CRS en filter de lijst om naar WGS 84 /
UTM zone 34S te zoeken.

• Klik op OK.

We moeten nu de informatie uitnemen die we nodig hebben vanuit de gegevensset van OSM. We moeten eindigen
met lagen die alle huizen, scholen, restaurants en wegen in de regio weergeven. Die informatie staat in de laag
multipolygons en kan worden uitgenomen met behulp van de informatie die aanwezig is in de Attributentabel. We
zullen beginnen met de laag scholen:

• Klik met rechts op de laag multipolygons in de Lagenlijst en open de Laag-eigenschappen.

• Ga naar het menu Algemeen.

• Onder Subset objecten klik op de knop [Query bouwer] om het dialoogvenster Query bouwer te openen.

• Ga door de lijst Velden, links in dat dialoogvenster, totdat u het veld amenity ziet.

• Klik er eenmaal op.

• Klik op de knop Alles onder de lijst Waarden:

Nu moeten we QGIS vertellen om ons alleen de polygonen te laten zien waar de waarde van amenity gelijk is
aan school.

• Dubbelklik op het woord amenity in de lijst Velden.
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• Bekijk wat er onder gebeurt in het veld Provider-specifieke filter-expressie

Het woord "amenity" is verschenen. De rest van de query opbouwen:

• Klik op de knop = (onder Operatoren).

• Dubbelklik op de waarde school in de lijst Waarden.

• Klik tweemaal op OK.

Dit zal de laag multipolygons van OSM filteren om alleen de scholen in uw regio te laten zien. U kunt nu
ofwel:

• De gefilterde OSM-laag hernoemen naar schools en de laag multipolygons opnieuw importeren
vanuit osm_data.osm, OF

• De gefilterde laag dupliceren, de kopie hernoemen, de Query bouwer leeg maken en uw nieuwe query
maken in de Query bouwer.

7.2.5 Try Yourself Vereiste lagen uit OSM uitnemen

Gebruik, met behulp van de hierboven vermelde techniek, het gereedschap Query bouwer om de resterende
gegevens uit OSM te halen om de volgende lagen te maken:
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• roads (uit de laag lines van OSM)

• restaurants (uit de laag multipolygons van OSM)

• houses (uit de laag multipolygons van OSM)

U wilt misschien de laag roads.shp opnieuw gebruiken die in eerdere lessen maakte.

Controleer uw resultaten

• Sla uw kaart op onder exercise_data, als analysis.qgs.

• Maak, in de bestandsbeheerder van uw besturingssysteem, een nieuwe map onder exercise_data en noem
die residential_development. Dit zal de plaats zijn waar u de gegevenssets zal opslaan die de
resultaten van de analyse-functies zijn.

7.2.6 Try Yourself Belangrijke wegen zoeken

Enkele van de wegen in de gegevensset van OSM zijn vermeld als unclassified, tracks, path en
footway. We willen die uit onze gegevensset van wegen weglaten.

• Open de Query bouwer voor de laag roads, klik op Leeg maken en bouw de volgende query:

"highway" != ’NULL’ AND "highway" != ’unclassified’ AND "highway" !=
’track’ AND "highway" != ’path’ AND "highway" != ’footway’

U kunt ofwel de bovenstaande benadering gebruiken, waar u dubbel klikte op waarden en op knoppen drukte, of
u kunt de opdracht hierboven kopiëren en plakken.

Dit zou het aantal wegen op uw kaart onmiddellijk moeten reduceren:

7.2.7 Try Yourself CRS van een laag converteren

Omdat we binnen onze lagen afstanden gaan meten, moeten we het CRS van de lagen wijzigen. We moeten, om
dit te doen, elke laag op zijn beurt selecteren, de laag opslaan naar een nieuw shapefile met onze nieuwe projectie,
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en dan die nieuwe laag in onze kaart importeren.

Notitie: In dit voorbeeld gebruiken we het CRS WGS 84 / UTM zone 34S, maar u kunt een UTM CRS gebruiken
dat meer toepasselijk is voor uw regio.

• Klik met rechts op de laag roads in het paneel Lagen.

• Klik op Opslaan als...

• Kies, in het dialoogvenster Vectorlaag opslaan als, de volgende instellingen en klik op OK (zorg
er voor dat u Voeg opgeslagen bestand toe aan kaart hebt geselecteerd):
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Het nieuwe shapefile zal worden gemaakt en de resulterende laag wordt toegevoegd aan uw kaart.

Notitie: Als u de instellingen Gelijktijdige CRS-transformatie inschakelen of Automatisch ‘on the fly’-
herprojectie inschakelen indien lagen verschillen van CRS niet heeft geactiveerd (zie de vorige les), zou u miss-
chien niet in staat zijn om de nieuwe lagen te zien die u zojuist heeft toegevoegd aan uw kaart. In dit geval kunt
u de kaart focussen op een willekeurige laag door met rechts te klikken op een laag en te klikken op Zoom naar
laag, of schakel een van de genoemde opties voor ‘direct’ in.

• Verwijder de oude laag roads.

164 Chapter 7. Module: Vectoranalyse



QGIS Training Manual, Release 2.14

Herhaal dit proces voor elke laag door een nieuwe shapefile en laag te maken met “_34S” toegevoegd aan de
originele naam en elk van de oude lagen te verwijderen.

Als u eenmaal het proces voor elke laag heeft voltooid, klik dan met rechts op een laag en klik op Zoom naar laag
om de kaart te focussen op het gebied waarin we geïnteresseerd zijn.

Nu we de gegevens van OSM hebben geconverteerd naar een UTM-projectie, kunnen we onze berekeningen
beginnen.

7.2.8 Follow Along: Analyseren van het probleem: Afstanden van scholen
en wegen

QGIS stelt u in staat afstanden te berekenen vanaf elk vectorobject.

• Zorg er voor dat alleen de lagen roads_34S en houses_34S zichtbaar zijn, om de kaart te vereenvoudigen
terwijl u werkt.

• Klik op het gereedschap Vector → Geoprocessing-gereedschappen → Buffer(s):

Dit geeft u een nieuw dialoogvenster.

• Stel dat als volgt in:
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De Bufferafstand is in meters omdat onze gegevensset voor invoer in een geProjecteerd Coördinaten Systeem dat
meter gebruikt als zijn basis maateenheid. Dat is waarom we geprojecteerde gegevens moesten gebruiken.

• Sla de resulterende laag op onder exercise_data/residential_development/ als
roads_buffer_50m.shp.

• Klik op OK en het zal de buffer maken.

• Wanneer er naar gevraagd wordt zou u “Resultaat aan kaartvenster toevoegen” moeten selecteren, klik op
Ja. (“TOC” betekent “Inhoudsopgave”, waarmee het de Lagenlijst bedoelt).

• Sluit het dialoogvenster Buffer(s).

Nu zal uw kaart er ongeveer zo uitzien:
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Als uw nieuwe laag boven in de lijst Lagen staat, zal het waarschijnlijk veel van uw kaart verbergen, maar dit
geeft ons alle gebieden in uw regio die binnen 50 m van een weg liggen.

Echter, het zal u opvallen dat er binnen onze buffer bepaalde gebieden zijn, die overeenkomen met alle individuele
wegen. Verwijder de laag en maak de buffer opnieuw met behulp van de hier weergegeven instellingen om dit
probleem op te lossen,
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• Merk op dat we nu het vak Dissolve buffer resultaten selecteren.

• Sla de uitvoer op onder dezelfde naam als eerder (klik Yes wanneer het uw toestemming vraagt om de oude
te overschrijven).

• Klik op OK en sluit opnieuw het dialoogvenster Buffer(s).

Als u eenmaal de laag aan de Lagenlijst heeft toegevoegd, zal het er zo uitzien:
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Nu zijn er geen onnodige onderverdelingen meer.

7.2.9 Try Yourself Afstand van scholen

• Gebruik dezelfde benadering als hierboven en maak een buffer voor uw scholen.

Die moet in een straal van 1 km zijn, en worden opgeslagen in de gebruikelijke map als
schools_buffer_1km.shp.

Controleer uw resultaten

7.2.10 Follow Along: Overlappende gebieden

Nu hebben we gebieden waar de weg 50 m verwijderd is en waar een school binnen 1 km ligt (directe lijn, niet
via de weg). Maar natuurlijk willen we alleen de gebieden waar aan beide criteria wordt voldaan. We zullen het
gereedschap Intersect moeten gebruiken om dat te kunnen doen. U vindt het onder Vector → Geoprocessing-
gereedschappen → Intersect. Stel het als volgt in:
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De twee invoerlagen zijn de twee buffers; de locatie om op te slaan is de gewoonlijke; en de bestandsnaam is
school_roads_intersect.shp. Als het eenmaal is ingesteld zoals hier, klik op OK en voeg de laag toe
aan de Lagenlijst als daar naar gevraagd wordt.

In de afbeelding hieronder geven de blauwe gebieden aan waar in één keer aan beide criteria voor de afstand wordt
voldaan!
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U kunt de twee bufferlagen verwijderen en alleen die ene behouden waar zij overlappen, omdat dat is wat we in
eerste instantie echt wilden weten:

7.2.11 Follow Along: Selecteren van de gebouwen

Nu heeft u het gebied dat de gebouwen moet overlappen. Vervolgens wilt u de gebouwen in dat gebied selecteren.

• Klik op het menu-item Vector → Onderzoeks-gereedschap → Selecteren op plaats. Een dialoogvenster zal
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verschijnen.

• Stel dat als volgt in:

• Klik op OK, en Close.

• U zult waarschijnlijk vinden dat er niet veel lijkt te zijn veranderd. Als dat zo is, verplaats dan de laag
school_roads_intersect tot onderin de lagenlijst en zoom dan in:
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De gebouwen die geel zijn geaccentueerd zijn die welke voldoen aan onze criteria en zijn geselecteerd, terwijl de
groene gebouwen er niet aan voldoen. We kunnen nu de geselecteerde gebouwen opslaan als een nieuwe laag.

• Klik met rechts op de laag houses_34S in de Lagenlijst.

• Selecteer Selectie opslaan als....

• Stel het dialoogvenster als volgt in:

• De bestandsnaam is well_located_houses.shp.

• Klik op OK.
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Nu heeft u de selectie als een afzonderlijke laag en kunt u de laag houses_34S verwijderen.

7.2.12 Try Yourself Onze gebouwen verder filteren

We hebben nu een laag die ons alle gebouwen binnen 1 km van een school en binnen 50 m vanaf een weg toont.
We moeten nu die selectie verkleinen om ons alleen gebouwen te tonen die binnen 500 m vanaf een restaurant
liggen.

Maak, met behulp van de hierboven beschreven processen, een nieuwe laag, genaamd
houses_restaurants_500m die uw laag well_located_houses verder filtert om alleen die
gebouwen te laten zien die binnen 500 m van een restaurant liggen.

Controleer uw resultaten

7.2.13 Follow Along: Selecteren van gebouwen met de juiste grootte

Bereken eerst de oppervlakten om te zien welke gebouwen groter zijn dan 100 vierkante meter.

• Open de attributentabel voor de laag houses_restaurants_500m.

• Ga naar modus Bewerken en open de veldberekening.

• Stel dat als volgt in:
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• Als u AREA niet in de lijst vindt, probeer dan een nieuw veld te maken zoals u in een eerdere les in deze
module deed.

• Klik op OK.

• Scroll naar de rechterzijde van de attributentabel; uw veld AREA heeft nu gebieden in meters voor alle
gebouwen in uw laag houses_restaurants_500m.

• Klik opnieuw op de knop voor de modus Bewerken om het bewerken te voltooien en sla uw gegevens op
als daarnaar gevraagd wordt.

• Bouw, zoals eerder in deze les, een query:
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• Klik op OK. Uw kaart zou nu alleen die gebouwen moeten laten zien die overeenkomen met uw begincriteria
en die groter zijn dan 100 m2.

7.2.14 Try Yourself

• Sla uw oplossing op als een nieuwe laag, met behulp van de benadering die u hierboven hebt geleerd
om dat te doen. Het bestand zou moeten worden opgeslagen in de gebruikelijke map, met de naam
solution.shp.

7.2.15 In Conclusion

Met behulp van de benadering van probleemoplossing voor GIS, tezamen met de gereedschappen voor vector-
analyse van QGIS, was u in staat een probleem met meerdere criteria snel een gemakkelijk op te lossen.

7.2.16 What’s Next?

In de volgende les, zullen we kijken naar de berekening van de kortste afstand over de weg van het ene punt naar
een ander.
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7.3 Lesson: Netwerkanalyse

Berekenen van de kortste afstand tussen twee punten is een veel voorkomend gebruik voor GIS. QGIS bevat dit
gereedschap, maar het is niet standaard zichtbaar. In deze korte les zullen we u laten zien wat er nodig is om te
beginnen.

Het doel voor deze les: De plug-in Road Graph activeren, configureren en gebruiken.

7.3.1 Follow Along: Het gereedschap activeren

QGIS heeft vele plug-ins die iets toevoegen aan zijn basisfuncties. Veel van deze plug-ins zijn z handig dat zij
tezamen met het programma worden verschaft. Zij zijn echter nog steeds standaard verborgen. U moet ze dus
eerst activeren om ze te kunnen gebruiken.

De plug-in Road Graph activeren:

• Start Plug-ins beheren door te klikken op het menu-item Plug-ins → Beheer en installeer plug-ins... in het
hoofdvenster van.QGIS, Een dialoogvenster verschijnt.

• Selecteer de plug-in als volgt:

• Klik op Close in het dialoogvenster Plug-ins.

Notitie: Als u de plug-in niet ziet in uw interface, ga dan naar Beeld → Panelen en zorg er voor dat vóór Kortste
pad een kruisje staat.

Dit paneel zal in uw interface verschijnen:
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7.3.2 Follow Along: Het gereedschap configureren

Sla eerst uw huidige kaart op om een laag te hebben om mee te rekenen. Als u dat nog niet heeft gedaan, sla dan
uw laag roads_34S op naar een shapefile door met rechts op de laag te klikken en te selecteren Opslaan als....
Maak een nieuwe kaart en laad deze laag daarin.

Omdat er bij het analyseren van netwerken zoveel configuraties mogelijk zijn, gaat de plug-in nergens van uit vóór
u het zelf heeft ingesteld. Dat betekent dat het helemaal niets doet, totdat u het heeft ingesteld.

• Klik op het menu-item Vector → Road graph → Instellingen. Een dialoogvenster zal verschijnen.

• Zorg er voor dat het als volgt is ingesteld (gebruik deze standaarden, tenzij iets anders wordt gespecificeerd):
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• Tijdseenheid: uren

• Afstandseenheid: kilometer

• Laag: roads_34S

• Snelheidsveld: Standaard gebruiken / km/u
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• Richting: Beide richtingen

• Snelheid: 60

7.3.3 Follow Along: Het gereedschap gebruiken

Zoek, op de wegen, twee punten op uw kaart. Zij hoeven geen enkele betekenis te hebben, maar zij moeten zijn
verbonden door wegen en op een redelijke afstand van elkaar liggen:
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• Klik, in het paneel van de plug-in, op de knop Punt vastleggen naast het veld Start:
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• Klik op het door u gekozen beginpunt.

• Gebruik de knop Punt vastleggen naast het veld Stop en leg het door u gekozen eindpunt vast.

• Klik op de knop Bereken om de uitkomst te zien:
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7.3.4 Follow Along: Criteria gebruiken

Notitie: Gedeelte ontwikkeld door Linfiniti en S Motala (Cape Peninsula University of Technology)

• Voeg uw laag restaurants_34S toe aan de kaart (neem het, indien nodig, uit uw kaart analyis).

• Open de attributentabel voor de laag roads_34S en ga naar de modus Bewerken.

• Voeg een nieuwe kolom toe met de naam SPEED, en geef die het type Geheel getal (integer) met een breedte
van 3.

• Activeer, in het hoofdvenster, het gereedschap Objecten met een rechthoek selecteren:
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• Selecteer enkele hoofdwegen in stedelijke - maar geen woon- - gebieden:

(Houd de toets Ctrl ingedrukt en sleep een vak rondom een weg die u wilt opnemen in de selectie om meer dan
één weg te selecteren.)

• Selecteer, in de attributentabel, Geselecteede objecten tonen.
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• Stel de waarde voor SPEED voor alle geselecteerde wegen in op 60:

In context betekent dit dat u de snelheidslimiet op deze wegen instelt op 60 km/u.

• Selecteer enkele snelwegen of hoofdwegen buiten stedelijke gebieden:
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• Stel de waarde voor SPEED voor alle geselecteerde wegen in op 120.

• Sluit de attributentabel, sla uw bewerkingen op en verlaat de modus Bewerken.

• Controleer de instellingen voor Vector → Road graph → Instellingen om er voor te zorgen dat het is in-
gesteld zoals eerder in deze les is uitgelegd, maar met de waarde Snelheid ingesteld op het veld SPEED dat
u zojuist heeft gemaakt.

• Klik, in het paneel Kortste pad, op de knop Beginpunt.

• Stel het beginpunt in op een kleine weg aan één kant van Swellendam en het eindpunt op een hoofdweg aan
de andere kant van de stad:
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• Selecteer, in de keuzelijst Criterium in het paneel Kortste pad, Lengte.

• Klik op Bereken. De route zal worden berekend voor de kortste afstand:

Let op de waarden in Lengte en Tijd in het paneel Kortste pad.

• Stel Criterium in op Tijd.

• Klik opnieuw op Bereken. De route zal worden berekend voor de kortste tijd:
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U kunt heen en weer schakelen tussen deze criteria, elke keer opnieuw berekenen en zien hoe de wijzigingen
worden opgenomen in Lengte en Tijd. Onthoud dat de veronderstelling om te arriveren rond de tijd die het duurt
om een route af te leggen geen rekening houdt met accelereren, en gaat er van uit dat u de gehele tijd reist met de
snelheidslimiet. In een echte situatie zou u misschien wegen willen opsplitsen in kleinere gedeelten en rekening
houden met de gemiddelde of verwachte snelheid op elk gedeelte, in plaats van met de snelheidslimiet.

Indien, bij het klikken op Bereken, u een fout ziet die aangeeft dat een pad niet kon worden gevonden, zorg er dan
voor dat de wegen die u heeft gedigitaliseerd ook echt op elkaar aansluiten. Als zij elkaar niet echt raken, repareer
ze dan ofwel door het aanpassen van de objecten, of stel de Topologie tolerantie in de instellingen van de plug-in
in. Als zij over elkaar heengaan zonder te kruisen, gebruik dan het gereedschap Objecten splitsen om wegen op
hun kruisingen te “splitsen”:

Onthoud dat het gereedschap Objecten splitsen echter alleen werkt op geselecteerde objecten in de modus Bew-
erken!

U zou ook kunnen vinden dat de kortste route ook de snelste is als deze fout wordt teruggegeven.

7.3.5 In Conclusion

Nu weet u hoe u de plug-in Road Graph kunt gebruiken om problemen met kortste paden op te lossen.

7.3.6 What’s Next?

Vervolgens zult u zien hoe u algoritmen voor ruimtelijke statistieken uitvoert op vector gegevenssets.

7.4 Lesson: Ruimtelijke statistieken

Notitie: Les ontwikkeld door Linfiniti en S Motala (Cape Peninsula University of Technology)
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Ruimtelijke statistieken stellen u in staat te analyseren en te begrijpen wat er gaande is in een bepaalde vector
gegevensset. QGIS bevat verschillende standaard gereedschappen voor statistische analyses die in dit opzicht hun
nut hebben bewezen.

Het doel voor deze les: Weten hoe de ruimtelijke statistische gereedschappen in QGIS te gebruiken.

7.4.1 Follow Along: Een test-gegevensset maken

We zullen een willekeurige verzameling van punten maken om een punt gegevensset te krijgen om mee te werken,

U heeft, om dat te doen, een polygoon gegevensset nodig die het bereik van het gebied waarin u de punten wilt
maken definieert.

We zullen het gebied gebruiken dat wordt bedekt door straten.

• Maak een nieuwe lege kaart.

• Voeg uw laag roads_34S toe, als ook het raster srtm_41_19.tif (hoogtegegevens) te vinden in
exercise_data/raster/SRTM/.

Notitie: U zou kunnen merken dat uw laag SRTM DEM een ander CRS heeft dan die van de laag roads. Als dat
zo is kunt u ofwel de laag roads of de laag DEM opnieuw projecteren met behulp van technieken die u eerder in
deze module leerde.

• Gebruik het gereedschap Convex hull(s) (beschikbaar onder Vector → Geoprocessing-gereedschap) om een
gebied te genereren dat alle wegen omvat:
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• Sla de uitvoer op onder exercise_data/spatial_statistics/ als roads_hull.shp.

• Selecteer de optie Voeg resultaat toe aan kaartvenster om de uitkomst toe te voegen aan de inhoudsopgave
(Lagenlijst).

Willekeurige punten genereren

• Maak in dit gebied willekeurige punten met behulp van het gereedschap Vector → Onderzoeks-gereedschap
→ Willekeurige punten:
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• Sla de uitvoer op onder exercise_data/spatial_statistics/ als random_points.shp.

• Selecteer de optie Voeg resultaat toe aan kaartvenster om de uitkomst toe te voegen aan de inhoudsopgave
(Lagenlijst).
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Een monster uit de gegevens

• U moet de plug-in Point sampling tool gebruiken om een monster-gegevensset uit het raster te maken,.

• Bekijk, indien nodig, de module over plug-ins.

• Zoek naar de frase point sampling in Plug-ins –> Beheer en installeer plug-ins... en u zult de plug-in
vinden.

• Zodra het is geactiveerd met Plug-inbeheer, zult u het gereedschap vinden onder Plug-ins → Analyses →
Point sampling tool:
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• Selecteer random_points als de laag die de monster-punten bevat en het SRTM-raster als de band waaruit
de waarden moeten komen.

• Zorg er voor dat “Add created layer to the TOC” is geselecteerd.

• Sla de uitvoer op onder exercise_data/spatial_statistics/ als random_samples.shp.

Nu kunt u de gegevens voor het monster uit het rasterbestand controleren in de attributentabel van de laag ran-
dom_samples, zij zullen in een kolom, genaamd srtm_41_19.tif, staan.

Een mogelijke laag voor het monster wordt hier weergegeven:

7.4. Lesson: Ruimtelijke statistieken 193



QGIS Training Manual, Release 2.14

De monster-punten worden door hun waarde geclassificeerd zodat donkere punten op een lagere hoogte liggen.

U zult deze monster-laag gaan gebruiken voor de rest van de statistische oefeningen.

7.4.2 Follow Along: Basisstatistieken

Nu nog de basisstatistieken voor deze laag ophalen.

• Klik op het menu-item Vector → Analyse-gereedschap → Basisstatistieken.

• Specificeer, in het dialoogvenster dat verschijnt, de laag:guilabel:random_samples als de bron.

• Zorg er voor dat het Doelveld is ingesteld op srtm_41_19.tif wat het veld is waarvoor u de statistieken
wilt berekenen.

• Klik op OK. U krijgt resultaten zoals deze:
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Notitie: U kunt de resultaten kopiëren en plakken in een werkblad. De gegevens gebruiken het scheidingsteken
(dubbele punt :).
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• Sluit het dialoogvenster als het voltooid is.

Bekijk deze lijst met definities om de bovenstaande statistieken te begrijpen:

Gemiddelde De gemiddelde waarde is eenvoudigweg de som van de waarden, gedeeld door het aantal waarden.

StdAfw: De standaard afwijking. Geeft een indicatie over hoe dicht de waarden zijn geclusterd rondom het
gemiddelde. Hoe kleiner de standaard afwijking, hoe meer waarden neigen naar het gemiddelde.

Som Alle waarden bij elkaar opgeteld.

Min De laagste waarde.

Max De hoogste waarde.

N Het aantal monsters/waarden.

CV: De ruimtelijke covariantie van de gegevensset.

Aantal unieke waarden: Het aantal waarden dat uniek is binnen de gegevensset. Als er 90 unieke waarden in
een gegevensset met N=100, dan zijn de 10 resterende waarden hetzelfde als één of meer van de andere.

Bereik Het verschil tussen de laagste en de hoogste waarden.

Mediaan Als u alle waarden schikt van de laagste tot de hoogste, is de middelste waarde (of het gemiddelde van
de twee middelste waarden als N een even getal is) de mediaan van de waarden.

7.4.3 Follow Along: Een afstandsmatrix berekenen

• Maak een nieuwe puntenlaag in dezelfde projectie als de andere gegevenssets (WGS 84 / UTM 34S).

• Ga naar modus Bewerken en digitaliseer drie punten ergens tussen de andere punten.

• Gebruik, als alternatief, dezelfde methode voor het genereren van willekeurige punten als hiervoor, maar
specificeer slechts drie punten.

• Sla uw nieuwe laag op als distance_points.shp.

Een afstandsmatrix genereren met behulp van deze drie punten:

• Open het gereedschap Vector → Analyse-gereedschap → Distance matrix.

• Selecteer de laag distance_points als de invoerlaag en de laag distance_points als de doellaag.

• Stel het als volgt in:
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• Sla het resultaat op als distance_matrix.csv.

• Klik op OK om de afstandsmatrix te genereren.

• Open het in een werkbladprogramma om de resultaten te zien. Hier is een voorbeeld:
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7.4.4 Follow Along: ‘Dichtstbijzijnde buur’-analyse

Een ‘Dichtstbijzijnde buur’-analyse uitvoeren:

• Klik op het menu-item Vector → Analyse-gereedschap → ‘Nearest neighbour’-analyse.

• Selecteer, in het dialoogvenster dat verschijnt, de laag random_samples en klik op OK.

• De resultaten zullen verschijnen in het tekstvak van het dialoogvenster, bijvoorbeeld:

Notitie: U kunt de resultaten kopiëren en plakken in een werkblad. De gegevens gebruiken het scheidingsteken
(dubbele punt :).
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7.4.5 Follow Along: Gemiddelde coördinaten

De gemiddelde coördinaten van een gegevensset verkrijgen:

• Klik op het menu-item Vector → Analyse-gereedschap → Gemiddelde coördinaten.

• Specificeer, in het dialoogvenster dat verschijnt, random_samples als de invoerlaag, maar laat de optionele
keuzen ongewijzigd.

• Specificeer de uitvoerlaag als mean_coords.shp.

• Klik op OK.

• Voeg, indien gevraagd, de laag toe aan de Lagenlijst.

Laten we dit eens vergelijken met de centrale coördinaat van de polygoon die werd gebruikt om het willekeurige
monster te maken.

• Klik op het menu-item Vector → Geometrie-gereedschappen → Polygoon centroïde.

• Selecteer, in het dialoogvenster dat verschijnt, roads_hull als de invoerlaag.

• Sla het resultaat op als center_point.

• Voeg de laag toe aan de Lagenlijst., indien daarnaar gevraagd.

Zoals u in het voorbeeld hieronder kunt zien vallen de gemiddelde coördinaten en het middelpunt van het gebruikte
gebied (in oranje) niet noodzakelijkerwijze samen:

7.4.6 Follow Along: Histogrammen van afbeeldingen

Het histogram van een gegevensset geeft de verdeling van de waarden ervan weer. De eenvoudigste manier om
dit in QGIS te demonstreren is via het histogram van een afbeelding, beschikbaar in het dialoogvenster Laag-
eigenschappen van elke afbeeldingslaag.

• Klik, in uw Lagenlijst, met rechts op de SRTM DEM-laag.

• Selecteer Eigenschappen.
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• Kies de tab Histogram. U moet misschien op de knop Histogram herberekenen klikken om de grafiek te
genereren. U zult een grafiek zien die de frequentie van de waarden in de afbeelding beschrijft.

• U kunt dat als een afbeelding exporteren:

• Selecteer de tab Metadata, u kunt meer gedetailleerde informatie bekijken binnen het vak Eigenschappen.

De gemiddelde waarde is 332.8, en de hoogste waarde is 1699! Maar deze waarden zijn niet zichtbaar in het
histogram. Waarom niet? Dat komt omdat er maar zo weinig van zijn, vergeleken met de overvloed aan pixels met
waarden onder het gemiddelde. Dat is ook waarom het histogram zich zo ver naar rechts uitstrekt, zelfs hoewel er
geen zichtbare rode lijn is die de frequentie markeert van waarden hoger dan ongeveer 250.

Onthoud daarom dat een histogram u de verdeling van de waarden laat zien en dat niet alle waarden noodzakeli-
jkerwijze ook zichtbaar zijn in de grafiek.

• (U kunt nu Laag-eigenschappen sluiten.)

7.4.7 Follow Along: Ruimtelijke interpolatie

Laten we zeggen dat u een collectie monsterpunten heeft van waaruit u gegevens wilt extrapoleren. U heeft
misschien toegang tot de gegevensset random_samples die we eerder gemaakt hebben en wil een idee krijgen over
hoe het terrein eruit ziet.
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Start, om te beginnen, het gereedschap Grid (Interpolatie) door te klikken op het menu-item Raster → Analyse →
Grid (Interpolatie).

• Selecteer random_samples. in het veld Invoerbestand.

• Selecteer het vak Z-veld en selecteer het veld srtm_41_19.

• Stel de locatie Uitvoerbestand in op exercise_data/spatial_statistics/interpolation.tif.

• Selecteer het vak Algoritme en selecteer Inverse afstandweging.

• Stel Macht in op 5.0 en de Afvlakken op 2.0. Laat de andere waarden zoals ze zijn.

• Selecteer het vak Na afloop in kaartvenster laden en klik op OK.

• Wanneer het voltooid is, klik op OK in het dialoogvenster dat zegt Verwerking voltooid, klik op OK
in het dialoogvenster dat de informatie over de terugkoppeling weergeeft (als het is verschenen), en klik op
Close in het dialoogvenster Grid (Interpolatie).

Hier is een vergelijking van de originele gegevensset (links) met die welke we hebben gemaakt uit onze mon-
sterpunten (rechts). Die van u kan er anders uitzien vanwege de willekeurige herkomst van de locatie van de
monsterpunten.

Zoals u kunt zien zijn 100 monsterpunten niet echt voldoende om een gedetailleerde impressie van het terrein te
geven. Het geeft een heel algemeen idee, maar het kan ook misleidend zijn. In de afbeelding hierboven is het
bijvoorbeeld niet duidelijk dat er een hoge ononderbroken bergrug van oost naar west loopt; in plaats daarvan lijkt
de afbeelding een vallei met hoge pieken in het westen weer te geven. Met behulp van slechts een visuele inspectie
kunnen we zien dat de monster-gegevensset niet representatief is voor het terrein.

7.4.8 Try Yourself

• Gebruik de hierboven weergegeven processen om een nieuwe set van 1000 willekeurige punten te maken.

• Gebruik die punten om een monster te nemen uit de originele DEM.

• Gebruik het gereedschap Grid (Interpolatie) op deze nieuwe gegevensset, zoals hierboven.

• Stel de bestandsnaam voor het uitvoerbestand in op interpolation_1000.tif, met Macht en
Afvlakken respectievelijk ingesteld op 5.0 en 2.0.

De resultaten (afhankelijk van de positie van uw willekeurige punten) zal er min of meer zo uitzien:
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De rand geeft de laag roads_hull weer (wat de begrenzing van de willekeurige monsterpunten weergeeft) om het
plotseling ontbreken van detail voorbij deze randen uit te leggen. Dit is al een veel betere weergave van het terrein,
wegens de veel grotere dichtheid van de monsterpunten.

Hier is een voorbeeld van hoe het er uitziet met 10.000 monsterpunten:

Notitie: Het wordt niet aangeraden dat u dit probeert te doen met 10.000 monsterpunten als u niet werkt op een
snelle computer, omdat de grootte van de monster-gegevensset heel veel verwerkingstijd vraagt.
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7.4.9 Follow Along: Aanvullende gereedschappen voor ruimtelijke analyse

Van origine een afzonderlijk project en later toegankelijk als een plug-in, is de software SEXTANTE toegevoegd
aan QGIS als een bronfunctie vanaf versie 2.0. U vindt het als een nieuw menu in QGIS onder zijn nieuwe naam
Processing van waaruit u toegang krijgt tot een goed gevulde kist met gereedschappen voor ruimtelijke analyses,
die u in staat stellen toegang te krijgen tot verschillende gereedschappen voor plug-ins met één enkele interface.

• Activeer deze set van gereedschappen door het menu-item Processing → Toolbox

U zult het waarschijnlijk vastgezet zien in QGIS aan de rechterkant van de kaart. Onthoud dat de hier ver-
melde gereedschappen koppelingen zijn naar de feitelijke gereedschappen. Sommige daarvan zijn SEXTANTE’s
eigen algoritmes en andere zijn koppelingen naar gereedschappen van waar toegang wordt verkregen uit externe
toepassingen zoals GRASS, SAGA of de Orfeo Toolbox. Deze externe toepassingen zijn tezamen met QGIS
geïnstalleerd dus u kunt er al gebruik van maken. In het geval dat u de configuratie van de gereedschappen voor
Processing moet wijzigen of, bijvoorbeeld, u moet bijwerken naar een nieuwe versie van een van de externe
toepassingen, krijgt u toegang tot de instellingen ervan via Processing → Opties en configuratie.

7.4.10 Follow Along: Analyse van ruimtelijke puntpatronen

Voor een eenvoudige indicatie van de ruimtelijke verdeling van punten in de gegevensset random_samples, kunnen
we gebruik maken van SAGA’s gereedschap Spatial Point Pattern Analysis via de Processing Toolbox die u zojuist
geopend heeft.

• Zoek, in de Processing Toolbox,naar dit gereedschap Spatial Point Pattern Analysis.

• Dubbelklik erop om het dialoogvenster ervan te openen.
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SAGA installeren

Notitie: Als SAGA niet is geïnstalleerd op uw systeem, zal het dialoogvenster van de plug-in u informeren over
het feit dat de afhankelijkheid ontbreekt. Als dat niet het geval is kunt u deze stappen overslaan.

Op Windows

Opgenomen in uw cursusmateriaal vindt u het installatieprogramma voor SAGA voor Windows.

• Start het programma en volg de instructies ervan om SAGA op uw Windows-systeem te installeren. Onthoud
het pad waaronder u het installeert!

Als u SAGA eenmaal heeft geïnstalleerd, dient u SEXTANTE te configureren om het pad te vinden waar het onder
werd geïinstalleerd.

• Klik op het menu-item Processing → Opties en configuratie.

• In het dialoogvenster dat verschijnt, vergroot het item SAGA en zoek naar SAGA folder. De waarde ervan
zal leeg zijn.

• Voer, in dit vak, het pad in waar u SAGA heeft geïnstalleerd.

Op Ubuntu

• Zoek naar SAGA GIS in het Software Center, of voer de frase sudo apt-get install saga-gis
in uw terminal in. (U moet misschien eerst een SAGA-repository toevoegen aan uw bronnen.)

• QGIS zal SAGA automatisch vinden, alhoewel u misschien QGIS opnieuw moet starten als het niet direct
werkt.

Op Mac

gebruikers van Homebrew kunnen SAGA installeren met deze opdracht:

• brew install saga-core

Als u Homebrew niet gebruikt, volg dan de instructies hieronder:

http://sourceforge.net/apps/trac/saga-gis/wiki/Compiling%20SAGA%20on%20Mac%20OS%20X

Na het installeren

Nu u SAGA heeft geïnstalleerd en geconfigureerd, zullen de functies ervan voor u toegankelijk zijn.

SAGA gebruiken

• Open het dialoogvenster van SAGA.

• SAGA produceert drie uitvoeren en zal daarom drie paden voor uitvoer nodig hebben.

• Sla deze drie uitvoeren op onder exercise_data/spatial_statistics/, onder bestandsnamen
die u toepasselijk vindt.
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De uitvoer zal er zo uitzien (de symbologie werd voor dit voorbeeld gewijzigd):
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De rode punt is het gemiddelde middelpunt; de grote cirkel is de standaard afstand, wat een indicatie geeft van
hoe dicht de punten zijn verdeeld rondom het gemiddelde middelpunt; en de rechthoek is het begrenzingsvak, dat
de kleinst mogelijke rechthoek beschrijft die nog steeds alle punten omsluit.

7.4.11 Follow Along: Analyse minimum afstand

Vaak zal de uitvoer van een algoritme geen shapefile zijn, maar in plaats daarvan een tabel die een overzicht
geeft van de statistische eigenschappen van een gegevensset. Eén hiervan is het gereedschap Minimum Distance
Analysis.

• Zoek dit gereedschap in de Processing Toolbox als :guilabel:‘Minimum

Het vereist geen andere invoer dan het specificeren van de vector punten gegevensset die moet worden geanaly-
seerd.

• Kies de gegevensset random_points.

• Klik op OK. Na het voltooien zal een DBF-tabel verschijnen in de Lagenlijst.

• Selecteer die en open de attributentabel. Hoewel de getallen kunnen variëren, zullen uw resultaten in deze
indeling zijn:
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7.4.12 In Conclusion

QGIS heeft vele mogelijkheden voor het analyseren van de ruimtelijke statistische eigenschappen van gegevens-
sets.

7.4.13 What’s Next?

Nu we vectoranalyse hebben behandeld, waarom niet eens kijken wat er met rasters gedaan kan worden? Dat is
wat we zullen gaan doen in de volgende module!
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CHAPTER 8

Module: Rasters

We hebben eerder rasters gebruikt voor het digitaliseren, maar rastergegevens kunnen ook direct worden gebruikt.
In deze module zult u zien hoe dat wordt gedaan in QGIS.

8.1 Werken met rastergegevens

Rastergegevens zijn heel anders dan vectorgegevens. Vectorgegevens hebben verschillende objecten die zijn
geconstrueerd uit punten en misschien verbonden met lijnen en/of gebieden. Rastergegevens echter zijn als een
afbeelding. Hoewel het verschillende eigenschappen van objecten in de echte wereld kan weergeven, deze ob-
jecten bestaan niet als afzonderlijke objecten; in plaats daarvan worden zij weergegeven door middel van pixels
van verschillende kleurwaarden.

Gedurende deze module gaat u rastergegevens gebruiken om uw bestaande GIS-analyse aan te vullen.

Het doel voor deze les: Leren hoe te werken met rastergegevens in de omgeving van QGIS.

8.1.1 Follow Along: Rastergegevens laden

• Open het project analysis.qgs dat is opgeslagen in de vorige oefening.

• Deactiveeer alle lagen met uitzondering van de lagen solution en important_roads.

• Klik op de knop Rasterlaag laden:

Het dialoogvenster Rasterlaag laden zal openen. De gegevens voor dit project staan in
exercise_data/raster.

• Ofwel laadt ze afzonderlijk in, of houdt Ctrl ingedrukt en klik achtereenvolgens op alle vier en open ze
tegelijkertijd.

Het eerste dat u zal opvallen is dat er niets lijkt te gebeuren in uw kaart. Worden de rasters niet geladen? Nou,
ze staan wel in de Lagenlijst, dus kennelijk zijn zij wel geladen. Het probleem is dat zij niet in dezelfde projectie
staan. Gelukkig hebben we la gezien wat we in een dergelijke situatie moeten doen.

• Selecteer Project –> Projectinstellingen in het menu:

• Selecteer de tab CRS in het menu:

• Schakel ‘Gelijktijde CRS-transformatie gebruiken’ in.

• Stel het in op dezelfde projectie als de rest van uw gegevens (WGS 84 / UTM zone 33S).

• Klik op OK.
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De rasters zouden netjes moeten passen:

Daar hebben we ze - vier luchtfoto’s die ons gehele gebied bedekken

8.1.2 Follow Along: Een virtueel raster maken

Zoals u hier kunt zien ligt uw laag ‘solution’ over alle vier de foto’s. Wat dit betekent is dat u ten alle tijde moet
werken met alle vier rasters. Dat is niet ideaal; het zou beter zijn om slechts één bestand voor één (samengestelde)
afbeelding, toch?

Gelukkig stelt QGIS u in staat om exact dat te doen en zonder de noodzaak om feitelijk een nieuw rasterbestand te
maken, wat heel veel ruimte zou kunnen innemen. In plaats daarvan kunt u een Virtueel raster maken. Dit wordt
vaak een Catalogus genoemd, wat zijn functie verklaart. Het is niet echt een nieuw raster. In plaats daravan is het
een manier om uw bestaande rasters te beheren in één catalogus: één bestand voor gemakkelijke toegang.

Een catalogus maken:

• Klik op het menu-item Raster → Allerlei → Virtueel raster maken (Catalogus).

• Selecteer, in het dialoogvenster dat verschijnt, het vak naast Gebruik zichtbare rasterlagen als invoer.

• Voer exercise_data/residential_development in als de locatie voor uitvoer.

• Voer aerial_photos.vrt in als de bestandsnaam.

• Selecteer het vak Na afloop in kaartvenster laden.
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Let op het tekstveld eronder. Wat dit dialoogvenster in feite doet is dat het die tekst voor u schrijft. Het is een
lange opdracht die QGIS gaat uitvoeren.

Notitie: Onthoud dat de tekst van de opdracht te bewerken is, dus u kunt de opdracht verder aanpassen als
u dat wenst. Zoek online naar de initiële opdracht (in dit geval, gdalbuildvrt) voor hulp over de syntaxis.

• Klik op OK om de opdracht uit te voeren.

Het kan even duren voor het voltooid is. Wanneer het voltooid is, zal het een berichtenvak weergeven.

• Klik op OK om het bericht te verwijderen.

• Klik op Close in het dialoogvenster Virtueel raster maken (Catalogus). (Klik niet opnieuw op OK, anders
gaat het de opdracht opnieuw uitvoeren.)
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• U kunt nu de originele vier rasters uit de Lagenlijst verwijderen.

• Indien nodig, klik en sleep de nieuwe raster cataloguslaag aerial_photos tot onder in de Lagenlijst zodat de
andere geactiveerde lagen zichtbaar worden.

8.1.3 Rastergegevens transformeren

De bovenstaande methoden stellen u in staat gegevenssets virtueel samen te voegen met behulp van een catalogus
en ze opnieuw “direct” te projecteren. Echter, als u gegevens instelt die u geruime tijd niet zal gebruiken, zou het
meer efficiënt zijn om nieuwe rasters te maken die al samengevoegd en opnieuw geprojecteerd zijn. Dat verbetert
de uitvoering bij het gebruiken van de rasters in een kaart, maar het ka enige tijd duren om het in het begin in te
stellen.

Rasters opnieuw projecteren

• Klik op het menu-item Raster → Projecties → Warp (Herprojecteren).

Onthoud dat dit gereedschap een handige batchoptie heeft voor het opnieuw projecteren van de inhoud van gehele
mappen. U kunt ook virtuele rasters (catalogussen) opnieuw projecteren, als ook een modus multithreaded verw-
erken inschakelen.
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Rasters samenvoegen

• Klik op het menu-item Raster → Allerlei → Samenvoegen.

U kunt er voor kiezen om gehele mappen te verwerken in plaats van enkele bestanden, wat u een heel handige in-
gebouwde mogelijkheid voor batchverwerking geeft. U kunt ook een virtueel raster als invoerbestand specificeren,
en alle rasters waaruit het bestaat zullen worden verwerkt.

U kunt ook uw eigen opdrachten voor de opdrachtregel toevoegen met behulp van het keuzevak Aanmaken opties
en in een lijst zetten. Dit is alleen van toepassing als u kennis bezit van de verwerking van de bibliotheken van
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GDAL.

214 Chapter 8. Module: Rasters



QGIS Training Manual, Release 2.14

8.1.4 In Conclusion

QGIS maakt het eenvoudig om rastergegevens in uw huidige projecten op te nemen.

8.1.5 What’s Next?

Vervolgens zullen we rastergegevens gebruiken die geen luchtfoto’s zijn en zien hoe symbolisatie ook handig is in
het geval van rasters.

8.2 Lesson: Symbologie van rasters wijzigen

Niet alle rastergegevens bestaan uit luchtfoto’s. Er zijn vele andere vormen van rastergegevens en in veel van deze
gevallen, is het essentieel om de gegevens juist te symboliseren zodat het op de juiste manier zichtbaar wordt en
bruikbaar.

Het doel voor deze les De symbologie voor een rasterlaag wijzigen.

8.2.1 Try Yourself

• Begin met de huidige kaart, die u zou moeten hebben gemaakt in de vorige oefening, analysis.qgs.

• Gebruik de knop Rasterlaag toevoegen om de nieuwe raster gegevensset te laden.

• Laad de gegevensset srtm_41_19.tif, te vinden in de map exercise_data/raster/SRTM/.

• Als die eenmaal is verschenen in de Lagenlijst, hernoem hem naar DEM.

• Zoom naar het bereik van deze laag door er met rechts op te klikken in de Lagenlijst en te selecteren Zoom
naar laag.

Deze gegevensset is een Digital Elevation Model (DEM). Het is een kaart van de hoogte van het terrein, wat ons
bijvoorbeeld in staat stelt te zien waar de bergen en valleien zijn.

Als het eenmaal is geladen zult u zien dat het in feite een uitgestrekte weergave in grijswaarden is van de DEM.
Hier is het te zien met de vectorlagen er bovenop:
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QGIS heeft automatisch de afbeelding opgerekt om redenen van visualisatie en we zullen meer leren over hoe dit
werkt als we doorgaan.

8.2.2 Follow Along: Symbologie van rasterlagen wijzigen

• Open het dialoogvenster Laag-eigenschappen voor de laag SRTM door met rechts te klikken op de laag in
de boom met lagen en de optie Eigenschappen te selecteren.

• Schakel naar de tab Stijl.
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Dit zijn de huidige instellingen die QGIS standaard voor ons heeft toegepast. Het is slechts één manier om naar
een DEM te kijken, dus laten we enkele andere verkennen.

• Wijzig het Rendertype naar een Enkelbands pseudocolor en gebruik de weergegeven standaard opties.

• Klik op de knop Classificeren om een nieuwe kleur te classificeren en klik op OK om deze classificatie op
de DEM toe te passen.
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U zult zien dat het raster er als volgt uitziet:
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Dit is een interessante manier om naar de DEM te kijken, maar misschien willen we het niet symboliseren met
behulp van deze kleuren.

• Open opnieuw het dialoogvenster Laag-eigenschappen.

• Schakel het Rendertype terug naar Enkelbands grijs.

• Klik op OK om deze instelling toe te passen op het raster.

U zult nu een totaal grijze rechthoek zien die helemaal niet bruikbaar is.
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Dat komt omdat we de standaard instellingen zijn verloren die de kleurwaarden “oprekten” om ze contrast weer
te laten geven.

Laten we QGIS vertellen om opnieuw de kleurwaarden “op te rekken”, gebaseerd op het bereik van de gegevens
in de DEM. Dit zal QGIS gebruik laten maken van alle beschikbare kleuren (in Grijswaarden, dit zijn zwart, wit
en alle tinten grijs daar tussenin).

• Specificeer de waarden Min en Max zoals hieronder is weergegeven.

• Set the value Contrast enhancement to Stretch To MinMax:
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But what are the minimum and maximum values that should be used for the stretch? The ones that are currently
under Min and Max values are the same values that just gave us a gray rectangle before. Instead, we should be
using the minimum and maximum values that are actually in the image, right? Fortunately, you can determine
those values easily by loading the minimum and maximum values of the raster.

• Under Load min / max values, select Min / Max option.

• Click the Load button:

Notice how the Custom min / max values have changed to reflect the actual values in our DEM:
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• Click OK to apply these settings to the image.

You’ll now see that the values of the raster are again properly displayed, with the darker colors representing valleys
and the lighter ones, mountains:
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But isn’t there a better or easier way?

Yes, there is. Now that you understand what needs to be done, you’ll be glad to know that there’s a tool for doing
all of this easily.

• Remove the current DEM from the Layers list.

• Load the raster in again, renaming it to DEM as before. It’s a gray rectangle again...

• Schakel het gereedschap in dat u nodig heeft via Beeld → Werkbalken → Raster. Deze pictogrammen zullen
in de interface verschijnen:

De derde knop van links Lokaal histogram Stretch zal automatisch uitrekken tot de minimum- en maximum-
waarden om u het beste contrast te geven in het lokale gebied waarop u bent ingezoomd. Het is handig voor grote
gegevenssets. De knop links Lokale cumulatieve strekking... zal de minimum- en maximum-waarden uitrekken
tot constante waarden in de gehele afbeelding.

• Klik op de vierde knop vanaf links (Histogram uitbreiden op basis van gehele gegevensset). U zult zien dat
de gegevens nu opnieuw juist worden weergegeven zoals eerder.

U kunt de andere knoppen op deze werkbalk proberen en zien hoe zij het oprekken van de afbeelding wijzigen
indien op lokale gebieden is ingezoomd of indien volledig is uitgezoomd.
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8.2.3 In Conclusion

Dit zijn slechts de basisfuncties om u te laten beginnen met symbologie voor rasters. QGIS heeft nog vele andere
opties voor u, zoals het symboliseren van een laag met behulp van standaard afwijkingen, of het weergeven van
verschillende banden in verschillende kleuren in een multispectrale afbeelding.

8.2.4 Verwijzing

De gegevensset van SRTM werd verkregen vanaf http://srtm.csi.cgiar.org/

8.2.5 What’s Next?

Nu we kunnen zien dat onze gegevens juist zijn weergegeven, kunnen we onderzoeken hoe ze verder zijn te
analyseren.

8.3 Lesson: Terreinanalyse

Bepaalde typen rasters stellen u in staat meer inzicht te verkrijgen over het terrein dat zij weergeven. Digital
Elevation Models (DEM’s) zijn in dit opzicht in het bijzonder bruikbaar. In deze les zult u gereedschappen voor
terreinanalyses gebruiken om meer uit te vinden over het te bestuderen gebied voor het eerder voorgestelde te
ontwikkelen woongebied.

Het doel voor deze les: Gereedschappen voor terreinanalyses gebruiken om meer informatie over het terrein te
verkrijgen.

8.3.1 Follow Along: Een schaduw voor heuvels berekenen

De DEM die u nu in uw kaart heeft toont u de hoogten in het terrein, maar het kan er soms wat abstract uitzien.
Het bevat alle 3D-informatie over het terrein die u nodig heeft, maar het ziet er niet uit als een 3D-object. Het is
mogelijk een schaduw voor heuvels te berekenen, wat een raster is dat de kaart weergeeft met behulp van licht en
een schaduw om het uiterlijk van een 3D-afbeelding aan te nemen, om een betere kijk op het terrein te krijgen.

U zou QGIS’ alles-in-één analyse-gereedschap DEM (Hoogtemodellen) moeten gebruiken om met DEM’s te
werken.

• Klik op het menu-item Raster → Analyse → DEM (Hoogtemodellen).

• Zorg, in het dialoogvenster dat verschijnt, er voor dat het Invoerbestand de laag DEM is.

• Stel het Uitvoerbestand in op hillshade.tif in de map exercise_data/residential_development.

• Zorg er ook voor dat bij de optie Modus Hillshade is geselecteerd.

• Selecteer het vak naast Na afloop in kaartvenster laden.

• U kunt alle andere opties ongewijzigd laten.

• Klik op OK om de schaduw voor de heuvels te genereren.

• Klik op OK in het berichtenvak om dat te sluiten wanneer het u vertelt dat de verwerking is voltooid,

• Klik op Close in het hoofdbester van het dialoogvenster DEM (Hoogtemodellen).

U zult nu een nieuwe laag, genaamd hillshade, hebben die er uitziet zoals dit:
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Dat ziet er leuk en 3D uit, maar kunnen we dit verbeteren? Op zichzelf ziet de schaduw voor de heuvels er uit als
een gipsafdruk. Kunnen we het op een of andere manier gebruiken met onze, meer kleurrijke, rasters? Natuurlijk
kunnen we dat, door de schaduw voor de heuvels er overheen te leggen.

8.3.2 Follow Along: Schaduw voor heuvels gebruiken door er overheen te
leggen

Een schaduw voor heuvels kan heel bruikbare informatie verschaffen over het zonlicht op een bepaald moment
van de dag. Maar het kan ook voor esthetische doeleinden gebruikt worden om de kaart er beter uit te laten zien.
De sleutel hiertoe is de schaduw voor de heuvels in te stellen op bijna geheel transparant.

• Wijzig de symbologie van de originele DEM om het schema Pseudokleur te gebruiken, zoals in de eerdere
oefening.

• Verberg alle lagen met uitzondering van de lagen DEM en hillshade.

• Klik en sleep DEM tot onder de laag hillshade in de Lagenlijst.

• Stel de laag hillshade in op transparant door de Laag-eigenschappen ervan te openen en ga naar de tab
Transparantie.

• Stel de Globale transparantie in op 50%:

• Klik op OK in het dialoogvenster Laag-eigenschappen. U zult een resultaat zoals dit krijgen:
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• Schakel de laag hillshade uit en weer in in de Lagenlijst om het verschil dat het maakt te zien.

Met het op deze manier gebruiken van een schaduw voor heuvels, is het mogelijk de topografie van het landschap
te verbeteren. Als het effect voor u niet sterk genoeg lijkt te zijn, kunt u de transparantie van de laag hillshade
vergroten; maar natuurlijk geldt: hoe helderder de schaduw van de heuvels wordt, hoe vager de kleuren erachter
zullen zijn. U dient een balans te vinden die voor u werkt.

Onthoud uw kaart op te slaan als u gereed bent.

Notitie: Gebruik een nieuwe kaart voor de volgende twee oefeningen. Laad alleen de DEM
raster gegevensset erin (exercise_data/raster/SRTM/srtm_41_19.tif). Dit om dingen te
vereenvoudigen wanneer u werkt met de gereedschappen voor de rasteranalyse. Sla de kaart op als
exercise_data/raster_analysis.qgs.

8.3.3 Follow Along: Berekenen van de helling

Een ander handig ding om te weten van het terrein is hoe steil het is. Als u bijvoorbeeld huizen wilt bouwen op
het land daar, heeft u land nodig dat relatief vlak is.

U moet de modus Slope van het gereedschap DEM (Hoogtemodellen) gebruiken om dit te doen.

• Open het gereedschap zoals eerder.

• Selecteer bij de optie Modus Slope:
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• Stel de locatie om op te slaan in op exercise_data/residential_development/slope.tif

• Schakel het keuzevak Na afloop in kaartvenster laden in .

• Klik op OK en sluit de dialoogvensters als de verwerking voltooid is, en klik op Close om het dialoogvenster
te sluiten. U zult zien dat een nieuw raster zal zijn geladen in uw kaart.

• Klik, met het nieuwe raster geselecteerd in de Lagenlijst, op de knop Histogram uitbreiden op basis van
gehele dataset. Nu zult u de helling van het terrein zien, met zwarte pixels voor vlak terrein en witte pixels
voor steil terrein:

8.3.4 Try Yourself Berekenen van het aspect

Het aspect van een terrein verwijst naar de richting waarin het ligt. Omdat deze studie plaatsvindt in de zuidelijk
hemisfeer, zouden gebouwen ideaal gesproken moeten worden gebouwd op een helling die uitkijkt op het noorden
zodat zij in het zonlicht blijven.
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• Gerbuik de modus Aspect van het gereedschap DEM (Hoogtemodellen) om het aspect van het terrein te
berekenen.

Controleer uw resultaten

8.3.5 Follow Along: Rasterberekeningen gebruiken

Denk even terug aan het probleem van de makelaar dat we bespraken in de les Vectoranalyse. Laten we ons eens
voorstellen dat de kopers een gebouw willen kopen en een kleinere woning willen bouwen op het land. We weten
dat, in de zuidelijke hemisfeer, een ideaal gebied voor ontwikkeling gebieden moet hebben die uitkijken op het
noorden, en met een helling van minder dan vijf graden. Maar als de helling minder is dan 2 graden, dan is het
aspect niet van belang.

Gelukkig heeft u al rasters die u zowel de helling als het aspect weergeven, maar u heeft geen manier om te weten
te komen waar aan beide voorwaarden tegelijkertijd wordt voldaan. Hoe zou deze analyse worden uitgevoerd?

Het antwoord ligt in de Rasterberekeningen.

• Klik op Raster > Rasterberekeningen... om dit gereedschap te starten.

• Dubbelklik, om gebruiken te maken van de gegevensset aspect, op het item aspect@1 in de lijst Raster
banden aan de linkerkant. Het zal verschijnen in het tekstvak Rasterberekening expressie beneden.

Noord ligt op 0 (nul) graden, dus voor het terrein dat op het noorden uitkijkt moet het aspect groter zijn dan 270
graden en minder dan 90 graden.

• Voer, in het veld Rasterberekening expressie, deze expressie in:

aspect@1 <= 90 OR aspect@1 >= 270

• Stel het uitvoerbestand in op aspect_north.tif in de map
exercise_data/residential_development/.

• Zorg er voor dat het vak Voeg resultaat toe aan project is geselecteerd.

• Klik op OK om de verwerking te beginnen.
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Uw resultaat zal dit zijn:

8.3. Lesson: Terreinanalyse 229



QGIS Training Manual, Release 2.14

8.3.6 Try Yourself

Nu u het aspect heeft gedaan, maak twee afzonderlijke nieuwe analyses van de laag DEM.

• De eerste zal het identificeren van alle gebieden zijn waar de helling minder is dan of gelijk aan 2 graden.

• De tweede is soortgelijk, maar de helling zou minder of gelijk moeten zijn aan 5 graden.

• Sla ze op onder exercise_data/residential_development/ als slope_lte2.tif en
slope_lte5.tif.

Controleer uw resultaten

8.3.7 Follow Along: Resultaten van rasteranalyses combineren

U heeft nu drie nieuwe analyse-rasters van de laag DEM:

• aspect_north: het terrein kijkt uit op het noorden

• slope_lte2: de helling is 2 graden of minder

• slope_lte5: de helling is 5 graden of minder

Waar aan de voorwaarden voor deze lagen wordt voldaan, zijn zij gelijk aan 1. Ergens anders zijn zij gelijk aan
0. Als u dan ook een van deze rasters vermenigvuldigt met een ander zult u de gebieden krijgen waar beide gelijk
zijn aan 1.
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De voorwaarden waaraan voldaan moet worden zijn: 5 graden helling of minder, het terrein moet uitkijken op het
noorden; maar bij 2 graden of minder helling is de richting waarop het terrein uitkijkt niet van belang.

Daarom moet u zoeken naar gebieden waar de helling 5 graden of minder is AND het terrein uitkijkt op het noorden;
OR de helling is 2 graden of minder. Dergelijk terrein zou geschikt zijn voor ontwikkeling.

De gebieden berekenen die voldoen aan deze criteria:

• Open opnieuw uw Rasterberekeningen.

• Gebruik de lijst Raster banden list, de knoppen Operatoren en uw toetsenbord om deze expressie op te
bouwen in het tekstvak Rasterberekening expressie:

( aspect_north@1 = 1 AND slope_lte5@1 = 1 ) OR slope_lte2@1 = 1

• Sla de uitvoer op onder exercise_data/residential_development/ als
all_conditions.tif.

• Klik op OK in Rasterberekeningen. Uw resultaten:

8.3.8 Follow Along: Het rastervereenvoudigen

Zoals u in bovenstaande afbeelding kunt zien, staan in de gecombineerde analyse vele, kleine gebieden die voldoen
aan de voorwaarden. Maar deze zijn niet echt bruikbaar voor onze analyse, omdat ze te klein zijn om er iets op te
bouwen. Laten we deze kleine onbruikbare gebieden verwijderen.

• Open het gereedschap Sieve (Raster → Analyse → Zeef ).

• Stel het Invoerbestand in op all_conditions, en het Uitvoerbestand op
all_conditions_sieve.tif (onder exercise_data/residential_development/).

• Stel de beide waarden Drempelwaarde en Pixelverbindingen in op 8, voer dan het gereedschap uit.
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Als de verwerking is voltooid zal de nieuwe laag worden geladen in het kaartvenster. Maar wanneer u probeert
het gereedschap voor het uitrekken van het histogram te gebruiken om de gegevens te bekijken, gebeurt dit:
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Wat is er aan de hand? Het antwoord ligt in de metadata van het nieuwe rasterbestand.

• Bekijk de metadata onder de tab Metadata van het dialoogvenster Laag-eigenschappen. Bekijk het gedeelte
Eigenschappen onderin.
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Waar dit raster, net zoals die waaruit het is afgeleid, alleen de waarden 1 en 0 zou moeten hebben, heeft het de
waarde STATISTICS_MINIMUM voor een heel groot negatief getal. Onderzoek van de gegevens geeft aan dat
dit getal zich gedraagt als een waarde null. Omdat we alleen gebieden willen die niet uitgefilterd werden, stelen
we deze waarden null in op nul.

• Open opnieuw Rasterberekeningen en bouw deze expressie:

(all_conditions_sieve@1 <= 0) = 0

Dit zal alle bestaande waarden nul behouden, terwijl het ook de negatieve getallen instelt op nul; wat alle
gebieden met de waarde 1 intact zal laten.

• Sla de uitvoer op onder exercise_data/residential_development/ als
all_conditions_simple.tif.

Uw uitvoer ziet er uit zoals dit:
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Dit is wat er verwacht werd: een vereenvoudigde versie van de eerdere resultaten. Onthoud dat als de resultaten
die u van een gereedschap krijgt niet zijn wat u er van verwacht, het bekijken van de metadata (en vectorattributen
indien van toepassing) essentieel kan blijken te zijn om het probleem op te lossen.

8.3.9 In Conclusion

U heeft gezien hoe u alle soorten analyse uit een DEM kunt halen. Dit omvat berekeningen voor schaduw voor
heuvels, helling en aspect. U heeft ook gezien hoe de rasterberekeningen te gebruiken voor verdere analyses en
het combineren van deze resultaten.

8.3.10 What’s Next?

Nu heeft u twee analyses: de vectoranalyse die u de potentieel geschikte bouwplaatsen laat zien, en de rasteranal-
yse die u het potentieel geschikte terrein laat zien. Hoe kunnen deze worden gecombineerd om tot een uiteindelijk
resultaat voor dit rp0obleem te komen? Dat is het onderwerp voor de volgende les, die begint in de volgende
module.
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CHAPTER 9

Module: De analyse completeren

U heeft nu twee halve analyses: een gedeelte vector en een gedeelte raster. In deze module zult u zien hoe ze te
combineren. U zult de analyse voltooien en de uiteindelijke resultaten presenteren.

9.1 Lesson: Conversie van raster naar vector

Converteren tussen de indelingen raster en vector stelt u in staat gebruik te maken van zowel raster- als vec-
torgegevens bij het oplossen van een probleem in GIS, als ook het gebruiken van de verschillende methoden voor
analyse uniek voor deze twee vormen van geografische gegevens. Dit vergroot de flexibiliteit die u heeft voor het
overwegen van gegevensbronnen en verwerkingsmethoden voor het oplossen van een probleem in GIS.

U moet het ene type gegevens converteren naar het andere om een raster- en vectoranalyse te combineren. Laten
we het rasterresultaat uit de vorige les converteren naar een vector.

Het doel voor deze les: Het rasterresultaat in een vector krijgen die kan worden gebruikt om de analyse te
voltooien.

9.1.1 Follow Along: Het gereedschap Raster naar vector

Begin met de kaart uit de vorige module, raster_analysis.qgs. Daar zou u
all_conditions_simple.tif moeten hebben die werd berekend gedurende de vorige oefeningen.

• Klik op Raster → Conversie → Vectoriseren (Raster naar vector). Het dialoogvenster van het gereedschap
zal verschijnen.

• Stel het in zoals dit:
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• Wijzig de veldnaam (die de waarden van het raster beschrijft) naar suitable.

• Sla het shapefile op onder exercise_data/residential_development als
all_terrain.shp.

Nu heeft u een vectorbestand dat alle waarden van het raster bevat, maar de enige gebieden waarin u geïnteresseerd
bent zijn die welke geschikt zijn; d.i. die polygonen waarvan de waarde van suitable 1 is. U kunt de stijl van
deze laag wijzigen als u een betere visualisatie ervan wilt.

9.1.2 Try Yourself

Bekijk de module over vectoranalyse nog eens.

• Maak een nieuw vectorbestand dat alleen de polygonen bevat waar suitable de waarde 1 heeft.

• Sla het nieuwe bestand op in exercise_data/residential_development/ als
suitable_terrain.shp.

Controleer uw resultaten

9.1.3 Follow Along: Het gereedschap Vector naar raster

Hoewel niet nodig voor ons huidige probleem, is het handig om de tegengestelde conversie van die welke we
hiervoor hebben uitgevoerd te kennen. Converteer het vectorbestand suitable_terrain.shp dat u zojuist
in de vorige stap heeft gemaakt naar raster.

• Klik op Raster → Conversie → Rasteriseren (Vector naar raster) om dit gereedschap te starten, en stel het
dan in zoals in de schermafdruk hieronder:

238 Chapter 9. Module: De analyse completeren



QGIS Training Manual, Release 2.14

• Invoerbestand is all_terrain;

• Uitvoerbestand... is exercise_data/residential_development/raster_conversion.tif;

• Breedte en Hoogte zijn respectievelijk 837 en 661.

Notitie: De grootte van de uitgevoerde afbeelding is hier gespecificeerd om hetzelfde te zijn als het originele
raster dat werd geconverteerd naar een vector. Open de metadata (tab Metadata in de Laag-eigenschappn) om de
dimensies van een afbeelding te bekijken.

• Klik op OK in het dialoogvenster om het conversieproces te beginnen.

• Wanneer het voltooid is, bewonder dan het succes door het nieuwe raster te vergelijken met het originele.
Zij zouden exact gelijk moeten zijn, pixel voor pixel.

9.1.4 In Conclusion

Converteren tussen indelingen voor raster en vector stelt u in sraat de toepasbaarheid van gegevens te vergroten en
hoeft niet te leiden tot verlies van gegevens.

9.1.5 What’s Next?

Nu we de resultaten van de terreinanalyse beschikbaar hebben in vectorindeling, kunnen zij worden gebruikt om
het probleem op te lossen van welke gebouwen te overwegen voor de stedelijke ontwikkeling.
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9.2 Lesson: Combineren van de analyses

Het gebruiken van de gevectoriseerde resultaten van de rasteranalyse stelt u in staat alleen die gebouwen te se-
lecteren die op geschikt terrein staan.

Het doel voor deze les: De gevectoriseerde terreinresultaten gebruiken om geschikte bouwplaatsen te selecteren.

9.2.1 Try Yourself

• Sla uw huidige kaart op (raster_analysis.qgs).

• Open de kaart waarin eerder de vectoranalyse is uitgevoerd (analysis.qgs).

• Schakel, in de Lagenlijst, deze lagen in:

– hillshade,

– solution (of buildings_over_100)

• In aanvulling op deze lagen, die al in de kaart zouden moeten zijn geladen van toen u daarin nog werkte,
voeg ook de gegevensset suitable_terrain.shp toe.

• Als u enkele lagen mist zou u ze moeten vinden in exercise_data/residential_development/

• Gebruik het gereedschap Intersectie (Vector –> Geoprocessing-gereedschap) om een nieuwe vectorlaag,
genaamd new_solution.shp, te maken die alleen die gebouwen bevat die kruisen met de laag
suitable_terrain.

U zou nu een laag moeten hebben die bepaalde gebouwen als uw oplossing laat zien, bijvoorbeeld:

Notitie: Als u merkt dat het gereedschap Intersectie geen resultaten produceert, controleer dan de instellingen
voor het CRS voor elk van uw lagen. Het CRS moet hetzelfde zijn voor beide lagen die u vergelijkt. U moet
misschien de ene laag opnieuw projecteren door de laag op te slaan als een nieuwe shapefile met het vereiste CRS.
In ons voorbeeld werd de laag suitable_terrain opnieuw geprojecteerd naar WGS 84 / UTM 34S en
suitable_terrain_34S genoemd.
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9.2.2 Try Yourself Inspecteren van de resultaten

Kijk naar elk gebouw in uw laag new_solution. Vergelijk ze met de laag suitable_terrain door de symbologie voor
de laag new_solution te veranderen zodat het alleen de omtrekken heeft. Wat valt u op aan sommige gebouwen?
Zijn zij alleen geschikt omdat zij kruisen met de laag suitable_terrain? Waarom wel of waarom niet? Welke zou
u beoordelen als ongeschikt?

Controleer uw resultaten

9.2.3 Try Yourself De analyse opnieuw definiëren

U kunt uit de resultaten aflezen dat sommig gebouwen die werden opgenomen niet echt geschikt waren, dus
kunnen we nu de analyse verfijnen.

We willen er zeker van zijn dat onze analyse alleen die gebouwen oplevert die geheel binnen de laag
suitable_terrain vallen. Hoe zou u dit bereiken? Gebruik één of meer gereedschappen voor Vectoranalyse
en onthoud dat onze gebouwen allemaal groter zijn dan 100m:sup:‘2’.

Controleer uw resultaten

9.2.4 In Conclusion

U heeft nu de originele onderzoeksvraag beantwoord, en kunt een mening bieden (met redenen omkleed, gerugges-
teund door de analyses) voor een aanbeveling met betrekking tot welk gedeelte te ontwikkelen.

9.2.5 What’s Next?

Vervolgens zult u deze resultaten presenteren als deel van uw tweede opdracht.

9.3 Opdracht

Maak, met behulp van de printvormgeving, een nieuwe kaart die de resultaten van uw analyse weergeeft. Neem
deze lagen er in op:

• places (met labels),

• hillshade,

• solution (of new_solution),

• roads en

• ofwel aerial_photos of DEM.

Schrijf een korte verklarende tekst om erbij te voegen. Neem in die tekst de criteria op die werden gebruikt in de
overweging om een huis aan te kopen en aanvullend te ontwikkelen, als ook een verklaring voor uw aanbeveling
over welke gebouwen geschikt zijn.

9.4 Lesson: Extra oefening

In deze les zult u door een volledige analyse in QGIS worden geleid.

Notitie: Les ontwikkeld door Linfiniti en S Motala (Cape Peninsula University of Technology)
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9.4.1 Definitie van het probleem

U krijgt de taak om gebieden in en rondom Cape Peninsula te vinden die een geschikte woonomgeving zijn voor
een een zeldzame fijnbos plantensoort. Het bereik van uw onderzoeksgebied Cape Peninsula is: ten zuiden van
Melkbosstrand, ten westen Strand. Botanisten hebben u voorzien van de volgende voorkeuren voor de betreffende
plantensoort:

• Het groeit op hellingen die uitkijken op het oosten.

• Het groeit op hellingen met een verloop tussen 15% en 60%.

• Het groeit in gebiedne die een totale jaarlijkse regenval hebben van > 1200 mm.

• Het kan alleen worden gevonden op een afstand van tenminste 250 m van een menselijke nederzetting.

• Het gebied met vegetatie waarin het voorkomt zou tenminste een omvang moeten hebben van 6000m2.

Als een vrijwilliger voor Cape Nature, heeft u er in toegestemd de plant te zoeken op het dichtstbij gelegen
geschikte stuk land vanaf uw huis. Gebruik uw vaardigheden in GIS om te bepalen waar u zou moeten zoeken.

9.4.2 Overzicht van de oplossing

U zult, om dit probleem op te lossen, de beschikbare gegevens (beschikbaar in
exercise_data/more_analysis) moeten gebruiken om het kandidaat-gebied te vinden dat het dichtst bij
uw huis ligt. Als u niet in Kaapstad woont (waar dit probleem op is gebaseerd) kunt u kiezen voor een willekeurig
huis in de regio Kaapstad. De oplossing zal omvatten:

• analyseren van de DEM om de hellingen te zoeken die uitkijken op het oosten en de hellingen met het juiste
verloop;

• analyseren van het raster voor de regenval om de gebieden te vinden met de juiste hoeveelheid regen;

• analyseren van de vectorlaag Zoning om gebieden te vinden die verwijderd liggen van menselijke ned-
erzettingen en van de juiste grootte zijn.

9.4.3 Instellen van de kaart

• Klik op de knop “CRS-status” in de uiterste rechter benedenhoek van het scherm. Onder de tab CRS van
het scherm dat verschijnt, zult u het vak Coördinatenreferentiesystemen van de wereld zien.

• Navigeer, in dat vak, naar Geprojecteerd Coördinaatsysteem → Universal Transverse Mercator (UTM).

• Selecteer het item WGS 84 / UTM zone 33S (met de EPSG-code 32733).

• Klik op OK. De kaart heeft nu het coördinatenreferentiesysteem UTM33S.

• Sla de kaart op door te klikken op de knop op de werkbalk Opslaan als, of gebruikt het menu-item Project
→ Opslaan als....

• Sla de kaart op in een map genaamd Rasterprac die u ergens op uw computer zou moeten maken. U
zult in die map ook alle lagen die u maakt opslaan.

9.4.4 Gegevens in de kaart laden

In order to process the data, you will need to load the necessary layers (street names, zones, rainfall, DEM) into
the map canvas.

Voor vectoren ...

• Klik op de knop Vectorlaag toevoegen, of gebruik het menu-item Kaartlagen → Vectorlaag toevoegen....

• Zorg er voor dat, in het dialoogvenster dat verschijnt, de keuzeknop Bestand is geselecteerd.
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• Klik on de knop Bladeren.

• Open, in het dialoogvenster dat verschijnt, de map exercise_data/more_analysis/streets.

• Selecteer het bestand Street_Names_UTM33S.shp.

• Klik op Openen.

Het dialoogvenster sluit en geeft het originele dialoogvenster weer, met het bestandspad gespecificeerd in het
tekstveld naast de knop Bladeren. Dit stelt u in staat er voor te zorgen dat het juiste bestand is geselecteerd. Het is
ook mogelijk het bestandspad handmatig in het veld in te voeren, als u dat zou willen.

• Klik op Openen. De vectorlaag zal worden geladen in uw kaart. De kleur ervan wordt automatisch
toegewezen, die zal later worden gewijzigd.

• Hernoem de laag naar Streets.

• Klik er met rechts op in de Lagenlijst (standaard is dat het paneel aan de linkerkant van het scherm).

• Klik op Hernoem in het dialoogvenster dat verschijnt en hernoem het, druk op de toets Enter indien gereed.

• Herhaal het proces van het toevoegen van de vector, maar selecteer deze keer het bestand Gener-
alised_Zoning_Dissolve_UTM33S.shp in de map Zoning.

• Hernoem het naar Zoning.

Voor rasters ...

• Klik op de knop Rasterlaag toevoegen, of gebruik het menu-item Kaartlagen → Rasterlaag toevoegen....

• Navigeer naar het toepasselijke bestand, selecteer het en klik op Openen.

• Doe dit voor elk van de twee rasterbestanden. De bestanden die u nodig hebt zijn DEM/reproject/DEM en
Rainfall/reprojected/rainfall.tif.

• hernoem het raster rainfall naar Rainfall (met een hoofdletter aan het begin). Initieel, als u ze laadt,
zullen de afbeeldingen grijze rechthoeken zijn. Geen zorgen, dit zal later gewijzigd worden.

• Sla de kaart op.

De symbologie voor de lagen moet gewijzigd worden om op de juiste wijze te kunen zien wat er gebeurt,

9.4.5 Wijzigen van de symbologie van vectorlagen

• Klik met rechts, in de Lagenlijst, op de laag Streets.

• Selecteer Eigenschappen uit het menu dat tevoorschijn komt.

• Schakel naar de tab Stijl in het dialoogvenster dat verschijnt.

• Klik op de knop, gelabeld Wijizgen, met een vierkant dat de huidige kleur van de laag Streets weergeeft.

• Selecteer een nieuwe kleur in het dialoogvenster dat verschijnt.

• Klik op OK.

• Klik opnieuw op OK in het dialoogvenster Laag-eigenschappen. Dit al de kleur van de laag Streets wijzigen.

• Volg een soortgelijk proces voor de laag Zoning en kies er een toepasselijke kleur voor.

9.4.6 Wijzigen van de symbologie van rasterlagen

Symbologie voor rasterlagen is enigszins anders.

• Open het dialoogvenster Laag-eigenschappen voor het raster Rainfall.

• Schakel naar de tab Stijl. U zult zien dat het dialoogvenster voor de stijl heel anders is dan de versie die
werd gebruikt voor vectorlagen.
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• Zorg er voor dat de knop Standaard afwijking gebruiken is geselecteerd.

• Wijzig de waarde in het bijbehorende vak naar 2.00 (het zou standaard moeten zijn ingesteld op 0.00).

• Wijzig, onder de kop Contrastverbetering, de waarde van de keuzelijst Geen verbetering naar ‘Stretch’ tot
MinMax.

• Klik op OK. Het raster “Rainfall”, indien zichtbaar, zou van kleur moeten veranderen, wat u in staat stelt de
verschillende waarden voor helderheid voor elke pixel te zien.

• Herhaal dit proces voor de DEM, maar stel de standaard afwijking die moet worden gebruikt voor het
uitrekken in op 4.00.

9.4.7 Wijzigen van de volgorde van lagen

• Klik en sleep, in de Lagenlijst, lagen naar boven en beneden om de volgorde waarin zij op de kaart verschi-
jnen te wijzigen.

• Nieuwere versies van QGIS zouden een keuzevak Volgorde vanl renderen beheren onder in de Lagenlijst
kunnen hebben. Zorg er voor dat het is geselecteerd.

Nu alle gegevens zijn geladen en op de juiste wijze zichtbaar zijn, kan de analyse beginnen. Het is het beste als
de bewerking clippen als eerste wordt uitgevoerd. Dit om er voor te zorgen dat er geen verwerkingskracht wordt
verspilt in het berekenen van waarden in gebiedne die toch niet gebruikt gaan worden.

9.4.8 Zoek naar de juiste districten

• Laad de vectorlaag admin_boundaries/Western_Cape_UTM33S.shp in uw kaart.

• Hernoem het naar Districts.

• Klik met rechts op de laag Districts in de Lagenlijst.

• Selecteer, in het menu dat verschijnt, het menu-item Query.... Het dialoogvenster Query bouwer verschijnt.

U zult nu een query gaan bouwen om alleen de volgende lijst met districten te selecteren:

• Bellville,

• Cape,

• Goodwood,

• Kuils River,

• Mitchells Plain,

• Simons Town, en

• Wynberg.

• Dubbelklik, in de lijst Velden, op het veld NAME_2. Het verschijnt in het tekstveld Provider-specifieke filter
expressie onderin.

• Klik op de knop =; een =-teken wordt aan de SQL-guery toegevoegd.

• Klik op de knop Alles onder de (momenteel lege) lijst Waarden. Na korte tijd zal dit de lijst Waarden vullen
met de waarden van het geselecteerde veld (NAME_2).

• Dubbelklik op de waarde Bellville in de lijst Waarden. Zoals eerder zal dit worden toegevoegd aan de
SQL-query.

U moet de Booleaanse operator OR gebruiken om meer dan één district te kiezen,

• Klik op de knop OR en het zal worden toegevoegd aan de SQL-query.

• Voeg, met een soortgelijk proces als hierboven, het volgende toe aan de bestaande SQL-query:
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"NAME_2" = ’Cape’

• Voeg nog een operator OR toe, en verwerk dan de bovenstaande lijst met districten op een soortgelijke
manier.

• De uiteindelijke query zou moeten zijn

"NAME_2" = ’Bellville’ OR "NAME_2" = ’Cape’ OR "NAME_2" = ’Goodwood’ OR
"NAME_2" = ’Kuils River’ OR "NAME_2" = ’Mitchells Plain’ OR "NAME_2" =
’Simons Town’ OR "NAME_2" = ’Wynberg’

• Klik op OK. De in uw kaart weergegeven districten beperken zich nu tot die in de lijst hierboven.

9.4.9 Clippen van de rasters

Nu u een beperkt gebied heeft, kunt u de rasters tot dit gebied clippen.

• Zorg er voor dat de zichtbare lagen alleen de lagen DEM, Rainfall en Districts zijn.

• Districts moet bovenop liggen zodat zij zichtbaar zijn.

• Open het dialoogvenster om te clippen door het menu-item Raster → Extractie → Clipper te selecteren.

• Selecteer, in de keuzelijst Invoerbestand (raster), de laag DEM.

• Specificeer een locatie voor de uitvoer in het tekstveld Uitvoerbestand door te klikken op de knop Se-
lecteren....

• Navigeer naar uw map Rasterprac.

• Voer een bestandsnaam in.

• Sla het bestand op. Laat het keuzevak Waarde voor ‘geen data’ leeg.

• Gebruik de clip-modus Extent door er voor te zorgen dat de juiste keuzeknop is geselecteerd.

• Klik en sleep een gebied in het kaartvenster, zodat het gebied dat de districten bevat is geselecteerd.

• Selecteer het vak Na afloop in kaartvenster laden.

• Klik op OK.

• Nadat de bewerking clippen is voltooid, SLUIT N I E T HET dialoogvenster Clipper. (Door dat wel te doen
zou u het geclipte gebied verliezen dat u al gedefinieerd heeft.)

• Selecteer het raster Rainfall in de keuzelijst Invoerbestand (raster) en kies een andere naam voor het uitvo-
erbestand.

• Wijzig geen van de andere opties. Wijzig niets aan het bestaande gebied om te clippen dat u eerder tekende.
Laat alles hetzelfde en klik op OK.

• nadat de tweede bewerking om te clippen is voltooid, kunt u het dialoogvenster Clipper sluiten.

• Sla de kaart op.

9.4.10 De kaart opruimen

• Verwijder de originele lagen Rainfall en DEM uit de Lagenlijst:

• Klik met rechts op deze lagen en selecteer Verwijder.

– Dit zal niet de gegevens uit uw opslagapparaat verwijderen, ze worden alleen uit uw kaart verwijderd.

• Deactiveer de labels op de laag Streets:

– Klik op de knop Labels.

– Deselecteer het vak Deze laag labelen met.
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– Klik op OK.

• Geef opnieuw alle Streets weer:

– Klik met rechts op de laag in de Lagenlijst.

– Selecteer Query.

• Klik, in het dialoogvenster Query dat verschijnt, op de knop Leegmaken, klik dan op OK.

• Wacht terwijl de gegevens worden geladen. Alle straten zullen nu zichtbaar zijn.

• Wijzig de symbologie voor het raster zoals eerder (zie Wijzigen van de symbologie van rasterlagen).

• Sla de kaart op.

• U kunt nu de vectorlagen verbergen door het vak naast ze in de Lagenlijst leeg te maken. Dit zorgt er voor
dat de kaart sneller wordt gerenderd en u enige tijd bespaart.

U zult een plug-in moeten gebruiken die speciaal werd geschreven voor dit doel om de schaduw voor heuvels te
maken.

9.4.11 Activeer de plug-in ‘Raster Terrain’-analyse

Deze plug-in is standaard opgenomen in QGIS 1.8. Hij zou echter niet direct zichtbaar kunnen zijn. Controleren
of hij toegankelijk is op uw systeem:

• Klik op het menu-item Plug-ins –> Beheer en installeer plug-ins....

• Zorg er voor dat het vak naast ‘Raster Terrain’-analyse plug-in is geselecteerd.

• Klik op OK.

U zult nu toegang hebben tot deze plug-in via het menu-item Raster → ‘Terrain analysis’.

Onthoud dat plug-ins soms afhankelijk kunnen zijn van het feit dat bepaalde modules voor Python modules op uw
systeem zijn geïnstalleerd. Zou een plug-in weigeren te werken terwijl hij klaagt over ontbrekende afhankelijkhe-
den, vraag dan uw leraar of lector om assistentie.

9.4.12 De schaduw voor heuvels maken

• Zorg er voor dat, in de Lagenlijst, DEM de actieve laag is (d.i. hij is geaccentueerd door erop te klikken).

• Klik op het menu-item Raster → ‘Terrain analysis’ → ‘Hillshade’ om het dialoogvenster Hillshade te
openen.

• Specificeer een toepasselijke locatie voor de uitvoerlaag en noem die hillshade.

• Selecteer het vak Voeg resultaat toe aan project.

• Klik op OK.

• Wacht tot de verwerking is voltooid.

De nieuwe laag hillshade is verschenen in uw Lagenlijst.

• Klik met rechts op de laag hillshade in uw Lagenlijst en roep het dialoogvenster Laag-eigenschappen op.

• Klik op de tab Transparantie en stel de schuifbalk voor de transparantie in op 80%.

• Klik op OK in het dialoogvenster.

• Let op het effect wanneer de transparante hillshade over de geclipte DEM wordt gelegd.
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9.4.13 Helling

• Klik op het menu-item Raster → ‘Terrain analysis’.

• Selecteer het type analyse Helling, met de geclipte DEM als de invoerlaag.

• Specificeer een toepasselijke bestandsnaam en locatie voor de uitvoer.

• Selecteer het vak Voeg resultaat toe aan project.

• Klik op OK.

De afbeelding voor de helling wordt berekend en toegevoegd aan de kaart. Echter, zoals gewoonlijk is het slechts
een grijze rechthoek. Wijzig de symbologie als volgt om goed te kunnen zien wat er gebeurt.

• Open het dialoogvenster Laag-eigenschappen voor de laag (zoals gewoonlijk via het menu voor rechts-
klikken van de laag).

• Klik op de tab Stijl.

• Waar het zegt Grijswaarden (in de keuzelijst Kleuren kaart), wijzig die naar Pseudokleur.

• Zorg er voor dat de keuzeknop Standaard afwijking gebruiken is geselecteerd.

9.4.14 Aspect

• Gebruik dezelfde benadering als voor het berekenen van de helling, maar selecteer Aspect in het initiële vak
van het dialoogvenster.

Denk er aan om de kaart regelmatig op te slaan.

9.4.15 Rasters opnieuw classificeren

• Klik op het menu-item Raster → Rasterberekeningen.

• Specificeer uw map Rasterprac als de locatie voor de uitvoerlaag.

• Zorg er voor dat het vak Voeg resultaat toe aan project is geselecteerd.

In de lijst Rasterbanden aan de linkerkant, ziet u alle rasterlagen in uw Lagenlijst. Als u laag voor de helling is
genaamd slope, zal die zijn vermeld als slope@1.

De helling dient te liggen tussen 15 en 60 graden. Alles minder dan 15 of groter dan 60 moet daarom worden
uitgesloten.

• Bouw, met behulp van de items in de lijst en de knoppen in de interface, de volgende expressie:

((slope@1 < 15) OR (slope@1 > 60)) = 0

• Stel het veld Uitvoerbestand in op een toepasselijke locatie en bestandsnaam.

• Klik op OK.

Zoek nu naar het juiste aspect (uitkijkend op het oosten: tussen 45 en 135 graden) met behulp van dezelfde
benadering.

• Bouw de volgende expressie:

((aspect@1 < 45) OR (aspect@1 > 135)) = 0

• Zoek op dezelfde manier naar de juiste regenval (groter dan 1200mm). Bouw de volgende expressie:

(rainfall@1 < 1200) = 0

Door alle rasters opnieuw te classificeren, zult u ze nu als grijze rechthoeken zien weergegeven in uw kaart
(aangenomen dat zij op de juiste manier aan de kaart zijn toegevoegd). U dient hun symbologie te wijzigen om de
rastergegevens juist weer te geven in slechts twee klassen (1 en 0, betekent: true of false), .
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9.4.16 Instellen van de stijl voor opnieuw geclassificeerde lagen

• Open de tab Stijl in het dialoogvenster Laag-eigenschappen zoals gewoonlijk.

• Selecteer, onder de kop Min / max waarden laden, de keuzeknop Actueel (langzamer).

• Klik op de knop Laden.

De velden Aangepaste waarden min / max zouden nu met respectievelijk 0 en 1 moeten worden gevuld. (Als dat
niet gebeurt was er een vergissing met het opnieuw classificeren van de gegevens, en u zult dat gedeelte opnieuw
moeten uitvoeren.)

• Stel, onder de kop Contrastverbetering, de keuzelijst Geen verbetering in op ‘Stretch’ tot MinMax.

• Klik op OK.

• Doe dit voor alle drie de opnieuw geclassificeerde rasters, en vergeet niet uw werk op te slaan!

Het enige criterium dat overblijft is dat het gebied 250m van stedelijke gebieden moet liggen. We zullen aan dit
vereiste voldoen door er voor te zorgen dat de gebieden die we berekenen 250m of meer vanaf de rand van een
landelijk gebied ligt. Maar, dan moeten we wel eerst de landelijke gebieden zoeken.

9.4.17 Landelijke gebieden zoeken

• Verberg alle lagen in de Lagenlijst.

• Geef de vectorlaag Zoning weer.

• Klik er met rechts op en roep het dialoogvenster Query op.

• Bouw de volgende query:

"Gen_Zoning" = ’Rural’

Bekijk de eerdere instructies voor het bouwen van de query Streets als u het even niet weet.

• Sluit het dialoogvenster Query als u gereed bent.

U zou een verzameling polygonen moeten zien uit de laag Zoning. U zult deze op moeten slaan naar een nieuw
laagbestand.

• Selecteer Opslaan als.... in het menu voor rechtsklikken van Zoning.

• Sla uw laag op in de map Zoning.

• Noem het uitvoerbestand rural.shp.

• Klik op OK.

• Voeg de laag toe aan uw kaart.

• Klik op het menu-item Vector → Geoprocessing=gereedschap → Dissolve.

• Selecteer de laag rural als uw invoer-vectorlaag, waarbij u het vak Alleen geselecteerde objecten gebruiken
niet selecteert.

• Selecteer, onder Veld voor ‘Dissolve’-aktie, — ‘Dissolve’ alles —.

• Sla uw laag op in de map Zoning.

• Klik op OK. Een dialoogvenster zal verschijnen dat u vraagt of u de nieuwe laag wilt toevoegen aan de
inhoudsopgave (“Table of Contents”, verwijzend naar de Lagenlijst).

• Klik op Ja.

• Sluit het dialoogvenster Dissolve.

• Verwijder de lagen rural en Zoning .

• Sla de kaart op.
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Nu moet u de gebieden uitsluiten die binnen 250m vanaf de rand van de landelijke gebieden liggen. Doe dat door
een negatieve buffer te maken, zoals hieronder uitgelegd.

9.4.18 Een negatieve buffer maken

• Klik op het menu-item Vector → Geoprocessing-gereedschap → Buffer(s).

• Selecteer, in het dialoogvenster dat verschijnt, de laag rural_dissolve als uw invoer vectorlaag (Alleen ges-
electeerde objecten gebruiken zou niet moeten zijn geselecteerd).

• Selecteer de knop Bufferafstand en vooer de waarde -250 in het geassocieerde veld in; de negatieve waarde
betekent dat de buffer een interne buffer moet zijn.

• Selecteer het vak Dissolve buffer resultaten.

• Stel het uitvoerbestand in voor dezelfde map als de andere landelijke vectorbestanden.

• Noem het uitvoerbestand rural_buffer.shp.

• Klik op Opslaan.

• Klik op OK en wacht tot de verwerking is voltooid.

• Selecteer Ja in het dialoogvenster dat verschijnt.

• Sluit het dialoogvenster Buffer.

• Verwijder de laag rural_dissolve.

• Sla de kaart op.

Het moet ook worden gerasteriseerd om de landelijke zones in dezelfde analyse met de drie bestaande rasters
te kunnen verwerken. Maar zij moeten van dezelfde grootte zijn om de rasters compatibel te laten zijn voor de
analyse. Daarom moet u, voordat u kunt rasteriseren, de vector clippen naar hetzelfde gebied als de drie rasters.
Een vector kan alleen worden geclipt naar een andere vector, dus moet u eerst een polygoon begrenzingsvak maken
van dezelfde grootte als de rasters.

9.4.19 Een vector begrenzingsvak maken

• Klik op het menu-item :guilabel:’Kaartlagen –> Nieuw –> Nieuwe Shapefile-laag...‘.

• Selecteer, onder de kop Type, de knop Polygoon.

• Klik op Geef het CRS en stel het coördinatenreferentiesysteem in op WGS 84 / UTM zone 33S :
EPSG:32733.

• Klik op OK.

• Klik ook op OK in het dialoogvenster Nieuwe vectorlaag .

• Sla de vector op in de map Zoning.

• Noem het uitvoerbestand bbox.shp.

• Verberg alle lagen met uitzondering van de nieuwe laag bbox en één van de opnieuw geclassificeerde rasters.

• Zorg er voor dat de laag bbox is geaccentueerd in de Lagenlijst.

• Navigeer naar het menu-item :Beeld > Werkbalken en zorg er voor dat Digitaliseren is geselecteerd. U zou
dan een pictogram voor de werkbalk moeten zien met een potlood erop. Dat is de knop :guilabel:‘Bewerken
aan-/uitzetten.

• Klik op de knop Bewerken aan-/uitzetten om naar de modus Bewerken te gaan. Dat stelt u in staat een
vectorlaag t ebewerken.

• Klik op de knop Object toevoegen, die nabij de knop Bewerken aan-/uitzetten zou moeten staan. Hij kan
zijn verborgen achter een knop met een dubbele pijl; als dat zo is klik dan op de knop met de dubbele pijl
om de verborgen pictogrammen van de werkbalk Digitaliseren weer te geven.
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• Klik met links, met het gereedschap Object toevoegen geactiveerd, op de hoeken van het raster. U moet
misschien inzoomen met het muiswiel om er voor te zorgen dat het nauwkeurig is. Klik en sleep in de kaart
met de middelste muisknop of het muiswiel om in deze modus over de kaart te schuiven.

• Klik met rechts, op het vierde en laatste punt, om de vorm te voltooien.

• Voer een willekeurig getal in voor de ID van de vorm.

• Klik op OK.

• Klik op de knop Wijzigingen laag opslaan.

• Klik op de knop Bewerken aan-/uitzetten om uw sessie voor bewerkingen te beëindigen.

• Sla de kaart op.

Nu u een begrenzingsvak heeft, kunt u die gebruiken om de laag rural buffer te clippen.

9.4.20 Een vectorlaag clippen

• Zorg er voor dat alleen de lagen bbox en rural_buffer zichtbaar zijn, met de laatste bovenop.

• Klik op het menu-item Vector > Geoprocessing-gereedschap > Clip.

• Stel, in het dialoogvenster dat verschijnt, de invoer vectorlaag in op rural_buffer en de cliplaag op bbox,
met in beide het vak :Alleen geselecteerde objecten gebruiken niet geselecteerd.

• Plaats het uitvoerbestand in de map Zoning.

• Noem het uitvoerbestand rural_clipped.

• Klik op OK.

• Klik op Ja. als gevraagd wordt of de laag moet worden toegevoegd aan de inhoudsopgave.

• Sluit het dialoogvenster.

• Vergelijk de drie vectoren bekijk zelf de resultaten.

• Verwijder de lagen bbox en rural_buffer, en sla dan uw kaart op.

Nu is die gereed om te worden gerasteriseerd.

9.4.21 Een vectorlaag rasterizeren

U zult een pixelgrootte moeten specificeren voor een nieuw raster dat u maakt, dus u zult eerst de grootte van een
van uw bestaande rasters moeten weten.

• Open het dialoogvenster Laag-eigenschappen van één van de drie bestaande rasters.

• Schakel naar de tab Metadata.

• Maak een notitie van de waarden X en Y onder de kop Dimensies in de tabel Metadata.

• Sluit het dialoogvenster Laag-eigenschappen.

• Klik op het menu-item Raster → Conversie → Rasterizeren. U zou een waarschuwing kunnen krijgen over
een gegevensset die niet wordt ondersteund. Klik het weg en negeer het.

• Selecteer rural_clipped als uw invoerlaag.

• Stel een locatie in voor het uitvoerbestand binnen de map Zoning.

• Noem het uitvoerbestand rural_raster.tif.

• Selecteer het vak Rstergrootte in pixels en voer de waarden X en Y in waarvan u eerder een notitie heeft
gemaakt.

• Selecteer het vak Na afloop in kaartvenster laden.
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• Klik op het pictogram van het potlood naast het tekstveld dat de opdracht weergeeft die zal worden uitgevo-
erd. Voeg, aan het einde van de bestaande tekst, een spatie toe en dan de tekst -burn 1. Dit vertelt de
functie Rasterizeren om de bestaande vector in het nieuwe raster te “branden” en geeft de gebieden die wor-
den bedekt door de vector de nieuwe waarde 1 (in tegenstelling tot de rest van de afbeelding die automatisch
0 zullen zijn).

• Klik op OK.

• Het nieuwe raster zou in uw kaart moeten verschijnen als het eenmaal is berekend.

• Het nieuwe raster zal er uitzien als een grijze rechthoek – u moet misschien de stijl voor de weergave
wijzigen zoals u deed voor de opnieuw geclassificeerde rasters.

• Sla uw kaart op.

Nu u alle vier criteria elk in een afzonderlijk raster heeft, moet u ze combineren om te zien welke gebieden voldoen
aan alle criteria. De rasters zullen met elkaar worden vermenigvuldigd om dat te doen. Wanneer dit gebeurt zullen
alle overlappende pixels met de waarde 1 de waarde 1 behouden, maar als een pixel in één van de vier rasters
de waarde 0 heeft, dan zal het 0 zijn in het resultaat. Op deze manier zal het resultaat alleen de overlappende
gebieden bevatten.

9.4.22 Rasters combineren

• Klik op het menu-item Raster → Rasterberekeningen.

• Bouw de volgende expressie (met de toepasselijke namen voor uw lagen, afhankelijk van hoe u ze genoemd
heeft):

[Rural raster] * [Reclassified aspect] * [Reclassified slope] *
[Reclassified rainfall]

• Stel de locatie voor de uitvoer in op de map Rasterprac.

• Noem het uitvoerraster cross_product.tif.

• Zorg er voor dat het vak Voeg resultaat toe aan project is geselecteerd.

• Klik op OK.

• Wijzig de symbologie van het nieuwe raster op dezelfde manier als waarop u de stijl voor de andere opnieuw
geclassificeerde rasters heeft ingesteld. Het nieuwe raster geeft nu op de juiste wijze de gebieden weer waar
aan alle criteria wordt voldaan.

U moet de gebieden selecteren die groter zijn dan 6000m:sup:’2’ om het uiteindelijke resultaat te krijgen. Het
berekenen van deze gebieden is echter alleen mogelijk in een vectorlaag, dus zult u het raster moeten vectoriseren.

9.4.23 Het raster vectoriseren

• Klik op het menu-item Raster → Conversie → Vectoriseren.

• Selecteer het raster cross_product.

• Stel de locatie voor de uitvoer in op Rasterprac.

• Noem het bestand candidate_areas.shp.

• Zorg er voor dat het vak Na afloop in kaartvenster laden is geselecteerd.

• Klik op OK.

• Sluit het dialoogvenster als de verwerking voltooid is.

Alle gebieden van het raster zijn gevectoriseerd, dus u moet alleen de gebieden selecteren die de waarde 1 hebben.

• Open het dialoogvenster Query voor de nieuwe vector.

• Bouw deze query:
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"DN" = 1

• Klik op OK.

• Maak een nieuw vectorbestand uit de resultaten door de vector candidate_areas op te slaan nadat de query
voltooid is (en alleen de gebieden met de waarde 1 zichtbaar zijn). Gebruik de functie Opslaan als... in het
rechtsklik-menu van de laag hiervoor.

• Sla het bestand op in de map Rasterprac.

• Noem het bestand candidate_areas_only.shp.

• Sla uw kaart op.

9.4.24 Het gebied voor elke polygoon berekenen

• Open het rechtsklik-menu van de nieuwe vectorlaag.

• Selecteer Attributentabel openen.

• Klik op de knop modus Bewerken aan-/uitzetten aan de onderzijde van de tabel, of druk op Ctrl+E.

• Klik op de knop Veldberekening openen aan de onderzijde van de tabel, of druk op Ctrl+I.

• Voer, onder de kop Nieuw veld in het dialoogvenster dat verschijnt, de veldnaam area in. Het type uitvo-
erveld zou een geheel getal moeten zijn, en de veldbreedte zou 10 moeten zijn.

• In Field calculator expression, type:

$area

Dit betekent dat de veldberekening het gebied van elke polygoon in de vectorlaag zal berekenen en ze dan
zal vermelden in een nieuwe kolom met een geheel getal (genaamd area) met de berekende waarde.

• Klik op OK.

• Herhaal deze stap voor een ander veld genaamd id. In Field calculator expression, type:

$id

Dit zorgt er voor dat elke polygoon een unieke ID heeft ter identificatie.

• Klik opnieuw op de knop modus Bewerken aan-/uitzetten en sla uw gegevens op als daarnaar gevraagd
wordt.

9.4.25 Gebieden met een bepaalde grootte selecteren

Nu de gebieden bekend zijn:

• Bouw een query (zoals gewoonlijk) om alleen de polygonen te selecteren die groter zijn dan
6000m:sup:’2’. De query is:

"area" > 6000

• Sla de selectie op als een nieuwe vectorlaag, genaamd solution.shp.

U heeft nu uw gebieden voor de oplossing, van waaruit u dat moet kiezen dat het dihtst bij uw huis ligt.

9.4.26 Uw huis digitaliseren

• maak net als eerder een nieuwe vectorlaag, maar deze keer, selecteer de waarde Type als Punt.

• Zorg er voor dat het in het juiste CRS is!

• Noem de nieuwe laag house.shp.
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• Voltooi het maken van de nieuwe laag.

• Ga naar de modus Bewerken (terwijl de nieuwe laag is geselecteerd).

• Klik op het punt waar uw huis of andere huidige verblijfplaats is, met behulp van de starten als een hulplijn.
U moet misschien andere lagen openen om u te helpen uw huis te vinden. Als u niet ergens dichtbij woont,
klik dan ergens langs de straat waar een mogelijk huis zou kunnen zijn.

• Voer een willekeurig getal in voor de ID van de vorm.

• Klik op OK.

• Sla uw bewerkingen op en verlaat de modus Bewerken.

• Sla de kaart op.

U zult de centroïden (“zwaartepunten”) voor de polygonen in het oplossingsgebied moeten zoeken om te kunnen
bepalen welk het dichtst bij uw huis ligt.

9.4.27 Centroïden voor polygonen berekenen

• Klik op het menu-item Vector → Geometrie-gereedschappen → Polygoon centroïde.

• Specificeer de invoerlaag als solution.shp.

• Geef als uitvoerlocatie op Rasterprac.

• Noem het doelbestand solution_centroids.shp.

• Klik op OK en voeg het resultaat toe aan de inhoudsopgave (Lagenlijst), en sluit dna het dialoogvenster.

• Sleep de nieuwe laag tot boven in de laagvolgorde zodat u hem kunt zien.

9.4.28 Berekenen welke centroïde het dichtst bij uw huis ligt

• Klik op het menu-item Vector –> Analyse-gereedschap –> Afstandsmatrix.

• De invoerlaag zou uw huis moeten zijn, en de doellaag solution_centroids. Beide zouden het veld ID als
hun unieke veld ID moeten gebruiken.

• Het type uitvoermatrix zou lineair moeten zijn.

• Stel een toepasselijke locatie voor de uitvoer en een naam in.

• Klik op OK.

• Open het bestand in een tekstbewerker (of importeer het in een werkblad). Onthoud welk doel-ID is geas-
socieerd met de kortste Afstand. Er zouden er meer dan één op dezelfde afstand kunnen zijn.

• Bouw een query in QGIS om alleen de oplossingsgebieden te selecteren die het dichtst bij uw huis liggen
(selecteer ze met behulp van het veld ID).

Dit is het uiteindelijke antwoord op de onderzoeksvraag.

Leg, voor als u het inlevert, de semi-transparante laag hillshade over een aantrekkelijk raster van uw keuze (zoals
de DEM of de laag slope bijvoorbeeld). Neem ook de polygoon van het dichtstbij gelegen oplossingsgebied en
uw huis op. Volg alle best practices voor cartografie bij het maken van uw uitvoerkaart.
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CHAPTER 10

Module: Plug-ins

Plug-ins stellen u in staat de functionaliteit die QGIS biedt uit te breiden. In deze module zal u worden getoond
hoe plug-ins te activeren en te gebruiken.

10.1 Lesson: Plug-ins installeren en beheren

U zult moeten weten hoe u ze moet downloaden, installeren en activeren om te kunnen beginnen met het gebruiken
van plug-ins, U zult leren hoe u Plug-in installeren en Plug-in Manager moet gebruiken om dit te doen.

Het doel voor deze les: Het systeem van plug-ins in QGIS begrijpen en gebruiken

10.1.1 Follow Along: Plug-ins beheren

• Klik op het menu-item Plug-ins → Plug-ins beheren en installeren om de Plugin Manager te openen.

• Zoek, in het dialoogvenster dat opent, naar de plug-in Processing:

• Klik in het vak naast deze plug-in en deselecteer het om het te deïnstalleren.
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• Klik op Sluiten.

• Kijkend naar het menu zult u zien dat het menu Processing nu is verdwenen. Dit betekent dat veel van de
functies voor het verwerken, die u eerder gebruikt heeft, zijn verdwenen! Dit omdat zij deel uitmaken van
de plug-in Processing, die voor u moet zijn geactiveerd om hem te kunnen gebruiken.

• Open de Plug-in Manager opnieuw en activeer de plug-in Processing opnieuw door te klikken in het keuze-
vak ernaast en te klikken op Close..

• Het menu Processing zou weer beschikbaar moeten zijn.

10.1.2 Follow Along: Nieuwe plug-ins Installeren

De lijst met plug-ins die u kunt activeren en deactiveren wordt gevormd door de plug-ins die u momenteel heeft
geïnstalleerd.

• Selecteer, om nieuwe plug-ins te installeren, de optie Niet geïnstalleerd in het dialoogvenster Plug-in Man-
ager. De voor u beschikbare plug-ins om te installeren zullen hier zijn vermeld. Deze lijst zal variëren
afhankelijk van de instelling van uw bestaande systeem.

• U vindt informatie over elke plug-in door die te selecteren in de lijst met weergegeven plug-ins.
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• Een plug-in kan worden geïnstalleerd door te klikken op de knop Installeer plug-in onder het paneel met
informatie over de plug-ins.

10.1.3 Follow Along: Aanvullende opslagplaatsen voor plug-ins configur-
eren

De plug-ins die voor u beschikbaar zijn om te installeren zijn afhankelijk van welke opslagplaatsen voor plug-ins
u heeft geconfigureerd om te gebruiken.

Plug-ins voor QGIS worden online opgeslagen in opslagplaatsen. Standaard zijn alleen de officiële opslagplaatsen
actief, wat betekent dat u alleen toegang heeft tot officiële plug-ins. Dit zijn gewoonlijk de eerste plug-ins die u
wilt, omdat zij uitputtend zijn getest en vaak standaard in QGIS zijn opgenomen.

Het is echter mogelijk om meer plug-ins uit te proberen dan alleen de standaard. U zult om te beginnen aanvullende
opslagplaatsen moeten configureren. Om dat te doen:

• Open de tab Extra in het dialoogvenster Plug-in Manager:
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• Klik op Toevoegen om een nieuwe opslagplaats te zoeken en toe te voegen.

• Geef een Naam en URL op voor de nieuwe opslagplaats die u wilt configureren en zorg er voor dat het vak
Ingeschakeld is geselecteerd.

• U zult nu de nieuwe opslagplaats voor plug-ins zien vermeld in de lijst met geconfigureerde opslagplaatsen
voor plug-ins
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• U kunt ook de optie selecteren om Experimentele plug-ins weer te geven door het vak Ook de experimentele
plug-ins tonen te selecteren.

• Als u nu terugschakelt naar de tab Niet geïnstalleerd, zult u zien dat er nu aanvullende plug-ins beschikbaar
zijn om te installeren.

• Klik er eenvoudigweg op in de lijst en klik dan op de knop Installeer plug-in om een plug-in te installeren.

10.1.4 In Conclusion

Installeren van plug-ins in QGIS is eenvoudig en effectief!

10.1.5 What’s Next?

Vervolgens zullen we u als voorbeelden enkele handige plug-ins laten zien.

10.2 Lesson: Handige plug-ins voor QGIS

Nu u plug-ins kunt installeren, inschakelen en uitschakelen, kunnen we eens zien hoe dat u in de praktijk kan
helpen door naar enkele voorbeelden van handige plug-ins te kijken.

Het doel voor deze les: Uzelf bekend te laten worden met de interface voor plug-ins en enkele handige plug-ins
te leren kennen.

10.2.1 Follow Along: De plug-in Raster Terrain Analysis

• Begin met een nieuwe kaart met alleen de raster gegevensset srtm_41_19.tif er in (kijk in
exercise_data/raster/SRTM).
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Vanuit de les over rasteranalyse bent u al bekend met functies voor rasteranalyse. U heeft daarvoor GDAL tools
gebruikt (toegankelijk via Raster –> Analyse). U zou echter ook op de hoogte moeten zijn van de plug-in ‘Raster
Terrain’-analyse. Deze wordt standaard meegeleverd met nieuwere versies van QGIS, en dus hoeft u hem niet
afzonderlijk te installeren.

• Open de Plug-in Manager en controleer of de plug-in ‘Raster Terrain’-analyse is ingeschakeld:

• Open het menu Raster. U zou een submenu Terrain analysis moeten zien.

• Klik op Terrain analysis → Reliëf en voer de volgende opties in:

• Sla het nieuwe bestand op onder exercise_data/plugins/relief.tif (maak een nieuwe map
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indien nodig).

• Laat Uitvoerformaat en Z factor ongewijzigd.

• Zorg er voor dat het vak Voeg resultaat toe aan project is geselecteerd.

• Klik op de knop Automatisch aanmaken. De lijst eronder zal worden gevuld:

Dit zijn de kleuren die de plug-in zal gebruiken om het reliëf te maken.

• Als u dat wilt kunt u deze kleuren wijzigen door te dubbelklikken op de kleurenbalk in elke rij. Bijvorbeeld:

• Klik op OK en het reliëf zal worden gemaakt:
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Dit geeft een soortgelijk effect als wanneer u de semi-transparante schaduw voor heuvels over een andere raster-
laag zou hebben gelegd. Het voordeel van deze plug-in is dat het dit effect maakt met behulp van slechts één
laag.

10.2.2 Follow Along: De plug-in OpenLayers

• Begin een nieuwe kaart en voeg de laag roads.shp er aan toe.

• Zoom in op het gebied van Swellendam.

• Zoek, met behulp van de Plug-in Manager, een nieuwe plug-in door het woord OpenLayers in te voeren
in het veld Zoek.

• Selecteer de plug-in OpenLayers uit de gefilterde lijst:
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• Klik op de knop Installeer plug-in om te installeren.

• Sluit het dialoogvenster :guilabel:‘Plug-in Manager ‘ als het voltooid is.

Zorg er voor dat zowel uw kaart als de plug-in juist zijn geconfigureerd voordat u het gebruikt:

• Open de instellingen voor de plug-in door te klikken op Web → OpenLayers plug-in → OpenLayers
Overview.

• Gebruik het paneel om een type kaart te kiezen dat u wilt gebruiken. In dit voorbeeld gebruiken we het type
kaart “Hybrid”, maar u kunt een van de andere kiezen als u dat wilt.

• Open het dialoogvenster Projectinstellingen door Project –> Projectinstellingen uit het menu te selecteren.
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• Schakel “Gelijktijdige CRS-transformatie gebruiken” in en gebruik de projectie Google Mercator:

• Gebruik nu de plug-in om u een kaart van Google van het gebied te geven. U kunt klikken op Plug-ins →
OpenLayers plug-in → Google Hybrid-laag toevoegen om hem toe te voegen:

Dit zal een nieuwe rasterafbeelding laden van Google die u kunt gebruiken om op terug te vallen, of om u te
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helpen om uit te zoeken waar op de kaart u bent. Hier is een dergelijke laag, met onze eigen vector wegenlaag er
overheen:

Notitie: U moet misschien uw laag met wegen tot boven de laag van Google slepen om hem zichtbaar te maken
boven de achtergrondlaag. Het kan ook nodig zijn om in te zoomen naar het bereik van de laag met wegen om de
kaart opnieuw te centreren.

10.2.3 Follow Along: De plug-in GeoSearch

• Begin een nieuwe kaart zonder gegevenssets.

• Open de Plug-in Manager en filter op de plug-in GeoSearch en klik op Installeer plug-in om te installeren.
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• Sluit de Plug-in Manager.

• U kunt nu de plug-in GeoSearch gebruiken om te zoeken naar plaatsnamen. Klik op Plug-ins –> GeoSearch
–> GeoSearch om het dialoogvenster voor GeoSearch te openen.

• Zoek naar Swellendam in het dialoogvenster GeoSearch om het op uw kaart te lokaliseren:
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10.2.4 In Conclusion

Er zijn vele handige plug-ins beschikbaar voor QGIS. U kunt naar nieuwe plug-ins zoeken en optimaal gebruik
van ze maken met behulp van de ingebouwde gereedschappen voor het installeren en beheren van deze plug-ins, .

10.2.5 What’s Next?

Vervolgens zullen we kijken naar hoe we lagen gebruiken die op dat moment worden gehost op servers op afstand.
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CHAPTER 11

Module: Online bronnen

Bij het overwegen van gegevensbronnen voor een kaart is er geen reden om te zijn beperkt tot gegevens die u
heeft opgeslagen op de computer waarop u werkt. Er zijn gegevensbronnen online waaruit u gegevens kunt laden
zolang u bent verbonden met het internet.

In deze module zullen we twee soorten web-gebaseerde GIS-services behandelen: Web Mapping Services (WMS)
en Web Feature Services (WFS).

11.1 Lesson: Web Mapping Services

Een Web Mapping Service (WMS) is een service die wordt gehost op een server op afstand. Net als met een
website kunt u er toegang tot verkrijgen, zolang u een verbinding met de server heeft. Met behulp van QGIS kunt
u een WMS direct in uw bestaande kaart laden.

Uit de les over plug-ins zult u hebben onthouden dat het mogelijk is een nieuwe rasterafbeelding te laden vanaf,
bijvoorbeeld, Google. Dat is echter een eenmalige transactie: als u de afbeelding eenmaal heeft gedownload,
wijzigt die niet meer. Een WMS is anders in die zin dat het een live service is die automatisch zijn weergave zal
vernieuwen als u op de kaart inzoomt of erover schuift.

Het doel voor deze les: Een WMS gebruiken en de beperkingen ervan begrijpen.

11.1.1 Follow Along: Een WMS-laag laden

Voor deze oefening kunt ofwel de basiskaart gebruiken die u aan het begin van de cursus heeft gemaakt, of gewoon
een nieuwe kaart beginnen en er enkele bestaande lagen in laden. Voor dit voorbeeld gebruikten we een nieuwe
kaart en laden de originele lagen places en landuse en pasten de symbologie aan:
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• Laad deze lagen nu in een nieuwe kaart, of gebruik uw originele kaart met alleen deze lagen zichtbaar.

• Deactiveer eerst “Gelijktijdige CRS-transformatie gebruiken” vóórdat u begint met het toevoegen van de
WMS-laag. Dit kan er voor zorgen dat de lagen elkaar niet langer juist overlappen, maar geen zorgen, dat
repareren we later.

• Klik op de knop WMS-laag toevoegen om WMS-lagen toe te voegen:

Weet u nog hoe u verbonden was met een database van SpatiaLite aan het begin van de cursus?. De lagen landuse,
places en water staan in die database. U moest eerst verbinden met die database om die lagen te kunnen gebruiken.
Een WMS gebruiken is soortgelijk, met de uitzondering dat de lagen op een server op afstand staan.

• Klik op de knop Nieuw om een nieuwe verbinding naar een WMS te maken.

U heeft een adres voor een WMS nodig om door te gaan. Er zijn verschillende gratis servers voor WMS beschik-
baar op het internet. Een daarvan is terrestris, die gebruik maakt van de gegevensset van OpenStreetMap.

• Stel, om gebruik te maken van deze WMS, het als volgt in in uw huidige dialoogvenster:
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• De waarde van het veld Naam zou terrestris moeten zijn.

• De waarde van het veld URL zou http://ows.terrestris.de/osm/service moeten zijn.

• Klik op OK. U zou de nieuwe server voor WMS moeten zien vermeld:
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• Klik op Verbinden. In de lijst hieronder zou u nu deze nieuwe items zien geladen:

Dit zijn alle lagen die worden gehost door de server van deze WMS.
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• Klik eenmaal op de laag OSM-WMS. Dit zal het CoördinatenReferentieSysteem ervan weergeven:

Laten we eens kijken naar alle CRS-en waaruit we kunnen kiezen, omdat we WGS 84 niet voor onze kaart
gebruiken.

• Klik op de knop Aanpassen. U zult een standaard dialoogvenster zien voor CoördinatenReferentieSysteem
selecteren.

• We willen een geprojecteerd CRS, dus laten we kiezen voor WGS 84 / Pseudo Mercator.
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• Klik op OK.

• Klik op Toevoegen en de nieuwe laag zal in uw kaart verschijnen als OSM-WMS.

• In de Lagenlijst, klik en sleep het tot onderin de lijst.

Het zal u opvallen dat de lagen niet op de juist locatie staan. Dat komt omdat “Gelijktijdige CRS-transformatie
gebruiken” is uitgeschakeld. Laten we die opnieuw inschakelen, maar laten we dezelfde projectie gebruiken als
de laag OSM-WMS , wat WGS 84 / Pseudo Mercator is.

• Schakel “Gelijktijdige CRS-transformatie gebruiken” in.

• Voer, op de tab CRS (dialoogvenster Projectinstellingen), de waarde pseudo in in het veld Filter:
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• Kies WGS 84 / Pseudo Mercator uit de lijst.

• Klik op OK.

• Klik nu met rechts op uw eigen lagen in de Lagenlijst en klik op Zoom naar laag. U zou het gebied
Swellendam moeten zien:
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Zie nu hoe de straten van de WMS-laag en uw eigen straten elkaar overlappen. Dat is een goed teken!

De natuur en beperkingen van WMS

Het zou u inmiddels opgevallen kunnen zijn dat deze WMS-laag in feite vele objecten in zich draagt. Het heeft
straten, rivieren, natuurreservaten, enzovoort. Maar verder, zelfs alsof het eruit ziet alsof het is gemaakt uit
vectoren, het lijkt een raster te zijn, maar u kunt de symbologie ervan niet veranderen. Waarom is dat?

Dit is hoe een WMS werkt: Het is een kaart, soortgelijk aan een normale kaart op papier, die u ontvangt als een
afbeelding. Wat gewoonlijk gebeurd is dat u vectorlagen heeft, die QGIS rendert als een kaart. Maar bij het
gebruiken van een WMS, bevinden die vectorlagen zich op de server van WMS, die het als een kaart rendert en
die kaart naar u verzendt als een afbeelding. QGIS kan deze afbeelding weergeven, maar kan de symbologie ervan
niet wijzigen, omdat dat allemaal wordt afgehandeld op de server.

Dit heeft verschillende voordelen, omdat u zich geen zorgen hoeft te maken over de symbologie. Dat is allemaal
al verwerkt, en zal goed genoeg zijn om te bekijken op elk competent ontworpen WMS.

Aan de andere kant kunt u de symbologie niet wijzigen als die u niet bevalt, en als er dingen wijzigen op de
server van WMS, dan zullen zij ook op uw kaart wijzigen. Dat is waarom soms in plaats daarvan een Web Feature
Service (WFS) wilt gebruiken, die u afzonderlijke vectorlagen geeft en niet als deel van een kaart in WMS-stijl.

Dit zal echter worden behandeld in de volgende les. Laten we eerst een andere WMS-laag van de WMS-server
terrestris toevoegen.

11.1.2 Try Yourself

• Verberg de laag OSM-WSM in de Lagenlijst.

• Voeg de server voor WMS “ZAF CGS 1M Bedrock Lithostratigraphy” op deze URL:
http://196.33.85.22/cgi-bin/ZAF_CGS_Bedrock_Geology/wms toe.

• Laad de laag BEDROCKGEOLOGY in de kaart (gebruik de knop WMS-laag toevoegen zoals eerder). Denk
er aan om die in dezelfde projectie WGS 84 / World Mercator te plaatsen als de rest van uw kaart!

• U wilt misschien Afbeeldingsformaat instellen op JPEG en de optie Tile-grootte op 200 bij 200, zodat het
sneller laadt:
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Controleer uw resultaten

11.1.3 Try Yourself

• Verberg alle andere WMS-lagen om te voorkomen dat ze op de achtergrond onnodig worden gerenderd.

• Voeg de server voor WMS “OGC” op deze URL toe: http://ogc.gbif.org:80/wms

• Voeg de laag bluemarble toe.

Controleer uw resultaten

11.1.4 Try Yourself

Een deel van de moeilijkheid van het gebruiken van WMS is het vinden van een goede (gratis) server.

• Zoek een nieuwe WMS op directory.spatineo.com (of ergens anders online). Het moet geen geassocieerde
kosten of beperkingen hebben en moet dekking hebben voor het te onderzoeken gebied Swellendam.

Onthoud dat het enige wat u nodig heeft om een WMS te gebruiken is alleen de URL ervan (en bij voorkeur
een soort beschrijving).

Controleer uw resultaten

11.1.5 In Conclusion

U kunt inactieve kaarten om op terug te vallen toevoegen aan uw bestaande gegevens voor uw kaarten door een
WMS te gebruiken,.

11.1.6 Further Reading

• Spatineo Directory

• Geopole.org
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• OpenStreetMap.org lijst van WMS-servers

11.1.7 What’s Next?

Nu u een inactieve kaart om op terug te vallen heeft toegevoegd, zult u blij zijn te weten dat het ook mogelijk is
om objecten (zoals de andere vectorlagen die u eerder toevoegd) kunt toevoegen. Toevoegen van objecten vanaf
servers op afstand is mogelijk door een Web Feature Service (WFS) te gebruiken. Dat is het onderwerp van de
volgende les.

11.2 Lesson: Web Feature Services

Een Web Feature Service (WFS) verschaft zijn gebruikers GIS-gegevens in indelingen die direct in QGIS kunnen
worden geladen. Anders dan een WMS, die u alleen een kaart verschaft die u niet kunt bewerken, geeft een WFS
u toegang tot de objecten zelf.

Het doel voor deze les: Een WFS gebruiken en begrijpen hoe die verschilt van een WMS.

11.2.1 Follow Along: Een WFS-laag laden

• Begin een nieuwe kaart. Deze is alleen om te demonstreren en wordt niet opgeslagen.

• Zorg er voor dat “Gelijktijdige CRS-transformatie gebruiken” is uitgeschakeld.

• Klik op de knop WFS-laag toevoegen:

• Klik op de knop Nieuw.

• Voer, in het dialoogvenster dat verschijnt, de Naam in als nsidc.org en de URL als
http://nsidc.org/cgi-bin/atlas_south?version=1.1.0.

• Klik op OK en de nieuwe verbinding zal verschijnen in uw Server-verbindingen.
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• Klik op de knop Verbinden. Een lijst met beschikbare lagen zal verschijnen:

• Zoek naar de laag south_poles_wfs.

• Klik op de laag om die te selecteren:
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• Klik op Toevoegen.

Het kan enige tijd vergen om de laag te laden. Als hij is geladen, verschijnt hij in de kaart. Hier ligt hij over de
omtrek van Antarctica (beschikbaar op dezelfde server onder de naam antarctica_country_border):

Hoe verschilt dit van het hebben van een WMS-laag? Dat zal duidelijk worden wanneer u de attributen van de
laag ziet.

• Open de attributentabel van de laag south_poles_wfs. U zou dit moeten zien:
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Omdat de punten attributen hebben, kunnen we ze labelen, al ook hun symbologie wijzigen. Hier is een voorbeeld:

• Voeg labels toe aan uw laag om voordeel te halen uit de gegevens voor attriobuten in deze laag.

Verschillen met WMS-lagen

Een Web Feature Service geeft de laag zelf terug, niet slechts een daaruit gerenderde kaart. Dit geeft u directe
toegang tot de gegevens, wat betekent dat u hun symbologie kunt wijzigen en analyse-functies erop kunt uitvoeren.
Dat gaat echter ten koste van heel veel gegevens die moeten worden verzonden. Dit zal speciaal duidelijk zijn als
de lagen die u laadt gecompliceerde vormen hebben, enorm veel attributen, of veel objecten; of zelfs als alleen
maar veel lagen laadt. WFS-lagen hebben hierom sowieso veel tijd nodig om te laden.
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11.2.2 Follow Along: Een WFS-laag bevragen

Hoewel het mogelijk is een query uit te voeren op een WFS-laag nadat die is geladen, is het vaak efficiënter om
de query uit te voeren voordat hij is geladen. Op die manier vraagt u alleen de objecten op die u wilt, wat betekent
dat u veel minder bandbreedte gebruikt.

Op de server van WFS die we momenteel gebruiken is bijvoorbeeld een laag genaamd countries (excluding
Antarctica). Laten we zeggen dat we willen weten waar Zuid-Afrika ligt, relatief ten opzichte van de laag
south_poles_wfs (en misschien ook de laag antarctica_country_border) die al is geladen.

Er zijn twee manieren om dit te doen. U kunt de gehele laag countries ... laden, en dan zoals gewoonlijk een query
bouwen als hij is geladen. Echter, het verzenden van de gegevens voor alle landen in de wereld en dan alleen de
gegevens voor Zuid-Afrika gebruiken lijkt een verspilling van bandbreedte. Afhankelijk van uw verbinding kan
het enkele minuten duren om deze gegevensset te laden.

Het alternatief is om de query als een filter te bouwen vóór zelfs de laag te laden vanaf de server.

• Verbindt, in het dialoogvenster WFS-laag toevoegen..., met de server die we eerder gebruikten en u zou de
lijst met beschikbare lagen moeten zien.

• Dubbelklik naast de laag countries ... in het veld Filter, of klik op Query maken:

• Bouw, in het dialoogvenster dat verschijnt, de query "Countryeng" = ’South Africa’:
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• Het zal verschijnen als de waarde Filter:
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• Klik op Toevoegen met de laag countries geselecteerd zoals hierboven. Alleen het land met de waarde
South Africa voor Countryeng zal voor die laag worden geladen:

U hoeft het niet te doen, maar als u beide methoden heeft gebruikt, zult u merken dat dit een stuk sneller is dan
het laden van alle landen vóórdat u ze gefilterd heeft!

Opmerkingen over de beschikbaarheid van WFS

Het is zeldzaam een host voor WFS te vinden die de objecten host die u nodig heeft, als u hele specifieke behoeften
heeft. De reden waarom Web Feature Services relatief zeldzaam zijn is vanwege de grote hoeveelheden gegevens
die moeten worden verzonden om een geheel object te beschrijven. Het is daarom niet erg kosteneffectief om een
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WFS te hosten in plaats van een WMS, dat alleen afbeeldingen verzendt.

Het meest voorkomende type WFS dat u daarom zult tegenkomen zal daarom waarschijnlijk op een lokaal netwerk
staan of zelfs op uw eigen computer, in plaats van op het internet.

11.2.3 In Conclusion

WFS-lagen hebben de voorkeur boven WMS-lagen als u directe toegang nodig heeft tot de attributen en geome-
trieën van de lagen. Echter de hoeveelheid gegevens in aanmerking nemende die moet worden gedownload (wat
leidt tot problemen met de snelheid en ook een gebrek aan eenvoudig beschikbare publieke servers voor WFS) is
het niet altijd mogelijk een WFS te gebruiken in plaats van een WMS.

11.2.4 What’s Next?

Vervolgens zullen we u laten zien hoe u QGIS kunt gebruiken als startpunt voor het beroemde GRASS GIS.
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CHAPTER 12

Module: GRASS

GRASS (Geographic Resources Analysis Support System) is een bekend open bron GIS met een brede variëteit
aan handige functies voor GIS. Het werd voor het eerst uitgegeven in 1984 en heeft sindsdien veel verbeteringen
ondergaan en aanvullende functionaliteit gekregen. QGIS stelt u in staat direct gebruik te maken van de krachtige
gereedschappen voor GIS in GRASS.

12.1 Lesson: GRASS instellen

GRASS gebruiken in QGIS vereist dat u op een enigszins andere manier naar de interface kijkt. Onthoud dat u
niet direct werkt in QGIS, maar dat u werkt in GRASS via QGIS.

Het doel voor deze les: Een project in GRASS beginnen in QGIS.

12.1.1 Follow Along: Een nieuw project in GRASS beginnen

Net als met elke andere plug-in moet u hem activeren om GRASS te starten vanuit QGIS. Als eerste, open een
nieuw project in QGIS.

• Schakel, in de Plug-in Manager, GRASS in in de lijst:
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De werkbalk voor GRASS zal verschijnen:

Vóórdat u GRASS kunt gebruiken, dient u een mapset te maken. GRASS werkt altijd in een omgeving van een
database, wat betekent dat u alle gegevens die u wilt gebruiken moet importeren in een database van GRASS.

• Klik op de knop Nieuwe mapset:

U zult een dialoogvenster zien dat de structuur van een mapset voor GRASS beschrijft.

• Maak een nieuwe map genaamd grass_db in exercise_data.

• Stel het in als de map die door GRASS zal worden gebruikt om de database ervan in te stellen:
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• Klik op Next.

GRASS moet een “locatie” maken, die het maximale bereik beschrijft van het geografische gebied waarin u zult
werken.

• Noem de nieuwe locatie South_Africa:
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• Klik op Next.

• We zullen werken met WGS 84, dus zoek naar en selecteer dit CRS:
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• Klik op Next.

• Selecteer nu de regio South Africa uit de keuzelijst en klik op Toepassen:
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• Klik op Next.

• Maak een mapset, wat het bestand met kaarten is waarmee u zult werken.
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Als u gereed bent, zult u een dialoogvenster zien dat u vraagt om te bevestigen dat de instellingen die worden
weergegeven juist zijn.

• Klik op Finish.

• Klik op OK in het dialoogvenster.

12.1.2 Follow Along: Vectorgegevens in GRASS laden

U zult nu een blanco kaart hebben. U moet een proces van twee stappen volgen om gegevens in GRASS te laden .

• Laad, zoals gewoonlijk, gegevens in QGIS. Gebruik voor nu de gegevensset roads.shp (te vinden onder
exercise_data/epsg4326/).

• Klik, zodra die is geladen, op de knop GRASS gereedschap openen:
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• Selecteer, in het nieuwe dialoogvenster, Moduleslijst.

• Zoek naar het gereedschap voor het importeren van een vector door de term v.in.ogr.qgis in te voeren
in het veld Filter.

De v staat voor “vector”, in betekent dat het een functie is om gegevens in de database van GRASS te importeren,
ogr is de software-bibliotheek die wordt gebruikt om de vectorgegevens te lezen, en qgis betekent dat het
gereedschap zal zoeken naar een vector tussen de vectoren die al in QGIS zijn geladen.

• Als u dit gereedschap eenmaal hebt gevonden, klik er op om het gereedschap zelf naar voren te halen:

• Stel de geladen laag in als roads en de versienaam voor GRASS als g_roads om verwarring te voorkomen.
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Notitie: Let op de extra opties voor importeren die worden verschaft onder Geavanceerde opties tonen.
Deze omvatten de mogelijkheid om een clausule WHERE toe te voegen aan de SQL-query die wordt gebruikt
voor het importeren van de gegevens.

• Klik op Uitvoeren om het importeren te starten.

• Klik, als het voltooid is, op de knop Uitvoer bekijken om de nieuw geïmporteerde laag voor GRASS in de
kaart te bekijken.

• Sluit eerst het gereedschap voor het importeren (klik op de knop Close direct rechts naast Uitvoer bekijken),
en sluit het venster GRASS-gereedschap.

• Verwijder de originele laag roads.

Nu heeft u alleen nog de geïmporteerde laag van GRASS weergegeven in uw kaart van QGIS.

12.1.3 Follow Along: Rastergegevens in GRASS laden

U weet nog dat onze DEM in het geprojecteerde CRS UTM 33S / WGS 84 staat, maar dat ons project voor
GRASS in het geografische CRS WGS 84 staat. Dus laten we eerst de DEM opnieuw projecteren.
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• Laad de gegevensset srtm_41_19.tif (te vinden onder exercise_data/raster/SRTM/) zoals
gewoonlijk in de kaart van QGIS, met behulp van het gereedschap van QGIS Rasterlaag toevoegen.

• Projecteer die opnieuw met behulp van het gereedschap GDAL Warp (Raster → Projecties → Warp (Her-
projecteren)), stel het in zoals hieronder weergegeven:

• Sla het raster op in dezelfde map als het origineel, maar met de bestandsnaam DEM_WGS84.tif. Als die
eenmaal in uw kaart is verschenen, verwijder dan de gegevensset srtm_41_19.tif uit uw Lagenlijst.
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Nu hij opnieuw geprojecteerd is kunt u hem laden in uw database van GRASS.

• Open opnieuw het dialoogvenster GRASS-gereedschap.

• Klik op de tab Moduleslijst.

• Zoek naar r.in.gdal.qgis en dubbelklik op het gereedschap om het dialoogvenster van het gereed-
schap te openen.

• Stel het zo in dat de invoerlaag DEM_WGS84 is en de uitvoer g_dem is.

• Klik op Uitvoeren.

• Als het proces is voltooid, klik op Uitvoer bekijken.

• Close de huidige tab en Close dan het gehele dialoogvenster.
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• U kunt nu de originele laag DEM_WGS84 verwijderen.

12.1.4 In Conclusion

De werkstroom voor GRASS voor het binnenhalen van gegevens is enigszins anders dan de methode van QGIS
omdat GRASS zijn gegevens in een ruimtelijke databasestructuur laad. Door echter QGIS als startpunt te ge-
bruiken, kunt u het instellen van een mapset voor GRASS eenvoudiger maken door bestaande lagen in QGIS te
gebruiken als gegevensbronnen voor GRASS.

12.1.5 What’s Next?

Nu de gegevens zijn geïmporteerd in GRASS kunen we kijken naar de geavanceerde analysebewerkingen die
GRASS bied.

12.2 Lesson: GRASS-gereedschap

In deze les zullen we een seelctie van gereedschappen presenteren om u een idee van de mogelijkheden van
GRASS te geven.

12.2.1 Follow Along: Rasterkleuren instellen

• Open het dialoogvenster GRASS-gereedschap.

• Zoek naar de module r.colors.table door gebruik te maken van het veld Filter op de tab Moduleslijst.

• Open het gereedschap en stel het als volgt in:
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Wanneer u het gereedschap uitvoert zal het uw raster opnieuw kleuren:
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12.2.2 Follow Along: Gegevens in 3D visualiseren

GRASS stelt u in staat een DEM te gebruiken om uw gegevens te visualiseren in drie dimensies. Het gereedschap
dat u zult gebruiken werkt op de regio voor GRASS, wat op dit moment is ingesteld op het gehele bereik van
Zuid-Afrika, zoals u dat eerder ingesteld heeft.

• Klik op deze knop om het bereik opnieuw te definiëren om alleen uw raster gegevensset te bedekken:

Als dit gereedschap is geactiveerd, zal uw cursor veranderen in een kruis wanneer die boven het kaartvenster van
QGIS is.

• Klik en sleep een rechthoek rondom de randen van het raster van GRASS met behulp van dit gereedschap.

• Klik op OK in het dialoogvenster GRASS regio-instellingen indien gereed.

• Zoek naar het gereedschap nviz:
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• Stel het in zoals hieronder weergegeven:
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• Onthoud om beide knoppen Regio van deze kaart gebruiken aan de rechterzijde van de twee keuzelijsten
voor de selectie van het raster in te schakelen. Dit zal NVIZ in staat stellen de resolutie van de rasters juist
te beoordelen.

• Klik op de knop Uitvoeren.

NVIZ zal een 3D-omgeving instellen met behulp van de geselecteerde raster en vector. Dit kan enige tijd vergen,
afhankelijk van uw hardware. Wanneer het voltooid is zult u de in 3D gerenderde kaart in een nieuwe venster zien:
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Experimenteer met de instellingen height, z-exag, en View method om uw weergave van de gegevens te wijzigen.
De navigatiemethoden moeten misschien even wennen.

Sluit, na het experimenteren, het venster NVIZ.

12.2.3 Follow Along: Het gereedschap Mapcalc

• Open de tab Moduleslijst van het dialoogvenster GRASS-gereedschap en zoek naar calc.

• Selecteer uit de lijst met modules r.mapcalc (niet r.mapcalculator, wat meer basaal is).

• Start het gereedschap.

Het dialoogvenster Mapcalc stelt u in staat een reeks analyses te construeren die moeten worden uitgevoerd op
een raster, of collectie rasters. U zult deze gereedschappen gebruiken om dat te doen:

In volgorde zijn dat:

• Kaart toevoegen: Voegt een rasterbestand uit uw huidige mapset van GRASS toe.

• Constante toevoegen: Een constante waarde toevoegen die moet worden gebruikt in functies.

• Operator of functie toevoegen: Een operator of functie toevoegen die moet worden verbonden
met de invoer en uitvoer.

• Verbinding toevoegen: Verbindt elementen. Klik en sleep, met behulp van dit gereedschap, van de
ene rode punt op het ene item naar de rode punt op een ander item. Punten die juiste zijn verbonden met
een verbindingslijn zullen grijs worden. Als de lijn of punt rood is, is die niet juist verbonden!

• Item selecteren: Selecteert een item en geselecteerde items verplaatsen.
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• Verwijder geselecteerde onderdeel: Verwijdert het geselecteerde item uit het huidige blad
voor mapcalc, maar niet uit de mapset (als het een bestaand raster is).

Met behulp van deze gereedschappen:

• Construeer het volgende algoritme:

• Wanneer u klikt op Uitvoeren, zou uw uitvoer er als volgt uit moeten zien:
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• Klik op Uitvoer bekijken om de uitvoer te zien weergegeven in uw kaart:

Dit geeft alle gebieden weer waar het terrein lager is dan 500 meter of hoger dan 1000 meter.
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12.2.4 In Conclusion

In deze les hebben we slechts een paar van de vele gereedschappen behandeld die GRASS te bieden heeft. Open
het dialoogvenster GRASS-gereedschap en scroll door de Moduleslijst om de mogelijkheden van GRAAS voor
uzelf te verkennen. OF, voor een meer gestructureerde benadering, kijk onder de tab Modulesboom, waar de
gereedschappen op type zijn vermeld.
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Module: Beoordeling

Gebruik uw eigen gegevens voor dit gedeelte. U zult nodig hebben:

• een punt-vectorgegevensset van interessante punten (POIi’s), met namen voor de punten en meerdere cate-
gorieën

• een lijn-vectorgegevensset van wegen

• een polygoon-vectorgegevensset van grondgebruik (met behulp van grenzen voor eigendommen)

• een afbeelding met visueel-spectrum (zoals een luchtfoto)

• een DEM (te downloaden vanaf deze URL als u er zelf geen heeft)

13.1 Een basiskaart maken

Vóórdat u een gegevensanalyse doet, heeft u een basiskaart nodig, die u de resultaten van de analyse met context
verschaft.

13.1.1 De puntlaag toevoegen

• Voeg de puntlaag toe. Gebaseerd op het niveau waarop u de cursus doet, doet u alleen wat vermeld is in het
toepasselijke gedeelte hieronder:

• Label de punten overeenkomstig een uniek attribuut, zoals plaatsnamen. Gebruik een klein lettertype en
houd de labels nauwelijks leesbaar. De informatie zou beschikbaar moeten zijn, maar zou geen hoofdon-
derdeel van de kaart uit moeten maken.

• Classificeer de punten zelf in verschillende kleuren, gebaseerd op een categorie. Categorieën zouden, bi-
jvoorbeeld, kunnen omvatten “toeristische bestemming”, “politiebureau” en “stadscentrum”.

• Doe hetzelfde als in het gedeelte .

• Classificeer de punten op belangrijkheid: hoe meer belangrijk een object is, hoe groter de punt ervan.
Overschrijd echter niet de grootte 2.00 voor de punt.
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• Voor objecten die niet zijn geplaatst op één punt (bijvoorbeeld provinciale/regionale namen, of namen van
steden op een grote schaal), wijst u in het geheel geen punt toe.

• Gebruik helemaal geen puntsymbolen om de laag te symboliseren. Gebruik in plaats daarvan labels die zijn
gecentreerd over de punten; de symbolen punt zelf zouden geen grootte moeten hebben.

• Gebruik Data-bepaalde eigenschappen om de labels op te maken in betekenisvolle categorieën.

• Voeg, indien nodig, toepasselijke kolommen toe aan de attributengegevens. Maak, als u dat doet, geen
fictionele gegevens - maar, gebruik de Veldberekening om de nieuwe kolommen te vullen, gebaseerd op
toepasselijk bestaande waarden in de gegevensset.

13.1.2 Voeg de lijnlaag toe

• Voeg de laag met wegen toe en wijzig dan de symbologie daarvan. De wegen krijgen geen label.

• Wijzig de symbologie van de weg naar een lichte kleur met een brede lijn. Maak het ook iets transparant.

• Maak een symbool met meerdere symboollagen. Het resulterende symbool zou er als een echte weg uit
moeten zien. U kunt hier een eenvoudig symbool voor gebruiken; bijvoorbeeld een zwarte lijn met een
dunne witte lijn die door het midden ervan loopt. Het mag ook meer uitgewerkt zijn, maar de resulterende
kaart zou er niet te druk uit moeten zien.

• Als uw gegevensset een hoge dichtheid aan wegen heeft op de schaal waarop u de kaart wilt weergeven,
zou u twee lagen met wegen moeten hebben: de uitgewerkte met het symbool dat op een weg lijkt en een
eenvoudiger symbool voor kleinere schalen. (Gebruik schaalafhankelijke zichtbaarheid om ze uit te laten
schakelen op de toepasselijke schalen.)

• Alle symbolen zouden meerdere symboollagen moeten hebben. Gebruik symbolen om ze juist te laten
weergeven.

• Doe hetzelfde als in het gedeelte hierboven.

• In aanvulling daarop zouden de wegen moeten worden geclassificeerd. Bij het gebruiken van realistische
wegen-achtige symbolen, zou elk type weg een toepasselijk symbool moeten hebben; een snelweg zou
bijvoorbeeld twee rijstroken in elke richting moeten hebben.

13.1.3 Voeg de polygoonlaag toe

• Voeg de laag voor grondgebruik toe en wijzig de symbologie daarvan.
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• Classificeer de laag overeenkomstig het grondgebruik. Gebruik volle kleuren.

• Classificeer de laag overeenkomstig het grondgebruik. Waar van toepassing, verwerk symboollagen, ver-
schillende typen symbolen, etc. laat echter de resultaten er gematigd en uniform uitzien. Onthoud dat dit
een deel is van de achtergrond!

• Gebruik op regels gebaseerde classificatie om het grondgebruik in algemene categorieën te verdelen, zoals
“stedelijk”, “landelijk”, “natuarreservaat”, etc.

13.1.4 Maak de raster-achtergrond

• Maak een schaduw voor heuvels uit de DEM en gebruik die als een transparant op een geclassificeerde
versie van de DEM zelf. U zou ook de plug-in Reliëf kunnen gebruiken (zoals weergegeven in de les over
plug-ins).

13.1.5 Voltooien van de basiskaart

• Maak met behulp van de genoemde bronnen een basiskaart door enkele of alle lagen te gebruiken. De kaart
dient alle basisinformatie te bevatten die nodig is ter orientatie en dient visueel eenduidig en attractief te
zijn.

13.2 De gegevens analyseren

• U zoekt naar een eigendom dat voldoet aan bepaalde criteria.

• U mag beslissen op basis van uw eigen criteria, die u wel moet documenteren.

• Er zijn enkele richtlijnen voor deze criteria:

– het doel-eigendom zou deel moeten zijn van (een) bepaalde type(n) grondgebruik

– het zou binnen een bepaalde afstand van wegen moeten liggen, of worden gekruist door een weg

– het zou binnen een bepaalde afstand van enige categorie van punten moeten liggen, zoals bijvoorbeeld
een ziekenhuis

13.2.1 /

• Neem rasteranalyse op in uw resultaten. Overweeg ten minste één afgeleide eigenschap van het raster,zoals
het aspect of de helling ervan.
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13.3 Uiteindelijke kaart

• Gebruik de Printvormgeving om een uiteindelijke kaart te maken, waarin uw analyseresultaten zijn verw-
erkt.

• Neem de kaart op in een document en vul aan met extra documentatie. Wanneer de kaart visueel te druk
wordt dan is het mogelijk lagen te deselecteren.

• Uw kaart moet een titel en een legenda bevatten.
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CHAPTER 14

Module: Toepassing Bosbouw

In de modules 1 tot en met 13 heeft u al heel veel geleerd over QGIS en hoe er mee te werken. Als u bent
geïnteresseerd om iets meer te leren over enkele basistoepassingen voor bosbouw van GIS, zal het volgen van deze
module u de mogelijkheid geven toe te passen wat u heeft geleerd en zal u enkele nieuwe handige gereedschappen
tonen.

De ontwikkeling van deze module is gesponsord door de Europese Unie.

14.1 Lesson: Presentatie module Bosbouw

Het volgen van deze module over een toepassing voor bosbouw vereist de kennis die u heeft geleerd in de modules
1 tot en met 11 van deze trainingshandleiding. De oefeningen in de volgende lessen gaan er van uit dat u al in staat
bent veel van de basisbewerkingen in QGIS uit te voeren en alleen gereedschappen die nog niet eerder werden
gebruikt zullen meer in detail worden gepresenteerd.

Niettegenstaande dat volgt de module een basisniveau door de lessen zodat, als u eerdere ervaringen heeft met
QGIS, u de instructies waarschijnlijk zonder problemen kunt volgen.

Merk op dat u een aanvullend pakket met gegevens moet downloaden voor deze module.

14.1.1 Voorbeeldgegevens Bosbouw

Notitie: De voorbeeldgegevens die in deze module worden gebruikt maken deel uit van de gegevensset voor de
Trainingshandleiding en kan hier worden gedownload. Download het zip-bestand en pak de map forestry\ uit
in uw map exercise_data\.

De aan bosbouw gerelateerde voorbeeldgegevens (kaart over bosbouw, gegevens over bosbouw), zijn verschaft
door de EVO-HAMK school voor bosbouw. De gegevenssets zijn aangepast om aan de behoeften voor de lessen
te voldoen.

De algemene voorbeeldgegevens (luchtfoto’s, gegevens van LiDAR, basiskaarten) zijn verkregen van de National
Land Survey of Finland open data service, en aangepast voor de doelen van deze lessen. Toegang tot de down-
loadservice voor het open gegevensbestand kan, in het Engels, hier worden verkregen.
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Waarschuwing: Net als voor de rest van de trainingshandleiding bevat deze module instructies over het to-
evoegen, verwijderen en wijzigen van gegevenssets voor GIS. We hebben voor dit doel trainingssets verschaft.
Zorg er voor dat u altijd goede back-ups heeft vóórdat u de hier beschreven technieken toepast op uw eigen
gegevens!

14.2 Lesson: Geoverwijzingen in een kaart

Een veelvoorkomende taak in de bosbouw zou het bijwerken kunnen zijn van de informatie over een gebied met
bosbouw. Het is mogelijk dat de eerdere informatie voor dat gebied al van jaren geleden is en analoog ( dat is: op
papier) werd verkregen of dat het werd gedigitaliseerd maar dat alles wat u nog heeft de papieren versie van de
gegevens van de inventarisatie is.

Heel waarschijnlijk zou u die informatie in uw GIS willen gebruiken om, bijvoorbeeld, later te vergelijken met
latere inventarisaties. Dit betekent dat u de voor de hand liggende informatie moet digitaliseren met uw software
voor GIS. Maar voordat u kunt beginnen met digitaliseren, is er een belangrijke eerste stap die moet worden
uitgevoerd, scannen en aanbrengen van geoverwijzingen in uw papieren kaart.

Het doel voor deze les: Het gereedschap Georeferencer in QGIS leren gebruiken.

14.2.1 De kaart scannen

De eerste taak die u zult moeten uitvoeren is het scannen van uw kaart. Als uw kaart te groot is, dan kunt u
hem scannen in verschillende delen maar onthoudt dat u de taken voor het voorverwerken en aanbrengen van
geoverwijzingen voor elk deel moet herhalen. Dus, indien mogelijk, scan de kaart in zo min mogelijk delen.

Als u een andere kaart gaat gebruiken dan die welke is verschaft voor deze handleiding, gebruik dan uw eigen
scanner om de kaart als een afbeeldingsbestand te scannen, een resolutie van 300 DPI is voldoende. Als uw kaart
kleuren heeft,m scan hem dan in kleur zodat u later die kleuren kunt gebruiken om informatie uit de kaart te halen
voor verschillende lagen (bijvoorbeeld, bosopstand, contourlijnen, wegen...).

Voor deze oefening zult u een eerder gescande kaart gebruiken, u vindt die als rautjarvi_map.tif in de
gegevensmap exercise_data/forestry

14.2.2 Follow Along: De gescande kaart voorzien van geoverwijzingen

Open QGIS en stel het CRS voor het project in op ETRS89 / ETRS-TM35FIN in Project → Projectinstellingen
→ CRS, wat het huidige gebruikte CRS in Finland is. Zorg er voor dat Gelijktijdige CRS-transformatie gebruiken
is geselecteerd, omdat we met oude gegevens zullen werken die in een ander CRS staan.
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Sla het project van QGIS op als map_digitizing.qgs.

U zult de plug-in voor geoverwijzingen gebruiken vanuit QGIS, de plug-in is al geïnstalleerd in QGIS. Activeer
de plug-in met behulp van de Plug-in Manager zoals u al in eerdere modules heeft gedaan. De plug-in is genaamd
Georeferencer GDAL.

Geoverwijzingen aanbrengen in de kaart:

• Open het gereedschap Georeferencer, Raster → Georeferencer → Georeferencer.

• Voeg het afbeeldingsbestand van de kaart, :kdb:‘rautjarvi_map.tif‘, in als de afbeelding die moet worden
voorzien van geoverwijzingen, Bestand → Raster openen.

• Indien daarnaar gevraagd, zoek en selecteer het CRS KKJ / Finland zone 2, dat is het CRS dat werd
gebruikt in Finland in 1994 toen deze kaart werd gemaakt.

• Klik op OK.

Vervolgens zou u de instellingen voor de transformatie moeten definiëren voor het aanbrengen van geoverwijzin-
gen in de kaart:

• Open Extra → Transformatie instellingen.

• Klik op het pictogram naast het vak Uitvoer rasterbestand, ga naar de map en maak de map
exercise_data\forestry\digitizing en noem het bestand rautjarvi_georef.tif.

• Stel de rest van de parameters in zoals hieronder weergegeven.
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• Klik op OK.

De kaart bevat verschillende kruisdraden die de coördinaten op de kaart markeren, we zullen die gebruiken om
geoverwijzingen aan te brengen in deze afbeelding. U kunt, zoals u gewoonlijk ook doet in QGIS, de gereed-
schappen zoomen en pannen gebruiken om de afbeelding in het venster van Georeferencer te inspecteren.

• Zoom in op de linker benedenhoek van de kaart en merk op dat daar een kruisdraad staat met een paar
coördinaten, x en y, die, zoals eerder is vermeld, staan in CRS KKJ / Finland zone 2. U zult dit
punt gebruiken als het eerste grondcontrolepunt voor het aanbrengen van de geoverwijzingen in uw kaart.

• Selecteer het gereedschap Punt toevoegen en klik op de kruising van de kruisdraad (pan en zoom zoals nodig
is).

• Vermeld, in het dialoogvenster Voer kaartcoördinaten in, de coördinaten die in de kaart verschijnen (X:
2557000 en Y: 6786000).

• Klik op OK.

Het eerste coördinaat voor het aanbrengen van geoverwijzingen is nu klaar.
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Zoek naar andere kruisdraden in de afbeelding met zwarte lijnen, zij liggen op 1000 meter van elkaar, zowel in
noordelijke als in oostelijke richting. U zou in staat moeten zijn de coördinaten van deze punten te berekenen in
relatie tot het eerste.

Zoom uit van de afbeelding en ga naar rechts totdat u een andere kruisdraad vindt en schat hoeveel kilometers
u bent verplaatst. Probeer grondcontrolepunten te vinden die zo ver mogelijk van andere liggen als mogelijk.
Digitaliseer ten minste nog drie grondcontrolepunten op dezelfde manier als u dat deed met het eerste. U zou
moeten eindigen met iets dat lijkt op dit:

Met al drie gedigitaliseerde grondcontrolepunten zult u in staat zijn om de afwijking voor de geoverwijzing als
een rode lijn vanuit de punten te zien. De afwijking in pixels kan ook worden bekeken in de GCP tabel in de
kolommen dX[pixels] en dY[pixels]. De afwijking in pixels zou niet hoger moeten zijn dan 10 pixels, als dat wel
zo is zou u de punten die u heeft gedigitaliseerd en de coördinaten die u heeft ingevoerd opnieuw moeten bekijken
om te zien wat het probleem is. U kunt de afbeelding hierboven gebruiken als richtlijn.

Als uw grondcontrolepunten eenmaal naar wens zijn, sla uw grondcontrolepunten dan op voor het geval u ze later
nog eens wilt gebruiken, en u zult dat willen:
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• Bestand → GCP -punten opslaan als....

• In de map exercise_data\forestry\digitizing, noem het bestand file
:kdb:‘rautjarvi_map.tif.points‘.

Tenslotte, aanbrengen van geoverwijzingen op uw kaart:

• Bestand → Georeferencer starten.

• Onthoud dat u het bestand al rautjarvi_georef.tif heeft genoemd toen u de instellingen voor de
Georeferencer bewerkte.

Nu kunt u de kaart in het project van QGIS zien als een raster met geoverwijzingen. Merk op dat het raster licht
geroteerd lijkt te zijn, maar dat komt doordat de gegevens in KKJ / Finland zone 2 staan en uw project in
ETRS89 / ETRS-TM35FIN.

U kunt de luchtfoto in de map exercise_data\forestry, genaamd rautjarvi_aerial.tif openen
om te controleren of uw gegevens op de juiste manier zijn voorzien van geoverwijzingen. Uw kaart en deze
afbeelding zouden redelijk goed overeen moeten komen. Stel de transparantie voor de kaart in op 50% en vergelijk
die met de luchtfoto.
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Sla de wijzigingen in uw project van QGIS op, u zult vanaf dit punt doorgaan naar de volgende les.

14.2.3 In Conclusion

Zoals u heeft gezien is het aanbrengen van geoverwijzingen vanaf een papieren kaart een relatief rechtstreekse
bewerking.

14.2.4 What’s Next?

In de volgende les zult u de bosopstanden in uw kaart digitaliseren als polygonen en de gegevens van de inven-
tarisatie eraan toevoegen
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14.3 Lesson: Bosopstanden digitaliseren

Tenzij u uw kaart met geoverwijzingen gaat gebruiken als een eenvoudige afbeelding voor de achtergrond, is de
volgende logische stap om de elementen erin te digitaliseren. U heeft dat al gedaan in de oefeningen over het
maken van vectorgegevens in Lesson: Een nieuwe vector gegevensset maken , toen u de velden van de school
digitaliseerde. In deze les gaat u de grenzen van de bosopstanden digitaliseren die als groene lijnen op de kaart
staan, maar in plaats van het te doen met behulp van een luchtfoto, zult u uw kaart met geoverwijzingen gebruiken.

Het doel voor deze les: Een techniek leren om te helpen bij de taak van het digitaliseren, bosopstanden digitalis-
eren en tenslotte de gegevens van de inventarisatie er aan toevoegen.

14.3.1 Follow Along: De grenzen van de bosopstanden uitnemen

Open uw project map_digitizing.qgs, dat u in de vorige les heeft opgeslagen, in QGIS.

Als u eenmaal uw kaart heeft gescand en voorzien van geoverwijzingen zou u direct kunnen beginnen met digi-
taliseren door naar de kaart te kijken als een hulpmiddel. Dat zou, zeer waarschijnlijk, de manier om te doen als
de afbeelding van waaruit u gaat digitaliseren, bijvoorbeeld, een luchtfoto is.

Als wat u gaat gebruiken voor het digitaliseren een goed kaart is, zoals in ons geval, is het aannemelijk dat de
informatie duidelijk wordt weergegeven als lijnen met verschillende kleuren voor elk type element. Deze kleuren
kunnen relatief eenvoudig worden uitgenomen als individuele afbeeldingen met behulp van een software voor het
bewerken van afbeeldingen, zoals GIMP. Dergelijke afzonderlijke afbeeldingen kunnen worden gebruikt om te
assisteren bij het digitaliseren, zoals u hieronder zult zien.

De eerste stap zal zijn om GIMP te gebruiken om een afbeelding te verkrijgen die alleen de bosopstanden bevat,
dat is, alle groene lijnen die u zou kunnen zien in de originele gescande kaart:

• Open GIMP (als u het nog niet geïnstalleerd heeft„ download het vanaf het internet of vraag uw leraar).

• Open de originele kaartafbeelding, Bestand → Openen, rautjarvi_map.tif in de map
exercise_data/forestry folder. Onthoud dat de bosopstanden als groene lijnen worden
weergegeven (met het nummer van de bosopstand ook in groen binnen elke polygoon).
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Nu kunt u de pixels in de afbeelding selecteren die de grenzen van de bosopstanden vormen (de groenachtige
pixels):

• Open het gereedschap Selecteren → Op kleur.

• Zoom, met het gereedschap actief, in op de afbeelding (Ctrl + muiswiel) zodat een lijn van een bosopstand
dichtbij genoeg is om de pixels die de lijn vormen te onderscheiden. Zie de linker afbeelding hieronder.

• Klik en sleep de muiscursor in het midden van de lijn zodat het gereedschap verscheidene kleurwaarden van
de pixels zal verzamelen.

• Laat de muisknop los en wacht enkele seconden. De pixels die overeenkomen met de kleuren die zijn
verzameld door het gereedschap zullen vanuit de gehele afbeelding worden geselecteerd.

• Zoom uit om te zien hoe de groenachtige pixels zijn geselecteerd in de gehele afbeelding.

• Als u niet tevreden bent met het resultaat, herhaal dan de bewerking klikken en slepen.

• Uw selectie van pixels zou er ongeveer uit moeten zien als op de rechter afbeelding hieronder.
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Als u eenmaal klaar bent met het selecteren moet u deze selectie als een nieuwe laag kopiëren en die dan opslaan
als een afzonderlijk afbeeldingsbestand:

• Kopieer (Ctr+C) de geselecteerde pixels.

• En plak de pixels direct (Ctr+V), GIMP zal de geplakte pixels weergeven als een nieuwe tijdelijke laag in
het paneel Lagen - Penselen als een Zwevende Selectie (Geplakte laag).

• Klik met rechts op die tijdelijke laag en selecteer Naar nieuwe laag.

• Klik op het pictogram “oog” naast de originele afbeeldingslaag om die uit te schakelen, zodat alleen de
Geplakte laag zichtbaar is:
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• Selecteer tenslotte Bestand → Exporteren als..., stel Selecteer bestandstype (Volgens extensie) in als een
TIFF-afbeelding, selecteer de map digitizing en noem het rautjarvi_map_green.tif. Se-
lecteer Geen compressie indien daarnaar gevraagd wordt.

U zou hetzelfde proces kunnen uitvoeren met andere elementen in de afbeelding, bijvoorbeeld de zwarte lijnen
uitnemen die wegen weergeven of de bruine die de contourlijnen van het terrein weergeven. Maar voor ons zijn
de bosopstanden voldoende.

14.3.2 Try Yourself De afbeelding met groene pixels voorzien van geover-
wijzingen

Zoals u al in de vorige les deed dient u deze nieuwe afbeelding te voorzien van geoverwijzingen om in staat te zijn
om hem te kunnen gebruiken met de rest van uw gegevens.

Onthoud dat u de grondcontrolepunten niet meer hoeft te digitaliseren omdat deze afbeelding nagenoeg hetzelfde
is als de originele afbeelding, voor zover het het gereedschap Georeferencer betreft. Hier zijn enkele dingen die u
zou moeten onthouden:

• Deze afbeelding is, natuurlijk, ook in het CRS KKJ / Finland zone 2 CRS.

• U zou de grondcontrolepunten moeten gebruiken die u heeft opgeslagen, bestand → GCP-ounten laden.

• Onthoud om de Transformatie instellingen opnieuw te bekijken.

• Noem het uitvoerraster rautjarvi_green_georef.tif in de map digitizing.

Controleer of het nieuwe raster netjes past op de originele kaart.

14.3.3 Follow Along: Ondersteunende punten voor digitaliseren maken

Met de gereedschappen voor digitaliseren in QGIS in gedachten, zou u misschien al kunnen denken dat het handig
zou zijn aan die groene pixels te ‘snappen’ tijdens het digitaliseren. Dat is precies wat u als volgende gaat doen,
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punten maken uit die pixels om ze later te kunnen gebruiken om de grenzen van de bosopstanden te volgen tijdens
het digitaliseren, met behulp van de beschikbare gereedschappen voor snappen in QGIS.

• Gebruik het gereedschap Raster → Conversie → Vectoriseren (Raster naar vector) om uw groene lijnen naar
polygonen te vectoriseren. Als u niet meer weet hoe, kunt u het nog eens bekijken in Lesson: Conversie van
raster naar vector.

• Sla op als rautjarvi_green_polygon.shp in de map digitizing.

Zoom in en zie hoe de polygonen eruit zien. U zult iets hebben zoals dit:

De volgende optie is om punten van deze polygonen te maken om hun zwaartepunten te vinden:

• Open Vector → Geometrie-gereedschap → Zwaartepunten polygonen.

• Stel de polygoonlaag die u zojuist had in als het invoerbestand voor het gereedschap.

• Noem het uitvoerbestand green_centroids.shp in de map digitizing.

• Selecteer Resultaat aan kaartvenster toevoegen.

• Voer het gereedschap uit om de zwaartepunten voor de polygonen te berekenen.
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Nu kunt u de laag rautjarvi_green_polygon uit de lagenlijst verwijderen.

Wijzig de symbologie van de laag met zwaartepunten naar:

• Open de Laag-eigenschappen voor green_centroids.

• Ga naar de tab Stijl.

• Stel de Eenheid in op Kaarteenheid.

• Stel de Grootte in op 1.

Het is niet nodig om de verschillende punten van elkaar te differentiëren, u heeft ze daar alleen maar nodig om
ze te laten gebruiken door de gereedschappen voor ‘snappen”. U kunt deze punten nu gebruiken om de originele
lijnen veel makkelijker te volgen dan zonder ze.

14.3.4 Follow Along: De bosopstanden digitaliseren

Nu bent u klaar om met het eigenlijke werk van digitaliseren te beginnen. U zou moeten beginnen met het maken
van een vectorbestand van het :guilabel:‘ type polygoon‘, maar, voor deze oefening, is er een shapefile met daarin
een gedeelte van het interessegebied dat al is gedigitaliseerd. U zult het digitaliseren voltooien voor de heflt van
de bosopstanden die zijn overgelaten tussen de belangrijke wegen (brede roze lijnen) en het meer:

14.3. Lesson: Bosopstanden digitaliseren 323



QGIS Training Manual, Release 2.14

• Ga naar de map digitizing met behulp van uw browser voor bestandsbeheer.

• Sleep en laat het vectorbestand forest_stands.shp op uw kaart vallen.

Wijzig de symbologie van de nieuwe laag zodat het gemakkelijker te zien is welke polygonen reeds gedigitaliseerd
zijn:

• De vulling van de polygoon naar groen.

• De randen van de polygonen naar 1 mm.

• en stel de transparantie in op 50%.

Nu, als u de voorgaande modules heeft onthouden, moeten we de opties voor “snappen” instellen en activeren:
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• Ga naar Extra → ‘Snapping’-opties....

• Activeer het snappen voor de lagen green_centroids en forest_stands.

• Stel hun Tolerantie in op 5 kaarteenheden.

• Selecteer het vak Kruisingen vermijden voor de laag forest_stands.

• Selecteer ‘Topologie bewerken’ aanzetten.

• Klik op Apply.

Met deze instellingen voor snappen, altijd wanneer u aan het digitaliseren bent en dicht genoeg bij een van de
punten in de laag met zwaartepunten of een punt van uw gedigitaliseerde polygonen komt, zal een roze kruis
verschijnen op het punt waaraan zal worden gesnapd.

Schakel tenslotte de zichtbaarheid van alle lagen, met uitzondering van forest_stands en
rautjarvi_georef uit. Zorg er voor dat de kaartafbeelding geen transparantie meer heeft.

Een paar belangrijke dingen om te onthouden vóórdat u begint met digitaliseren:

• Probeer niet te nauwkeurig te zijn bij het digitaliseren van de randen.

• Als een rand een rechte lijn is, digitaliseer die dan met slechts twee knopen. In het algemeen: gebruik bij
het digitaliseren zo min mogelijk knopen.

• Zoom alleen in om gebieden te sluiten als u denkt dat u nauwkeurig moet zijn, bijvoorbeeld, op sommige
hoeken of wanneer u een polygoon wilt verbinden met een andere polygoon op ene bepaalde knoop.

• Gebruik de middelste knop van de muis om in of uit te zoomen en te pannen als u digitaliseert.

• Digitaliseer slechts één polygoon per keer.

• Na het digitaliseren van een polygoon, schrijf dan het ID van de bosopstand dat u kunt zien in de kaart.

Nu kunt u beginnen met digitaliseren:

• Lokaliseer de bosopstand 357 in het kaartvenster.

• Schakel Bewerken aan-/uitzetten in voor de laag forest_stands.shp.

• Selecteer het gereedschap Object toevoegen.

• Start het digitaliseren van bosoptand 357 door enkele van de punten te verbinden.

• Merk de roze kruisen op die het snappen aangeven.
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• Wanneer u gereed bent, klik dan met rechts om het digitaliseren voor dat polygoon te beëindigen.

• Voer de ID voor de bosopstand in (in dit geval 357).

• Klik op OK.

Als u niet werd gevraagd naar het id voor de polygoon toen u het digitaliseren voltooide, ga naar Extra →
Opties → Digitaliseren en zorg er voor dat Voorkom tonen van attributenformulier na intekenen object niet is
geselecteerd.

Uw gedigitaliseerde polygoon zal er ongeveer zo uitzien:
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Voor de tweede polygoon gebruiken we bosopstand 358. Zorg er voor dat Kruisingen vermijden. is geselecteerd
voor de laag forest_stands. Deze optie staat geen kruisende polygonen toe bij het digitaliseren, dus als
u digitaliseert over een bestaande polygoon, zal de nieuwe polygoon worden afgebroken op de rand van de al
bestaande polygonen. U kunt deze karakteristiek gebruiken om automatisch een gezamenlijke rand te krijgen.

• Begin het digitaliseren van bosopstand 358 op één van de gemeenschappelijke knopen met de bosopstand
357.

• Ga dan normaal door totdat u bij de volgende gemeenschappelijke knoop voor beide bosopstanden komt.

• Digitaliseer tenslotte een aantal punten binnen polygoon 357 er zorg voor dragend dat de gemeenschappelijk
rand niet wordt gekruist. Zie de linker afbeelding hieronder.

• Klik met rechts om het bewerken van bosopstand 358 te voltooien.

• Voer als id in 358.

• Klik op OK, uw nieuwe polygoon zou nu een gemeenschappelijk rand moeten weergeven met de bosopstand
357, zoals u kunt zien in de afbeelding rechts.
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Het gedeelte van de polygoon dat de bestaande polygoon overlapte is automatisch afgebroken en u blijft achter
met een gemeenschappelijk rand, wat uw bedoeling was.

14.3.5 Try Yourself Digitaliseren van de bosopstanden voltooien

Nu heeft u twee bosopstanden voltooid. En een goed idee over hoe u verder moet gaan. Ga in uw eigen tempo
door met digitaliseren totdat u alle bosopstanden, die worden begrensd door de hoofdweg en het meer, heeft
gedigitaliseerd.

Het lijkt heel veel werk te zijn, maar u zult er snel aan gewend raken om de bosopstanden te digitaliseren. Het zou
u ongeveer 15 minuten moeten kosten.

Gedurende het digitaliseren moet u misschien knopen bewerken of verwijderen, polygonen splitsen of samenvoe-
gen. U heeft over de benodigde gereedschappen geleerd in Lesson: Topologie voor objecten, nu is het waarschi-
jnlijk een goed moment om het nog eens na te lezen.

Onthoud dat met Topologie bewerken activeren geactiveerd, u in staat bent knopen te verplaatsen die gemeen-
schappelijk zijn voor twee polygonen zodat de gezamenlijke rand tegelijkertijd wordt bewerkt voor beide polygo-
nen.

Uw resultaat zal er uitzien zoals dit:
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14.3.6 Follow Along: De gegevens voor de bosopstanden samenvoegen

Het is mogelijk dat de gegevens van de inventarisatie van het bos die u voor uw kaart heeft ook op papier zijn
geschreven. In dat geval zou u eerst de gegevens naar een tekstbestand of werkblad moeten wegschrijven. Voor
deze oefening is de informatie van de inventarisatie voor 1994 (dezelfde inventarisatie als de kaart) al aanwezig
als een komma-gescheiden tekstbestand (csv).

Open het bestand rautjarvi_1994.csv uit de map exercise_data\forestry in een tekstbewerker
en merk op dat het gegevensbestand van de inventarisatie een attribuut heeft, genaamd ID dat de nummers
van de bosopstanden bevat. Deze nummers zijn hetzelfde als de ID’s voor de bosopstanden die u voor
uw polygonen heeft ingevoerd en kunnen worden gebruikt om de gegevens uit het tekstbestand te koppelen
aan uw vectorbestand. U kunt de metadata voor deze gegevens van inventarisatie bekijken in het bestand
rautjarvi_1994_legend.txt in dezelfde map.

• Open de .csv in QGIS met het gereedschap Kaartlagen → Tekstgescheiden kaartlaag toevoegen.... Stel
het dialoogvenster als volgt in:
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De gegevens uit het .csv-bestand toevoegen:

• Open de Laag-eigenschappen voor de laag forest_stands.

• Ga naar de tab Koppelingen.

• Klik op het plusteken onder in het vak van het dialoogvenster.

• Selecteer rautjarvi_1994.csv als de Koppelingslaag en ID als het veld Koppelveld.

• Zorg er voor dat ook het veld Doelveld is ingesteld op id.

• Klik tweemaal op OK.

De gegevens uit het tekstbestand zouden nu moeten zijn gekoppeld aan uw vectorbestand. Open de attributentabel
voor de laag forest_stands om te zien wat er is gebeurd. U kunt zien dat alle attributen van het gegevensbe-
stand voor de inventarisatie nu zijn gekoppeld aan uw gedigitaliseerde vectorlaag.

14.3.7 Try Yourself Namen voor attributen hernoemen en gebied en begren-
zing toevoegen

De gegevens uit het .csv-bestand zijn slechts gekoppeld aan uw vectorbestand. U moet de laag
forest_stands als een nieuw vectorbestand opslaan om deze koppeling permanent te maken, zodat de
gegevens feitelijk worden opgenomen in het vectorbestand. Sluit de attributentabel en klik met rechts op de
laag forest_stands om die op te slaan als forest_stands_1994.shp.

Open uw nieuwe forest_stands_1994.shp in uw kaart als u die al nog niet heeft toegevoegd. Open dan
de attributentabel. U zult zien dat de namen van de kolommen die u zojuist heeft toegevoegd niet erg bruikbaar
zijn. Om dit op te lossen:
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• Voeg de plug-in Table Manager toe zoals u eerder ook met andere plug-ins heeft gedaan.

• Zorg ervoor dat de plug-in is geactiveerd.

• Selecteer, in de inhoudsopgave, de laag forest_stands_1994.shp.

• Ga dan naar Vector → Table Manager → Table manager.

• Gebruik het vak van het dialoogvenster om de namen van de kolommen te bewerken om overeen te komen
met die in het .csv-bestand.

• Klik op Save.

• Selecteer Yes om de stijl van de laag te behouden.

• Sluit het dialoogvenster van de Table Manager.

U wilt misschien het gebied en de begrenzingen van de bosopstanden berekenen om het verzamelen van de infor-
matie gerelateerd aan deze bosopstanden. U heeft gebieden voor polygonen al berekend in Lesson: Extra oefening.
Ga terug naar die les als dat nodig is en bereken de gebieden voor de bosopstanden, noem het nieuwe attribuut
Area en zorg er voor dat de waarden worden berekend in hectares.

Nu is uw laag forest_stands_1994.shp gereed en verpakt met alle beschikbare informatie.

Sla uw project op om de huidige presentatie van de kaart te behouden voor het geval u daar later terug moet komen.
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14.3.8 In Conclusion

Het heeft een aantal muisklikken gekost maar u heeft nu uw oude gegevens van de inventarisatie in digitale indeling
en gereed voor gebruik in QGIS.

14.3.9 What’s Next?

U zou nu kunnen beginnen met het uitvoeren van verschillende analyses met uw brandnieuwe gegevensset, maar
u bent misschien meer geïnteresseerd in het uitvoeren van analyses op een meer up to date gegevensset. Het
onderwerp van de volgende les zal het maken van bosopstanden zijn, met behulp van recente luchtfoto’s en het
toevoegen van enige relevante informatie aan uw gegevensset.

14.4 Lesson: Bijwerken van de bosopstanden

Nu u de informatie uit de oude inventariskaarten heeft gedigitaliseerd en de overeenkomende informatie aan de
bosopstanden heeft toegevoegd, zou de volgende stap de inventaris van de huidige status van het bos te maken.

U zult nieuwe bosopstanden vanaf nul digitaliseren door middel van een luchtfoto van dat bosgebied. De kaart van
het bos die u in de vorige les digitaliseerde werd gemaakt vanuit een infrarood gekleurde luchtfoto (CIR). Dit type
afbeeldingen, waarbij het infrarode licht wordt opgenomen in plaats van het blauwe licht, worden breed gebruikt
om begroeide gebieden te bestuderen. U zult in deze les ook een CIR-afbeelding gebruiken.

Na het digitaliseren van de bosopstanden, zult u informatie toevoegen, zoals nieuwe beperkingen, opgelegd door
regelgeving met betrekking tot het behouden ervan.

Het doel voor deze les: Een nieuwe set bosopstanden digitaliseren vanuit CIR-luchtfoto’s en informatie toevoegen
vanuit andere gegevenssets.

14.4.1 Oude bosopstanden met huidige luchtfoto’s vergelijken

De National Land Survey van Finland heeft een beleid voor open gegevens die u in staat stellen een groot scala
aan geografische gegevens, zoals luchtfoto’s, traditionele topografische kaarten, DEM, LiDAR-gegevens, etc,
te downloaden. Toegang tot de service kan ook hier in het Engels worden verkregen. De in deze oefening
gebruikte luchtfoto is gemaakt uit twee orthogerectificeerde CIR-afbeeldingen, gedownload vanaf die service
(M4134F_21062012 en M4143E_21062012).

• Open QGIS en stel het CRS van het project in op ETRS89 / ETRS-TM35FIN in Project → Projectin-
stellingen → CRS.

• Zorg er voor dat Gelijktijdige CRS-transformatie gebruken is geselecteerd.

• Voeg, vanuit de map exercise_data\forestry\, de CIR-afbeelding rautjarvi_aerial.tif
toe dat de gedigitaliseerde meren bevat.

• Sla dan het project van QGIS op als digitizing_2012.qgs.

De CIR-afbeeldingen zijn van 2012. U kunt de bosopstanden die werden gemaakt in 1994 vergelijken met de
situatie bijna 20 jaar later.

• Voeg uw laag forest_stands_1994.shp toe.

• Stel de opmaak zo in dat u door uw polygonen heen kunt kijken.

• Bekijk hoe de oude bosopstanden volgen (of niet) wat u visueel als een homogeen bos zou interpreteren.

Zoom en pan over het gebied. U zult waarschijnlijk opmerken dat sommige van de oude bosopstanden nog steeds
zullen corresponderen met de afbeeldingen maar dat andere dat niet doen.

Dit is een normale situatie, omdat 20 jaar is verstreken en verschillende bewerkingen in de bossen zijn uitgevoerd
(oogsten, uitdunnen...). Het is ook mogelijk dat de bosopstanden er in 1992 homogeen uitzagen voor de persoon
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die ze digitaliseerde maar dat sommige bossen zich, bij het verstrijken van de tijd, op verschillende manieren
hebben ontwikkeld. Of de prioriteiten voor het inventariseren van de bossen waren eenvoudigweg anders dan dat
zij vandaag de dag zijn.

Vervolgens zult u nieuwe bosopstanden maken voor deze afbeelding, zonder de oude te gebruiken. Later kunt u
ze vergelijken om de verschillen te bekijken.

14.4.2 De CIR-afbeelding interpreteren

Laten we hetzelfde gebied digitaliseren als dat wat werd bedekt door de oude inventarisatie, begrensd door de
wegen en het meer. U hoeft niet het gehele gebied te digitaliseren, net zoals in de vorige oefening kunt u beginnen
met een vectorbestand dat al de meeste bosopstanden bevat.

• Verwijder de laag forest_stands_1994.shp.

• Voeg de laag forest_stands_2012.shp toe, die zich bevind in de map
exercise_data\forestry\.

• Stel de opmaak van deze laag zo in dat de polygonen geen vulling hebben en de randen zichtbaar zijn.
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U kunt zien dat een regio in het noordelijke gedeelte van het gebied van de inventarisatie nog ontbreekt. Dat zal
uw taak zijn, het digitaliseren van de ontbrekende bosopstanden.

Maar, voordat u begint, besteed enige tijd aan het bekijken van de reeds gedigitaliseerde bosopstanden en de
overeenkomende bossen in de afbeelding. Probeer een idee te vormen over hoe de grenzen van de bosopstanden
worden bepaald, het helpt als u enige kennis over bosbouw heeft.

Enkele ideeën over wat u uit de afbeeldingen zou kunnen identificeren:

• Welke bossen zijn loofbomen (in Finland meestal berkenbossen) en welke zijn coniferen (in deze regio
den of spar). In CIR-afbeeldingen zullen loofbomen veelal een heldere rode kleur hebben, waar coniferen
donkergroene kleuren geven.

• Als de leeftijd van een bosopstand wijzigt, door te kijken naar de grootte van de boomkruinen die kunnen
worden geïdentificeerd in de afbeelding.

• De dichtheid van de verschillende bosopstanden, een bosopstand waar recent werd uitgedund bijvoorbeeld
zal duidelijk ruimte weergeven tussen de boomkruinen en zou eenvoudig te herkennen moeten zijn van de

334 Chapter 14. Module: Toepassing Bosbouw



QGIS Training Manual, Release 2.14

andere bosopstanden er omheen.

• Blauwachtige gebieden geven onvruchtbaar terrein, wegen en stedelijke gebieden , gewassen die nog niet
zijn gaan groeien etc. aan.

• Gebruik geen zoom die te dicht op de afbeelding komt bij het proberen te identificeren van bosopstanden.
Een schaal tussen 1 : 3.000 en 1 : 5.000 zou voor deze afbeeldingen voldoende moeten zijn. Zie de
afbeelding hieronder (schaal 1 : 4.000):

14.4.3 Try Yourself Bosopstanden vanuit CIR-afbeeldingen digitaliseren

Bij het digitaliseren van bosopstanden zou u moeten proberen bosgebieden te krijgen die zo homogeen mogelijk
zijn in termen van boomsoorten, leeftijd van het bos, dichtheid van de bosopstand... Wees echter niet te gede-
tailleerd, of u eindigt met het maken van honderden kleine bosopstanden die in het geheel niet bruikbaar zijn.
U zou moeten proberen opstanden te krijgen die betekenisvol zijn in de context van bosbouw, niet te klein (ten
minste 0,5 ha) maar ook niet te groot (niet meer dan 3 ha).

Met deze indicaties in gedachten kunt u nu de ontbrekende bosopstanden digitaliseren.

• Schakel Bewerken aan/uitzetten in voor forest_stands_2012.shp.

• Stel de opties voor snappen en topologie in zoals in de afbeelding.

• Vergeet niet op Apply of OK te klikken.
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Begin met het digitaliseren zoals u dat deed in de vorige les, met als enige verschil dat u nu geen puntlaag heeft
waaraan u kunt snappen. Voor dit gebied zou u ongeveer 14 nieuwe bosopstanden moeten krijgen. Vul het veld
Stand_id met nummers, beginnend met 901, tijdens het digitaliseren.

Wanneer u gered bent zou uw laag er ongeveer als volgt uit moeten zien:

Nu heeft u een nieuwe set polygonen die de verschillende bosopstanden definiëren voor de huidige situatie zoals
die kan worden geïnterpreteerd vanuit de CIR-afbeeldingen. Maar u mist duidelijk nog de gegevens van de inven-
tarisatie van de bossen, toch? Daarvoor dient u nog steeds naar het bos te gaan en monstergegevens te verzamelen
die u zult gebruiken om de attributen voor de bossen in te schatten voor elk van de bosopstanden. U zult in de
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volgende les zien hoe u dat doet.

Op dit moment kunt u nog steeds uw vectorlaag verbeteren met enige extra informatie die u heeft over regelgeving
voor natuurbehoud waarmee in dit gebied rekening zou moeten worden gehouden.

14.4.4 Follow Along: Bosopstanden bijwerken met informatie over natu-
urbehoud

Voor het gebied waarmee u werkt is onderzocht dat met de volgende regels met betrekking tot natuurbehoud
rekening moet worden gehouden bij het maken van de planning voor de bossen:

• Twee locaties van een beschermde soort gewone vliegende eekhoorn (Pteromys volans) zijn geïdentificeerd.
Overeenkomstig de regelgeving dient een gebied van 15 meters rondom die plaatsen onaangetast te blijven.

• Een aan de oever gelegen bos met speciale betekenis langs een stroom in het gebied moet worden beschermd.
Tijdens veldonderzoek is vastgesteld dat 20 meter aan beide zijden van de stroom beschermd moet worden.

U heeft een vectorbestand dat de informatie bevat over de locaties van de eekhoorns en een ander dat de
gedigitaliseerde stroom bevat die in het noordelijke gedeelte naar het meer stroomt. Voeg, vanuit de map
exercise_data\forestry\ , de vectorbestanden squirrel.shp en stream.shp toe.

Voor het beschermen van de locaties van de eekhoorns gaat u een nieuw attribuut (kolom) toevoegen aan uw
nieuwe bosopstanden, die informatie zal bevatten over de puntlocaties die moeten worden beschermd. Die infor-
matie zal later beschikbaar zijn wanneer er een bewerking in het bos moet worden gepland, en het team in het
veld, vóór het werk begint, in staat stellen het gebied te markeren dat onaangetast moet blijven.

• Open de attributentabel voor de laag squirrel.

• U kunt zien dat er twee locaties zijn gedefinieerd voor de gewone vliegende eekhoorn, en dat het gebied dat
moet worden beschermd is aangegeven door een afstand van 15 meter vanaf die locaties.

Voor het samenvoegen van de informatie over de eekhoorns met die van de bosopstanden kunt u Attributen op
basis van plaats bijeenbrengen gebruiken:

• Open Vector → Datamanagement-gereedschap → Attributen op basis van plaats bijeenbrengen.

• Stel de laag forest_stands_2012.shp in als de Doel vectorlaag.

• Selecteer als Join vectorlaag de puntenlaag squirrel.shp.

• Noem het uitvoerbestand stands_squirrel.shp.

• Selecteer, in Uitvoer tabel, Alle rijen behouden (ook de niet-passende doelrijen). Zodat u alle bosopstanden
in de laag behoudt in plaats van alleen die te behouden die ruimtelijk zijn gerelateerd aan de locaties van de
eekhoorns.

• Klik op OK.

• Selecteer Yes als gevraagd wordt om de laag toe te voegen aan de inhoudsopgave.

• Sluit het dialoogvenster.
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Nu heeft u een nieuwe laag met bosopstanden, stands_squirrel met nieuwe attributen die overeenkomen
met de informatie voor natuurbehoud die is gerelateerd aan de gewone vliegende eekhoorn.

Open de tabel van de nieuwe laag en maak de volgorde dusdanig dat de bosopstanden met informatie over het
attribuut Protection bovenaan staan. U zou nu twee bosopstanden moeten hebben waar de eekhoorn zich bevindt:
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Hoewel deze informatie genoeg kan zijn, keek eens naar welke gebieden, gerelateerd aan de eekhoorns, beschermd
zou moeten zijn. U weet dat u een buffer van 15 meter rondom de locaties van de eekhoorns moet hebben:

• Open Vector → Geoprocessing-gereedschap → Buffer.

• Maak een buffer van 15 meter voor de laag squirrel.

• Noem het resultaat squirrel_15m.shp.
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U zult opmerken dat als u inzoomt op de locatie in het noordelijke gedeelte van het gebied, de gebied van de buffer
zich ook uitstrekt tot in de aanliggende bosopstand. Dit betekent dat wanneer er een bewerking van het bos plaats
zou vinden in die bosopstand, ook rekening gehouden zou moeten worden met de beschermde locatie.
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Vanuit uw eerdere analyse werd die bosopstand niet verkregen om informatie te registreren over de beschermde
status. Dit probleem oplossen:

• Voer het gereedschap Attributen op basis van plaats bijeenbrengen opnieuw uit.

• Maar gebruik deze keer de laag squirrel_15m als join vectorlaag.

• Noem het uivoerbestand stands_squirrel_15m.shp.
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Open de attributentabel voor deze nieuwe laag en merk op dat u nu drie bosopstanden heeft die informatie hebben
over de beschermde locaties. De informatie in de gegevens voor de bosopstanden zullen aan de beheerder van het
bos duidelijk maken dat er rekening moet worden gehouden met regels over natuurbehoud. Dan kan hij of zij de
locatie ophalen uit de gegevensset squirrel, en het gebied bezoeken om de overeenkomende buffer rondom
de locatie te markeren, zodat de veldwerkers kunnen voorkomen dat zij de woonomgeving van de eekhoorns
verstoren.

14.4.5 Try Yourself Bosopstanden bijwerken met afstand tot de stroom

Door dezelfde benadering, zoals aangegeven voor de beschermde locaties voor de eekhoorns, te volgen kunt u
nu uw bosopstanden bijwerken met de informatie voor de bescherming die is gerelateerd aan de stroom die is
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geïdentificeerd in het veld:

• Vergeet niet dat de buffer in dit geval 20 meter rondom is.

• U wilt alle informatie over de bescherming in hetzelfde vectorbestand, gebruik dus de laag
stands_squirrel_15m als het doel.

• Noem uw uitvoerbestand forest_stands_2012_protect.shp.

Open de attributentabel voor de nieuwe vectorlaag en stel vast dat u nu alle informatie heeft over bescherming
voor de bosopstanden die worden geraakt door de beschermingsmaatregelen voor het aan de oever gelegen bos,
geassocieerd met de stroom.

Sla uw project van QGIS op.

14.4.6 In Conclusion

U heeft gezien hoe u CIR-afbeeldingen kunt interpreteren om bosopstanden te digitaliseren. Natuurlijk zou het
enige praktijkervaring vergen om meer nauwkeurige bosopstanden te maken en gewoonlijk zou het gebruiken van
andere informatie,zoals kaarten van de bodem, betere resultaten geven, maar u kent nu de basis voor dit type taak.
Toevoegen van informatie uit andere gegevenssets bleek een onbeduidende taak te zijn.

14.4.7 What’s Next?

De bosopstanden die u heeft gedigitaliseerd zullen worden gebruikt voor het plannen van bewerkingen in de
bossen in de toekomst, maar u moet nog steeds meer informatie over het bos krijgen. In de volgende les zult u
zien hoe u een aantal monsterplaatsen plant om het bosgebied dat u zojuist heeft gedigitaliseerd te inventariseren,
en een algehele indruk te krijgen over de parameters van het bos.

14.5 Lesson: Systematisch ontwerpen van monsters

U heeft al een set polygonen gedigitaliseerd die de bosopstanden weergeven, maar u heeft op dit moment nog geen
informatie over het bos. Voor dat doel kunt u een enquête ontwerpen om het gehele bosgebied te inventariseren
en dan de parameters daarvan in te schatten. In deze les zult u een systematische set van monsterplaatsen maken.

Wanneer u begint met het plannen van de inventarisatie van het bos, is het belangrijk om de doelen helder te
definiëren, de typen monsterplaatsen die zullen worden gebruikt, en de gegevens die zullen worden verzameld om
de doelen te bereiken. Voor elk individueel geval zullen deze afhangen van het type bos en de beheersdoeleinden;
en zouden zorgvuldig moeten worden gepland door iemand met kennis van bosbouw. In deze les zult u een
theoretische inventarisatie implementeren, gebaseerd op een systematisch ontwerp van monsterplaatsen.

Het doel voor deze les: Een systematisch ontwerp van monsterplaatsen maken om het bosgebied te onderzoeken.

14.5.1 Inventariseren van het bos

Er bestaan verscheidene methoden om bossen te inventariseren, elk daarvan voor verschillende doeleinden en met
andere voorwaarden. Een zeer nauwkeurige manier om bijvoorbeeld een bos te inventariseren (als u alleen kijkt
naar soorten bomen) zou zijn om het bos te bezoeken en een lijst te maken van elke boom en de karakteristieken
daarvan. Zoals u zich kunt voorstellen is dat, met uitzondering van enkele kleine gebieden of in speciale situaties,
niet algemeen toe te passen.

De meest voorkomende manier om een bos te onderzoeken is door er monsters van te nemen, dat is, metingen
verrichten op verschillende locaties in het bos en die informatie te veralgemeniseren voor het gehele bos. Deze
metingen worden vaak verricht op monsterplaatsen wat kleinere bosgebieden zijn die gemakkelijk bemeten kun-
nen worden. De monsterplaatsen kunnen elke grootte zijn (bijv. 50 m2, 0,5 ha) en vorm (bijv. cirkelvormig,
rechthoekig, variabele grootte), en kunnen op verschillende manieren in het bos liggen (bijv. willekeurig, sys-
tematisch, langs lijnen). De grootte, vorm en locatie van de monsterplaatsen worden gewoonlijk bepaald aan de

14.5. Lesson: Systematisch ontwerpen van monsters 343



QGIS Training Manual, Release 2.14

hand van statistische, economische en praktische overwegingen. Als u geen kennis heeft over bosbouw, bent u
misschien geïnteresseerd in het lezen van dit artikel op Wikipedia.

14.5.2 Follow Along: Een systematisch ontwerp van monsterplaatsen im-
plementeren

Voor het bos waarmee u werkt heeft de beheerder besloten dat een systematisch ontwerp van monsterplaatsen het
meest toepasselijk is voor dit bos en heeft besloten dat een vaste afstand van 80 meter tussen de monsterplaatsen
en monsterlijnen betrouwbare resultaten zal opleveren (voor dit geval een gemiddelde foutmarge van +- 5% bij
een waarschijnlijkheid van 68%). Besloten is dat monsterplaatsen met een variabele grootte de meest effectieve
methode voor deze inventarisatie zijn, voor groeiende en volwassen bosopstanden, maar monsterplaatsen met een
vaste straal van 4 meter zal worden gebruikt voor bosopstanden met zaailingen.

In de praktijk dient u eenvoudigweg de monsterplaatsen weer te geven als punten, die later zullen worden gebruikt
door de teams in het veld:

• Open uw project digitizing_2012.qgs uit de vorige les.

• Verwijder alle lagen, met uitzondering van forest_stands_2012.

• Sla uw project nu op als forest_inventory.qgs

Nu moet u een rechthoekig raster van punten maken die 80 meter van elkaar liggen:

• Open Vector → Onderzoeks-gereedschap → Regelmatige punten.

• Selecteer Invoer grenslaag in de definities Vlak.

• En stel als invoerlaag de laag forest_stands_2012 in.

• Selecteer, in de instellingen Tussenruimte raster, Gebruik deze tussenruimte voor punten en stel die in op
80.

• Sla het uitvoerbestand op als systematic_plots.shp in de map forestry\sampling\.

• Selecteer Resultaat aan kaartvenster toevoegen.

• Klik op OK.

Notitie: De voorgestelde Regelmatige punten maakt de systematische punten, beginnend in de linker bovenhoek
van het bereik van de geselecteerde polygoonlaag. Indien u enige willekeurigheid aan deze regelmatige punten
wilt toevoegen, zou u een willekeurig berekend getal tussen 0 en 80 (80 is de afstand tussen onze punten) kunnen
gebruiken, en dan op te geven als de parameter Beginwaarde voor hoek (LH kant) in het dialoogvenster van het
gereedschap.

U zult gemerkt hebben dat het gereedschap het gehele bereik van uw laag met bosopstanden heeft gebruikt om
een rechthoekig raster van punten te genereren. Maar u bent alleen geïnteresseerd in de punten die feitelijk binnen
uw bosgebied liggen (bekijk de afbeeldingen hieronder):
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• Open Vector → Geoprocessing-gereedschap → Clip.

• Selecteer systematic_plots als Invoer vectorlaag.

• Stel forest_stands_2012 in als de Cliplaag.

• Sla het resultaat op als systematic_plots_clip.shp.

• Selecteer Resultaat aan kaartvenster toevoegen.

• Klik op OK.

U heeft nu de punten die de teams in het veld zullen gebruiken om naar de locaties van de ontworpen monsterplaat-
sen te navigeren. U kunt deze punten nog steeds voorbereiden zodat ze meer bruikbaar zijn voor het veldwerk. U
zult tenminste betekenisvolle namen moeten toevoegen aan de punten en ze exporteren naar een indeling die kan
worden gebruikt in hun GPS-apparaten.

Laten we beginnen met het benoemen van de monsterplaatsen. Als u de Attributentabel voor de monsterplaat-
sen binnen het bosgebied controleert, kunt u zien dat het standaard veld id automatisch is gegenereerd door het
gereedschap Regelmatige punten. Label de punten om ze op de kaart te zien en overweeg of u deze nummers als
deel voor de namen van uw monsterplaatsen kunt gebruiken:

• Open de Laag-eigenschappen –> Labels voor uw systematic_plots_clip.

• Selecteer Deze laag labelen met en selecteer het veld ID.

• Ga naar de opties Buffer en selecteer Teken tekstbuffer, stel Grootte in op 1.

• Klik op OK.

Bekijk nu de labels op uw kaart. U kunt zien dat de punten zijn gemaakt en genummerd van Oost naar West en
vervolgens van Noord naar Zuid. Als u opnieuw naar de attributentabel kijkt, zult u zien dat de volgorde in de
tabel ook dat patroon volgt. Tenzij u een reden hebt om de monsterplaatsen een andere naam te geven, is het
benoemen ervan op de wijze van West-Oost/Noord-Zuid een logische volgorde en is een goede optie.
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Notitie: Als u ze in een andere volgorde of met een andere naam zou willen hebben, zou u een werkblad kunnen
gebruiken om in staat te zijn rijen en kolommen op een andere manier te ordenen en te combineren.

Niettegenstaande dat zijn de nummerwaarden in het veld id niet zo goed. Het zou beter zijn als de namen iets
zouden zijn van p_1, p_2.... U kunt een nieuwe kolom maken voor de laag systematic_plots_clip:

• Ga naar de Attributentabel voor systematic_plots_clip.

• Schakel de modus Bewerken in.

• Open de Veldberekening en noem de nieuwe kolom Plot_id.

• Stel het Type voor veld in op Tekst (string).

• In the Expression field, write, copy or construct this formula concat(’P_’, $rownum ). Remember
that you can also double click on the elements inside the Function list. The concat function can be found
under String and the $rownum parameter can be found under Record.

• Klik op OK.

• Schakel de modus Bewerken uit en sla uw wijzigingen op.

Nu heeft u een nieuwe kolom met namen voor plaatsen die betekenis voor u hebben. Wijzig, voor de laag
systematic_plots_clip, het veld dat wordt gebruikt voor de labels naar uw nieuwe veld Plot_id.
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14.5.3 Follow Along: Monsterplaatsen in GPX-indeling exporteren

De teams in het veld zullen waarschijnlijk een GPS-apparaat gebruiken om de monsterplaatsen te vinden die u
heeft gepland. De volgende stap is om de punten die u gemaakt heeft te exporteren in een indeling die uw GPS
kan lezen. QGIS stelt u in staat uw gegevens voor punt- en lijnvector te exporteren in GPS eXchange Format
(GPX)<http://en.wikipedia.org/wiki/GPS_Exchange_Format>, wat een standaard GPS-gegevensindeling is die
kan worden gelezen door de meeste gespecialiseerde software. U moet voorzichtig zijn bij het selecteren van het
CRS wanneer u uw gegevens opslaat:

• Klik met rrechts op systematic_plots_clip en selecteer Opslaan als.
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• Selecteer GPS eXchange Format [GPX] in Formaat.

• Sla de uitvoer op als plots_wgs84.gpx.

• Selecteer Geselecteerd CRS in CRS.

• Blader naar WGS 84 (EPSG:4326).

..opmerking:: De indeling GPX accepteert alleen dit CRS. Als u een ander selecteert zal QGIS geen foutmelding
geven, maar u krijgt een leeg bestand.

• Klik op OK.

• Selecteer, in het dialoogvenster dat opent, alleen de laag waypoints (de rest van de lagen zijn leeg).

De monsterplaatsen voor de inventarisatie staan nu in een standaardindeling die door de meeste GPS-software
kan worden afgehandeld. De teams in het veld kunnen nu de locaties van de monsterplaatsen uploaden naar hun
apparaten. Dat zou moeten worden gedaan met behulp van de eigen software voor de specifieke apparaten en
het bestand plots_wgs84.gpx dat u zojuist heeft opgeslagen. Een andere optie zou zijn om de plug-in GPS-
gereedschap te gebruiken maar daarbij zou het zeer waarschijnlijk inhouden dat het gereedschap moet worden
ingesteld om te werken met uw specifieke GPS-apparaat. Als u werkt met uw eigen gegevens en wilt zien hoe het
gereedschap werkt, kunt u er meer informatie over vinden in het gedeelte Werken met GPS-gegevens in de QGIS
Gebruikershandleiding.

Sla nu uw project van QGIS op.
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14.5.4 In Conclusion

U zag zojuist hoe eenvoudig u een systematisch ontwerp voor monstername kunt maken dat gebruikt kan worden
worden voor de inventarisatie van een bos. Het maken van andere typen ontwerpen voor het nemen van monsters
zal het gebruiken van andere gereedschappen binnen QGIS behelzen, werkbladen of scripten om de coördinaten
van de monsterplaatsen te berekenen, maar het algemene idee blijft hetzelfde.

14.5.5 What’s Next?

In de volgende les zult u zien hoe u de mogelijkheden voor Atlas in QGIS kunt gebruiken om automatisch gede-
tailleerde kaarten te genereren die teams in het veld zullen gebrukken om naar de monsterplaatsen te navigeren
die aan hen zijn toegewezen.

14.6 Lesson: Gedetailleerde kaarten maken met het gereedschap
Atlas

Het systematisch ontwerp voor het nemen van monsters is gereed en de teams in het veld hebben de GPS-
coördinaten in hun navigatieapparaten geladen. Zij hebben ook een formulier met veldgegevens waarop zij de
informatie zullen verzamelen die zij hebben gemeten op elke monsterplaats. Zij hebben een aantal gedetailleerde
kaarten gevraagd waarop enige informatie over het terrein duidelijk zichtbaar is, tezamen met een kleinere subset
van monsterplaatsen en enige informatie over het gebied van de kaart om eenvoudiger hun weg naar elke mon-
sterplaats te vinden. U kunt het gereedschap Atlas gebruiken om automatisch een aantal kaarten in een gelijke
indeling te generen.

Het doel voor deze les: Het gereedschap Atlas in QGIS leren gebruiken om gedetailleerde af te drukken kaarten
te genereren om te helpen bij de inventarisatie in het veld.

14.6.1 Follow Along: De Printvormgeving voorbereiden

Vóór we de gedetailleerde kaarten van het bosgebied en onze monsterplaatsen kunnen automatiseren, moeten we
een kaartsjabloon maken met alle elementen die we nuttig achten voor het werk in het veld. Natuurlijk is het meest
belangrijke dat het goed opgemaakt is, maar, zoals u al eerder heeft gezien, u zult ook heel veel andere elementen
moeten toevoegen die de afgedrukte kaart completeren.

Open het project forest_inventory.qgs van QGIS vanuit de vorige les. U zou ten minste de volgende
lagen moeten hebben:

• forest_stands_2012 (met een transparantie van 50%, groene vulling en donkergroene lijnen als rand).

• systematic_plots_clip.

• rautjarvi_aerial.

Sla het project op onder de nieuwe naam map_creation.qgs.

Onthoud dat u de Printvormgeving-manager: gebruikt om een kaart te maken die kan worden afgedrukt,

• Open Project → Printvormgeving-manager....

• In het dialoogvenster Printvormgeving-manager.

• Klik op de knop Toevoegen en noem uw compositie forest_map.

• Klik op OK.

• Klik op de knop Tonen.

Stel de printeropties zo in dat uw kaarten en marges op uw papier passen, voor een A4-tje:

• Open menuselection:Printvormgeving –> Pagina-instellingen.
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• Grootte is A4 (217 x 297 mm).

• Oriëntatie is Landschap.

• Marges (millimeters) worden allemaal ingesteld op 5.

Ga, in het venster Printvormgeving, naar de tab Lay-out (in het paneel rechts) en zorg er voor dat deze instellingen
voor Papier en kwaliteit hetzelfde zijn als die welke u definieerde voor de printer:

• Voorinstellingen: A4 (210x297mm).

• Oriëntatie: Liggend.

• Export resolutie: 300dpi.

Het maken van een kaart gaat eenvoudiger als u gebruikt maakt van het kaartraster om de verschillende elementen
te plaatsen. Bekijk de instellingen voor het raster van Printvormgeving:

• Vergroot, op de tab Lay-out, het gebied Hulplijnen en raster.

• Controleer of Rasterafstand is ingesteld op 10 mm.

• En dat Tolerantie voor ‘snappen’ is ingesteld op 2 mm.

U dient het gebruiken van het raster te activeren:

• Open het menu Beeld.

• Klik op Grid tonen.

• Selecteer Aan grid snappen.

• Merk op dat de opties voor het gebruiken van hulplijnen standaard zijn geselecteerd, wat u in staat stelt rode
hulplijnen te zien wanneer u elementen in de printvormgeving verplaatst.

Nu kunt u beginnen met het toevoegen van elementen aan aan kaartvenster. Voeg eerst een kaartelement toe zodat
u kunt bekijken hoe het er uitziet als u wijzigingen in de symbologie van de kaart maakt:

• Klik op de knop Nieuwe kaart toevoegen: .

• Klik en sleep een rechthoek op het kaartvenster zodat de kaart het grootste deel daarvan bedekt.
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Merk op hoe de muiscursor snapt aan het kaartraster. Gebruik deze functie als u andere elementen toevoegt. Als
u nauwkeuriger wilt werken, wijzig dan de instelling Rasterafstand voor het raster. Als u om enige reden niet op
een bepaald punt niet zou willen snappen aan het raster, kunt u het altijd in- of uitschakelen in het menu Beeld.

14.6.2 Follow Along: Een achtergrondkaart toevoegen

Laat de printvormgeving open maar ga terug naar de kaart. Laten we enige achtergrondgegevens toevoegen en
enige opmaak maken zodat de inhoud van de kaart zo duidelijk als maar mogelijk is.

• Voeg het raster voor de achtergrond basic_map.tif toe dat u kunt vinden in de map
exercise_data\forestry\.

• Selecteer het CRS ETRS89 / ETRS-TM35FIN CRS voor het raster als daarnaar gevraagd wordt.

Zoals u kunt zien is de kaart voor de achtergrond al opgemaakt. Dit type direct te gebruiken cartografie-raster is
vrij algemeen. Het wordt gemaakt vanuit vectorgegevens, opgemaakt in een standaard indeling en opgeslagen als
een raster zodat u zich niet bezig hoeft te houden met het opmaken van verscheidene vectorlagen en u geen zorgen
hoeft te maken of u wel een goed resultaat krijgt.

• Zoom nu in op uw monsterplaatsen, zodat u alleen nog vier of vijf lijnen met monsterplaatsen ziet.

De huidige opmaak van de monsterplaatsen is niet al te best, maar hoe ziet het er in de printvormgeving uit?:

Gedurende de laatste oefeningen was de witte buffer boven op de luchtfoto OK, maar nu dat de achtergrondaf-
beelding meest wit is kunt u de labels nog nauwelijks zien. U kunt ook controleren hoe het eruit ziet in de
printvormgeving:

• Ga naar het venster Printvormgeving.

• Gebruik de knop om het kaartelement te selecteren in de Printvormgeving.

• Ga naar de tab Item-eigenschappen.

• Klik, onder Bereik, op Toon bereik in kaartvenster.

• Klik onder Algemene eigenschappen op de knop Voorvertoning bijwerken als u het element moet
vernieuwen.

Dit is duidelijk niet voldoende, u wilt de nummers van de monsterplaatsen zo zichtbaar mogelijk maken voor de
teams in het veld.

14.6.3 Try Yourself De symbologie van de lagen wijzigen

In Module: Een basiskaart maken is gewerkt met symbologie en in Module: Vectorgegevens classificeren met
labels. Het is aan te raden deze delen van de handleiding nog even door te lezen. Doel is om locaties en namen
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van monsterplaatsen zichtbaar te maken op een manier waarbij de ondergrond ook zichtbaar blijft. Onderstaande
afbeelding geeft een mogelijk resultaat:

U zult later de groene opmaak van de laag forest_stands_2012 gebruiken. Om die te behouden en een
visualisatie er van te hebben die alleen de randen van de bosopstanden weergeeft:

• Klik met rechts op forest_stands_2012 en selecteer Dupliceren

• U krijgt een nieuwe laag, genaamd forest_stands_2012 kopiëren, die u kunt gebruiken om een
andere stijl te definiëren, bijvoorbeeld zonder vulling en met rode randen.

Nu heeft u twee verschillende visualisaties van de bosopstanden en kunt u beslissen welke weer te geven voor uw
detailkaart.

Ga vaak terug naar het venster Printvormgeving om te zien hoe de kaart er uit zou komen te zien. Voor het doel
gedetailleerde kaarten te maken, zoekt u naar een symbologie die er niet goed uitziet op de schaal van het gehele
bosgebied (linker afbeelding hieronder) maar op een kleinere schaal (rechter afbeelding hieronder). Vergeet niet
Voorvertoning bijwerken en Aanpassen aan kaartformaat te gebruiken wanneer u de zoomfactor wijzigt in uw
kaart of de printvormgeving.

352 Chapter 14. Module: Toepassing Bosbouw



QGIS Training Manual, Release 2.14

14.6.4 Try Yourself Een sjabloon voor een basiskaart maken

Als u eenmaal een symbologie heeft die u bevalt, bent u klaar om meer informatie aan uw af te drukken kaart toe
te voegen. Voeg ten minste de volgende elementen toe:

• Titel.

• Een schaalbalk.

• Een raster voor uw kaart.

• Coördinaten aan de zijkanten van het raster.

U heeft een soortgelijke lay-out al gemaakt in composition already in Module: Kaarten maken. Ga terug naar die
module als dat nodig is. U kunt deze voorbeeldafbeelding als verwijzing gebruiken:

Exporteer uw kaart als een afbeelding en bekijk hem.

• Printvormgeving → Als afbeelding exporteren.

• Gebruik de JPG format voor het voorbeeld.

Dat is hoe het er uit zal zien na het afdrukken.

14.6.5 Follow Along: Meer elementen aan de printvormgeving toevoegen

Zoals u waarschijnlijk al is opgevallen in de voorgestelde voorbeelden voor afbeeldingen van sjablonen, is er ruim
voldoende ruimte aan de rechterzijde van het kaartvenster. Laten we eens zien wat daar nog meer zou kunnen
worden geplaatst. Voor het doel van onze kaart is een legenda niet echt nodig, maar een overzichtskaart en enkele
tekstvakken zouden waarde aan de kaart kunnen toevoegen.

Een overzichtskaart zou de teams in het veld helpen de gedetailleerde kaart binnen het algehele bosgebied te
plaatsen:

• Voeg een ander kaartelement toe aan het kaartvenster, rechts onder de tekst voor de titel.
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• Open, op de tab Item-eigenschappen, de keuzelijst Overzichtskaarten.

• Stel het Kaartframe in op Kaart 0. Dit maakt een geschaduwde rechthoek over de kleinere kaart die het
bereik weergeeft dat zichtbaar is in de grotere kaart.

• Selecteer ook de optie Frame met een zwarte kleur en een Dikte van 0.30.

Merk op dat uw overzichtskaart niet echt een overzicht geeft van het gehele bosgebied, wat is wat u wilt. U
wilt dat deze kaart het gehele bosgebied weergeeft en u wilt dat het alleen de achtergrondkaart en de laag
forest_stands_2012weergeeft, en niet de monsterplaatsen. Ook wilt u dat zijn weergave wordt vergrendeld
zodat die niet meer wijzigt wanneer u de zichtbaarheid of volgorde van de lagen wijzigt.

• Ga terug naar de kaart, maar sluit de Printvormgeving niet.

• Klik met rechts op de laag forest_stands_2012 en klik op Op kaartlaag inzoomen.

• Deactiveer alle lagen met uitzondering van basic_map en forest_stands_2012.

• Ga terug naar de Printvormgeving.

• Klik, met de kleine kaart geselecteerd, op Aanpassen aan kaartformaat om zijn bereik in te stellen op wat u
ziet in het kaartvenster.

• Vergrendel de weergave voor de overzichtskaart door te selecteren Lagen vastzetten voor kaartonderdeel
onder Algemene eigenschappen.

Nu is uw overzichtskaart meer zoals u verwachtte en de weergave ervan zal niet meer wijzigen. Maar, natuurlijk,
nu geeft uw gedetailleerde kaart de randen van de bosopstanden niet meer weer, noch de monsterplaatsen. Laten
we dat repareren:

• Ga opnieuw naar het kaartvenster en selecteer de lagen die zichtbaar moeten zijn
(systematic_plots_clip, forest_stands_2012 kopiëren en Basic_map).

• Zoom opnieuw in zodat slechts een paar lijnen met monsterplaatsen zichtbaar zijn.

• Ga terug naar het venster Printvormgeving.

• Selecteer de grotere kaart in uw Printvormgeving ( ).
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• Klik, in Item-eigenschappen op Voorvertoning bijwerken en Aanpassen aan kaartformaat.

Merk op dat alleen de grotere kaart de huidige kaartweergave toont, en dat de kleinere overzichtskaart dezelfde
weergave heeft als toen u die vergrendelde.

Merk ook op dat de overzichtskaart een geschaduwd frame weergeeft voor het bereik dat wordt weergegeven in
de detailkaart.

Uw sjabloon voor de kaart is bijna voltooid. Voeg nu twee tekstvakken onder de kaart toe, één met de tekst
‘Gedetailleerde kaart zone: ‘ en de andere met ‘Opmerking: ‘. Plaats ze zoals u kunt zien in bovenstaande
afbeelding.

U kunt ook een Noordpijl toevoegen aan de overzichtskaart:

• Gebruik het gereedschap Afbeelding toevoegen, .

• Klik in de rechter bovenhoek van de overzichtskaart.

• Open, in Item-eigenschappen, Mappen doorzoeken en blader naar een afbeelding van een pijl.

• Selecteer, onder Rotatie afbeelding, Met kaart synchroniseren en selecteer Kaart 1 (de overzichtskaart).

• Deselecteer Achtergrond.

• Wijzig de grootte van de afbeelding van de pijl zodat die er goed uitziet op een kleine kaart.

De lay-out voor de basiskaart is nu gereed, nu wilt u gebruikmaken van het gereedschap Atlas om zoveel gede-
tailleerde kaarten in deze indeling te generen als u nodig vindt.
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14.6.6 Follow Along: Een Atlas-bedekking genereren

De Atlas dekking is slechts een vectorlaag die zal worden gebruikt om de gedetailleerde kaarten te genereren, één
kaart voor elk object in de dekking. Hier is een volledige set van gedetailleerde kaarten voor het bosgebied om
een idee te krijgen van wat vervolgens zal worden gedaan.

De bedekking zou elke bestaande laag kunnen zijn, maar gewoonlijk is het verstandiger er een te maken voor dit
specifieke doel. Laten we een raster van polygonen maken die het bosgebied bedekken:

• Open, in de kaartweergave van QGIS, Vector → Onderzoeks-gereedschap → Vectorgrid.

• Stel het gereedschap in zoals in deze afbeelding:
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• Sla de uitvoer op als atlas_coverage.shp.

• Maak de nieuwe laag atlas_coverage zo op dat de polygonen geen vulling hebben.

De nieuwe vlakken bedekken het hele gebied van het bos en geven een indruk van wat elke kaart (gemaakt van
individuele vlakken) bevat.
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14.6.7 Follow Along: Het gereedschap Atlas instellen

De laatste stap is om het gereedschap Atlas in te stellen:

• Ga terug naar de Printvormgeving.

• Ga, in het paneel rechts, naar de tab Atlas-generatie.

• Stel de opties als volgt in:
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Dat vertelt het gereedschap Atlas om de objecten (polygonen) binnen atlas_coverage te gebruiken als de
focus voor elke gedetailleerde kaart. Het zal één kaart uitvoeren voor elk object in de laag. De Verborgen be-
dekkingslaag vertelt de Atlas om de polygonen niet weer te geven op de uitgevoerde kaarten.

Er moet nog één ding worden gedaan. U moet het gereedschap Atlas vertellen welk kaartelement moet worden bi-
jgewerkt voor elke uitgevoerde kaart. U kunt nu waarschijnlijk wel raden dat het kaartonderdeel dat voor elke kaart
moet worden bijgewerkt dat is welk u heeft voorbereid om detailweergaven te bevatten van de monsterplaatsen,
dat is het grotere kaartelement in uw kaartvenster:

• Selecteer het grotere kaartelement.

• Ga naar de tab Item-eigenschappen.

• Selecteer in de lijst Beheerd door Atlas.

• En stel Marge rond object in op 10%. Het bereik voor de weergave zal 10% groter zijn dan de polygonen,
wat betekent dat uw gedetailleerde kaarten elkaar 10% overlappen.
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Nu kunt u het gereedschap Voorvertoning voor Atlas-kaarten gebruiken om te zien hoe uw kaarten eruit zullen
komen te zien:

• Activeer de voorbeelden van Atlas met behulp van de knop of, als uw werkbalk Atlas niet zichtbaar is,
via Atlas → Voorbeeld Atlas.

• U kunt de pijlen in de werkbalk Atlas gebruiken of die in het menu Atlas om door de te maken kaarten te
verplaatsen.

Merk op dat sommige ervan niet interessant zijn. Laten we daar iets aan doen en enkele bomen sparen door die
onbruikbare kaarten niet af te drukken.

14.6.8 Follow Along: De bedekkingslaag bewerken

Naast het verwijderen van de polygonen voor die gebieden die niet interessant zijn, kunt u ook de tekstlabels in
uw te generen kaart aanpassen met inhoud uit de Attributentabel van uw bedekkingslaag:

• Ga terug naar de kaartweergave.
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• Schakel Bewerken in voor de laag atlas_coverage.

• Selecteer de polygonen die zijn geselecteerd (in geel) in onderstaande afbeelding.

• Verwijder de geselecteerde polygonen.

• Schakel Bewerken uit en sla de wijzigingen op.

U kunt nu terug gaan naar de Printvormgeving en controleren of de voorbeelden van Atlas alleen de polygonen
gebruiken die zijn overgebleven op de laag.

De bedekkingslaag die u gebruikt heeft nog geen bruikbare informatie die u zou kunnen gebruiken om de inhoud
van de labels op uw kaart aan te passen. De eerste stap is om ze te maken, u kunt bijvoorbeeld een code voor de
zone toevoegen voor de gebieden van de polygonen en een veld met enkele opmerkingen voor de teams in het veld
om rekening mee te houden:

• Open de Attributentabel voor de laag atlas_coverage.

• Schakel Bewerken in.

• Gebruik de veldberekening om de volgende twee velden te maken en in te vullen.

• Maak een veld genaamd Zone en typ Geheel getal (integer).

• In het vak Expressie schrijf/kopieer/construeer $rownum.
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• Maak een ander veld, genaamd Opmerking:,van het type Tekst (string) en een breedte van 255.

• Schrijf, in het vak Expressie, ’Geen opmerkingen.’. Dat zal de standaard waarde instellen voor alle
polygonen.

De beheerder van het bos zal enige informatie hebben over het gebied die bruikbaar is bij het bezoeken van het
gebied.Bijvoorbeeld de aanwezigheid van een brug, een moeras of de locatie van een beschermde soort. De laag
atlas_coverage staat waarschijnlijk nog steeds in de modus Bewerken, voeg de volgende tekst toe in het veld
Opmerking voor de overeenkomende polygonen (dubbelklik op de cel om die te bewerken):

• Voor de Zone 2: Brug ten noorden van monsterplaats 19. Gewone vliegende
eekhoorn tussen p_13 en p_14..

• Voor de Zone 6: Moeilijk te verplaatsen in het moeras ten noorden van het
meer..

• Voor de Zone 7: Gewone vliegende eekhoorn ten zuiden van p_94..

• Schakel Bewerken uit en sla uw wijzigingen op.

Bijna klaar. Nu moet u het gereedschap Atlas vertellen dat u wilt dat enkele tekstlabels de informatie uit de
attributentabel van de laag atlas_coverage gebruiken.

• Ga terug naar de Printvormgeving.

• Selecteer het tekstlabel dat Gedetailleerde kaart... bevat.

• Stel de grootte van Lettertype in op 12.

• Zet de cursor aan het einde van de tekst in het label.

• Klik op Voeg een expressie in op de tab Item-eigenschappen, in de Algemene eigenschappen .

• Dubbelklik, in de Functielijst, op het veld Zone onder Velden en waarden.

• Klik op OK.

• De tekst in het vak in de Item-eigenschappen zou nu Gedetailleerde kaart zone [% "Zone"
%] moeten weergeven. Onthoud dat [% "Zone" %] zal worden vervangen door de waarde van het veld
Zone voor het overeenkomende object uit de laag atlas_coverage.

Test de inhoud van het label door te kijken naar de verschillende voorbeelden van de kaarten in Atlas.

Doe hetzelfde voor de labels met de tekst Opmerking: door het veld met de informatie voor de zone te ge-
bruiken. U kunt een regeleinde invoegen vóór u de expressie invoert. U kunt het resultaat voor het voorbeeld van
zone 2 zien in de afbeelding hieronder:
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Gebruik de voorbeelden van Atlas om door alle kaarten te bladeren die u nu snel zult maken en geniet ervan!

14.6.9 Follow Along: De kaarten afdrukken

Als laatste maar niet het minste, afdrukken of exporteren van uw kaarten als afbeeldingen of PDF-bestanden. U
kunt Atlas → Atlas als afbeeldingen exporteren... of Atlas → Atlas als PDF exporteren... gebruiken. Momenteel
werkt het exporteren naar de indeling SVG nog niet goed en zal een slecht resultaat geven.

Laten we de kaarten als één enkele PDF exporteren die u naar het veldbureau kunt sturen om af te drukken:

• Ga naar de tab Atlas-generatie in het paneel rechts.

• Selecteer, onder Uitvoer, Exporteren naar enkel bestand indien mogelijk. Dit zal alle kaarten bij elkaar in
één PDF stoppen, als deze optie niet wordt geselecteerd krijgt u één bestand voor elke kaart.

• Open Printvormgeving → Als PDF exporteren....

• Sla het PDF-bestand op als inventory_2012_maps.pdf in uw map
exercise_data\forestry\samplig\map_creation\.

Open het PDF-bestand om te controleren of alles is gegaan zoals verwacht.

U zou net zo makkelijk afzonderlijke afbeeldingen kunnen maken voor elke kaart (onthoud om het maken van één
enkel bestand uit te schakelen), hier kunt u de miniaturen zien voor de afbeeldingen die gemaakt zullen worden:
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Sla, in de Printvormgeving, uw jaart op als een sjabloon voor printvormgeving als forestry_atlas.qpt
in uw map exercise_data\forestry\map_creation\. Gebruik Printvormgeving → Als sjabloon op-
slaan. U zult in staat zijn dit sjabloon steeds opnieuw te gebruiken.

Sluit de Printvormgeving en sla uw project van QGIS op.

14.6.10 In Conclusion

U bent erin geslaagd een sjabloonkaart te maken die kan worden gebruikt om automatisch gedetailleerde kaarten
te genereren die in het veld kunnen worden gebruikt om naar de verschillende monsterplaatsen te navigeren. Zoals
u heeft gemerkt was dit geen eenvoudige taak maar de voordelen worden duidelijk wanneer u soortgelijke kaarten
moet maken voor andere regio’s en u het sjabloon kunt gebruiken dat u zojuist heeft gemaakt.

14.6.11 What’s Next?

In de volgende les zult u zien hoe u gegevens van LiDAR kunt gebruiken om een DEM te maken en die dan te
gebruiken om de zichtbaarheid van uw gegevens en kaarten te vergroten.

14.7 Lesson: De parameters voor het bos berekenen

Het bepalen van de parameters van het bos is het doel van de inventarisatie van het bos. In aansluiting op het
voorbeeld uit de vorige les, zult u de in het veld verzamelde informatie van de inventarisatie gaan gebruiken om
de parameters voor het bos te berekenen, eerst voor het gehele bos, en dan voor de bosopstanden die u eerder
digitaliseerde.

Het doel voor deze les: Parameters voor het bos berekenen, voor het geheel en op niveau van bosopstand.

14.7.1 Follow Along: De resultaten van de inventarisatie toevoegen

De teams in het veld hebben het bos bezocht en, met behulp van de informatie die u heeft verschaft, informatie
over het bos verzameld op elke monsterplaats.

Heel vaak zal de informatie worden verzameld op papieren formulieren in het veld, daarna getypt in een werkblad.
De informatie van de monsterplaatsen is opgenomen in een .csv-bestand dat eenvoudig kan worden geopend in
QGIS.

Ga door met het project van QGIS uit de les over het ontwerpen van de inventarisatie. U heeft het waarschijnlijk
forest_inventory.qgs genoemd.
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Voeg als eerste de metingen van de monsterplaatsen toe aan uw project van QGIS:

• Ga naar Laag → Tekstgescheiden kaartlaag toevoegen....

• Blader naar het bestand systematic_inventory_results.csv located in de map
exercise_data\forestry\results\.

• Zorg er voor dat de optie Puntcoördinaten is geselecteerd.

• Stel de velden voor de coördinaten in op de velden X en Y.

• Klik op OK.

• Selecteer het CRS ETRS89 / ETRS-TM35FIN CRS als daarnaar gevraagd wordt.

• Open de Attributentabel voor de nieuwe laag en bekijk de gegevens.

U kunt het type gegevens dat is opgenomen in de metingen op de monsterplaatsen lezen
in het tekstbestand legend_2012_inventorydata.txt dat is geplaatst in de map
exercise_data\forestry\results\.

De laag systematic_inventory_results die u zojuist heeft toegevoegd is in feite slechts een virtuele
weergave van de tekstinformatie in het .csv-bestand. Converteer, vóórdat u doorgaat, de resultaten van de
inventarisatie naar een echt shapefile:

• Klik met rechts op de laag systematic_inventory_results.

• Blader naar de map exercise_data\forestry\results\.

• Noem het bestand sample_plots_results.shp.

• Selecteer Voeg opgeslagen bestand toe aan kaart.

• Verwijder de laag systematic_inventory_results uit uw project.

14.7.2 Follow Along: Schatting voor parameters voor gehele bos

U kunt de gemiddelden berekenen voor het gehele bosgebied vanuit de resultaten voor de inventarisatie voor
enkele interessante parameters, zoals het volume en het aantal stammen per hectare. Omdat de systematische
monsterplaatsen gelijke gebieden vertegenwoordigen, kunt u direct de gemiddelden van de volumes en het anatal
stammen per hectare berekenen vanuit de laag sample_plots_results.

U kunt het gemiddelde van een veld in een vectorlaag berekenen met behulp van het gereedschap Basisstatistieken:

• Open Vector → Analyse-gereedschap → Basisstatistieken.

• Selecteer sample_plots_results als de Invoer vectorlaag.

• Selecteer Vol als Doelveld.

• Klik op OK.

Het gemiddelde volume in het bos is 135,2 m³/ha.

U kunt op dezelfde manier het gemiddelde aantal stammen berekenen, 2745 stammen/ha.
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14.7.3 Follow Along: Parameters voor de bosopstanden schatten

U kunt gebruikmaken van deze zelfde systematische monsterplaatsen schattingen te berekenen voor de verschil-
lende bosopstanden die u eerder digitaliseerde. Enkele van deze bosopstanden kregen geen monsterplaats en voor
hen zult u dus geen informatie ontvangen. U zou enkele extra monsterplaatsen hebben kunnen plannen toen u de
systematische inventarisatie plande, zodat de teams in het veld voor dit doel een paar extra monsterplaatsen zouden
hebben bemeten. Of u zou later een team het veld ingestuurd kunnen hebben om schattingen voor de ontbrek-
ende bosopstanden te verkrijgen om de inventarisatie van de bosopstanden te completeren. Niettegenstaande dat,
u zult informatie verkrijgen voor een groot aantal bosopstanden door slechts gebruik te maken van de geplande
monsterplaatsen.

Wat u nodig heeft zijn de gemiddelden van de monsterplaatsen die binnen elk van de bosopstanden vallen. Wan-
neer u informatie wilt combineren, gebaseerd op hun relatieve locaties, moet u een ruimtelijke join uitvoeren:

• Open het gereedschap Vector → Datamanagement-gereedschap → Attributen op basis van plaats bijeen-
brengen.

• Stel forest_stands_2012 in als de Doel vectorlaag. De laag waarvoor u de resultaten wilt.

• Stel sample_plots_results in als de Join vectorlaag. De laag waaruit u de schattingen wilt bereke-
nen.

• Selecteer Samenvatting gebruiken van snijdende objecten.

• Selecteer om alleen het Gemiddelde te berekenen.

• Noem het resultaat forest_stands_2012_results.shp en sla het op in de map
exercise_data\forestry\results\.

• Selecteer tenslotte Alle rijen behouden..., zodat u later kunt controleren welke bosopstanden geen informatie
kregen.

• Klik op OK.

• Accepteer, indien daarnaar gevraagd, het toevoegen van de nieuwe laag aan uw project.

• Sluit het gereedschap Attributen op basis van plaats bijeenbrengen.

Open de Attributentabel voor forest_stands_2012_results en bekijk de resultaten die u heeft. Merk op
dat een aantal bosopstanden NULL hebben als de waarde voor de berekeningen, dat zijn die welke geen monster-
plaatsen hebben. Selecteer ze en bekijk ze op de kaart, het zijn enkele van de kleinere bosopstanden:
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Laten we nu dezelfde gemiddelden berekenen zoals u eerder voor het gehele bos heeft gedaan, alleen zullen we
deze keer de gemiddelden die u kreeg voor de bosopstanden gebruiken als basis voor de berekening. Onthoud dat
in de eerdere situatie elke monsterplaats een theoretisch bosopstand weergaf van 80x80 m. Nu moet u in plaats
daarvan het gebied van elke bosopstand individueel in ogenschouw nemen. Op die manier worden, opnieuw, de
gemiddelde waarden van de parameters die in, bijvoorbeeld, m³/ha voor de volumes zijn, worden geconverteerd
naar totale volumes voor de bosopstanden.

U moet eerst de gebieden voor de bosopstanden berekenen en dan totale volumes en aantal stammen voor elk
ervan berekenen:

• Schakel, in de Atributentabel, Bewerken in.

• Open de Veldberekening.
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• Maak een nieuw veld, genaamd area.

• Laat het Type voor veld staan op Decimaal getal (real).

• Stel Precisie in op 2.

• Schrijf, in het vak Expressie, $area / 10000. Dit zal het gebied van de bosopstanden berekenen in ha.

• Klik op OK.

Bereken nu een veld met de total volumes en geschatte anatal stammen voor elke bosopstand:

• Noem de velden s_vol en s_stem.

• De velden mogen gehele getallen zijn of u kunt ook real-getallen gebruiken.

• Gebruik respectievelijk de expressies "area" * "MEANVol" en "area" * "MEANStems" voor to-
tale volumes en totaal aantal stammen.

• Sla de wijzigingen op als u gereed bent.

• Schakel Bewerken uit.

In de eerdere situatie waren de gebieden die door elke monsterplaats werden weergegeven hetzelfde, dus was het
voldoende om het gemiddelde van de monsterplaatsen te berekenen. Voor het berekenen van de schattingen, moet
u nu de som van het volume of het aantal stammen voor de bosopstand delen door de som van de gebieden van de
bosopstanden die informatie bevatten.

• Selecteer, in de guilabel:Attributentabel voor de laag forest_stands_2012_results, alle bosop-
standen die informatie bevatten.

• Open Vector → Analyse-gereedschap → Basisstatistieken.

• Selecteer forest_stands_2012_results als de Invoer vectorlaag.

• Selecteer area als Doelveld.

• Selecteer Alleen geselecteerde objecten gebruiken

• Klik op OK.
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Zoals u kunt zien is de totale som van de gebieden van de bosopstanden 66.04 ha. Merk op dat het gebied van
de ontbrekende bosopstanden slechts ongeveer 7 ha is.

Op dezelfde wijze kunt u berekenen dat het totale volume voor deze bosopstanden 8908 m³/ha is en het totale
aantal stammen is 179594 stammen.

Het gebruiken van de informatie voor de bosopstanden, in plaats van die direct vanuit de monsterplaatsen te
gebruiken, geeft de volgende schattingen voor de gemiddelden:

• 184.9 m³/ha en

• 2719 stammen/ha.

Sla uw project voor QGIS op, forest_inventory.qgs.

14.7.4 In Conclusion

U bent er in geslaagd schattingen voor het gehele bos te berekenen met behulp van de informatie uit uw system-
atische monsterplaatsen, eerst zonder de karakteristieken van het bos in overweging te nemen en ook met behulp
van de interpretatie van de luchtfoto naar bosopstanden. En u heeft ook enige waardevolle informatie verkregen
over de afzonderlijke bosopstanden, wat zou kunnen worden gebruikt om het beheer van het bos te plannen voor
de komende jaren.
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14.7.5 What’s Next?

In de volgende les zult u eerst een achtergrond met schaduw voor een heuvel maken vanuit een gegevensset van
LiDAR die u zult gebruiken om een kaartweergave voor te bereidem met de resultaten voor het bos die u zojuist
heeft berekend.

14.8 Lesson: DEM vanuit gegevens van LiDAR

U kunt het uiterlijk van uw kaarten verbeteren door gebruik te maken van verschillende achtergrondafbeeldingen.
U zou de basiskaart of de luchtfoto kunnen gebruiken die u eerder heeft gebruikt, maar een raster met schaduw
voor heuvels van het terrein zal er in sommige situaties beter uitzien.

U zult LAStools gebruiken om een DEM uit een gegevensset van LiDAR te nemen en dan een raster met een
schaduw voor heuvels maken om later in uw kaartweergave te gebruiken.

Het doel voor deze les: LAStools installeren en een DEM berekenen vanuit gegevens van LiDAR en een raster
met schaduw voor heuvels.

14.8.1 Follow Along: LAStools installeren

Beheren van gegevens van LiDAR binnen QGIS is mogelijk met behulp va het framework Processing en de
algoritmen die worden verschaft door LAStools.

Een digitaal hoogtemodel (DEM) kan worden gemaakt op basis van een LiDAR puntenwolk. Vervolgens kun-
nen eventueel schaduwen worden gegenereerd voor presentatiedoeleinden. De instellingen van het framework
Processing dienen als volgt te worden ingesteld om met LAStools aan de slag te gaan:

• Sluit QGIS, als u dat al heeft gestart.

• Een oudere plug-in voor LiDAR zou al standaard geïnstalleerd kunnen zijn op uw systeem in de map
C:/Program Files/QGIS Valmiera/apps/qgis/python/plugins/processing/.

• Als u een map heeft die is genaamd lidar, verwijder die. Dit geldt voor sommige installaties van QGIS
2.2 en 2.4.

370 Chapter 14. Module: Toepassing Bosbouw

http://rapidlasso.com/2013/09/29//how-to-install-lastools-toolbox-in-qgis


QGIS Training Manual, Release 2.14

• Ga naar de map exercise_data\forestry\lidar\, daar vindt u het bestand
QGIS_2_2_toolbox.zip. Open het en pak de map lidar uit om die, welke u zojuist heeft
verwijderd, te vervangen.

• Als u een andere versie van QGIS gebruikt, kunt u meer instructies voor de installatie vinden in deze
handleiding.

Nu moet u de LAStools op uw computer installeren. Haal de nieuwste versie van LAStools hier op en pak de
inhoud van het bestand LAStools.zip uit in een map op uw systeem, bijvoorbeeld, c:\LAStools\. Het
pad naar de map LAStools mag geen spaties of speciale tekens bevatten.

Notitie: Lees het bestand LICENSE.txt in de map LAStools. Sommige van de LAStools zijn open bron
en andere zijn gesloten en vereisen een licentie voor meestal commercieel en gebruik door de overheid. Voor
educatieve en evaluatie-doeleinden mag u LAStools gebruiken en testen zoveel u wilt.

De plug-in en de actuele algoritmen zijn nu geïnstalleerd op uw computer en bijna klaar om te gebruiken, u dient
alleen nog het framework Processing in te stellen om ze te kunnen gebruiken:

• Open een nieuw project in QGIS.

• Stel het CRS van het project in op ETRS89 / ETRS-TM35FIN.

• Sla het project op als forest_lidar.qgs.

De LAStools instellen in QGIS:

• Ga naar Processing → Opties en configuratie.

• Ga, in het dialoogvenster Processing opties, naar Providers en dan naar Tools for LiDAR data

• Selecteer Activate.
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• Stel voor LAStools folder in c:\lastools\ (of de map waarin u LAStools uitpakte).

14.8.2 Follow Along: Een DEM berekenen met LAStools

U heeft de toolbox Processing al gebruikt in Lesson: Ruimtelijke statistieken om enkele algoritmen van SAGA uit
te voeren. Nu gaat u het gebruiken om programma’s van LAStools uit te voeren:

• Open Processing → Toolbox.

• Selecteer, in het keuzemenu onderaan, Advanced interface.

• U zou de categorie Tools for LiDAR data moeten zien.
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• Vergroot het om de beschikbare gereedschappen te zien, en vergroot ook de categorie LAStools (het aantal
algoritmen kan variëren).

• Scroll naar beneden totdat u het algoritme lasview vindt, dubbelklik er op om hte te openen.

• Voor Input LAS/LAZ file, blader naar exercise_data\forestry\lidar\ en selecteer het bestand
rautjarvi_lidar.laz.
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• Klik op Run.

Nu kunt u de gegevens van LiDAR zien in het dialoogvenster just a little LAS and LAZ viewer:

Er zijn vele dingen die u kunt doen binnen deze viewer, maar voor nu kunt u in de viewer klikken en daarin slepen
n de puntenwolk van LiDAR om te zien hoe die er uit ziet.

Notitie: Als u meer details wilt weten over hoe de LAStools werken, kunt u de README tekstbestanden lezen

374 Chapter 14. Module: Toepassing Bosbouw



QGIS Training Manual, Release 2.14

over elk van de gereedschappen, in de map C:\LAStools\bin\. Handleidingen en andere materialen zijn
beschikbaar op de webpagina van Rapidlasso.

• Sluit de viewer als u klaar bent.

Het maken van een DEM met LAStools kan worden gedaan in twee stappen, de eerste om de puntenwolk te
classificeren in punten ground en no ground en dan een DEM berekenen met behulp van slechts de punten
ground.

• Ga terug naar de Processing Toolbox.

• In het vak Zoek..., schrijf lasground.

• Dubbelklik om het gereedschap lasground te openen en stel het in zoals in deze afbeelding:

• Het uitvoerbestand wordt opgeslagen in dezelfde map als waar rautjarvi_lidar.laz is geplaatst en
wordt genoemd rautjarvi_lidar_1.las.

U kunt het openen met lasview als u het wilt controleren.
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De bruine punten zijn de punten die zijn geclassificeerd als grond en de grijze is de rest, u kunt op de letter g
klikken om alleen de grondpunten te visualiseren of de letter u om alleen de niet geclassificeerde punten te zien.
Klik op de letter a om alle punten weer opnieuw te zien. Controleer het bestand lasview_README.txt voor
meer opdrachten. Als u bent geïnteresseerd, ook deze handleiding over het handmatig bewerken van punten van
LiDAR tootn u verschillende bewerkingen binnen de viewer.

• Sluit de viewer opnieuw.

• Zoek, in de Processing Toolbox, naar las2dem.

• Open het gereedschap las2dem en stel het in zoals weergegeven in deze afbeelding:

376 Chapter 14. Module: Toepassing Bosbouw

http://www.rapidlasso.com/2014/03/02/tutorial-manual-lidar-editing/


QGIS Training Manual, Release 2.14

De resulterende DEM wordt toegevoegd aan uw kaart met de algemene naam Output raster file.

Notitie: De gereedschappen lasground en las2dem vereisen een licentie. U kunt de niet gelicenseerde gereed-
schappen gebruiken zoals aangegeven in het bestand over de licentie, maar u krijgt de diagonalen die u kunt
bewonderen in de afbeelding met de resultaten.

14.8.3 Follow Along: Een terrein met schaduw voor heuvels maken

Voor visualisatie geeft een schaduw voor heuvels, gegenereert uit een DEM, een betere visualisatie van het terrein:

• Open Raster → Terreinanalyse → Schaduw heuvels.

• Voor de Resultaatlaag, blader naar exercise_data\forestry\lidar\ en noem het bestand
hillshade.tif.

• Laat de rest van de parameters op de standaard instellingen staan.
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• Selecteer ETRS89 / ETRS-TM35FIN als het CRS als daarnaar gevraagd wordt.

Ondanks de diagonale lijnen die zich in het raster met schaduw voor heuvels bevinden, kunt u duidelijk een
nauwkeurig reliëf van het gebied zien. U kunt zelfs de de verschillende drainages zien die zijn ingegraven in de
bossen.
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14.8.4 In Conclusion

Met behulp van gegevens van LiDAR een DEM verkrijgen, speciaal in beboste gebieden, geeft goede resultaten
met weinig inspanning. U zou ook reeds uit LiDAR afgeleide DEM’s kunnen gebruiken of andere bronnen zoals
de SRTM 9m resolution DEM’s. Ongeacht welke, u kunt ze gebruiken om een raster met schaduw voor heuvels
te maken om in uw kaartweergaven te gebruiken.

14.8.5 What’s Next?

In de volgende, en laatste stap in deze module, les zult u het raster met schaduw voor heuvels en de resultaten van
de inventarisatie van het bos gebruiken om een kaartweergave van de resultaten te maken.

14.9 Lesson: Kaartweergave

In de vorige lessen heeft u een oude inventarisatie van een bos geïmporteerd als een project voor GIS, het bijgew-
erkt naar de huidige situatie, een inventarisatie voor het bos ontworpen, kaarten gemaakt voor het veldwerk en
parameters voor het bos berekend vanuit de metingen in het veld.

Het is vaak belangrijk om kaarten te maken met de resultaten van een project van GIS. Een kaart die de resultaten
van de inventarisatie van het bos weergeeft zal het voor iedereen eenvoudiger maken om met een snelle blik een
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goed idee te krijgen van de resultaten, zonder naar de specifieke getallen te kijken.

Het doel voor deze les: Een kaart maken om de resultaten van de inventarisatie weer te geven met behulp van een
raster met schaduw voor heuvels als achtergrond.

14.9.1 Follow Along: De gegevens voor de kaart voorbereiden

Open het project van QGIS uit de les over de berekeningen van de parameters, forest_inventory.qgs.
Behoud ten minste de volgende lagen:

• forest_stands_2012_results.

• basic_map.

• rautjarvi_aerial.

• lakes (als u die niet heeft, voeg die dan toe vanuit de map exercise_data\forestry\).

U gaat de gemiddelde volumes van uw bosopstanden in een kaart weergeven. Als u de Attributentabel opent
voor de laag forest_stands_2012_results, lunt u de waarden NULL zien voor de bosopstanden zonder
informatie. Om in staat te zijn ook die bosopstanden in uw opmaak te zien zou u de waarden NULL moeten
wijzigen naar, bijvoorbeeld, -999, wetende dat deze negatieve getallen betekenen dat er geen gegevens zijn voor
deze polygonen.

Voor de laag forest_stands_2012_results:

• Open de Attributentabel en schakel Bewerken in.

• Selecteer de polygonen met de waarde NULL.

• Gebruik de veldberekening om de waarden van het veld MEANVol bij te werken naar -999, alleen voor de
geselecteerde objecten.

• Schakel Bewerken uit en sla de wijzigingen op.

Nu kunt u een opgeslagen opmaak voor deze laag gebruiken:

• Ga naar de tab Stijl.

• Klik op Stijl laden.

• Selecteer forest_stands_2012_results.qml uit de map exercise_data\forestry\results\.

• Klik op OK.
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Uw kaart ziet er nu ongeveer zo uit:

14.9. Lesson: Kaartweergave 381



QGIS Training Manual, Release 2.14

14.9.2 Try Yourself Verschillende mengmodi gebruiken

De stijl die u heeft geladen:
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gebruikt de modus Hard licht voor de Laag blending modus. Merk op dat de verschillende modi verschillende
filters toepassen die de onder- en bovenliggende lagen combineren, in dit geval worden het raster met schaduw
voor heuvels en uw bosopstanden gebruikt. U kunt over deze modi lezen in de Gebruikersgids.

Probeer de verschillende modi en bekijk de verschillen in uw in uw kaart. Kies dan die welke u beter vindt voor
uw uiteindelijke kaart.

14.9.3 Try Yourself Een sjabloon van Printvormgeving gebruiken om het
kaartresultaat te maken

Gebruik een eerder voorbereid sjabloon om de resultaten weer te geven. Het sjabloon forest_map.qpt is
geplaatst in de map exercise_data\forestry\results\. Laad dat met behulp van het dialoogvenster
Project → Composer Manager....
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Open de printvormgeving en bewerk de uiteindelijke kaart om een resultaat te krijgen waarmee u tevreden bent.

Het kaartsjabloon dat u gebruikt zal een kaart geven soortgelijk aan deze:
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Sla uw project voor QGIS op voor toekomstige verwijzingen.
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14.9.4 In Conclusion

Door middel van deze module heeft u gezien hoe een basisinventarisatie van een bos kan worden gepland en
weergegeven met QGIS. Veel meer analyses voor bossen zijn mogelijk met de variëteit aan gereedschappen waar
u toegang toe heeft, maar hopelijk heeft deze handleiding u een goed startpunt gegeven om te ontdekken hoe u de
specifieke resultaten kunt bereiken die u nodig heeft.
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CHAPTER 15

Module: Concepten van databases met PostgreSQL

Relationele databases zijn een belangrijk onderdeel van elk GIS-systeem. In deze module zult u over concepten
van Relational Database Management System (RDBMS) leren en zult u PostgreSQL gebruiken om een nieuwe
database te maken om gegevens op te slaan, als ook leren over andere typische functies voor RDBMS.

15.1 Lesson: Introductie voor databases

Laten we, voordat we PostgreSQL gebruiken, onze basis vaststellen door algemene theorie over databases te
behandelen. U hoeft geen voorbeeldcode in te voeren; het is er alleen ter illustratie.

Het doel voor deze les: Fundamentele concepten voor databases begrijpen.

15.1.1 Wat is een database?

Een database bestaat uit een georganiseerde verzameling gegevens voor één of meer doeleinden, gewoonlijk in
digitale vorm. - Wikipedia

Een database management system (DBMS) bestaat uit software die werkt op databases, opslag, toegang, beveilig-
ing, back-up en andere faciliteiten verschaft. - Wikipedia

15.1.2 Tabellen

In relationele databases en platte databases, is een tabel een verzameling gegevenselementen (waarden) die is
georganiseerd met behulp van een model van verticale kolommen (die worden geïdentificeerd door hun naam) en
horizontale rijen. Een tabel heeft een gespecificeerd aantal kolommen, maar kunnen elk willekeurig aantal rijen
hebben. Elke rij wordt geïdentificeerd door de waarden die verschijnen in een bepaalde subset van kolommen die
wordt geïdentificeerd als een kandidaat-sleutel. - Wikipedia

id | name | age
----+-------+-----

1 | Tim | 20
2 | Horst | 88

(2 rows)

In databases van SQL staat een tabel ook bekend als een relatie.

15.1.3 Kolommen / Velden

Een kolom is een verzameling gegevenswaarden van een bepaald eenvoudig type, één voor elke rij van de tabel.
De kolommen verschaffen de structuur waarin de rijen overeenkomstig worden samengesteld. De term veld wordt
vaak uitwisselbaar gebruik met kolom, hoewel velen het meer correct vinden om veld (of veldwaarde) te gebruiken
om specifiek te verwijzen naar het enkele item dat bestaat op de kruising van één rij en één kolom. - Wikipedia
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Een kolom:

| name |
+-------+
| Tim |
| Horst |

Een veld:

| Horst |

15.1.4 Records

Een record is de informatie die is opgeslagen in een rij van een tabel. Elk record zal een veld hebben voor elk van
de kolommen in de tabel.

2 | Horst | 88 <-- one record

15.1.5 Datatypen

Datatypen beperken het soort informatie dat kan worden opgeslagen in een kolom. - Tim en Horst

er bestaan vele soorten datatypen. Laten we focussen op de meest voorkomende:

• String - om tekstgegevens in de vorm van vrije tekst op te slaan

• Integer - om gehele getallen op te slaan

• Real - om decimale getallen op te slaan

• Date - om de verjaardag van Horst op te slaan zodat niemand die vergeet

• Boolean - om eenvoudige waarden ja/nee op te slaan

U kunt de database vertellen om u ook toe te staan niets in een veld op te slaan. Als er niets in een veld staat, dan
wordt naar de veldinhoud verwezen als een ‘null’-waarde:

insert into person (age) values (40);

select * from person;

Resultaat:

id | name | age
----+-------+-----
1 | Tim | 20
2 | Horst | 88
4 | | 40 <-- null for name

(3 rows)

Er zijn nog veel meer datatypen die u kunt gebruiken - bekijk de handleiding van PostgreSQL!

15.1.6 Een adresdatabase modelleren

Laten we een eenvoudig geval bekijken om te zien hoe een database is opgebouwd. We willen een adresdatabase
maken.

388 Chapter 15. Module: Concepten van databases met PostgreSQL

http://www.postgresql.org/docs/current/static/datatype.html


QGIS Training Manual, Release 2.14

Try Yourself

Schrijf de eigenschappen op waaruit een eenvoudig adres bestaat en die we zouden willen opslaan in onze database.

Controleer uw resultaten

Structuur van een adres

De eigenschappen die een adres beschrijven zijn de kolommen. Het type informatie dat wordt opgeslagen in elke
kolom is het datatype. In het volgende gedeelte zullen we onze conceptuele adrestabel analyseren om te zien hoe
we het beter kunnen maken!

15.1.7 Database theorie

Het proces van het maken van een database omvat het maken van een model van de echte wereld; concepten uit
de echte wereld nemen en die in de database weer te geven als entiteiten.

15.1.8 Normalisatie

Eén van de belangrijkste ideeën in een database is om duplicatie / herhaling van gegevens te vermijden. Het proces
van het verwijderen van herhaling uit een database wordt Normalisatie genoemd.

Normalisatie is een systematische manier om er voor te zorgen dat een structuur van een database geschikt is
voor bevragingen van algemene aard en vrij van bepaalde ongewenste karakteristieken - afwijkingen bij invoegen,
bijwerken en verwijderen - die zouden kunnen leiden tot verlies van de integriteit van gegevens. - Wikipedia

Er bestaan verschillende ‘vormen’ van normalisatie.

Laten we eens naar een eenvoudig voorbeeld kijken:

Table "public.people"

Column | Type | Modifiers
----------+------------------------+-----------------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
| |

name | character varying(50) |
address | character varying(200) | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)

select * from people;

id | name | address | phone_no
--+---------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duester | 4 Avenue du Roix, Geneva | 072 121 122

(2 rows)

Veronderstel dat u veel vrienden heeft met dezelfde straatnaam of stad. Elke keer dat deze gegevens worden
gedupliceerd, nemen zij ruimte in. Erger nog, als een naam van een stad wijzigt, moet u veel werk uitvoeren om
uw database bij te werken.
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15.1.9 Try Yourself

Ontwerp de bovenstaande theoretische tabel people opnieuw om duplicatie te verminderen en de structuur van de
gegevens te normaliseren.

U kunt hier meer lezen over normalisatie van databases

Controleer uw resultaten

15.1.10 Indexen

Een index voor een database is een gegevensstructuur die de snelheid van bewerkingen voor het ophalen van
gegevens uit een databasetabel verhoogt. - Wikipedia

Veronderstel dat u een tekstboek aan het lezen bent en zoekt naar de uitleg over een concept - en dat het tekstboek
geen index heeft! U zult met lezen moeten beginnen bij het voorblad en u geheel door het boek moeten werken
totdat u de informatie vindt die u nodig heeft. De index aan het einde van het boek helpt u om snel naar de pagina
met de relevante informatie te springen:

create index person_name_idx on people (name);

Zoekacties op namen zullen nu sneller zijn:

Table "public.people"

Column | Type | Modifiers
----------+------------------------+-----------------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
| |

name | character varying(50) |
address | character varying(200) | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"person_name_idx" btree (name)

15.1.11 Reeksen

Een reeks is een generator voor unieke nummers. Het wordt normaal gesproken gebruikt om een unieke identifi-
catie te maken voor een kolom in een tabel.

In dit voorbeeld is id een reeks - het nummer wordt opgehoogd, elke keer als een record aan de tabel wordt
toegevoegd:

id | name | address | phone_no
---+--------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122

15.1.12 Entiteit Relaties Diagrammen

In een genormaliseerde database heeft u gewoonlijk vele relaties (tabellen). Het entiteit-relatie diagram (ER
Diagram) wordt gebruikt om de logische afhankelijkheden tussen de relaties te ontwerpen. Denk aan onze niet-
genormaliseerde tabel people eerder in deze les:
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select * from people;

id | name | address | phone_no
----+--------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122

(2 rows)

Met weinig werk kunnen we die splitsen in twee tabellen, waarbij we de noodzaak om de straatnaam te herhalen
voor mensen die in dezelfde straat wonen verwijderen:

select * from streets;

id | name
----+--------------
1 | Plein Street

(1 row)

en:

select * from people;

id | name | house_no | street_id | phone_no
----+--------------+----------+-----------+-------------

1 | Horst Duster | 4 | 1 | 072 121 122
(1 row)

We kunnen dan de twee tabellen koppelen met behulp van de ‘sleutels’ streets.id en
people.streets_id.

Als we een ER Diagram tekenen voor deze twee tabellen zou het er ongeveer zo uitzien:

Het ER Diagram helpt ons om ‘één tot veel’-relaties uit te drukken. In dit geval geeft het pijlsymbool aan dat in
één straat veel mensen zouden kunnen leven.

Try Yourself

Ons model people heeft nog steeds enige problemen met normalisatie - probeer eens of u het verder kunt nor-
maliseren en geef uw gedachten weer door middel van een ER Diagram.

Controleer uw resultaten

15.1.13 Beperkingen, Primaire sleutels en Vreemde sleutels

Een beperking voor een database wordt gebruikt om er voor te zorgen dat de gegevens in een relatie overeenkomt
met de weergave van het model over hoe die gegevens zouden moeten worden opgeslagen. Een beperking op uw
postcode zou er, bijvoorbeeld, voor kunnen zorgen dat de getallen vallen tussen 1000 en 9999.

Een Primaire sleutel zijn één of meer veldwaarden die een record uniek maken. Gewoonlijk wordt de primaire
sleutel id genoemd en is een reeks.

Een vreemde sleutel wordt gebruikt om te verwijzen naar een uniek record in een andere tabel (met behulp van de
primaire sleutel van de andere tabel).

In ER Diagrammen wordt de koppeling tussen tabellen gewoonlijk gebaseerd op het koppelen van Vreemde sleu-
tels aan Primaire sleutels.
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Als we naar ons voorbeeld people kijken geeft de definitie van de tabel weer dat de kolom street een vreemde
sleutel is die verwijst naar de primaire sleutel van de tabel streets:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+--------------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

15.1.14 Transacties

Bij het toevoegen, wijzigen of verwijderen van gegevens in een database, is het altijd belangrijk dat de database
in een goede status wordt achtergelaten als er iets fout gaat. De meeste databases verschaffen een mogelijkheid,
genaamd ondersteuning voor transacties. Transacties stellen u in staat om een positie vast te stellen voor het
terugdraaien waarnaar u kunt terugkeren als de aanpassingen aan de database niet gingen zoals was gepland.

Neem een scenario waar u een boekhoudsysteem heeft. U moet fondsen van de ene rekening transfereren en
toevoegen aan de andere rekening. De reeks stappen zou als volgt zijn:

• verwijder R20 van Joe

• voeg R20 toe aan Anne

Als er iets misgaat gedurende het proces (bijv. stroomuitval), zal de transactie worden teruggedraaid.

15.1.15 In Conclusion

Databases stellen u in staat gegevens op een gestructureerde manier te beheren met behulp van eenvoudige code-
structuren.

15.1.16 What’s Next?

Laten we, nu we hebben gekeken naar hoe databases in theorie werken, een nieuwe database maken om de theorie
die we hebben behandeld te implementeren.

15.2 Lesson: Het gegevensmodel implementeren

Nu we alle theorie hebben behandeld, laten we eens een nieuwe database maken. Deze database zal worden
gebruikt voor onze oefeningen voor de lessen die hierna volgen.

Het doel voor deze les: De vereiste software installeren en die gebruiken om onze voorbeelddatabase te imple-
menteren.

15.2.1 PostgreSQL installeren

Notitie: Hoewel het buiten het bereik van dit document ligt kunnen gebruikers van Mac PostgreSQL installeren
met behulp van Homebrew. Gebruikers van Windows kunnen het grafische installatieprogramma gebruiken dat
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zich hier bevindt: http://www.postgresql.org/download/windows/. Onthoud dat de documentatie er van uitgaat dat
gebruikers QGIS uitvoeren onder Ubuntu.

Onder Ubuntu:

sudo apt-get install postgresql-9.1

U zou een bericht als dit moeten krijgen:

[sudo] password for qgis:
Reading package lists... Done
Building dependency tree
Reading state information... Done
The following extra packages will be installed:
postgresql-client-9.1 postgresql-client-common postgresql-common
Suggested packages:
oidentd ident-server postgresql-doc-9.1
The following NEW packages will be installed:
postgresql-9.1 postgresql-client-9.1 postgresql-client-common postgresql-common
0 upgraded, 4 newly installed, 0 to remove and 5 not upgraded.
Need to get 5,012kB of archives.
After this operation, 19.0MB of additional disk space will be used.
Do you want to continue [Y/n]?

Druk op Y en Enter en wacht tot het downloaden en installeren is voltooid.

15.2.2 Hulp

PostgreSQL heeft hele goede online documentatie.

15.2.3 Een gebruiker voor de database aanmaken

Onder Ubuntu:

Als de installatie is voltooid, voer deze opdracht uit om de gebruiker postgres te worden en dan een nieuwe
gebruiker voor de database te maken:

sudo su - postgres

Type uw normale wachtwoord voor inloggen in als daar naar gevraagd wordt (u moet rechten hebben voor sudo).

Nu, bij de bash prompt van de gebruiker postgres, maak de gebruiker voor de database aan. Zorg er voor dat de
naam van de gebruiker overeenkomt met uw inlognaam voor unix : het zal uw leven veel eenvoudiger maken,
omdat Postgres u automatisch zal authenticeren wanneer u ingelogd bent als die gebruiker:

createuser -d -E -i -l -P -r -s qgis

Voer een wachtwoord in als daar naar gevraagd wordt. U zou een ander wachtwoord moeten gebruiken dan uw
wachtwoord om in te loggen.

Wat betekenen deze opties?

-d, --createdb role can create new databases
-E, --encrypted encrypt stored password
-i, --inherit role inherits privileges of roles it is a member of (default)
-l, --login role can login (default)
-P, --pwprompt assign a password to new role
-r, --createrole role can create new roles
-s, --superuser role will be superuser

Nu zou u de omgeving van de bash shell van de gebruiker Postgres moeten verlaten door te typen:
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exit

15.2.4 Het nieuwe account verifiëren

psql -l

Zou iets terug moeten geven als dit:

Name | Owner | Encoding | Collation | Ctype |
----------+----------+----------+------------+------------+
postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template0 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template1 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
(3 rows)

Typ q om af te sluiten.

15.2.5 Een database maken

De opdracht createdb wordt gebrukt om een nieuwe database te maken. Het zou moeten worden uitgevoerd
vanaf de bash shell prompt:

createdb address -O qgis

U kunt het bestaan van uw nieuwe database verifiëren met behulp van deze opdracht:

psql -l

Wat iets zoals dit zou moeten teruggeven:

Name | Owner | Encoding | Collation | Ctype | Access privileges
----------+----------+----------+------------+------------+-----------------------
address | qgis | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template0 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres: postgres=CTc/postgres
template1 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres: postgres=CTc/postgres
(4 rows)

Typ q om af te sluiten.

15.2.6 Een database shell-sessie beginnen

U kunt uw database eenvoudig verbinden door dit:

psql address

Verlaten van de psql database shell, typ:

\q

Voor hulp in het gebruiken van de shell, type:

\?

Voor hulp bij het gebruiken van SQL-opdrachten, typ:

\help

Hulp krijgen over een specifieke opdracht, typ (bijvoorbeeld):
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\help create table

Bekijk ook het Psql cheat sheet <http://www.postgresonline.com/downloads/special_feature/postgresql90_cheatsheet_A4.pdf>
- online beschikbaar ‘hier <http://www.postgresonline.com/downloads/special_feature/postgresql90_cheatsheet_A4.pdf‘_.

15.2.7 Tabellen in SQL maken

Laten we beginnen met het maken van enkele tabellen! We zullen ons ER Diagram als gids gebruiken. Verbind
eerst met de db address:

psql address

Maak dan een tabel streets:

create table streets (id serial not null primary key, name varchar(50));

serial en varchar zijn datatypen. serial vertelt PostgreSQL om een reeks van een geheel getal te starten
(automatisch nummeren) om id automatisch te vullen voor elk nieuw record. varchar(50) vertelt PostgreSQL
om een veld van 50 tekens in lengte te maken.

Het zal u opvallen dat elke opdracht eindigt met een ; - alle opdrachten voor SQL zouden op deze manier moeten
worden beëindigd. Wanneer u op Enter drukt, zal psql iets rapporteren als dit:

NOTICE: CREATE TABLE will create implicit sequence "streets_id_seq" for
serial column "streets.id"

NOTICE: CREATE TABLE / PRIMARY KEY will create implicit index "streets_pkey"
for table "streets"

CREATE TABLE

Dat betekent dat uw tabel met succes werd gemaakt, met een primaire sleutel streets_pkey met behulp van
streets.id.

Opmerking: Als u op Return drukte zonder een ; in te voeren, dan zult u een prompt zoals deze krijgen:
address-#. Dit omdat PG van u meer invoer verwacht. Voer ; in om uw opdracht uit te voeren.

U kunt dit doen om uw schema van de tabel te bekijken:

\d streets

Wat er ongeveer uit zou moeten zien zoals dit:

Table "public.streets"
Column | Type | Modifiers

--------+-----------------------+--------------------------------------
id | integer | not null default

| | nextval(’streets_id_seq’::regclass)
name | character varying(50) |

Indexes:
"streets_pkey" PRIMARY KEY, btree (id)

U kunt dit doen om de inhoud van uw tabel te bekijken:

select * from streets;

Wat er ongeveer uit zou moeten zien zoals dit:

id | name
---+------
(0 rows)

Zoals u kunt zien is onze tabel momenteel leeg.
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Try Yourself

Gebruik de hierboven weergegeven benadering om een tabel, genaamd people, te maken:

Voeg velden toe zoals telefoonnummer, adres, naam, etc. Zorg dat de velden een geldige veldnaam krijgen (geen
spaties). Geef de tabel een kolom ID met hetzelfde datatype als hierboven.

Controleer uw resultaten

15.2.8 Sleutels maken in SQL

Het probleem met onze oplossing hierboven is dat de database niet weet dat er een logische relatie bestaat tussen
people en streets. We moeten, om deze relatie aan te geven, een vreemde sleutel definiëren die verwijst naar de
primaire sleutel van de tabel streets.

Er zijn twee manieren om dat te doen:

• De sleutel toevoegen nadat de tabel is gemaakt

• De sleutel definiëren bij het maken van de tabel

Onze tabel is al gemaakt, dus doen we het op de eerste manier:

alter table people
add constraint people_streets_fk foreign key (street_id) references streets(id);

Dat vertelt de tabel people dat zijn velden street_id moeten overeenkomen met een geldige id voor street
uit de tabel streets.

De meest gebruikte manier om een beperking toe te voegen is om dat te doen wanneer u de tabel maakt:

create table people (id serial not null primary key,
name varchar(50),
house_no int not null,
street_id int references streets(id) not null,
phone_no varchar null);

\d people

Na het toevoegen van de beperking ziet ons schema voor de tabel er nu als volgt uit:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+---------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)

Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets(id)
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15.2.9 Indexen in SQL maken

We willen zoekacties met de snelheid van het licht op namen van mensen. We kunnen een index op de kolom
name van onze tabel people maken om dat mogelijk te maken.:

create index people_name_idx on people(name);

\d people

Wat resulteert in:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+-----------------------------------
id | integer | not null default nextval

| | (’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name) <-- new index added!

Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets(id)

15.2.10 Tabellen in SQL verwijderen

Als u een tabel wilt verwijderen kunt u gebruk maken van de opdracht drop:

drop table streets;

Notitie: In ons huidige voorbeeld zou de bovenstaande opdracht niet werken. Waarom niet? Bekijk waarom

Als u dezelfde opdracht drop table zou gebruiken op de tabel people, zou die met succes worden uitgevoerd:

drop table people;

Notitie: Als u echt die opdracht invoerde en de tabel people verwijderde, zou nu een goed moment zijn om
hem opnieuw te bouwen, omdat u het in de volgende oefeningen nodig heeft.

15.2.11 Een woord over pgAdmin III

SQL opdrachten van psql worden gebruikt omdat dit een goede manier is om te leren werken met databases. Er
zijn echter eenvoudigere en mogelijk snellere manieren om deze SQL opdrachten uit te voeren, bijvoorbeeld met
pgAdmin III. Dit is een grafische tool waarmee tabellen kunnen worden gemaakt, verwijderd en gewijzigd met
behulp van slepen en klikken.

Onder Ubuntu kunt u het op deze manier installeren:

sudo apt-get install pgadmin3

pgAdmin III zal meer detail worden behandeld in een andere module.

15.2.12 In Conclusion

U heeft nu gezien hoe u een nagelnieuwe database maakt, geheel vanaf niets beginnend.
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15.2.13 What’s Next?

Vervolgens zult u leren de DBMS te gebruiken om nieuwe gegevens toe te voegen.

15.3 Lesson: Gegevens aan het model toevoegen

De modellen die we hebben gemaakt moeten nu worden gevuld met de gegevens die zij geacht worden te bevatten.

Het doel voor deze les: Leren hoe nieuwe gegevens in de modellen van de database in te voeren.

15.3.1 Argument Insert

Hoe voegt u gegevens toe aan een tabel? Het argument voor SQL INSERT verschaft daar de functionaliteit voor:

insert into streets (name) values (’High street’);

Een anatal dingen om te onthouden:

• Na de naam van de tabel (streets), vermeldt u de kolomnamen die u wilt vullen (in dit geval alleen de
kolom name).

• Na het sleutelwoord values, plaats de lijst met veldwaarden.

• Strings zouden moeten worden omsloten door enkele aanhalingstekens.

• Onthoud dat we geen waarde hebben ingevuld voor de kolom id; dat is omdat het een reeks is en automa-
tisch wordt gegenereerd.

• Indien u de id handmatig instelt, kunt u ernstige problemen veroorzaken voor de integriteit van uw database.

U zou INSERT 0 1 moeten zien als het met succes is voltooid.

U kunt het resultaat van uw invoeractie zien door alle gegevens in de tabel te selecteren:

select * from streets;

Resultaat:

select * from streets;
id | name

----+-------------
1 | High street

(1 row)

Try Yourself

Gebruik de opdracht INSERT om een nieuwe straat in te voeren in de tabel streets.

Controleer uw resultaten

15.3.2 Toevoegen van gegevens in overeenstemming met beperkingen

15.3.3 Try Yourself

probeer een object persoon toe te voegen aan de tabel people met de volgende details:
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Name: Joe Smith
House Number: 55
Street: Main Street
Phone: 072 882 33 21

Notitie: Onthoud dat we in dit voorbeeld telefoonnummers hebben gedefinieerd als strings, niet als integers.

Op dit punt zou u een foutbericht moeten krijgen als u dit probeert te doen zonder eerst een record voor Main
Street te hebben gemaakt in de tabel streets.

U zou ook moeten hebben opgemerkt dat:

• U kunt de straat niet toevoegen met behulp van zijn naam

• U kunt geen straat toevoegen met behulp van een id voor de straat zonder eerst het record voor de straat te
hebben gemaakt in de tabel streets

Onthoud dat onze twee tabellen zijn gekoppeld via een paar Primaire/Vreemde sleutel. Dit betekent dat geen
geldige persoon kan worden gemaakt zonder dat er ook een geldig overeenkomend record is voor de straat.

Voeg, met behulp van bovenstaande kennis, de nieuwe persoon toe aan de database.

Controleer uw resultaten

15.3.4 Gegevens selecteren

We hebben u de syntaxis voor het selecteren van records al laten zien. Laten we eens naar nog een aantal voor-
beelden kijken:

select name from streets;

select * from streets;

select * from streets where name=’Main Road’;

In latere gedeelten zullen we meer in detail ingaan op hoe gegevens te selecteren en te filteren.

15.3.5 Gegevens bijwerken

Wat als u een wijziging wilt maken in enkele bestaande gegevens? Bijvoorbeeld: een straatnaam is gewijzigd:

update streets set name=’New Main Road’ where name=’Main Road’;

Wees zeer voorzichtig met het gebruiken van dergelijke argumenten voor bijwerken - als meer dan één record
overeenkomt met uw clausule WHERE, zullen zij allemaal worden bijgewerkt!

Een betere oplossing is om de primaire sleutel van de tabel te gebruiken om te verwijzen naar het record dat moet
worden gewijzigd:

update streets set name=’New Main Road’ where id=2;

Het zou terug moeten geven UPDATE 1.

Notitie: de criteria voor het argument WHERE zijn hoofdlettergevoelig Main Road is niet hetzelfde als Main
road

15.3.6 Gegevens verwijderen

Gebruik de opdracht DELETE om een object uit een tabel te verwijderen:
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delete from people where name = ’Joe Smith’;

Laten we nu eens naar onze tabel people kijken:

address=# select * from people;

id | name | house_no | street_id | phone_no
----+------+----------+-----------+----------

(0 rows)

15.3.7 Try Yourself

Gebruik de vaardigheden die u heeft geleerd om enkele nieuwe vrienden aan uw database toe te voegen:

name | house_no | street_id | phone_no
-----------------+----------+-----------+--------------
Joe Bloggs | 3 | 2 | 072 887 23 45
Jane Smith | 55 | 3 | 072 837 33 35
Roger Jones | 33 | 1 | 072 832 31 38
Sally Norman | 83 | 1 | 072 932 31 32

15.3.8 In Conclusion

Nu weet u hoe u nieuwe gegevens moet toevoegen aan de bestaande modellen die u eerder heeft gemaakt. Onthoud
dat als u nieuwe soorten gegevens wilt toevoegen, u misschien moet aanpassen en/of nieuwe modellen moet maken
om die gegevens te kunnen bevatten.

15.3.9 What’s Next?

Nu dat u enkele gegevens heeft toegevoegd, zult u leren hoe u query’s gebruikt om op verschillende manieren
toegang te krijgen tot deze gegevens.

15.4 Lesson: Query’s

Wanneer u een opdracht SELECT ... schrijft staat die algemeen bekend als een query - u bevraagt de database
op informatie.

Het doel voor deze les: Query’s die bruikbare informatie teruggeven leren maken.

Notitie: Als u dat al niet deed in de vorige les, voeg de volgende objecten persoon toe aan uw tabel people.
Als u foutberichten krijgt gerelateerd aan beperkingen voor vreemde sleutels, zult u eerst het object ‘Main Road’
moeten toevoegen aan uw tabel streets

insert into people (name,house_no, street_id, phone_no)
values (’Joe Bloggs’,3,2,’072 887 23 45’);

insert into people (name,house_no, street_id, phone_no)
values (’Jane Smith’,55,3,’072 837 33 35’);

insert into people (name,house_no, street_id, phone_no)
values (’Roger Jones’,33,1,’072 832 31 38’);

insert into people (name,house_no, street_id, phone_no)
values (’Sally Norman’,83,1,’072 932 31 32’);
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15.4.1 Resultaten ordenen

Laten we een lijst van mensen ophalen, gesorteerd op hun huisnummers:

select name, house_no from people order by house_no;

Resultaat:

name | house_no
--------------+----------
Joe Bloggs | 3
Roger Jones | 33
Jane Smith | 55
Sally Norman | 83

(4 rows)

U kunt de resultaten sorteren op de waarden van meer dan één kolom:

select name, house_no from people order by name, house_no;

Resultaat:

name | house_no
--------------+----------
Jane Smith | 55
Joe Bloggs | 3
Roger Jones | 33
Sally Norman | 83

(4 rows)

15.4.2 Filteren

Vaak zult u niet elk afzonderlijk record in de database willen zien - in het bijzonder als er duizenden records zijn
en u alleen geïnteresseerd bent in het bekijken van één of twee.

Hier is een voorbeeld van een numeriek filter wat alleen objecten teruggeeft waarvan het house_no kleiner is
dan 50:

select name, house_no from people where house_no < 50;

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

U kunt filters combineren (gedefinieerd met behulp van de clausule WHERE) met sorteren (gedefinieerd met behulp
van de clausule ORDER BY):

select name, house_no from people where house_no < 50 order by house_no;

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

U kunt ook filteren gebaseerd op tekstgegevens:

select name, house_no from people where name like ’%s%’;

name | house_no
-------------+----------
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Joe Bloggs | 3
Roger Jones | 33
(2 rows)

Hier hebben we de clausule LIKE gebruikt om alle namen met een s erin te vinden. Het zal u zijn opgevallen dat
deze query hoofdlettergevoelig is, dus is het item Sally Norman niet vermeld.

Als u wilt zoeken naar een tekenreeks van letters, ongeacht hoofd- of kleine letters, kunt u een zoekactie uitvoeren
die niet hoofdlettergevoelig is met behulp van de clausule ILIKE:

select name, house_no from people where name ilike ’%r%’;

name | house_no
--------------+----------
Roger Jones | 33
Sally Norman | 83
(2 rows)

Die query gaf elk object uit people terug met een r of R in hun naam.

15.4.3 Samenvoegingen (joins)

Wat als u de details van personen en hun straatnaam wilt zien in plaats van de ID? U dient de twee tabellen samen
te voegen in één enkele query om dat te kunnen doen. Laten we eens naar een voorbeeld kijken:

select people.name, house_no, streets.name
from people,streets
where people.street_id=streets.id;

Notitie: Met samenvoegingen (joins) worden twee of meer tabellen of views samengevoegd, in dit geval de
tabellen people en streets. Er dient te worden gespecificeerd welke velden overeen moeten komen (vreemde
sleutel & primaire sleutel). Indien deze velden niet worden gespecificeerd worden alle velden van de tabellen
onderling gecombineerd. Dit resulteert in alle mogelijke combinaties van mensen en straten, maar geeft geen
antwoord op de vraag wie in welke straat woont.

Hier is hoe de juiste uitvoer eruit zal zien:

name | house_no | name
--------------+----------+-------------
Joe Bloggs | 3 | Low Street
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road

(4 rows)

We zullen samenvoegingen (joins) opnieuw tegenkomen als we later meer complexe query’s maken. Onthoud
alleen dat zij een eenvoudige manier bieden om de informatie uit twee of meer tabellen te combineren.

15.4.4 Sub-Select

Sub-selecties stellen u in staat objecten te selecteren uit één tabel, gebaseerd op de gegevens uit een andere tabel
die is gekoppeld met een relatie vreemde sleutel. In ons geval willen we mensen vinden die in een specifieke straat
wonen.

Laten we eerst onze gegevens iets aanpassen:

insert into streets (name) values(’QGIS Road’);
insert into streets (name) values(’OGR Corner’);
insert into streets (name) values(’Goodle Square’);
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update people set street_id = 2 where id=2;
update people set street_id = 3 where id=3;

Laten we even snel kijken naar onze gegevens na deze wijzigingen: we kunnen onze query uit het eerdere gedeelte
opnieuw gebruiken:

select people.name, house_no, streets.name
from people,streets
where people.street_id=streets.id;

Resultaat:

name | house_no | name
--------------+----------+-------------
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road
Joe Bloggs | 3 | Low Street

(4 rows)

Nu willen we u een sub-selectie van deze gegevens laten zien. We willen alleen de mensen laten zien die wonen
in street_id nummer 1:

select people.name
from people, (

select *
from streets
where id=1

) as streets_subset
where people.street_id = streets_subset.id;

Resultaat:

name
--------------
Roger Jones
Sally Norman

(2 rows)

Hoewel dit een zeer eenvoudig voorbeeld is en onnodig met onze kleine sets met gegevens, illustreert het hoe
bruikbaar en belangrijk sub-selecties kunnen zijn bij het bevragen van grote en complexe sets met gegevens.

15.4.5 Samenvattende query’s

Eén van de krachtige mogelijkheden van een database is zijn mogelijkheid om de gegevens in zijn tabellen samen
te vatten. Deze samenvattingen worden aggregate queries genoemd. Hier is a typisch voorbeeld wat u vertelt
hoeveel objecten people er in uw tabel people staan:

select count(*) from people;

Resultaat:

count
-------

4
(1 row)

Als we de tellingen willen samenvatten op straatnaam kunnen we dit doen:

select count(name), street_id
from people
group by street_id;

Resultaat:
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count | street_id
-------+-----------

2 | 1
1 | 3
1 | 2

(3 rows)

Notitie: Omdat we geen clausule ORDER BY hebben gebruikt, zou de volgorde van uw resultaten niet overeen
hoeven komen met wat hier is weergegeven.

Try Yourself

Samenvatten van de personen op straatnaam en de feitelijke straatnamen laten zien in plaats van de street_id’s.

Controleer uw resultaten

15.4.6 In Conclusion

U heeft gezien hoe u query’s kunt gebruiken om de gegevens in uw database terug te geven op een manier die u in
staat stelt daaruit bruikbare informatie te halen.

15.4.7 What’s Next?

Vervolgens zult u zien hoe u weergaven kunt maken uit de query’s die u heeft geschreven.

15.5 Lesson: Weergaven

Wanneer u een query schrijft, spendeert u veel tijd en moeite om die te formuleren. Met weergaven kunt u de
definitie van een query in SQL opslaan in een opnieuw te gebruiken ‘virtuele tabel’.

Het doel voor deze les: Een query al een weergave op te slaan.

15.5.1 Een weergave maken

U kunt een weergave net zo behandelen als een tabel, maar de gegevens ervan vinden hun oorsprong in een query.
Laten we, gebaseerd op bovenstaande, een eenvoudige weergave maken:

create view roads_count_v as
select count(people.name), streets.name
from people, streets where people.street_id=streets.id
group by people.street_id, streets.name;

Zoals u kunt zien is het enige dat veranderd is het gedeelte create view roads_count_v as aan het
begin. We kunnen nu gegevens uit die weergave selecteren:

select * from roads_count_v;

Resultaat:

count | name
-------+-------------

1 | Main Road
2 | High street
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1 | Low Street
(3 rows)

15.5.2 Een weergave aanpassen

Een weergave staat niet vast en bevat geen ‘echte gegevens’. Dit betekent dat u hem eenvoudig kunt wijzigen
zonder dat dat enige impact heeft op de gegevens in uw database:

CREATE OR REPLACE VIEW roads_count_v AS
SELECT count(people.name), streets.name
FROM people, streets WHERE people.street_id=streets.id
GROUP BY people.street_id, streets.name
ORDER BY streets.name;

(Dit voorbeeld toont ook de best practice conventie voor het gebruiken van UPPER CASE voor alle sleutelwoorden
van SQL.)

U zult zien dat we een clausule ORDER BY hebben toegevoegd zodat de rijen van onze weergave netjes zijn
gesorteerd:

select * from roads_count_v;

count | name
-------+-------------

2 | High street
1 | Low Street
1 | Main Road

(3 rows)

15.5.3 Een weergave verwijderen

Als u een weergave niet langer nodig heeft, kunt u die op deze manier verwijderen:

drop view roads_count_v;

15.5.4 In Conclusion

Met behulp van weergave kunt u een query opslaan en toegang krijgen tot de resultaten daravan, als was het een
tabel.

15.5.5 What’s Next?

Soms, bij het wijzigen van gegevens, wilt u dat uw wijzigingen ook ergens anders in de database effect hebben.
De volgende les zal u tonen doe dat te doen.

15.6 Lesson: Regels

Regels maken het mogelijk de “queryboom” van een inkomende query te herschrijven. Een veel voorkomend
gebruik is om weergaven te implementeren, inclusief een bij te werken weergave. - Wikipedia

Het doel voor deze les:: Leren nieuwe regels voor de database te maken.
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15.6.1 Gematerialiseerde weergaven (Op regels gebaseerde weergaven)

Stel dat u elke wijziging van phone_no in uw tabel people wilt loggen in een tabel people_log. Dus maakt u een
nieuwe tabel:

create table people_log (name text, time timestamp default NOW());

Maak, in de volgende stap, een regel die elke wijziging van een telefoonnummer in de tabel people in de tabel
people_log logt:

create rule people_log as on update to people
where NEW.phone_no <> OLD.phone_no
do insert into people_log values (OLD.name);

Laten we een telefoonnummer aanpassen om te testen of de regel werkt:

update people set phone_no = ’082 555 1234’ where id = 2;

Controleer of de tabel people juist werd bijgewerkt:

select * from people where id=2;

id | name | house_no | street_id | phone_no
----+------------+----------+-----------+--------------

2 | Joe Bloggs | 3 | 2 | 082 555 1234
(1 row)

Dankzij de regel die we hebben gemaakt, zal de tabel people_log er nu zo uitzien:

select * from people_log;

name | time
------------+----------------------------
Joe Bloggs | 2014-01-11 14:15:11.953141

(1 row)

Notitie: De waarde van het veld time is afhankelijk van de huidige datum en tijd.

15.6.2 In Conclusion

Regels stellen u in staat automatisch gegevens toe te voegen of te wijzigen in uw database om wijzigingen in
andere delen van de database weer te geven.

15.6.3 What’s Next?

De volgende module brengt u naar het gebruiken van de Ruimtelijke database met behulp van PostGIS, wat deze
concepten overneemt en die toepast op gegevens voor GIS.
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CHAPTER 16

Module: Concepten van een ruimtelijke database met PostGIS

Ruimtelijke databases maken het opslaan van de geometrieën van records in een database mogelijk, als ook het
verschaffen van functionaliteit voor het bevragen en ophalen van de records met behulp van die geometrieën. In
deze module zullen we PostGIS gebruiken, een uitbreiding voor PostgreSQL, om te leren hoe een ruimtelijke
database in te stellen, gegevens importeren vanuit shapefiles in de database en gebruikmaken van de geografische
functies die PostGIS biedt.

Gedurende het werken in dit gedeelte wilt u misschien een kopie hebben van het PostGIS spiekblad beschikbaar
vanaf de Boston GIS gebruikersgroep. Een andere bruikbare bron is de online documentatie van PostGIS.

Er zijn ook enkele meer uitgebreide handleidingen over PostGIS en ruimtelijke databases beschikbaar vanaf
Boundless Geo:

• Introduction to PostGIS

• Spatial Database Tips and Tricks

Zie ook PostGIS online.

16.1 Lesson: Instellen van PostGIS

Instellen van functies voor PostGIS zal u in staat stellen toegang te verkrijgen tot ruimtelijke functies binnen
PostgreSQL.

Het doel voor deze les: Ruimtelijke functies installeren en in het kort hun effecten demonstreren.

Notitie: We gaan er van uit dat we voor deze oefening PostGIS versie 2.1 gebruiken. De installatie en configuratie
van de database zijn anders voor oudere versies, maar de rest van dit materiaal in deze module zal nog steeds
werken. Consulteer de documentatie voor uw platform voor hulp bij de installatie en de configuratie van de
database.

16.1.1 Installeren onder Ubuntu

Postgis wordt eenvoudig geïnstalleerd vanuit apt.

$ sudo apt-get install postgis
$ sudo apt-get install postgresql-9.1-postgis

Echt, zo eenvoudig is dat...

Notitie: Afhankelijk van welke versie van Ubuntu u gebruikt en welke afhankelijkheden u heeft geconfigureerd,
zullen deze opdrachten PostGIS 1.5, of 2.x installeren. U kunt de geïnstalleerde versie zoeken door een query
select PostGIS_full_version(); uit te voeren met psql of een ander gereedschap.

U kunt de volgende opdrachten gebruiken om de absoluut laatste versie van PostGIS te installeren.
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$ sudo apt-add-repository ppa:sharpie/for-science
$ sudo apt-add-repository ppa:sharpie/postgis-nightly
$ sudo apt-get update
$ sudo apt-get install postgresql-9.1-postgis-nightly

16.1.2 Installeren onder Windows

Installeren op Windows is iets meer gecompliceerd, maar nog steeds niet moeilijk. Onthoud dat u online moet zijn
om de opgeslagen Postgis te installeren.

Bezoek eerst de downloadpagina.

Volg dan deze gids.

Meer informatie over het installeren op Windows kan worden gevonden op de website van PostGIS.

16.1.3 Installeren op andere platformen

De PostGIS website bevat informatie over de installatie op andere besturingssystemen en platformen waaronder
MacOSX en linux distributies.

16.1.4 Databases configureren om PostGIS te gebruiken

Als PostGIS eenmaal is geïnstalleerd, zult u uw database moeten configureren om de extensies te gebruiken. Als
u PostGIS versie > 2.0 heeft geïnstalleerd, is dit zo simpel als de volgende opdracht met psql uit te voeren met
behulp van de adresdatabase uit onze vorige oefening.

$ psql -d address -c "CREATE EXTENSION postgis;"

Notitie: Als u PostGIS 1.5 gebruikt en een versie van PostgreSQL lager dan 9.1, zult u een andere reeks stap-
pen moeten volgen om de extensies van Postgis te installeren voor uw database. Consulteer de documentatie
voor PostGIS voor instructies over hoe dit te doen. Er zijn ook enkele instructies in de vorige versie van deze
handleiding.

16.1.5 Kijken naar de geïnstalleerde functies van PostGIS

Aan PostGIS kan worden gedacht als aan een collectie van functies binnen de database die de bronmogelijkheden
van PostgreSQL uitbreiden zodat het ruimtelijke gegevens kan afhandelen. Met ‘afhandelen’ bedoelen we opslaan,
ophalen, bevragen en bewerken. Een aantal functies worden in de database geïnstalleerd om dit te kunnen doen.

Onze PostgreSQL database address is nu geo-ruimtelijk ingeschakeld, dankzij PostGIS. We gaan hier in de
komende gedeelten een stuk dieper op in, maar laten we u een klein voorproefje geven. Laten we zeggen dat we
een punt uit tekst willen maken. Eerst gebruiken we de opdracht voor psql om functies te zoeken in relatie tot
punten. Als u nog niet verbonden bent met de database address, doe dat dan nu. Voer dan uit:

\df *point*

Dit is de opdracht waar we naar zoeken: st_pointfromtext. Gebruik de pijl naar beneden om door de lijst
te gaan en druk op q om terug te gaan naar de shell van psql.

Probeer deze opdracht uit te voeren:

select st_pointfromtext(’POINT(1 1)’);

Resultaat:
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st_pointfromtext
--------------------------------------------
0101000000000000000000F03F000000000000F03F
(1 row)

Drie dingen om te onthouden:

• We definieerden een punt op de positie 1,1 (we gaan uit van EPSG:4326) met behulp van POINT(1 1),

• We voerden een argument van sql uit, maar niet op een tabel, alleen maar op gegevens ingevoerd vanuit de
SQL-prompt,

• De resulterende rij heeft weinig betekenis.

De resulterende rij is in de indeling OGC, genaamd ‘Well Known Binary’ (WKB). We zullen in het volgende
gedeelte in detail naar deze indeling kijken.

We kunnen een snelle scan doen door de functielijst naar iets dat tekst teruggeeft om de resultaten als tekst terug
te krijgen:

\df *text

De query waar we nu naar zoeken is st_astext. Laten we die combineren met de vorige query:

select st_astext(st_pointfromtext(’POINT(1 1)’));

Resultaat:

st_astext
------------

POINT(1 1)
(1 row)

Hier voerden we de tekenreeks POINT(1,1) in, maakten daar een punt van met behulp van
st_pointfromtext(), en maakten er weer een door mensen te lezen vorm van met st_astext(), wat
ons onze originele tekenreeks teruggaf.

Een laatste voorbeeld voor we echt naar de details gaan van het gebruiken van PostGIS:

select st_astext(st_buffer(st_pointfromtext(’POINT(1 1)’),1.0));

Wat deed dat? Het maakte een buffer van 1 graad rondom ons punt, en gaf het resultaat als tekst terug.

16.1.6 Ruimtelijke referentiesystemen

In aanvulling op de functies van PostGIS, bevat de extensie een verzameling definities voor ruimtelijke referen-
tiesystemen (SRS) zoals gedefinieerd door de European Petroleum Survey Group (EPSG). Deze worden gebruikt
tijdens bewerkingen zoals conversies van coördinaten referentiesystemen (CRS).

We kunnen deze definities voor SRS inspecteren in onze database omdat zij zijn opgeslagen in normale
databasetabellen.

Laten we eerst eens kijken naar het schema van de tabel door de volgende opdracht in te voeren bij de psql prompt:

\d spatial_ref_sys

Het resultaat zou dit moeten zijn:

Table "public.spatial_ref_sys"
Column | Type | Modifiers

-----------+-------------------------+-----------
srid | integer | not null
auth_name | character varying(256) |
auth_srid | integer |
srtext | character varying(2048) |
proj4text | character varying(2048) |
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Indexes:
"spatial_ref_sys_pkey" PRIMARY KEY, btree (srid)

U kunt standaard SQL-queries gebruiken (zoals we hebben geleerd uit onze gedeelten ter introductie), om deze
tabel t ebekijken en te bewerken - hoewel het geen goed idee is om records te bewerken of te verwijderen, tenzij
u weet waar u mee bezig bent.

Eén SRID waarin u misschien geïnteresseerd bent is EPSG:4326 - het geografische / lat lon referentiesysteem dat
de ellipsoïde WGS 84 gebruikt. Laten we er eens naar kijken:

select * from spatial_ref_sys where srid=4326;

Resultaat:

srid | 4326
auth_name | EPSG
auth_srid | 4326
srtext | GEOGCS["WGS 84",DATUM["WGS_1984",SPHEROID["WGS
84",6378137,298.257223563,AUTHORITY["EPSG","7030"]],TOWGS84[0,
0,0,0,0,0,0],AUTHORITY["EPSG","6326"]],PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],UNIT["degree",0.01745329251994328,
AUTHORITY["EPSG","9122"]],AUTHORITY["EPSG","4326"]]
proj4text | +proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs

De srtext is de definitie van de projectie in well known text (u zou dit kunnen herkennen van de bestanden .prj
in uw verzameling shapefiles).

16.1.7 In Conclusion

U heeft nu functies van PostGIS geïnstalleerd in uw kopie van PostgreSQL. Hiermee bent u in staat gebruik te
maken van de uitgebreide ruimtelijke functies van PostGIS.

16.1.8 What’s Next?

Vervolgens zult u leren hoe ruimtelijke objecten worden weergegeven in een database.

16.2 Lesson: Eenvoudig object model

Hoe kunnen we geografische objecten in een database opslaan en weergeven? In deze les zullen we één benadering
behandelen, het Eenvoudige object model zoals dat is gedefinieerd door de OGC.

Het doel voor deze les: Leren wat het Eenvoudig object model is en hoe het te gebruiken.

16.2.1 Wat is OGC?

Het Open Geospatial Consortium (OGC), een internationale organisatie voor standaarden onder vrijwillige con-
sensus, werd opgericht in 1994. In de OGC werken meer dan 370+ commerciële, overheids-, non-profit- en
onderzoeksorganisaties wereldwijd samen in een proces voor open consensus voor het aanmoedigen van de on-
twikkeling en implementatie van standaarden voor georuimtelijke inhoud en services, het verwerken van gegevens
voor GIS en het delen van gegevens. - Wikipedia

16.2.2 Wat is het SFS-model (Eenvoudig object model)

Het Simple Feature voor SQL (SFS) Model is een niet-topologische manier om georuimtelijke gegevens op te slaan
in een database en definieert functies vooe toegang tot, het bewerken van en het construeren van deze gegevens.
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Het model definieert georuimtelijke gegevens vanuit typen Punt, Lijn en Polygoon (en samenvoegingen daarvan
naar Multi-objecten).

Kijk, voor meer informatie, eens naar de OGC Simple Feature for SQL standaard.

16.2.3 Een veld voor geometrie aan een tabel toevoegen

Laten we een veld point aan onze tabel people toevoegen:

alter table people add column the_geom geometry;

16.2.4 Een beperking, gebaseerd op een type geometrie, toevoegen

U zult opmerken dat het veldtype geometrie niet impliciet het type geometrie voor het veld specificeert - daarvoor
hebben we een beperking (constraint) nodig:

alter table people
add constraint people_geom_point_chk

check(st_geometrytype(the_geom) = ’ST_Point’::text OR the_geom IS NULL);

Dit voegt een beperking aan de tabel toe zodat die alleen een geometrie punt of een waarde null accepteert.

16.2.5 Try Yourself

Maak een nieuwe tabel, genaamd cities, en geef die enkele toepasselijke kolommen, inclusief een veld voor
geometrie voor het opslaan van polygonen (de stadsgrenzen). Zorg er voor dat het een beperking heeft die maakt
dat de geometrieën polygonen zijn.

Controleer uw resultaten

16.2.6 Tabel geometry_columns vullen

Op dit punt zou u ook een item aan de tabel geometry_columns moeten toevoegen:
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insert into geometry_columns values
(’’,’public’,’people’,’the_geom’,2,4326,’POINT’);

Waarom? geometry_columns wordt door bepaalde toepassingen gebruikt om bij te houden welke tabellen in
de database gegevens met geometrie bevatten.

Notitie: Als het bovenstaande argument INSERT een fout veroorzaakt, voer dan eerst deze query uit:

select * from geometry_columns;

If the column :kbd:‘f_table_name‘ contains the value :kbd:‘people‘, then
this table has already been registered and you don’t need to do anything
more.

De waarde 2 verwijst naar het aantal dimensies; in dit geval twee: X en Y.

De waarde 4326 verwijst naar de projectie die we gebruiken; in dit geval WGS 84, waarnaar wordt verwezen
door het getal 4326 (bekijk de eerdere bespreking van EPSG).

Try Yourself

Voeg een toepasselijk item voor geometry_columns in voor uw nieuwe laag cities

Controleer uw resultaten

16.2.7 Record met geometrie toevoegen aan tabel met behulp van SQL

Nu onze tabellen ingeschakeld zijn voor geometrie, kunnen we er geometrieën in opslaan:

insert into people (name,house_no, street_id, phone_no, the_geom)
values (’Fault Towers’,

34,
3,
’072 812 31 28’,
’SRID=4326;POINT(33 -33)’);

Notitie: In het nieuwe item hierboven zult u moeten specificeren welke projectie (SRID) u wilt gebruiken. Dit
omdat u de geometrie van het nieuwe punt invoert met behulp van een gewone tekenreeks van tekst, wat niet
automatisch de juiste informatie over de projectie toevoegt. Uiteraard dient het nieuwe punt hetzelfde SRID te
gebruiken als de gegevensset waaraan het wordt toegevoegd, dus u moet het specificeren.

Als u op dit punt een grafische interface zou gebruiken, zou, bijvoorbeeld, het specificeren van de projectie voor
elk punt automatisch gebeuren. Met andere woorden: u hoeft zich gewoonlijk geen zorgen te maken over het
gebruiken van de juiste projectie voor elk punt dat u wilt toevoegen als u het al voor die gegevensset heeft gespeci-
ficeerd, zoals wij eerder al deden.

Nu is het waarschijnlijk een goed moment om QGIS te openen en te proberen uw tabel people te bekijken. Ook
zouden we moeten proberen records te bewerken / toe te voegen / te verwijderen en dan query’s SELECT op de
database uitvoeren om te zien hoe de gegevens zijn gewijzigd.

Een laag van PostGIS laden in QGIS, gebruik de menuoptie Laag → PostGIS-laag toevoegen of de knop op de
werkbalk:

Dit zal het dialoogvenster openen:
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Klik op de knop Nieuw om dit dialoogvenster te openen:
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Definieer dan een nieuwe verbinding, bijv.:

Name: myPG
Service:
Host: localhost
Port: 5432
Database: address
User:
Password:

Klik op Test verbinding om te zien of QGIS de database address heeft gevonden en of uw gebruikersnaam en
wachtwoord juist zijn. Als het werkt, selecteer dan de vakken naast Gebruikersnaam opslaan en Wachtwoord
opslaan. Klik dan op OK om deze verbinding te maken.
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Terug in het dialoogvenster PostGIS-tabel(len) toevoegen, klik op Verbinden en voeg de lagen zoals gewoonlijk
toe aan uw project.

Try Yourself

Formuleer een query die de naam, straatnaam en positie (vanuit de kolom the_geom) weergeeft als gewone tekst.

Controleer uw resultaten

16.2.8 In Conclusion

U heeft gezien hoe u ruimtelijke objecten toevoegt aan uw database en ze bekijkt in GIS-software.

16.2.9 What’s Next?

Vervolgens zult u zien hoe u gegevens importeert naar en exporteert vanuit uw database.

16.3 Lesson: Importeren en exporteren

Natuurlijk zou een database zonder eenvoudige manier voor het in en uit migreren van gegevens niet van veel nut
zijn. Gelukkig zijn er een aantal gereedschappen die u gegevens eenvoudig in en uit PostGIS laten verplaatsen.

16.3.1 shp2pgsql

shp2pgsql is een gereedschap voor de opdrachtregel om ESRI-shapefiles in de database te importeren. Onder Unix
kunt u de volgende opdracht gebruiken voor het importeren van een nieuwe tabel van PostGIS:

shp2pgsql -s <SRID> -c -D -I <path to shapefile> <schema>.<table> | \
psql -d <databasename> -h <hostname> -U <username>

Onder Windows dient u het proces van importeren in twee stappen uit te voeren:

shp2pgsql -s <SRID> -c -D -I <path to shapefile> <schema>.<table> > import.sql
psql psql -d <databasename> -h <hostname> -U <username> -f import.sql

U zou deze fout kunnen tegenkomen:

ERROR: operator class "gist_geometry_ops" does not exist for access method
"gist"

Dit is een bekend probleem met betrekking tot het in situ maken van een ruimtelijke index voor de gegevens
die u importeert. Sluit de parameter -I uit om deze fout te vermijden. Dit zal betekenen dat er niet direct een
ruimtelijke index wordt gemaakt, en u zult die in de database moeten maken nadat de gegevens zijn geïmporteerd.
(Het maken van een ruimtelijke index zal worden behandeld in de volgende les.)

16.3.2 pgsql2shp

pgsql2shp is een programma voor de opdrachtregel om tabellen, weergaven of SQL SELECT-query’s vanuit Post-
GIS te exporteren. Dit doen onder Unix:

pgsql2shp -f <path to new shapefile> -g <geometry column name> \
-h <hostname> -U <username> <databasename> <table | view>

De gegevens exporteren met behulp van een query:

16.3. Lesson: Importeren en exporteren 415



QGIS Training Manual, Release 2.14

pgsql2shp -f <path to new shapefile> -g <geometry column name> \
-h <hostname> -U <username> "<query>"

16.3.3 ogr2ogr

ogr2ogr is een zeer krachtig gereedschap om gegevens naar en vanuit PostGIS te converteren in vele indelingen.
ogr2ogr is deel van de software van GDAL/OGR en moet afzonderlijk worden geïnstalleerd. U kunt deze opdracht
gebruiken om een tabel vanuit PostGIS naar GML te exporteren:

ogr2ogr -f GML export.gml PG:’dbname=<databasename> user=<username>
host=<hostname>’ <Name of PostGIS-Table>

16.3.4 SPIT

SPIT is een plug-in voor QGIS die wordt geleverd met QGIS. U kunt SPIT gebruiken voor het uploaden van
ESRI-shapefiles naar PostGIS.

Zoek naar deze knop als u eenmaal de plug-in SPIT hebt toegevoegd via Plug-ins beheren en installeren:

Klikken erop of selecteren Database –> Spit –> Importeer Shapefiles in PostgreSQL uit het menu zal u het
dialoogvenster van SPIT geven:
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U kunt shapefiles aan de database toevoegen door te klikken op de knop Toevoegen, die u een venster voor be-
standsbeheer zal geven.

16.3.5 DB Manager

U heeft misschien een ander optie opgemerkt in het menu Database gelabeld DB Manager. Dat is een nieuw
gereedschap in QGIS 2.0 dat een eenduidige interface verschaft voor het werken met ruimtelijke databases in-
clusief PostGIS. Het stelt u ook in staat om vanuit databases naar andere indelingen te importeren en exporteren.
Omdat de volgende module voor een groot deel is toegespitst op dit gereedschap, zullen we het hier slechts kort
vermelden.

16.3.6 In Conclusion

Importeren en exporteren van gegevens naar en vanuit de database kan op vele verschillende manieren worden
gedaan. In het bijzonder bij het gebruiken van verscheidene gegevensbronnen, zult u waarschijnlijk deze functies
gebruiken (of andere soortgelijke) op een regelmatige basis.

16.3.7 What’s Next?

Vervolgens zullen we kijken hoe we de gegevens bevragen die we eerder hebben gemaakt.

16.4 Lesson: Ruimtelijke query’s

Ruimtelijke query’s zijn niet anders dan andere query’s voor databases. U kunt de kolom voor geometrie net zo
gebruiken als elke andere kolom in een database. Met de installatie van PostGIS in onze database, hebben we
aanvullende functies om onze database te bevragen.

het doel voor deze les: Zien hoe ruimtelijke functies worden geïmplementeerd, soortgelijk aan “normale” niet
ruimtelijke functies.

16.4.1 Ruimtelijke operatoren

Wanneer u wilt weten welke punten binnen een afstand van 2 graden vanaf een punt(X,Y) liggen, kunt dat doen
met:

select *
from people
where st_distance(the_geom,’SRID=4326;POINT(33 -34)’) < 2;

Resultaat:

id | name | house_no | street_id | phone_no | the_geom
----+--------------+----------+-----------+---------------+-----------------

6 | Fault Towers | 34 | 3 | 072 812 31 28 | 01010008040C0
(1 row)

Notitie: waarde the_geom hierboven werd afgebroken voor ruimte op deze pagina. Als u het punt in voor mensen
leesbare coördinaten wilt zien, probeer dan iets soortgelijks als wat u eerder deed in het gedeelte “Bekijk een punt
als WKT”.

Hoe weten we dat de query hierboven alle punten binnen 2 graden teruggeeft? Waarom geen 2 meter? Of elke
andere maateenheid, nu we het er toch over hebben?

Controleer uw resultaten
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16.4.2 Ruimtelijke indexen

We kunnen ook ruimtelijke indexen definiëren. Een ruimtelijke index maakt uw ruimtelijke query’s veel sneller.
Gebruik, om een ruimtelijke index op de kolom voor geometrie te maken:

CREATE INDEX people_geo_idx
ON people
USING gist
(the_geom);

\d people

Resultaat:

Table "public.people"
Column | Type | Modifiers

-----------+-----------------------+----------------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
the_geom | geometry |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_geo_idx" gist (the_geom) <-- new spatial key added
"people_name_idx" btree (name)

Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype(the_geom) = ’ST_Point’::text
OR the_geom IS NULL)

Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

16.4.3 Try Yourself

Pas de tabel cities zo aan dat zijn kolom voor geometrie ruimtelijk wordt geïndexeerd.

Controleer uw resultaten

16.4.4 Demonstratie ruimtelijke functies van PostGIS

We zullen een nieuwe database maken die enkele (fictionele) gegevens bevat om de ruimtelijke functies van
PostGIS te demonstreren.

Maak, om te beginnen, eerst een nieuwe database (verlaat eerst de shell van psql):

createdb postgis_demo

Vergeet niet de extensies voor PostGIS te installeren:

psql -d postgis_demo -c "CREATE EXTENSION postgis;"

Importeer vervolgens de gegevens die worden verschaft in de map exercise_data/postgis/. Bekijk de
vorige les voor de instructies, maar onthoud dat u een nieuwe verbinding voor PostGIS naar de nieuwe database.
U kunt importeren vanuit de terminal of via SPIT. Importeer de bestanden in de volgende tabellen van de database:

• points.shp in building

• lines.shp in road

• polygons.shp in region
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Laad deze drie lagen van de database in QGIS via het dialoogvenster PostGIS-laag toevoegen, zoals gewoonlijk.
Wanneer u hun attributentabellen opent, zult u merken dat zij alle een veld id en een veld gid hebben, gemaakt
door het importeren met PostGIS.

Nu de tabellen zijn geïmporteerd, kunnen we PostGIS gebruiken om de gegevens te bevragen. Ga terug naar uw
terminal (opdrachtregel) en voer bij de prompt van psql in:

psql postgis_demo

We zullen enkele van deze argumenten SELECT demonstreren door er weergaven van te maken, zodat u ze in
QGIS kunt openen en hun resultaten kunt zien.

Op locatie selecteren

Alle gebouwen in de regio KwaZulu verkrijgen:

SELECT a.id, a.name, st_astext(a.the_geom) as point
FROM building a, region b
WHERE st_within(a.the_geom, b.the_geom)
AND b.name = ’KwaZulu’;

Resultaat:

id | name | point
----+------+------------------------------------------
30 | York | POINT(1622345.23785063 6940490.65844485)
33 | York | POINT(1622495.65620524 6940403.87862489)
35 | York | POINT(1622403.09106394 6940212.96302097)
36 | York | POINT(1622287.38463732 6940357.59605424)
40 | York | POINT(1621888.19746548 6940508.01440885)

(5 rows)

Of, als we er een weergave van maken:

CREATE VIEW vw_select_location AS
SELECT a.gid, a.name, a.the_geom
FROM building a, region b

WHERE st_within(a.the_geom, b.the_geom)
AND b.name = ’KwaZulu’;

Voeg de weergave als een laag toe en bekijk die in QGIS:
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Buren selecteren

Geef een lijst weer van de namen van alle regio’s die naast de regio Hokkaido liggen:

SELECT b.name
FROM region a, region b
WHERE st_touches(a.the_geom, b.the_geom)
AND a.name = ’Hokkaido’;

Resultaat:

name
--------------
Missouri
Saskatchewan
Wales

(3 rows)

Als een weergave:

CREATE VIEW vw_regions_adjoining_hokkaido AS
SELECT b.gid, b.name, b.the_geom
FROM region a, region b

WHERE TOUCHES(a.the_geom, b.the_geom)
AND a.name = ’Hokkaido’;

In QGIS:
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Merk de ontbrekende regio op (Queensland). Dit zou kunnen komen door een fout in de topologie. Artefacten
zoals dit kunnen ons waarschuwen voor potentiële problemen in de gegevens. Dit enigma oplossen zonder verstrikt
te raken in de afwijkingen in de gegevens die de gegevens zouden kunnen hebben, zouden we in plaats daarvan
een buffer voor kruisingen kunnen gebruiken:

CREATE VIEW vw_hokkaido_buffer AS
SELECT gid, ST_BUFFER(the_geom, 100) as the_geom
FROM region

WHERE name = ’Hokkaido’;

Dit maakt een buffer van 100 meter rondom de regio Hokkaido.

Het donkere gebied is de buffer:
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Selecteren met behulp van de buffer:

CREATE VIEW vw_hokkaido_buffer_select AS
SELECT b.gid, b.name, b.the_geom
FROM
(

SELECT * FROM
vw_hokkaido_buffer

) a,
region b
WHERE ST_INTERSECTS(a.the_geom, b.the_geom)
AND b.name != ’Hokkaido’;

In deze query wordt de originele weergave van de buffer gebruikt zoals elke andere tabel gebruikt zou worden.
Het is het alias a gegeven en het veld voor de geometrie ervan, a.the_geom, wordt gebruik om elke polygoon
in de tabel region (alias b) te selecteren waarmee het kruist. Echter, Hokkaido zelf wordt uitgesloten van dit
argument SELECT, omdat we die niet willen; we willen alleen de regio’s die er naast liggen.

In QGIS:
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Het is ook mogelijk alle objecten binnen een bepaalde afstand te selecteren, zonder de extra stap van het maken
van een buffer:

CREATE VIEW vw_hokkaido_distance_select AS
SELECT b.gid, b.name, b.the_geom
FROM region a, region b

WHERE ST_DISTANCE (a.the_geom, b.the_geom) < 100
AND a.name = ’Hokkaido’
AND b.name != ’Hokkaido’;

Dit levert hetzelfde resultaat op, zonder de noodzaak van een tussenliggende stap voor de buffer:
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Unieke waarden selecteren

Een lijst weergeven van alle unieke namen van steden voor alle gebouwen in de regio Queensland:

SELECT DISTINCT a.name
FROM building a, region b
WHERE st_within(a.the_geom, b.the_geom)
AND b.name = ’Queensland’;

Resultaat:

name
---------
Beijing
Berlin
Atlanta

(3 rows)

Meer voorbeelden ...

CREATE VIEW vw_shortestline AS
SELECT b.gid AS gid, ST_ASTEXT(ST_SHORTESTLINE(a.the_geom, b.the_geom)) as
text, ST_SHORTESTLINE(a.the_geom, b.the_geom) AS the_geom
FROM road a, building b

WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_longestline AS
SELECT b.gid AS gid, ST_ASTEXT(ST_LONGESTLINE(a.the_geom, b.the_geom)) as
text, ST_LONGESTLINE(a.the_geom, b.the_geom) AS the_geom
FROM road a, building b

WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_road_centroid AS
SELECT a.gid as gid, ST_CENTROID(a.the_geom) as the_geom
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FROM road a
WHERE a.id = 1;

CREATE VIEW vw_region_centroid AS
SELECT a.gid as gid, ST_CENTROID(a.the_geom) as the_geom
FROM region a

WHERE a.name = ’Saskatchewan’;

SELECT ST_PERIMETER(a.the_geom)
FROM region a
WHERE a.name=’Queensland’;

SELECT ST_AREA(a.the_geom)
FROM region a
WHERE a.name=’Queensland’;

CREATE VIEW vw_simplify AS
SELECT gid, ST_Simplify(the_geom, 20) AS the_geom
FROM road;

CREATE VIEW vw_simplify_more AS
SELECT gid, ST_Simplify(the_geom, 50) AS the_geom
FROM road;

CREATE VIEW vw_convex_hull AS
SELECT
ROW_NUMBER() over (order by a.name) as id,
a.name as town,
ST_CONVEXHULL(ST_COLLECT(a.the_geom)) AS the_geom
FROM building a
GROUP BY a.name;

16.4.5 In Conclusion

U heeft gezien hoe u ruimtelijke objecten kunt bevragen met behulp van de nieuwe databasefuncties van PostGIS.

16.4.6 What’s Next?

Vervolgens gaan we de structuren van meer complexe geometrieën onderzoeken en hoe ze te maken met behulp
van PostGIS.

16.5 Lesson: Construeren van geometrie

In dit gedeelte duiken we een beetje dieper in hoe eenvoudige geometrieën worden geconstrueerd in SQL. In de
realiteit zou u waarschijnlijk een GIS zoals QGIS gebruiken om complexe geometrieën te maken met behulp van
hun gereedschappen voor digitaliseren; echter, begrijpen hoe zij worden geformuleerd kan handig zijn bij het
schrijven van query’s en begrijpen hoe de database is samengesteld.

Het doel van deze les: Beter begrijpen hoe ruimtelijke entiteiten direct in PostgreSQL/PostGIS te maken.

16.5.1 Lijnen maken

Terug naar onze database address, laten we zorgen dat onze tabel streets overeenkomt met de andere; d.i. een
beperking hebben op de geometrie, een index en een item in de tabel geometry_columns.
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16.5.2 Try Yourself

• Pas de tabel streets zo aan dat die een kolom voor geometrie bevat van het type ST_LineString.

• Vergeet niet een update uit te voeren om de geometrie kolom te laten maken.

• Voeg een constraint toe om te voorkomen dat andere geometrie dan lijnen of lege geometrie kan worden
ingevoerd.

• Maak een ruimtelijke index op de nieuwe geometrie kolom

Controleer uw resultaten

Laten we nu een lijn in onze tabel streets maken. In dit geval zullen we een bestaand record voor een straat
bijwerken:

update streets set the_geom = ’SRID=4326;LINESTRING(20 -33, 21 -34, 24 -33)’
where streets.id=2;

Bekijk de resultaten in QGIS. (U moet misschien met rechts klikken op de laag streets in het paneel ‘Lagen’ en
kiezen voor ‘Op kaartlaag inzoomen’.)

Maak nu nog enkele items voor streets - enkele in QGIS en enkele vanaf de opdrachtregel.

16.5.3 Polygonen maken

Het maken van polygonen is net zo eenvoudig. Eén ding om te onthouden is dat, bij definitie, polygonen tenminste
vier hoekenpunten hebben, waarvan de eerste en laatste op één lijn liggen:

insert into cities (name, the_geom)
values (’Tokyo’, ’SRID=4326;POLYGON((10 -10, 5 -32, 30 -27, 10 -10))’);

Notitie: Een polygoon vereist dat er dubbele haken rondom de lijst met coördinaten staat; dat is om het voor u
mogelijk te maken complex polygonen met meerdere niet verbonden gebieden toe te voegen. Bijvoorbeeld

insert into cities (name, the_geom)
values (’Tokyo Outer Wards’, ’SRID=4326;POLYGON((20 10, 20 20, 35 20, 20 10),

(-10 -30, -5 0, -15 -15, -10 -30))’);

Indien u deze stap volgde kunt u controleren wat die deed door de gegevensset cities te laden in QGIS, de attribu-
tentabel ervan te openen en het nieuwe item te selecteren. merk op hoe de twee nieuwe polygonen zich gedragen
als één polygoon.

16.5.4 Oefening: Steden aan mensen koppelen

Voor deze oefening zou u het volgende moeten doen:

• Alle gegevens uit uw tabel people verwijderen.

• Een kolom voor een vreemde sleutel, die verwijst naar de primaire sleutel van de tabel cities, aan people
toevoegen.

• QGIS gebruiken om enkele steden vast te leggen.

• SQL gebruiken om enkele nieuwe records voor people in te voeren, er zorg voor dragend dat elk daarvan
een geassocieerde straat en stad heeft.

Uw bijgewerkte schema voor people zou er ongeveer zo uit moeten zien:
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\d people

Table "public.people"
Column | Type | Modifiers

-----------+-----------------------+--------------------------------------------
id | integer | not null

| | default nextval(’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
the_geom | geometry |
city_id | integer | not null

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name)

Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype(the_geom) =

’ST_Point’::text OR the_geom IS NULL)
Foreign-key constraints:

"people_city_id_fkey" FOREIGN KEY (city_id) REFERENCES cities(id)
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

Controleer uw resultaten

16.5.5 Ons schema bekijken

Ons schema zou er nu ongeveer zo uit moeten zien:

16.5.6 Try Yourself

Maak stadsgrenzen door de minimum convex hull van alle adressen voor die stad te berekenen en een buffer
rondom dat gebied te berekenen.

16.5.7 Toegang tot sub-objecten

Met de functies voor het SFS-model heeft u een breed scala aan opties om toegang te verkrijgen tot sub-objecten
van geometrieën van SFS. Wanneer u het eerste vertexpunt van elke geometrie polygoon in de tabel myPoly-
gonTable wilt selecteren, moet u dat op de volgende manier doen:

• Transformeer de tanden van de polygoon naar een lijn:
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select st_boundary(geometry) from myPolygonTable;

• Selecteer het eerste vertexpunt van de resulterende lijn:

select st_startpoint(myGeometry)
from (

select st_boundary(geometry) as myGeometry
from myPolygonTable) as foo;

16.5.8 Gegevens verwerken

PostGIS ondersteunt alle standaard conforme functies van OGC SFS/MM. Al deze functies beginnen met ST_.

16.5.9 Clippen

U kunt de functie ST_INTERSECT() gebruiken om een sub-gedeelte van uw gegevens te clippen. Vermijd lege
geometrieën door te gebruiken:

where not st_isempty(st_intersection(a.the_geom, b.the_geom))

select st_intersection(a.the_geom, b.the_geom), b.*
from clip as a, road_lines as b
where not st_isempty(st_intersection(st_setsrid(a.the_geom,32734),

b.the_geom));
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16.5.10 Geometrieën uit andere geometrieën bouwen

vanuit een opgegeven punttabel wilt u een lijn genereren. De volgorde van de punten wordt gedefinieerd door
hun id. Een andere methode van sorteren zou een tijdstempel kunnen zijn, zoals die welke u krijgt wanneer u
waypoints vastlegt met een GPS-ontvanger.
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U kunt de volgende opdracht gebruiken om een lijn uit een nieuwe puntlaag, genaamd ‘points’, te maken:

select ST_LineFromMultiPoint(st_collect(the_geom)), 1 as id
from (

select the_geom
from points
order by id

) as foo;

U zou deze opdracht ook uit kunnen voeren op de laag ‘people’, hoewel dat natuurlijk weinig nut binnen de echte
wereld zou hebben om dit te doen, om te zien hoe het werkt zonder een nieuwe laag te maken.
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16.5.11 Geometrie opruimen

U kunt meer informatie over dit onderwerp krijgen in dit blog-item.

16.5.12 Verschillen tussen tabellen

U kunt het sleutelwoord voor PostgreSQL EXCEPT gebruiken om het verschil tussen twee tabellen met dezelfde
structuur te detecteren:

select * from table_a
except
select * from table_b;

Als resultaat zult u alle records uit table_a verkrijgen die niet zijn opgeslagen in table_b.

16.5.13 Tabelruimten

U kunt definiëren waar Postgres zijn gegevens op schijf op zou moeten slaan dor tabelruimten te maken:

CREATE TABLESPACE homespace LOCATION ’/home/pg’;

U kunt u dan, wanneer u een database maakt, specificeren welke tabelruimte gebruikt moet worden bijv.:
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createdb --tablespace=homespace t4a

16.5.14 In Conclusion

U heeft geleerd hoe u meer complexe geometrieën maakt met behulp van argumenten van PostGIS. Onthoud dat
dit meer is om uw achtergrondkennis te verbeteren wanneer u werkt met voor geo ingeschakelde databases via een
GIS als startpunt. Gewoonlijk hoeft u deze argumenten niet handmatig in te voeren, maar als u een algemeen idee
heeft van hun structuur zal dat u helpen wanneer u een GIS gebruikt, in het bijzonder als u fouten tegenkomt die
anders nogal cryptisch zouden kunnen lijken.

432 Chapter 16. Module: Concepten van een ruimtelijke database met PostGIS



CHAPTER 17

De QGIS-gids voor Processing

Deze module is bijgedragen door Victor Olaya en Paolo Cavallini.

Inhoud:

17.1 Introductie

Deze gids beschrijft hoe het framework Processing in QGIS te gebruiken. Het gaat uit van geen eerdere kennis van
het framework Processing of één van de toepassingen waarop het vertrouwt. Het gaat voorts uit van basiskennis
van QGIS. De hoofdstukken over scripten gaan er van uit dat u enige basiskennis heeft van Python en misschien
de Python API vanQGIS.

Deze gids is ontworpen voor zelfstudie of om te worden gebruikt in een uit te voeren workshop voor Processing.

Voorbeelden in deze gids gebruiken QGIS 2.0, met gedeeltelijke bijwerkingen tot en met 2.10. Zij zouden niet
kunnen werken of niet beschikbaar kunnen zijn in andere versies dan die.

Deze gids is samengesteld uit een verzameling kleine oefeningen met progressieve complexiteit. Indien u nog
nooit het framework Processing heeft gebruikt zou u vanaf het eerste begin moeten starten. Indien u enige eerdere
ervaringen heeft, het staat u vrij om lessen over te slaan. Zij zijn min of meer onafhankelijk van elkaar, en elke
introduceert enige nieuwe new concepten of enige nieuwe elementen, welke worden aangegeven in de titel van
het hoofdstuk en de korte introductie aan het begin van elk hoofdstuk. Dat zou het eenvoudig moten maken lessen
te lokaliseren die een bepaald onderwerp behandelen.

Voor een meer systematische beschrijving van alle componenten van het framework en hun gebruik, wordt aan-
bevolen om het overeenkomstige hoofdstuk in de handleiding van QGIS te raadplegen. Gebruik het als onderste-
unende tekst naast deze gids.

Alle oefeningen in deze handleiding maken gebruik van een open dataset die kan worden gedownload vanaf de
QGIS website. De gecomprimeerde download bevat een mappenstructuur die overeenkomt met de oefeningen
in de handleiding. In elke map bevindt zich een QGIS project bestand. Na het openen van dit bestand kan de
oefening worden gestart.

Veel plezier!

17.2 Een belangrijke waarschuwing vóór het beginnen

Net zoals een handleiding voor een tekstverwerker u niet leert om een roman of een gedicht te schrijven, of een
handleiding voor CAD u niet laat zien hoe u de grootte voor een balk voor een gebouw berekent, zal deze gids
u geen ruimtelijke analyses leren. In plaats daarvan zal het u tonen hoe het framework Processing in QGIS te
gebruiken,een krachtig gereedschap voor het uitvoeren van ruimtelijke analyses, maar het is aan u om de vereiste
concepten te leren die nodig zijn om dat type analyse te begrijpen. Zonder dat heeft het geen zin om het framework
en de algoritmen daarin te gebruiken, hoewel u misschien in de verleiding komt om het te proberen.

Laten we dit eens aan de hand van een voorbeeld duidelijk maken.
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Met opgegeven verzameling punten en een waarde van een opgegeven waarde voor een variabele voor elk punt,
kunt u voor hen een rasterlaag berekenen met behulp van het geo-algoritme Kriging. Het dialoogvenster voor de
parameters van die module ziet eruit zoals het volgende.

Het ziet er ingewikkeld uit, niet?

Door deze handleiding te lezen zult u dingen leren zoals hoe die module te gebruiken, hoe het uit te voeren in
een batch-proces om rasterlagen uit honderden puntlagen te maken in één enkele uitvoering, of wat er gebeurd als
op de invoerlaag enkele punten zijn geselecteerd. Echter, de parameters zelf worden niet uitgelegd. Een ervaren
analist met goede kennis van geo-statistieken zal geen probleem hebben de parameters te begrijpen. Als u niet
één van hen bent en sill, range, of nugget zijn gene bekende concepten voor u, dan zou u de module Kriging
niet moeten gebruiken. Meer dan dat, u bent nog lang niet klaar om de module Kriging te gebruiken, omdat het
leren vereist van concepten zoals ruimtelijke autocorrelatie of semi-variogrammen, waarvan u waarschijnlijk ook
nooit eerder gehoord heeft, of tenminste nog niet lang genoeg bestudeerd heeft. U zou ze eerst moeten bestuderen
en begrijpen, en dan terugkomen naar QGIS om het feitelijk uit te voeren en de analyse uit te voeren. Negeren
hiervan zal leiden tot verkeerde resultaten en slechte (en zeer waarschijnlijk nutteloze) analyse.

Hoewel niet alle algoritmen zo complex zijn als Kriging (maar sommige ervan zijn nog complexer!), vereisen de
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meeste ervan het begrijpen van de fundamentele analyse-ideeën waarop zij zijn gebaseerd. Zonder die kennis zal
het gebruiken ervan zeer waarschijnlijk leiden tot slechts resultaten.

gebruiken van geo-algoritmen zonder een goede fundatie te hebben van ruimtelijke analyse is als het proberen een
roman te schrijven zonder iets af te weten van grammatica of syntaxis, en gene kennis hebben over het vertellen
van verhalen. U zou een resultaat kunnen krijgen, maar het is waarschijnlijk dat er helemaal geen waarde wordt
verkregen. Houd uzelf niet voor de gek door te denken dat u na het lezen van deze gids u al in staat bent een
ruimtelijke analyse uit te voeren en degelijke resultaten te krijgen. U zult ook de ruimtelijke analyse moeten
bestuderen.

Hier is een goede verwijzing die u kunt lezen om meer te leren over ruimtelijke gegevensanalyse.

Geospatial Analysis (3rd Edition): A Comprehensive Guide to Principles, Techniques and Software Tools Michael
John De Smith, Michael F. Goodchild, Paul A. Longley

Het is hier online beschikbaar.

17.3 Het framework Processing instellen

Het eerste om te doen, vóór het framework Processing te kunnen gebruiken, is om het te configureren. Er is niet
veel in te stellen, dus dit is een eenvoudige taak.

Later zullen we laten zien hoe de externe toepassingen te configureren die worden gebruikt om de lijst met beschik-
bare algoritmen uit te breiden, maar voor nu gaan we alleen met het framework zelf werken.

Het framework Processing is een bronplug-in voor QGIS, wat betekent dat, als u QGIS 2.0 of later draait, het al
op uw systeem geïnstalleerd zou moeten zijn, omdat het is opgenomen in QGIS. In het geval dat het actief is zou
u een menu, genaamd Processing, in uw menubalk moeten zien. Daar zult u toegang vinden tot alle componenten
van het framework.

Als u dat menu niet kunt vinden, dient u de plug-in in te schakelen door te gaan naar Beheer en installeer plug-ins
en het te activeren.
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Het belangrijkste element waarmee we zullen gaan werken is de Toolbox. Klik op het overeenkomende item van
het menu en u zult de vastgezette Toolbox zien aan de rechterkant van het venster van QGIS.

De Toolbox bevat een lijst van alle beschikbare algoritmen, verdeeld in groepen. Er zijn twee manieren om deze
algoritmen weer te geven en te beheren: de geavanceerde interface en de eenvoudige interface.

Standaard zult u de eenvoudige modus zien, die algoritmen groepeert aan de hand van de verwerking die zij
uitvoeren. Hoewel enkele van de algoritmen die u in de Toolbox zult zien afhankelijk zijn van andere externe
toepassingen (in feite; de meeste van hen zijn dat), zult u geen vermelding voor die toepassing zien. De herkomst
van algoritmen wordt in deze modus verborgen, wat een facade is die het gebruiken van algoritmen door middel
van het framework Processing vereenvoudigt.
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Voorbeelden in deze gids gebruiken alleen de eenvoudige interface. De geavanceerde interface heeft enkele aan-
vullende mogelijkheden en algoritmen, maar het vereist kennis van de toepassingen die worden aangeroepen, dus
dat is een meer gevorderd onderwerp en zal later worden uitgelegd.

U kunt schakelen tussen de eenvoudige en de geavanceerde interface met behulp van de selectie in het onderste
gedeelte van de Toolbox.

Het vak Toolbox, indien gebruikt in de geavanceerde interface, ziet er zo uit.

Als u dit punt heeft bereikt bent u er klaar voor om geo-algoritmen te gebruiken. Er is op dit moment geen
noodzaak om nog iets anders te configureren. We kunnen ons eerste algoritme al gaan uitvoeren, wat we ook
zullen doen in de volgende les.

17.4 Uw eerste algoritme uitvoeren. De Toolbox

Notitie: In deze les zullen we ons eerste algoritme uitvoeren, en ons eerste resultaat daaruit verkrijgen.

Zoals we al hebben besproken kan het framework Processing algoritmen uit andere toepassingen uitvoeren, maar
het bevat ook eigen algoritmen die geen externe software nodig hebben om te worden uitgevoerd. We gaan één
van deze eigen algoritmen uitvoeren om te beginnen met het verkennen van het framework Processing. In het
bijzonder gaan we de middelpunten berekenen van een verzameling polygonen.

Open eerst het project van QGIS dat correspondeert met deze les. Het bevat slechts één enkele laag met twee
polygonen
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Ga nu naar het tekstvak bovenin de Toolbox. Dat is het zoekvak en als u tekst daarin typt, zal het de lijst met
algoritmen filteren zodat slechts die, welke de ingevoerde tekst bevatten worden weergegeven. Typ centroids
en u zou iets zoals dit moeten zien.

Het zoekvak is een zeer praktische manier voor het vinden van het algoritme dat u zoekt.

U hoeft slechts te dubbelklikken op de naam in de Toolbox om een algoritme uit te voeren. Als u dubbelklikt op
het algoritme Centroids, zult u het volgende dialoogvenster zien.
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Alle algoritmen hebben een soortgelijke interface, die als basis parameters voor invoer bevat die u moet invullen
en voor uitvoer die u moet selecteren om de plaats voor opslaan te kiezen. In dit geval is de enige invoer die we
hebben een vectorlaag met polygonen.

Selecteer de laag Polygons als invoer. Het algoritme heeft één enkele uitvoer, wat de laag Centroids is. Er zijn
twee opties om te definiëren waar uitvoer van gegevens wordt opgeslagen: voer ofwel een bestandspad in of sla
het op naar een tijdelijke bestandsnaam

In het geval dat u een bestemming wilt instellen, en het resultaat niet wilt opslaan in een tijdelijk bestand, wordt de
indeling van de uitvoer gedefinieerd door de extensie van de bestandsnaam. Selecteer eenvoudigweg de correspon-
derende bestandsextensie (of voeg die toe, als u in plaats daarvan het bestandspad direct intypt) om een indeling
te selecteren. Als de extensie van het bestandspad dat u invoerde niet overeenkomt met een van de ondersteunde
indelingen, zal een standaard extensie (gewoonlijk .dbf voor tabellen, .tif voor rasterlagen en .shp voor
vectorlagen) worden toegevoegd aan het bestandspad, en de bestandsindeling die correspondeert met die extensie
zal worden gebruikt om de laag of de tabel op te slaan.

In alle oefeningen in deze handleiding zullen we de resultaten opslaan naar een tijdelijk bestand, omdat er geen
reden is ze op te slaan voor later gebruik. het staat u uiteraard vrij om ze op een vaste locatie op te slaan als u dat
wilt.

Waarschuwing: Tijdelijke bestanden worden verwijderd als u QGIS afsluit. Als u een project maakte met
een uitvoer die werd opgeslagen als een tijdelijk bestand, zal QGIS klagen als u later het project weer wilt
openen, omdat het uitvoerbestand niet meer bestaat.

Als u eenmaal het dialoogvenster voor het algoritme heeft geconfigureerd, druk dan op Run om het algoritme uit
te voeren.

U zult de volgende uitvoer krijgen.
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De uitvoer heeft hetzelfde CRS als de invoer. Geo-algoritmen gaan er van uit dat alle invoerlagen hetzelfde CRS
delen en projecteert niets opnieuw. Behalve in het geval van enkele speciale algoritmen (bijvoorbeeld die voor
opnieuw projecteren), de uitvoer zal ook datzelfde CRS hebben. We zullen hier snel meer van zien.

Probeer het zelf op te slaan in verschillende bestandsindelingen (gebruik bijvoorbeeld shp en geojson als
extensies). Ook kunt u, als u niet wilt dat de laag zal worden geladen in QGIS nadat die is gegenereerd, het
keuzevak deselecteren dat staat onder het vak voor het pad van de uitvoer.

17.5 Meer algoritmen en gegevenstypen

Notitie: In deze les zullen we nog drie algoritmen uitvoeren, leren hoe andere typen voor invoer te gebruiken, en
uitvoer configureren om automatisch te worden opgeslagen in een bepaalde map.

Voor deze lessen zullen we een tabel en een laag voor polygonen nodig hebben. We zullen een puntenlaag gaan
maken gebaseerd op coördinaten in de tabel, en dan het aantal punten in elke polygoon tellen. Als u het project
voor QGIS opent dat correspondeert met deze les, zult u een tabel vinden met X- en Y-coördinaten, maar u zult
geen laag voor polygonen vinden. Geen zorgen, die zullen we maken met behulp van een geo-algoritme van
Processing.

Het eerste dat we zullen gaan doen is een puntenlaag maken uit de coördinaten in de tabel, met behulp van het
algoritme Points layer from table. U weet nu hoe u het zoekvak kunt gebruiken, dus zou het voor u niet zo moeilijk
moeten zijn om dat op te zoeken. Dubbelklik erop om het uit te voeren en u krijgt het volgende dialoogvenster.

Dit algoritme, net zoals dat uit de vorige les, genereert slechts één enkele uitvoer, en het heeft drie invoeren:

• Invoerlaag: de tabel met de coördinaten. U zou hier de tabel uit de gegevens voor de les moeten selecteren.

• X- en Y-velden: deze twee parameters zijn gekoppeld aan de eerste. De overeenkomende selectie zal de
naam weergeven van de velden die beschikbaar zijn in de geselecteerde tabel. Selecteer het veld XCOORD
voor de parameter X, en het veld YYCOORD voor de parameter Y.

• doel-CRS: Omdat dit algoritme geen invoerlagen heeft, kan het geen CRS aan de uitvoerlaag toewijzen die
daar op is gebaseerd. In plaats daarvan vraagt het u om handmatig het CRS te selecteren dat de coördinaten
in de tabel gebruiken. Klik op de knop aan de rechterkant om de selectie van CRS voor QGIS te openen, en
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selecteer EPSG:4326 als het CRS voor de uitvoer. We gebruiken dat CRS omdat de coördinaten in de tabel
in dat CRS staan.

Uw dialoogvenster zou er nu zo uit moeten zien.

Druk nu op de knop Run om de volgende laag te krijgen (u moet misschien volledig inzoomen om de kaart rondom
de nieuw gemaakte punten te laten zien):

17.5. Meer algoritmen en gegevenstypen 441



QGIS Training Manual, Release 2.14

Het volgende dat we nodig hebben is de polygoonlaag. We gaan een rechthoekig raster van polygonen maken met
behulp van het algoritme Create grid, wat het volgende dialoogvenster voor de parameters heeft.

Waarschuwing: De opties zijn eenvoudiger in recent versies van QGIS; u hoeft slechts de min en max voor
X en Y in te voeren (voorgestelde waarden: -5.696226,-5.695122,40.24742,40.248171)

De vereiste invoeren voor het maken van het raster zijn allemaal getallen. Wanneer u een numerieke waarde
dient in te voeren heeft u twee opties: het direct typen in het overeenkomende vak of klikken op de knop aan de
rechterkant om een dialoogvenster te krijgen zoals dat hieronder wordt weergegeven.
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Het dialoogvenster bevat een eenvoudige calculator, dus u kunt expressies typen zoals 11 * 34.7 + 4.6, en
het resultaat zal worden berekend en in het overeenkomende vak in het dialoogvenster van de parameters worden
geplaatst. Het bevat ook constanten die u kunt gebruiken en waarden uit andere beschikbare lagen.

In dit geval willen we een raster maken dat het bereik van de puntenlaag voor invoer bedekt, dus zouden we de
coördinaten daarvan moeten gebruiken om de coördinaat van het midden van het raster te berekenen en de breedte
en hoogte daarvan, omdat dat de parameters zijn die het algoritme nodig heeft om het raster te kunnen maken. met
een beetje rekenkundige hulp, probeer dat zelf eens te doen met behulp van het dialoogvenster met de calculator
en de constanten van de puntenlaag van de invoer.

Selecteer Rectangles (polygons) in het veld Type.

Net zoals in het geval van het laatste algoritme moeten we hier ook het CRS invullen. Selecteer EPSG:4326 als
het doel-CRS, zoals we al eerder deden.

Uiteindelijk zou u een dialoogvenster voor parameters moeten hebben zoals dit:
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(Het is beter om één afstand toe te voegen voor breedte en hoogte: Horizontal spacing: 0.0001, Vertical spacing:
0.0001, Width: 0.001004, Height: 0.000651, Center X: -5.695674, Center Y: 40.2477955) Het geval van X center
is een beetje gevoelig, zie: -5.696126+(( -5.695222+ 5.696126)/2)

Druk op Run en u zult de laag met het raster krijgen.
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De laatste stap is om de punten te tellen in elke rechthoek van dat raster. We zullen het algoritme Count points in
polygons gebruiken.

Nu hebben we het resultaat dat we zochten.

Vóórdat we deze les beëindigen: hier is een snelle tip om uw leven eenvoudiger te maken voor het geval u uw
gegevens steeds wilt opslaan. Als u wilt dat al uw gegevens voor de uitvoer worden opgeslagen in één bepaalde
map, hoeft u niet elke keer de naam van de map te typen. Ga, in plaats daarvan, naar het menu Processing en
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selecteer het item Opties en configuratie. dat zal het dialoogvenster voor configuratie openen.

In het item Output folder dat u zult vinden in de groep General, typt u het pad naar uw doelmap.
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Wanneer u nu een algoritme uitvoert, gebruik dan slechts de bestandsnaam in plaats van het volledige
pad. Bijvoorbeeld, met de hierboven weergegeven configuratie, als u graticule.shp invoert als het
pad voor uitvoer voor het algoritme dat we zojuist hebben gebruikt, zal het resultaat worden opgeslagen in
D:\processing_output\graticule.shp. U kunt nog steeds een volledig pad invoeren voor de gevallen
waarin u wilt dat het resultaat wordt opgeslagen in een andere map.

Probeer zelf het algoritme Create grid met verschillende grootten raster, en ook met verschillende typen raster.

17.6 CRS-en opnieuw.projecteren

Notitie: In deze les zullen we bespreken hoe Processing CRS-en gebruikt. We zullen ook een zeer bruikbaar
algoritme bekijken: opnieuw projecteren.

CRS-en zijn een grote bron van verwarring voor gebruikers van Processing in QGIS, dus zijn er enkele algemene
regels over hoe zij worden afgehandeld door geo-algoritmen bij het maken van een nieuwe laag.

• Als er invoerlagen zijn, zal het het CRS van de eerste laag gebruiken. Aangenomen wordt dat dat het CRS is
van alle invoerlagen, omdat zij allemaal hetzelfde zouden moeten hebben. Als u lagen gebruikt met CRS-en
die niet overeenkomen, zal QGIS u daarover waarschuwen. Merk op dat het CRS van invoerlagen wordt
weergegeven, tezamen met de naam, in het dialoogvenster voor de parameters.

• Als er geen invoerlaag is, zal het het CRS van het project gebruiken, tenzij het algoritme een specifiek veld
voor het CRS bevat (zoals gebeurde in de laatste les met het algoritme voor het raster)

Open het project dat correspondeert met dezes les en u zult twee lagen zien, genaamd 23030 en 4326. Zij bevatten
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beide dezelfde punten, maar zijn in verschillende CRS-en (EPSG:23030 en EPSG:4326). Zij verschijnen op
dezelfde plaats omdat QGIS direct opnieuw projecteert naar het CRS van het project (EPSG:4326), maar in feite
zijn zij niet dezelfde laag.

Open het algoritme Export/Add geometry columns.

Dit algoritme voegt nieuwe kolommen toe aan de attributentabel van een vectorlaag. De inhoud van de kolommen
is afhankelijk van het type geometrie van de laag. In het geval van punten, voegt het nieuwe kolommen toe met
de X- en Y-coördinaten van elk punt.

In de lijst met beschikbare lagen die u kunt vinden in het veld voor de invoerlaag, zult u elk zien met zijn
overeenkomend CRS. Dat betekent dat, hoewel zij op dezelfde plaats in uw kaartvenster verschijnen, zij ver-
schillend zullen worden behandeld. Selecteer de laag 4326.

De andere parameter van het algoritme maakt het mogelijk in te stellen hoe het algoritme coördinaten gebruikt
om de nieuwe waarde te berekenen die zal worden toegevoegd aan de resulterende lagen. De meeste algoritmen
hebben geen optie zoals dit, en gebruiken eenvoudigweg direct de coördinaten. Selecteer de laagoptie Layer CRS
om de coördinaten slechts te gebruiken zoals zij zijn. Dit is hoe bijna alle geo-algoritmen werken.

U zou een nieuwe laag moeten krijgen met exact dezelfde punten als de andere twee lagen. Als u met rechts klikt
op de naam van de laag en de eigenschappen ervan opent, zult u zien dat het hetzelfde CRS van de invoerlaag
deelt, dat is, EPSG:4326. Wanneer de laag wordt geladen in QGIS, zult u worden gevraagd het CRS van de laag
in te voeren, omdat QGIS daar al van weet.

Als u de attributentabel van de nieuwe laag opent zult u zien dat het nu twee nieuwe velden bevat met de X- en
Y-coördinaten van elk punt.
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Deze waarden voor de coördinaten zijn in het CRS van de laag, omdat we die optie kozen. Echter, zelfs als u een
andere optie kiest, zou het CRS van de uitvoer van de laag hetzelfde zijn, omdat het CRS van de invoer is gebruikt
om het CRS van de uitvoerlaag in te stellen. Kiezen van een andere optie zal er voor zorgen dat de waarden anders
zijn, maar zal het resulterende punt niet wijzigen of het CRS van de uitvoerlaag te laten verschillen van het CRS
van die van de invoer.

Doe nu dezelfde berekening met behulp van de andere laag. U zou moeten zien dat de resulterende laag op
exact dezelfde plaats is gerenderd als de andere, en het zal het CRS EPSG:23030 hebben, omdat dat die van de
invoerlaag was.

Als u naar de attributentabel ervan gaat, zult u zien dat die anders zijn dan die uit de eerste laag die we maakten.

Dit komt omdat de originele gegevens anders zijn (het gebruikt een ander CRS), en deze coördinaten komen daar
uit.

Wat zou u hieruit moeten leren? Het belangrijkste idee achter deze voorbeelden is dat geo-algoritmen de laag
gebruiken zoals die is in zijn originele gegevensbron, en het opnieuw projecteren dat QGIS zou kunnen doen vóór
het renderen volledig negeert. Met andere woorden, vertrouw niet wat u ziet in uw kaartvenster, maar onthoud dat
altijd de originele gegevens zullen worden gebruikt. Dat is in dit geval niet zo belangrijk, omdat we slechts één
laag per keer gebruiken, maar in een algoritme dat er meerdere nodig heeft (zoals een algoritme om te clippen),
zouden lagen die overeenkomen of over elkaar liggen ver uit elkaar kunnen liggen, omdat ze verschillende CRS-en
zouden kunnen hebben.

Algoritmen voeren projecteren niet opnieuw (behalve in het algoritme voor opnieuw projecteren dat we hierna
zullen zien), dus is het aan u om er voor te zorgen dan de lagen overeenkomende CRS-en hebben.
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Een interessante module die werkt met CRS-en is die voor opnieuw projecteren. Het vertegenwoordigt een bij-
zonder geval, omdat het een invoerlaag heeft (die welke opnieuw moet worden geprojecteerd), maar het zal niet
het CRSaarvan gebruiken voor de uitvoer.

Open het algoritme Reproject layer.

Selecteer een van de lagen als invoer, en selecteer EPSG:23029 als het doel-CRS. Voer het algoritme uit en u
zult een nieuwe laag krijgen die identiek is aan die van de invoer, maar met een ander CRS. Het zal op dezelfde
regio in het kaartvenster verschijnen, net als de andere, omdat QGIS het direct opnieuw zal projecteren, maar de
originele coördinaten ervan zijn anders. U kunt dat zien door het algoritme Export/Add geometry columns uit te
voeren met deze nieuwe laag als invoer en verifiëren dat de toegevoegde coördinaten verschillen van die in de
attributentabellen van de beide andere twee lagen die we eerder hadden berekend.

17.7 Selectie

Notitie: In deze les zullen we zien hoe algoritmen van Processing selecties in vectorlagen afhandelen die worden
gebruikt als invoer, en hoe een selectie te maken met behulp van een bepaald type algoritme.

Anders dan in andere plug-ins voor analyse in QGIS, zult u in geo-algoritmen van Processing geen keuzevak
“Alleen geselecteerde objecten gebruiken” of iets dergelijks vinden. Het gedrag met betrekking tot selecteren is
ingesteld voor de gehele plug-in en al zijn algoritmen, en niet voor de uitvoering van elk algoritme. Algoritmen
volgen de volgende eenvoudige regels bij het gebruiken van een vectorlaag.

• Als de laag een selectie heeft, worden alleen geselecteerde objecten gebruikt.

• Als er geen selectie is worden alle objecten gebruikt.

Onthoud dat u dit gedrag kunt wijzigen door de relevante optie te deselecteren in het menu Processing → Opties
→ Algemeen‘.

U kunt dat zelf testen door enkele punten van een van de lagen, die we gebruikten in het laatste hoofdstuk, te
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selecteren, en het algoritme voor opnieuw projecteren daarmee uit te voeren. De opnieuw geprojecteerde laag die
u zult krijgen zal alleen de geselecteerde punten bevatten, tenzij er geen selectie was, wat er voor zal zorgen dat
de resulterende laag alle punten uit de originele laag zal bevatten.

U kunt alle beschikbare methoden en gereedschappen in QGIS gebruiken om een selectie te maken. U kunt
echter ook een algoritme gebruiken om dat te doen. Algoritmen voor het maken van een selectie kunnen worden
gevonden in de Toolbox onder Vector/Selection

Open het algoritme Random selection.

Met de standaard waarden zal het 10 punten selecteren uit de huidige laag.
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Het zal u opvallen dat dit algoritme geen uitvoer produceert, maar de invoerlaag aanpast (niet de laag zelf, maar
de selectie ervan). Dit is afwijkend gedrag, omdat alle andere algoritmen nieuwe lagen zullen produceren en niet
de invoerlagen wijzigen.

Omdat de selectie geen deel is van de gegevens zelf, maar iets dat alleen bestaat binnen GIS, moeten deze algorit-
men voor selectie alleen worden gebruikt voor het selecteren van een laag die is geopend in QGIS, en niet met de
optie voor het selecteren van een bestand dat u vindt in het overeenkomende vak voor de waarde van de parameter.

De selectie die we zojuist hebben gemaakt, net zoals de meeste andere zoals die worden gemaakt door de rest van
de algoritmen voor selectie, kan ook handmatig vanuit QGIS worden gemaakt, dus u zou zich af kunnen vragen
wat het nut is van het gebruiken van een algoritme daarvoor. Hoewel dat op dit moment misschien niet zinvol lijkt
voor u, zullen we later zien hoe we modellen en scripts maken. Als u een selectie in het midden van een model wilt
maken (wat een werkstroom voor verwerking definieert), kan alleen een geo-algoritme worden toegevoegd aan een
model, en andere elementen van QGIS en bewerkingen kunnen niet worden toegevoegd. Dat is de reden waarom
enkele algoritmeen voor Processing functionaliteit dupliceren die ook beschiknbaar is in andere elementen van
QGIS.

Onthoud op dit moment alleen dat selecties kunnen worden gemaakt met behulp van processing geo-algoritmen
voor Processing, en dat algoritmen alleen de geselecteerde objecten gebruiken als er een selectie aanwezig is,
anders worden alle objecten gebruikt.

17.8 Een extern algoritme uitvoeren

Notitie: In deze les zullen we zien hoe we algoritmen gebruiken die afhankelijk zijn van een toepassing van een
derde partij, in het bijzonder SAGA, die één van de belangrijkste providers van algoritmen is.

Alle algoritmen die we tot dusverre hebben uitgevoerd maken deel uit van het framework Processing. Dat is,
zij zijn eigen algoritmen die zijn geïmplementeerd in de plug-in en worden uitgevoerd door QGIS net zoals de
plug-in zelf wordt uitgevoerd. Echter, één van de grootste mogelijkheden van het framework Processing is dat
het algoritmen kan gebruiken van externe toepassingen en de mogelijkheden van die toepassingen kan uitbrei-
den. Dergelijke algoritmen zijn verpakt en opgenomen in de Toolbox, zodat u ze eenvoudig vanuit QGIS kunt
gebruiken, en gegevens van QGIS kunt gebruiken om ze uit te voeren.

Sommig algoritmen die u ziet in de vereenvoudigde weergave vereisen dat toepassingen van derde partijen zijn
geïnstalleerd op uw systeem. Een provider van algoritmen die speciale aandacht behoeft is SAGA (System for
Automated Geospatial Analysis). Eerst moeten we alles configureren zodat QGIS SAGA op de juiste wijze kan
aanroepen. Dit is niet moeilijk, maar het is belangrijk te weten hoe dit werkt. Elke externe toepassing heeft zijn
eigen configuratie, en later in deze zelfde handleiding zullen we enkele van de andere bespreken, maar SAGA zal
ons belangrijkste backend zijn, dus zullen we dat hier bespreken.

Als u op Windows werkt, is de beste manier om met externe algoritmen te werken om QGIS te installeren met
behulp van het zelfstandige installatieprogramma. Dat zal zorg dragen voor het installeren van alle benodigde
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afhankelijkheden, inclusief SAGA, dus als u het heeft gebruikt, is er niets anders te doen. U kunt het dialoogven-
ster Instellingen openen en naar de groep Providers/SAGA gaan.

Het pad SAGA zou reeds moeten zijn geconfigureerd en moeten wijzen naar de map waar SAGA is geïnstalleerd.

Als u QGIS heeft geïnstalleerd zonder het zelfstandige installatieprogramma, dan moet u daar het pad naar uw
installatie van SAGA invoeren (wat u afzonderlijk zou moeten hebben geïnstalleerd). De vereiste versie is SAGA
2.1 [dit wijzigt overeenkomstig de uitgaven van SAGA].

Voor het geval u Linux gebruikt hoeft u het pad naar uw installatie van SAGA niet in te stellen in de configuratie
van processing. In plaats daarvan moet u SAGA installeren en er voor zorgen dat de map van SAGA in PATH
staat, zodat het kan worden aangeroepen vanaf de console (open eenvoudigweg een console en typ saga_cmd
om het te controleren). Onder Linux is de doelversie van SAGA ook 2.1, maar in sommige installaties (zoals
de OSGeo Live DVD) heeft u misschien alleen 2.0.8 beschikbaar. er zijn enkele pakketten voor 2.1 beschikbaar,
maar zij worden niet algemeen geïnstalleerd en zouden enkele problemen kunnen hebben, dus als u liever de
meer algemene en stabielere 2.0.8 zou willen gebruiken, dan kunt u dat doen door compatibiliteit voor 2.0.8 in te
schakelen in het dialoogvenster voor configuratie, onder de groep SAGA.
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Als SAGA eenmaal is geïnstalleerd, kunt u een algoritme van SAGA starten door dubbel te klikken op de naam
ervan, net als met elk ander algoritme. Omdat we de vereenvoudigde interface gebruiken, weet u niet welke
algoritmen zijn gebaseerd op SAGA of een andere externe toepassing, maar als dubbelklikt op een er van en de
overeenkomende toepassing is niet geïnstalleerd, zult u iets soortgelijks als dit zien.

In ons geval, en er van uit gaande dat SAGA juist is geïnstalleerd en geconfigureerd, zou u dit venster niet zien,
en u zou in plaats daarvan naar het dialoogvenster voor de parameters gaan.

Laten we het eens proberen met een algoritme dat is gebaseerd op SAGA, dat welke is genaamd Split shapes layer

454 Chapter 17. De QGIS-gids voor Processing



QGIS Training Manual, Release 2.14

randomly.

Gebruik de puntenlaag in het project dat bedoeld is voor deze les als invoer, en de standaard waarden voor de
parameters, en u zult iets zoals dit krijgen (de splitsing is willekeurig, dus uw resultaat zou anders kunnen zijn).

De invoerlaag is gesplitst in twee lagen, elk met hetzelfde aantal punten. Dit resultaat is berekend door SAGA, en
later overgenomen door QGIS en toegevoegd aan het project van QGIS.

Als alles goed gaat zult u geen verschil merken tussen dit op SAGA gebaseerde algoritme en een van de andere
die we eerder uitgevoerd hebben. Echter, SAGA zou, om enige reden, niet in staat kunnen zijn een resultaat
te produceren en niet het bestand genereren dat QGIS verwacht. In dat geval zullen er problemen zijn om het
resultaat toe te voegen aan het project van QGIS, en een foutbericht zoals dit zal worden weergegeven.
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Dit soort problemen zouden kunnen voorkomen, zelfs als SAGA (of enige andere toepassing die we aanroepen
vanuit het framework Processing) correct is geïnstalleerd, en het is belangrijk te weten hoe dit af te handelen.
Laten we eens een van deze foutberichten produceren.

Open het algoritme Create graticule en gebruik de volgende waarden.

We gebruiken waarden voor breedte en hoogte die groter zijn dan het gespecificeerde bereik, dus kan SAGA geen
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uitvoer produceren. Met andere woorden, de waarden van de parameters zijn verkeerd, maar zij worden niet
gecontroleerd totdat SAGA ze krijgt en probeert het raster te maken. Omdat het het niet kan maken, zal het niet
de verwachte laag produceren, en u zult het foutbericht dat hierboven wordt weergegeven zien.

Notitie: In SAGA >= 2.2.3 zal de opdracht automatisch verkeerde gegevens voor invoer aanpassen, zodat u geen
fout krijgt. Gebruik negatieve waarden voor delen om een fout uit te lokken.

Het begrijpen van dit soort problemen zal u helpen ze op te lossen en een verklaring te vinden voor wat er gebeurt.
Zoals u in het foutbericht kunt zien wordt een test uitgevoerd om te controleren of de verbinding met SAGA
correct werkt, wat voor u een indicatie zou kunnen zijn dat er een probleem zou kunnen zijn in hoe het algoritme
werd uitgevoerd. Dit is niet alleen van toepassing op SAGA, maar ook op andere externe toepassingen.

In de volgende les zullen we het log van de verwerking introduceren, waar informatie over opdrachten, uitgevoerd
door geo-algoritmen, wordt bijgehouden, en u zult zien hoe u meer details verkrijgt als problemen zoals deze
optreden.

17.9 Het log van de verwerking

Notitie: Deze les beschrijft het log van de verwerking.

Alle analyses die worden uitgevoerd met het framework Processing wordt gelogd in zijn het systeem voor loggen
in QGIS. Dit stelt u in staat meer te weten te komen over wat er met de gereedschappen voor Processing is gedaan,
om problemen op te lossen als zij voorkomen, en ook om eerder uitgevoerde bewerkingen opnieuw uit te voeren,
omdat het systeem voor loggen ook enige interactiviteit implementeert.

Klik op de ballon rechtsonder op de statusbalk van QGIS om het log te openen. Sommige algoritmen zouden
hier informatie achter kunnen laten over hun uitvoering. Bijvoorbeeld: die algoritmen die een externe toepassing
aanroepen loggen gewoonlijk de uitvoer van de console van die toepassing in dit item. Als u er naar kijkt zult
u zien dat de uitvoer van het algoritme van SAGA dat we zojuist hebben uitgevoerd (en die mislukte omdat de
gegevens voor de invoer niet juist waren) hier is opgeslagen.

Dit is behulpzaam om te begrijpen wat er aan de hand is. Gevorderde gebruikers zullen in staat zijn die uitvoer te
analyseren om uit te zoeken waarom het algoritme faalde. Als u geen gevorderde gebruiker bent, zal dit bruikbaar
zijn om anderen u te laten helpen het probleem dat u heeft te diagnosticeren, wat een probleem zou kunnen zijn in
de installatie van de externe software of een probleem met de gegevens die u verschafte.

Zelfs als het algoritme zou kunnen worden uitgevoerd, zouden sommige algoritmen waarschuwingen achter kun-
nen laten in het geval dat het resultaat niet juist zou kunnen zijn. Bijvoorbeeld bij het uitvoeren van een algoritme
voor interpolatie met een zeer klein aantal punten, het algoritme kan worden uitgevoerd en zal een resultaat pro-
duceren, maar het is aannemelijk dat het niet juist zal zijn, omdat meer punten zouden moeten worden gebruikt.
Het is een goed idee om regelmatig op dit type waarschuwingen te controleren als u niet zeker bent van bepaalde
aspecten van een bepaald algoritme.

In het menu Processing, onder het gedeelte Geschiedenis, vindt u ALGORITHM. Alle algoritmen die worden
uitgevoerd, zelfs als zij worden uitgevoerd vanuit de GUI en niet vanuit de console (wat later in deze handleiding
zal worden uitgelegd) worden in deze sectie van het log opgeslagen als een aanroep van de console. Dat betekent
dat elke keer dat u een algoritme uitvoert, een opdracht voor de console wordt toegevoegd aan het log, en u een
volledige geschiedenis heeft van uw werksessie. Hier is hoe die geschiedenis er uit ziet:
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Dit kan erg bruikbaar zijn bij het beginnen te werken met de console, om te leren over de syntaxis van algoritmen.
We zullen het gebruiken wanneer we bespreken hoe opdrachten voor analyses vanuit de console uit te voeren.

De geschiedenis is ook interactief, en u kunt elk eerder algoritme opnieuw uitvoeren door eenvoudigweg op het
item ervan te dubbelklikken. Dit is een eenvoudige manier voor het herhalen van werk dat we al eerder gedaan
hebben.

probeer bijvoorbeeld het volgende. Open de gegevens die overeenkomen met het eerste hoofdstuk van deze
handleiding en voer het daar uitgelegde algoritme uit. Ga nu naar het dialoogvenster van het log en zoek het
laatste algoritme in de lijst op, wat correspondeert met het algoritme dat u zojuist heeft uitgevoerd. Dubbelklik
erop en een nieuw resultaat zou moeten worden geproduceerd, net zoals wanneer u het uitvoert als met het normale
dialoogvenster en het aanroept vanuit de Toolbox.

17.9.1 Gevorderd

U kunt ook het algoritme aanpassen. Kopieer het eenvoudigweg, open Plug-ins → Python-console, klik op
Importeer klasse → Importeer klsse Processing, en plak het dan om de analyse opnieuw uit te voeren; wijzig
de tekst zoals u wilt. Typ iface.addVectorLayer(’/pad/bestandsnaam.shp’, ’Laagnaam in
legenda’, ’ogr’) om het resulterende bestand weer te geven. Anders kunt u processing.runandload
gebruiken.

17.10 De Raster calculator. Waarden Geen gegevens

Notitie: In deze les zullen we zien hoe we de Raster calculator gebruiken om enkele bewerkingen op rasterla-
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gen uit te voeren. We zullen ook uitleggen wat waarden Geen gegevens zijn en hoe de berekeningen en andere
algoritmen die behandelen

De Raster calculator is een van de meest krachtige algoritmen die u zult tegenkomen. Het is een enorm flexibel en
veelzijdig algoritme dat voor veel verschillende berekeningen kan worden gebruikt, en een dat snel een belangrijk
deel van uw gereedschapskist zal zijn.

In deze les zullen we enkele berekeningen met Raster calculator uitvoeren, de meeste daarvan redelijk eenvoudig.
Dat zal ons laten zien hoe het wordt gebruikt en hoe het enkele bijzondere situaties behandelt die het zou kunnen
tegenkomen. Dat begrijpen is belangrijk om later de verwachte resultaten te krijgen bij het gebruiken van Raster
calculator, en ook om bepaalde technieken te begrijpen die er algemeen mee toegepast worden.

Open het project voor QGIS voor deze les en u zult zien dat het verschillende rasterlagen bevat.

Open nu de Toolbox en open het dialoogvenster dat correspondeert met de Raster calculator.

Notitie: De interface is anders in recente versies.

Het dialoogvenster bevat 2 parameters.

• De voor de analyse te gebruiken lagen. Dit is een meervoudige invoer, wat betekent dat u zoveel lagen kunt
selecteren als u wilt. Klik op de knop aan de rechterkant en selecteer dan de lagen die u wilt gebruiken in
het dialoogvenster dat verschijnt.

• De toe te passen formule. De formule gebruikt de lagen die zijn geselecteerd in de parameter hierboven,
die worden vermeld met letters uit het alfabet (a, b, c...) of g1, g2, g3... als namen voor
variabelen. Dat is, de formule a + 2 * b is hetzelfde als g1 + 2 * g2 en zal de som van de waarde
in de eerste laag plus twee keer de waarde van de tweede laag berekenen. De volgorde van de lagen is
dezelfde volgorde als die welke u ziet in het dialoogvenster voor de selectie.

Waarschuwing: De calculator is hoofdlettergevoelig.
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We zullen, om mee te beginnen, de eenheden van de DEM wijzigen van meters naar voet. De formule die we
nodig hebben is de volgende:

h’ = h * 3.28084

Selecteer de DEM in het veld voor de lagen en typ a * 3.28084 in het veld voor de formule.

Waarschuwing: Voor niet Engelse gebruikers: gebruik altijd ”.”, niet ”,”.

Klik op Run om het algoritme uit te voeren. U zult ene laag krijgen die er hetzelfde uitziet als de invoerlaag, maar
met andere waarden. De invoerlaag die we gebruikten had geldige waarden in al zijn cellen, dus heeft de laatste
parameter in het geheel geen effect.

Laten we nu een andere berekening uitvoeren, deze keer op de laag accflow. Deze laag bevat waarden van een
geaccumuleerde stroom, een hydrologische parameter. Het bevat alleen die waarden binnen het gebied van een
bepaalde waterkering, zonder waarden geen gegevens daarbuiten. Zoals u kunt zien, is het renderen niet erg
informatief, vanwege de manier waarop de waarden zijn verdeeld. Gebruiken van de logaritme van die accumulatie
van die stroom zal een veel meer informatieve weergave opleveren. We kunnen die berekenen met behulp van de
Raster calculator.

Open opnieuw het dialoogvenster voor het algoritme, selecteer de laag accflow als de enige laag voor de invoer,
en voer de volgende formule in: log(a).

Hier is de laag die u zult krijgen.

Als u het gereedschap Object identificeren selecteert om de waarde van een laag op een bepaald punt te weten te
komen, selecteer de laag die we zojuist hebben gemaakt en klik op een punt buiten het bassin, u zult zien dat het
een waarde Geen gegevens bevat.
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Voor de volgende oefening gaan we twee lagen gebruiken in plaats van een, en we zullen een DEM gaan krijgen
met alleen geldige waarden binnen het bassin, gedefinieerd in de tweede laag. Open het dialoogvenster voor de
calculator en selecteer beide lagen van het project in het veld voor de invoerlagen. Voer de volgende formule in
het corresponderende veld in:

a/a * b

a verwijst naar de laag met de geaccumuleerde stroom (omdat het de eerste in de lijst is) en b verwijst naar de
DEM. Wat we hier in het eerste deel van de formule gaan doen is de laag met de geaccumuleerde stroom delen
door zichzelf, wat zal resulteren in een waarde 1 binnen het bassin, en een waarde Geen gegevens daarbuiten. Dan
vermenigvuldigen we met de DEM, om de hoogtewaarden in de cellen binnen het bassin te krijgen (DEM * 1 =
DEM) en de waarden Geen gegevens daarbuiten (DEM * no_data = no_data)

Hier is de resulterende laag.

Deze techniek wordt regelmatig gebruikt om waarden in een rasterlaag te maskeren, en is bruikbaar wanneer u
berekeningen uit wilt voeren op een andere regio dan de willekeurige rechthoekige regio die wordt gebruikt door de
rasterlaag. Een hoogte-histogram bijvoorbeeld van een rasterlaag heeft weinig betekenis. Als het echter berekend
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met alleen de waarden die overeenkomen met een bassin (zoals in het bovenstaande geval), is het resultaat dat we
verkrijgen een betekenisvolle die in feite informatie geeft over de configuratie van het bassin.

Los van de waarden Geen gegevens en hoe zij worden afgehandeld zijn er andere interessante dingen met be-
trekking tot dit algoritme dat we zojuist hebben uitgevoerd. Als u eens kijkt naar de bereiken van de lagen die
we hebben vermenigvuldigd (u kunt dat doen door te dubbelklikken op de naam van de laag in de inhoudsopgave
en hun eigenschappen bekijken), zult u zien dat zij niet hetzelfde zijn, omdat het bereik dat wordt bedekt door de
laag van de geaccumuleerde stroom kleiner is dan het bereik van de volledige DEM.

Dat betekent dat deze lagen niet overeenkomen, en dat zij niet direct kunnen worden vermenigvuldigd zonder die
grootten en bereiken te homogeniseren door één of beide lagen te resamplen. Wij deden echter helemaal niets.
QGIS handelt deze situatie af en resampled automatisch invoerlagen als dat nodig is. Het bereik van de uitvoer
is het minimale bedekte bereik dat wordt berekend vanuit de invoerlagen, en de minimale celgrootte van hun
celgrootten.

In dit geval (en in de meeste gevallen), produceert dit de gewenste resultaten, maar u zou zich altijd bewust moeten
zijn van de aanvullende bewerkingen die plaatsvinden, omdat zij het resultaat zouden kunnen beïnvloeden. In
gevallen wanneer dit gedrag niet gewenst is, zou van tevoren handmatig moeten worden geresampled. In latere
hoofdstukken zullen we meer zien over het gedrag van algoritmen indien gebruikt met meerdere rasterlagen.

Laten we deze les afsluiten met een andere oefening in maskeren. We gaan de helling berekenen voor alle gebieden
met een hoogte tussen 1000 en 1500 meter.

In dit geval hebben we geen laag die we als masker kunnen gebruiken, maar die kunnen we maken met behulp
van de calculator.

Voer de calculator uit met behulp van de DEM als enige invoerlaag en de volgende formule

ifelse(abs(a-1250) < 250, 1, 0/0)

Zoals u kunt zien gebruiken we de calculator niet alleen om eenvoudige algebraïsche bewerkingen uit te voeren,
maar ook om meer complexe berekeningen uit te voeren die voorwaardelijke zinnen in zich hebben, zoals die
hierboven.

Het resultaat heeft een waarde van 1 binnen het bereik waarmee we willen werken, en Geen gegevens in cellen
daarbuiten.

De waarde geen gegevens komt uit de uitdrukking 0/0. Omdat dat een onbepaalde waarde is, zal SAGA een
waarde NaN (Not a Number) toevoegen, die in feite wordt behandeld als een waarde Geen gegevens. Met deze
kleine truc kunt u een waarde Geen gegevens instellen, zonder dat u hoeft te weten wat de waarde geen gegevens
van de cel is.

462 Chapter 17. De QGIS-gids voor Processing



QGIS Training Manual, Release 2.14

Nu hoeft u het nog slechts te vermenigvuldigen met de laag van de helling die is opgenomen in het project, en zult
u het gewenste resultaat verkrijgen.

Dit kan allemaal worden gedaan in één enkele bewerking met de calculator. We laten dat als een oefening voor de
lezer.

17.11 Vectorcalculator

Notitie: In deze les zullen we zien hoe we nieuwe attributen toevoegen aan een vectorlaag, gebaseerd op een
rekenkundige uitdrukking, met behulp van de vectorcalculator.

We weten al hoe we de raster calculator moeten gebruiken om nieuwe lagen te maken met behulp van rekenkundige
uitdrukkingen. Een soortgelijk algoritme is beschikbaar voor vectorlagen, en genereert een nieuwe laag met
dezelfde attributen van de invoerlaag, plus een aanvullende met het resultaat van de ingevoerde uitdrukking. Het
algoritme heet Veld calculator en heeft het volgende dialoogvenster voor parameters.

Notitie: In nieuwere versies van Processing is de interface aanzienlijk gewijzigd, hij is krachtiger en eenvoudiger
te gebruiken.

Hier zijn enkele voorbeelden van het gebruik van dat algoritme.

Laten we eerst de bevolkingsdichtheid berekenen van blanke mensen in elke polygoon, wat een census
weergeeft. We hebben twee velden in de attributentabel die we daarvoor kunnen gebruiken, namelijk WHITE
en SHAPE_AREA. We moeten ze alleen delen en vermenigvuldigen met 1 miljoen (om de dichtheid per vierkante
km te verkrijgen), dus we kunnen de volgende formule in het overeenkomstige veld gebruiken

( "WHITE" / "SHAPE_AREA" ) * 1000000

Het dialoogvenster voor de parameters zou moeten worden gevuld zoals hieronder weergegeven.
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Dit zal een nieuw veld genereren, genaamd WHITE_DENS

Laten we nu de ratio berekenen tussen de velden MALES en FEMALES om een nieuw veld te maken dat aangeeft
of de mannelijk bevolking numeriek domineert boven de vrouwelijke bevolking.

Voer de volgende formule in

"MALES" / "FEMALES"

Deze keer zou het venster met de parameters er zo uit moeten zien voordat op de knop OK wordt gedrukt.
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In een eerdere versie zou, omdat beide velden van het type integer zijn, het resultaat worden afgebroken tot een
integer. In dit geval zou de formule : 1.0 * "MALES" / "FEMALES" moeten zijn, om aan te geven dat we
een getal floating point als resultaat willen hebben.

We kunnen voorwaardelijke functies gebruiken om een nieuw veld met tekststrings male of female te krijgen
in plaats van de waarden voor de ratio, met behulp van de volgende formule:

CASE WHEN "MALES" > "FEMALES" THEN ’male’ ELSE ’female’ END

Het venster voor de parameters zou er zo uit moeten zien.
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Een Python veldcalculator is beschikbaar in de “Advanced Python field calculator”, waarover we hier niet in detail
treden
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17.12 Bereiken definiëren

Notitie: In deze les zullen we zien hoe we bereiken definiëren, die bij sommige algoritmen nodig zijn, in het
bijzonder voor rasters.

Sommige algoritmen vereisen een bereik om het gebied te definiëren dat moet worden bedekt door de analyse die
zij uitvoeren, en gewoonlijk ook om het bereik van de resulterende laag te definiëren.

Wanneer een bereik wordt vereist, kan het handmatig gedefinieerd worden door de vier waarden die het definieert
in te voeren (min X, min Y, max X, max Y), maar er zijn ook meer praktische en interessantere manieren om dat
te doen. We zullen ze allemaal zien in deze les.

Laten we eerst een algoritme openen dat vereist dat een bereik wordt gedefinieerd. Open het algoritme Rasterize,
wat een rasterlaag uit een vectorlaag maakt.
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Alle parameters, met uitzondering van de laatste twee, worden gebruikt om te definiëren welke laag moet worden
omgezet naar een raster, en configureren hoe het proces van het omzetten naar raster zou moeten werken. De twee
laatste parameters, aan de andere kant, definiëren de karakteristieken voor de uitvoerlaag. Dat betekent dat zij het
gebied definiëren dat wordt bedekt (wat niet noodzakelijkerwijze hetzelfde gebied is als dat wat wordt bedekt door
de invoerlaag), en de resolutie/celgrootte (die niet kan worden afgeleid vanuit de vectorlaag, omdat vectorlagen
geen celgrootten hebben).

Het eerste dat u kunt doen is de 4 waarden voor de definitie, zoals hierboven besproken, in te typen, gescheiden
door komma’s.

Dat behoeft geen nadere extra uitleg. Hoewel dit de meest flexibele optie is, is het in sommige gevallen ook minder
praktisch, en dat is waarom ander opties werden geïmplementeerd. U moet op de knop aan de rechterkant van het
tekstvak voor het bereik klikken om daar toegang toe te krijgen.

Laten we eens kijken wat elk ervan doet.

De eerste optie is Use layer/canvas extent, wat het dialoogvenster voor selectie zal weergeven dat hieronder staat.
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Hier kunt u het bereik voor het kaartvenster selecteren (het bereik dat wordt bedekt door de huidige zoom), of
het bereik van elk van de beschikbare lagen. Selecteer het en klik op OK, en het tekstvak zal automatisch worden
gevuld met de overeenkomende waarden.

De tweede optie is Select extent on canvas. In dit geval verdwijnt het dialoogvenster van het algoritme en kunt u
in het kaartvenster van QGIS klikken en slepen om het gewenste bereik te definiëren.

Als u de muisknop weer loslaat zal het dialoogvenster weer verschijnen en zal het tekstvak al de waarden bevatten
die overeenkomen met het gedefinieerde bereik.

De laatste optie is Use min covering extent from input layers, wat de standaard optie is. Dit zal de minimale bedekte
bereik berekenen van alle lagen die gebruikt zullen worden om het algoritme uit te voeren, en er is geen reden
om enige waarde in het tekstvak in te voeren. In het geval van één enkele invoerlaag, zoals in het algoritme dat
we uitvoeren, kan hetzelfde bereik worden verkregen door diezelfde invoerlaag te selecteren in Use layer/canvas
extent die we al eerder zagen. Echter, wanneer er verscheidene invoerlagen zijn, correspondeert het minimale
bedekte bereik niet met enig bereik van de invoerlaag, omdat het uit alle tezamen wordt berekend.

We zullen deze laatste methode gebruiken om ons algoritme voor het omzetten naar raster uit te voeren.

Vul het dialoogvenster voor de parameters zoals hieronder weergegeven en druk op OK.
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Notitie: In dit geval is het beter een Integer (1 byte) te gebruiken in plaats van een Floating point (4 byte), omdat
de NAME een integer is met de maximale waarde=64. Dit zal resulteren in een kleinere bestandsgrootte en snellere
berekeningen.

U zult een rasterlaag verkrijgen die exact het gebied bedekt dat wordt bedekt door de originele vectorlaag.
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In sommige gevallen zou de laatste optie, Use min covering extent from input layers, niet beschikbaar kunnen zijn.
Dit zal gebeuren bij die algoritmen die geen invoerlagen hebben, maar slechts parameters van andere typen. In dat
geval zult u de waarde handmatig moeten invoeren of een van de andere opties gebruiken.

Onthoud dat, wanneer een selectie bestaat, het bereik van de laag dat van de gehele verzameling objecten is, en
de selectie wordt niet gebruikt voor de berekening van het bereik, zelfs hoewel het rasteriseren werd uitgevoerd
op alleen de geselecteerde items. In dat geval wilt u misschien een nieuwe laag maken van de selectie, en die dan
gebruiken als invoer.

17.13 HTML-uitvoer

Notitie: In deze les leren we hoe QGIS uitvoer in de indeling HTML afhandelt, die wordt gebruikt om uitvoer
als tekst en afbeeldingen te produceren.

Alle uitvoer die we tot dusverre hebben geproduceerd waren lagen (zowel raster als vector). Echter, sommige
algoritmen genereren uitvoer in de vorm van tekst en afbeeldingen. Al deze uitvoer wordt verpakt in in HTML-
bestanden en weergegeven in het zogenaamde venster Resultaten, wat een ander element is van het framework
Processing.

Laten we eens naar één van die algoritmen kijken om te begrijpen hoe die werken.

Open het project met de gegevens die in de les moeten worden gebruikt en open dan het algoritme Basic statistics
for numeric fields.
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Het algoritme is nogal eenvoudig, en u hoeft slechts de laag te selecteren die moet worden gebruikt en één veld
daarvan (een numeriek veld). De uitvoer is van het type HTML, maar het overeenkomstige vak werkt exact zoals
dat wat u zult vinden in het geval van een uitvoer als raster of vector. U kunt ofwel een bestandspad invoeren of
het leeg laten om naar een tijdelijk bestand op te slaan. In dit geval, zijn echter alleen de extensies html en htm
toegestaan, dus is er geen manier om de indeling van de uitvoer te wijzigen door een andere te gebruiken.

Voer het algoritme uit door de enige laag in het project als invoer te selecteren, en het veld POP2000, en een nieuw
dialoogvenster zoals dat wat hieronder wordt weergegeven zal verschijnen zodra het algoritme is uitgevoerd en
het dialoogvenster voor de parameters wordt gesloten.
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Dit is het venster Resultaten. Het bevat alle HTML-resultaten die zijn gegenereerd gedurende de huidige sessie,
eenvoudig toegankelijk, dus u kunt ze snel controleren wanneer u ze maar nodig heeft. Net zoals met lagen, als
u de uitvoer hebt opgeslagen naar een tijdelijk bestand, zal het worden verwijderd als u QGIS afsluit. Als u hebt
opgeslagen naar een niet tijdelijk pad, wordt het bestand behouden, maar het zal niet verschijnen in het venster
Resultaten als u de volgende keer QGIS opent.

Sommige algoritmen genereren tekst die niet kan worden opgedeeld in meer gedetailleerde uitvoer. Dat is het
geval als, bijvoorbeeld, het algoritme de tekstuitvoer vastlegt vanuit een extern proces. In andere gevallen wordt
de uitvoer gepresenteerd als tekst, maar wordt intern opgedeeld in verscheidene kleinere uitvoeren, gewoonlijk in
de vorm van numerieke waarden. Het algoritme dat we zojuist hebben uitgevoerd is er daar één van. Elk van deze
waarden wordt afgehandeld als één enkele uitvoer, en opgeslagen in een variabele. Dit heeft op dit moment geen
enkel belang, maar als we eenmaal doorgaan naar Grafische modellen bouwen, zult u zien dat het ons zal toestaan
die waarden te gebruiken als numerieke invoer voor andere algoritmen.

17.14 Eerste voorbeeld analyse

Notitie: In deze les zullen we enkele echte analyses uitvoeren met behulp van alleen de Toolbox, zodat u meer
bekend raakt met de elementen van het framework Processing.

Nu alles is geconfigureerd en we externe algoritmen kunnen gebruiken, hebben we een zeer krachtig gereedschap
om ruimtelijke analyses uit te voeren. Het is tijd om een wat grotere oefening met gegevens uit de echte wereld
uit te werken.

We zullen de welbekende gegevensset gebruiken die John Snow gebruikte in zijn baanbrekende werk in 1854
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(http://en.wikipedia.org/wiki/John_Snow_%28physician%29), en we zullen enkele interessante resultaten verkrij-
gen. De analyse van deze gegevensset is redelijk helder en er is geen noodzaak voor ingewikkelde GIS-technieken
om te eindigen met goede resultaten en conclusies, maar het is een goede manier om weer te geven hoe deze
ruimtelijke problemen kunnen worden geanalyseerd en opgelost door verschillende gereedschappen van Process-
ing.

De gegevensset bevat shapefiles met choleradoden en pomplocaties, en een OSM gerenderde kaart in de indeling
TIFF. Open het overeenkomstige project van QGIS voor deze les.

Het eerste dat moet worden gedaan is het Voronoi-diagram berekenen (ook bekend als. Thyessen polygonen)
van de laag Pumps, om de zone van invloed voor elke pomp te verkrijgen. Het algoritme Voronoi Diagram kan
daarvoor worden gebruikt.
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Redelijk eenvoudig, maar het geeft ons al interessante informatie.
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Duidelijk, de meeste gevallen liggen binnen een van de polygonen

We kunnen het aantal doden in elk polygoon tellen om een meer kwantitatief resultaat te verkrijgen,. omdat elk
punt een gebouw weergeeft waar doden vielen, en het aantal doden is opgeslagen in een attribuut, kunnen we
niet eenvoudigweg de punten tellen. We hebben een gewogen telling nodig, dus zullen we het gereedschap Count
points in polygon (weighted) gebruiken.
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Het nieuwe veld zal DEATHS worden genoemd, en we gebruiken het veld COUNT als het te wegen veld. De
resulterende tabel geeft duidelijk aan dat het aantal doden in de polygoon die overeenkomt met de eerste pomp
veel groter is dan in de andere.
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Een andere goede manier om de afhankelijkheid van elk punt op de laag Cholera_deaths te visualiseren met
een punt in de laag Pumps is om een lijn te tekenen naar het dichtstbijzijnde. Dit kan worden gedaan met het
gereedschap Distance to nearest hub, en de hieronder getoonde configuratie te gebruiken.
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Het resultaat ziet er uit als dit:
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Hoewel het aantal lijnen groter is in het geval van de centrale pomp, vergeet niet dat dit niet het aantal doden
weergeeft, maar het aantal locaties waar choleragevallen werden aangetroffen. Het is een representatieve param-
eter, maar het houdt geen rekening met het feit dat sommige locaties meer gevallen zouden kunnen hebben dan
andere.

Een laag voor dichtheid zal ons ook een zeer helder beeld geven van wat er gebeurt. We kunnen die maken met
het algoritme Kernel density. Door de laag Cholera_deaths te gebruiken, het veld COUNT daarvan als veld om te
wegen, met een straal van 100, het bereik en de celgrootte van de rasterlaag Streets, krijgen we zoiets als dit.
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Onthoud dat, om het bereik voor uitvoer te krijgen, u die niet hoeft in te voeren. Klik op de knop aan de rechterkant
en selecteer Use layer/canvas extent.
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Selecteer de rasterlaag Streets en het bereik daarvan zal automatisch worden toegevoegd aan het tekstveld. U moet
hetzelfde doen voor de celgrootte, door ook de celgrootte van die laag te selecteren.

Door dit te combineren met de laag Pumps, zien we dat er slechts één pomp duidelijk in de hotspot ligt waar de
maximale dichtheid van dodelijke gevallen is gevonden.

17.15 Rasterlagen clippen en samenvoegen

Notitie: In deze les zullen we een ander voorbeeld van ruimtelijke voorbereiding zien, om het gebruiken van
geo-algoritmen in scenario’s van de echte wereld te vervolgen.

Voor deze les gaan we een hellingslaag berekenen voor een gebied dat een stedelijk gebied omsluit, wat is
opgegeven in een vectorlaag met één enkele polygoon. De basis DEM is opgedeeld in twee rasterlagen die,
tezamen, een veel groter gebied bedekken dan dat rondom de stad waarmee we willen werken. Als u het project
opent dat overeenkomt met deze les, zult u iets zoals dit zien.
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Deze lagen hebben twee problemen:

• Zij bedekken ene gebied dat veel te groot is voor wat we willen (we zijn geïnteresseerd in een kleinere regio
rondom het centrum van de stad)

• Zij staan in twee verschillende bestanden (de stadsgrenzen vallen precies binnen één enkele rasterlaag, maar,
zoals gezegd, we willen er wat extra gebied rondom bij).

Beide zijn eenvoudig op te lossen met behulp van de toepasselijke geo-algoritmen.

Eerst willen we een rechthoek maken die het gebied definieert dat we willen. We maken, om dit te doen, een laag
die het begrenzingsvak van de laag met de grenzen van het stedelijk gebied bevat, en dan bufferen we die, om een
rasterlaag te verkrijgen die iets meer bedekt dan strikt noodzakelijk.

We kunnen het algoritme Polygon from layer extent gebruiken om het begrenzingsvak te berekenen.
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We gebruiken het algoritme Fixed distance buffer, met de volgende waarden voor de parameters om het te bufferen.
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Waarschuwing: Syntaxis is in recente versies gewijzigd; stel zowel Afstand als Boogpunt in op .25

Hier is het resulterende begrenzingsvak dat is verkregen met behulp van de hierboven weergegeven parameters

Het is een afgerond vak, maar we kunnen eenvoudig het equivalente vak met vierkante hoeken verkrijgen door het
algoritme Polygon from layer extent er op uit te voeren. We zouden eerst de stadsgrenzen hebben kunnen bufferen,
en dan de rechthoek van het bereik berekenen, wat ons één stap bespaart.

Het zal u opvallen dat de rasters een verschillende projectie dan de vector hebben. We zouden ze daarom opnieuw
moeten projecteren, met behulp van het gereedschap Warp (Herprojecteren), voordat we verder gaan.
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Notitie: Recente versies hebben een meer complexe interface. Zorg er voor dat tenminste één methode voor
compressie is geselecteerd.

Met deze laag, die het begrenzingsvak bevat van de rasterlaag die we willen verkrijgen, kunnen we beide rasterla-
gen bijsnijden, met behulp van het algoritme Clip raster with polygons.
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Als de lagen eenmaal zijn bijgesneden, kunnen zij worden samengevoegd met behulp van het algoritme van GDAL
Merge.
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Notitie: U kunt tijd besparen door eerst samen te voegen en dan bij te snijden, en u zult voorkomen dat u
het algoritme voor clippen tweemaal moet aanroepen. Als er echter meerdere lagen zijn die moeten worden
samengevoegd en zij zijn van een nogal aanzienlijke grootte, dan zult u eindigen met een grote laag die later
misschien moeilijk te verwerken is. In dat geval dient u misschien het algoritme voor clippen meerder malen aan
te roepen, wat tijd zou kunnen vergen, maar maak u geen zorgen, we zullen snel zien dat er enkele aanvullende
gereedschappen zijn om die bewerking te automatiseren. In dit voorbeeld hebben we slechts twee lagen, dus u
zou zich daar nu geen zorgen over moeten maken.

Daarmee krijgen we de uiteindelijke DEM die we willen.

Nu is het tijd om de hellingslaag te berekenen.

Een hellingslaag kan worden berekend met het algoritme Slope, Aspect, Curvature, maar de in de laatste stap
verkregen DEM is niet geschikt als invoer, omdat de waarden voor de hoogte in meters zijn, maar de celgrootte is
niet uitgedrukt in meters (de laag gebruikt een CRS met geografische coördinaten). Opnieuw projecteren is nodig.
Het algoritme Warp (herprojecteren) kan opnieuw worden gebruikt om een rasterlaag opnieuw te projecteren. We
projecteren opnieuw naar een CRS met meters als eenheden (bijv. 3857), zodat we daarna de helling correct kunen
berekenen, met ofwel SAGA of GDAL.

Met de nieuwe DEM kan de helling nu worden berekend.
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En hier is de uiteindelijke hellingslaag.
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De door het algoritme Slope, Aspect, Curvature geproduceerde helling kan worden uitgedrukt in graden of radi-
alen, maar graden zijn een meer praktische en algemenere eenheid. In het geval u het berekende in radialen zal
het algoritme Metric conversions zal ons helpen de conversie uit te voeren (maar voor het geval u niet wist dat dat
algoritme bestond, kunt u de Raster calculator gebruiken die we al eerder hebben gebruikt).
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We krijgen de uiteindelijke laag die we willen door de geconverteerde hellingslaag opnieuw terug te projecteren
met Reproject raster layer.

Waarschuwing: todo: Afbeelding toevoegen

De processen voor opnieuw projecteren zouden er voor hebben kunnen zorgen dat de uiteindelijke laag gegevens
bevat die buiten het begrenzingsvak liggen dat we in een van de eerste stappen hebben berekend. Dit kan worden
opgelost door het opnieuw te clippen, zoals we hebben gedaan om de basis DEM te krijgen.

17.16 Hydrologische analyse

Notitie: In deze les zullen we een hydrologische analyse uitvoeren. Deze analyse zal worden gebruikt in enkele
van de volgende lessen, omdat het bestaat uit een goed voorbeeld van een werkstroom voor een analyse, en we het
zullen gebruiken voor het demonstreren van enkele geavanceerde mogelijkheden.

In deze les zullen we een hydrologische analyse uitvoeren. Beginnend met een DEM, zullen we een netwerk van
kanalen gaan uitnemen, waterkeringen uittekenen en enkele statistieken berekenen.

Het eerste is om het project te laden met de gegevens voor de les, wat slechts een DEM bevat.
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De eerste module die moet worden uitgevoerd is Catchment area (in sommige versies van SAGA wordt hij Flow
accumulation (Top Down) genoemd). U kunt elke van de andere genaamd Catchment area gebruiken. Zij hebben
verschillende onderliggende algoritmen maar de resultaten zijn in de basis hetzelfde.

Selecteer de DEM in het veld Elevation, en laat de rest van de parameters staan op de standaard waarden.
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Sommige algoritmen berekenen vele lagen, maar de laag Catchment Area is de enige die we zullen gebruiken.

U kunt de andere weggooien als u dat wilt.

Het renderen van de laag is niet erg informatief.

U kunt, om te weten waarom, naar het histogram kijken en u zult zien dat de waarden niet evenredig zijn verdeeld
(er zijn slechts weinig cellen met een zeer hoge waarde, die welke overeenkomen met het netwerk van kanalen).
Het berekenen van de logaritme van de waarde van het opvanggebied levert een laag op die veel meer informatie
bevat (u kunt dat doen met Rasterberekeningen).
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Het opvanggebied (ook bekend als flow accumulation), kan worden gebruikt om een drempel in te stellen voor het
initiëren van kanalen. Dit kan worden gedaan met behulp van het algoritme Channel network. Hier staat hoe u het
in moet stellen (let op de Initiation threshold Greater than 10.000.000).
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gebruik de originele laag catchment area, niet die van de logaritme. Die was alleen om te renderen.

Als u de waarde Initiation threshold verhoogt, zult u een spaarzamer netwerk van kanalen verkrijgen. Als u het
verlaagt, zult u een dichter verkrijgen. Dit is wat u krijgt met de voorgestelde waarde.
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De afbeelding hierboven geeft slechts de resulterende vectorlaag en de DEM weer, maar er zou ook een raster-
laag moeten zijn met hetzelfde netwerk van kanalen. Die rasterlaag zal in feite degene zijn die we zullen gaan
gebruiken.

Nu zullen we het algoritme Watersheds basins gaan gebruiken om de subbassins uit te tekenen die overeenkomen
met dat netwerk van kanalen, waarbij we alle kruisingen daarin gebruiken als uitlaatpunt. Hier staat hoe u het
overeenkomende dialoogvensters met parameters moet instellen.
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En dit is wat u zult krijgen.

Dit is een rasterresultaat. U kunt het vectoriseren met behulp van het algoritme Vectorising grid classes.
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Laten we nu eens proberen statistieken te berekenen over de hoogtewaarden in één van de subbassins. Het idee is
om een laag te krijgen die slechts de hoogte binnen dat subbassin weergeeft en die dan doorgeeft naar de module
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die die statistieken berekent.

Laten we eerst de originele DEM clippen met de polygoon die een subbassin weergeeft. We zullen het algoritme
Clip raster with polygon gebruiken. Als we één enkele polygoon voor een subbassin selecteren en dan het algo-
ritme voor het clippen aanroepen, kunnen we de DEM clippen tot het gebied dat wordt bedekt door die polygoon,
omdat het algoritme zich bewust is van de selectie.

Selecteer een polygoon,

en roep het algortime om te clippen aan met de volgende parameters:

17.16. Hydrologische analyse 499



QGIS Training Manual, Release 2.14

Het geselecteerde element in het invoerveld is, natuurlijk, de DEM die we willen clippen.

U zult iets krijgen zoals dit.
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Deze laag is gereed om te worden gebruikt in het algoritme Raster layer statistics.

De resulterende statistieken zijn de volgende.

We zullen zowel de procedure voor het berekenen van het bassin gebruiken als de berekeningen voor statistieken
uit andere lessen, om uit te zoeken hoe andere elementen ons kunnen helpen om beide te automatiseren en meer
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effectief te werken.

17.17 Beginnen met Grafische modellen bouwen

Notitie: In deze les zullen we Grafische modellen bouwen gebruiken, een krachtige component die we kunnen
gebruiken om een werkstroom te definiëren en een reeks algoritmen uit te voeren.

Een normale sessie met de gereedschappen voor Processing omvat meer dan het uitvoeren van één enkel algoritme.
gewoonlijk worden verscheidene ervan uitgevoerd om een resultaat te krijgen, en de uitvoer van sommige van die
algoritmen worden gebruikt als invoer voor sommige van de andere.

Door het gebruiken van Grafische modellen bouwen kan die werkstroom worden geplaatst in een model, wat
in één enkele keer alle noodzakelijke algoritmen zal uitvoeren, aldus het gehele proces vereenvoudigend en het
automatiseren.

We gaan een parameter, genaamd Topographic wetness index, om deze les te beginnen. Het algoritme dat dit
berekent is genaamd Topographic wetness index (twi)

Zoals u kunt zien zijn er twee verplichte invoeren: Slope en Catchment area. Er is ook een optionele invoer, maar
die zullen we niet gebruiken, dus kunnen we die negeren.

De gegevens voor deze les bevat slechts een DEM, dus we hebben geen van de vereiste invoeren. We weten echter
hoe we die beide kunnen berekenen vanuit die DEM, omdat we al algoritmen hebben gezien om de helling en
het opvanggebied te berekenen. We kunnen dus eerst die lagen berekenen en ze dan gebruiken voor het algoritme
TWI.

Hier zijn de dialoogvensters voor de parameters die u zou moeten gebruiken om de 2 tussenliggende lagen te
berekenen.

Notitie: Helling moet worden berekend in radialen, niet in graden.
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En dit is hoe u het dialoogvenster voor de parameters van het algoritme TWI zou moeten instellen.
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Dit is het resultaat dat u zult verkrijgen (het standaard geïnverteerde palet enkelband pseudokleur is gebruikt voor
het renderen). U kunt de verschafte stijl twi.qml gebruiken.

Wat we nu zullen proberen te doen is om een algoritme te maken dat de TWI berekent vanuit een DEM in slechts
één enkele stap. Dat zal ons werk besparen voor het geval we later een laag TWI moeten berekenen uit een andere

17.17. Beginnen met Grafische modellen bouwen 505



QGIS Training Manual, Release 2.14

DEM, omdat we slechts één stap nodig hebben om het te doen in plaats van de 3 bovenstaande. Alle processen
die we nodig hebben zijn te vinden in de Toolbox, dus wat we moeten doen is de werkstroom definiëren om ze te
verpakken. Dat is waar Grafische modellen bouwen van pas komt.

Open Grafische modellen bouwen door het menuitem daarvan te selecteren in het menu Processing.

Twee dingen zijn nodig om een model te maken: de benodigde invoer instellen en het algoritme definiëren dat
het bevat. Beide worden gedaan door elementen toe te voegen uit de twee tabs aan de linkerkant van het venster
Grafische modellen bouwen: Invoer en Algoritmen

Laten we beginnen met de invoer. In dit geval hebben we niet veel toe te voegen. We hebben slechts een rasterlaag
nodig met de DEM en dat zullen onze enige gegevens voor invoer zijn.

Dubbelklik op de invoer Raster Layer en u zult het volgende dialoogvenster zien.

Hier moeten we de invoer definiëren die we willen. Omdat we verwachten dat deze rasterlaag een DEM zal zijn,
zullen we die DEM noemen. Dat is de naam die de gebruiker van het model zal zien bij het uitvoeren. Omdat we
die laag nodig hebben om te kunnen werken, zullen we het definiëren als een vereiste laag.

Hier is hoe het dialoogvenster zou moeten zijn geconfigureerd.
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Klik op OK en de invoer zal verschijnen in het kaartvenster van Grafische modellen bouwen.

Laten we nu naar de tab Algoritmen gaan. Het eerste algoritme dat we moeten uitvoeren is het algoritme Slope,
aspect, curvature. Zoek het op in de lijst met algoritmen, dubbelklik erop en u zult het dialoogvenster zien dat
hieronder wordt weergegeven.
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Dit dialoogvenster lijkt erg op dat wat u krijgt als u het algoritme uitvoert vanuit de Toolbox, maar het element
dat u kunt gebruiken als waarde voor de parameters worden niet uit het huidige project van QGIS genomen, maar
vanuit het model zelf. Dat betekent dat, in dit geval, we niet alle rasterlagen van ons project beschikbaar hebben
voor het veld Elevation, maar slechts die welke zijn gedefinieerd in ons model. Omdat we slechts één enkele
rasterinvoer hebben toegevoegd, genaamd DEM, zal dat de enige rasterlaag zijn die we zullen zien in de lijst die
correspondeert met de parameter Elevation.

Uitvoer gegenereerd door een algoritme wordt een beetje anders afgehandeld als het algoritme wordt gebruikt als
deel van een model. In plaats van het bestandspad te selecteren waar u elke uitvoer wilt opslaan, hoeft u slechts te
specificeren dat de uitvoer een tussenliggende laag is (en dat u het niet wilt behouden nadat het model is uitgevo-
erd), of dat het het uiteindelijke is. In dit geval zijn alle door dit algoritme geproduceerde lagen tussenliggende.
We zullen er slechts één van gebruiken (de hellingslaag), maar we willen die niet behouden, omdat we die slechts
nodig hebben om de laag TWI te berekenen, die het uiteindelijke resultaat is dat we willen verkrijgen.

Wanneer lagen geen uiteindelijk resultaat zijn, zou u het corresponderende veld moeten laten zoals het is. Anders
moet u een naam invoeren die zal worden gebruikt om de laag te identificeren in het dialoogvenster voor de
parameters dat zal worden weergegeven wanneer u het model later uitvoert.

Er is niet veel te selecteren in dit eerste dialoogvenster, omdat we slechts één laag in ons model hebben (De invoer
DEM die we gemaakt hebben). In feite is de standaard configuratie van het dialoogvenster de juiste in dit geval,
dus u hoeft alleen maar op OK te drukken. Dit is wat u zult hebben in het kaartvenster van Grafische modellen
bouwen.
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Het tweede algoritme dat we moeten toevoegen aan ons model is het algoritme Catchment area. We zyllen het al-
goritme, genaamd Catchment area (Paralell) gebruiken. We zullen opnieuw de laag DEM gebruiken als invoer, en
geen van de uitvoeren die het produceert is de uiteindelijke, dus hier is hoe u het overeenkomstige dialoogvenster
in moet vullen.
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Nu zou uw model er zo uit moeten zien.
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De laatste stap is om het algoritme Topographic wetness index toe te voegen, met de volgende configuratie.

In dit geval zullen we niet de DEM gebruiken als invoer, maar in plaats daarvan zullen we de lagen voor de
helling en het opvanggebied gebruiken die zijn berekend door de algoritmen die we eerder toevoegden. Als u
nieuwe algoritmen toevoegt, komt de uitvoer die zij produceren beschikbaar voor andere algoritmen, en door ze
te gebruiken koppelt u de algoritmen, wat de werkstroom maakt.
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In dit geval is de uitvoerlaag TWI de uiteindelijke laag, dus moeten we dat aangeven. Voer, in het overeenkomstige
tekstvak, de naam in die u wilt hebben weergegeven voor deze uitvoer.

Nu is uw model voltooid en zou er zo uit moeten zien.

Voer een naam en een naam voor de groep in in het bovenste gedeelte van het venster Grafische modellen bouwen,
en sla het dan op door te klikken op de knop Opslaan.

U kunt het overal opslaan waar u wilt en het later openen, maar als u het opslaat in de map Models (wat de map is
die u zult zien als het dialoogvenster Opslaan verschijnt), zal uw model ook in de Toolbox beschikbaar zijn. Blijf
dus in die map en sla het model op onder de bestandsnaam die uw voorkeur heeft.

Sluit nu het dialoogvenster Grafische modellen bouwen en ga naar de Toolbox. In het item Models zult u uw
model vinden.

U kunt het net als elk normaal algoritme uitvoeren, door erop te dubbelklikken.
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Zoals u kunt zien bevat het dialoogvensters voor de parameters de invoer die u had toegevoegd aan het model,
tezamen met de uitvoer die u als uiteindelijk heeft ingesteld bij het toevoegen van de overeenkomstige algoritmen.

Voer het uit met behulp van de DEM als invoer en u zult de laag TWI in slechts één stap krijgen.

17.18 Meer complexe modellen

Notitie: In deze les zullen we werken met een meer complex model in Grafische modellen bouwen.

Het eerste model dat we hebben gemaakt in het vorige hoofdstuk was een heel eenvoudig, met slechts één invoer
en 3 algoritmen. Meer complexe modellen kunnen worden gemaakt, met verschillende typen voor invoer en
die meerdere stappen bevatten. Voor dit hoofdstuk zullen we werken met een model dat een vectorlaag met
waterkering maakt, gebaseerd op een DEM en een drempelwaarde. Dat zal zeer bruikbaar zijn voor het berekenen
van verscheidene vectorlagen die overeenkomen met verschillende drempelwaarden, zonder elke stap elke keer te
hoeven herhalen.

Deze les bevat geen instructies over hoe uw model te maken. U kent de noodzakelijke stappen al (we zagen ze al
in een eerdere les) en u u heeft de basisideeën voor het bouwen van modellen al gezien, dus u zou het zelf moeten
proberen. Spendeer een paar minuten aan het proberen te maken van uw eigen model, en maak u geen zorgen
over eventuele fouten die u maakt. Onthoud om eerst de invoer toe te voegen en voeg dan de algoritmen toe die
ze gebruiken om de werkstroom te maken.

Voor het geval u het volledige model niet zelf kon bouwen en u heeft wat extra hulp nodig, de map met gegevens
die overeenkomt met deze les bevat een ‘bijna gereed’ voltooide versie ervan. Open Grafische modellen bouwen
en open het bestand van het model dat u zult vinden in de map met gegevens. U zou iets als dit moeten zien.
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Dit model bevat alle stappen die nodig zijn om de berekening te voltooien, maar het heeft slechts één invoer: de
DEM. Dat betekent dat de drempel voor de definitie van het kanaal een vaste waarde gebruikt, wat het model niet
zo bruikbaar maakt als zo kunnen. Dat is geen probleem, omdat we het model kunnen bewerken en dat is precies
wat we zullen gaan doen.

Laten we als eerste een numerieke invoer toevoegen. Die zal de gebruiker vragen naar een numerieke invoer die
we kunnen gebruiken wanneer een dergelijke waarde nodig is in een van de algoritmen die zijn opgenomen in ons
model. Klik op het item Number in de boom voor de invoer, en u zult het overeenkomende dialoogvenster zien.
Vul het met de waarden doe hieronder worden weergegeven.

Uw model zou er nu ongeveer zo uit moeten zien.
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De invoer die we zojuist hebben toegevoegd is niet gebruikt, dus is het model in feite niet veranderd. We moeten
die invoer koppelen aan het algoritme dat het gebruikt, in dit geval is dat Channel network. Dubbelklik een-
voudigweg op het overeenkomstige vak in het kaartvenster om een algoritme, dat al bestaat in Grafische modellen
bouwen, te bewerken,. Als u klikt op het algoritme Channel network zult u iets als dit zien.

Het dialoogvenster is gevuld met de huidige waarden die door het algoritme gebruikt worden. U kunt zien dat de
parameter voor de drempelwaarde een vast waarde heeft van 1.000.000 (dit is ook de standaard waarde van het
algoritme, maar elke andere waarde kan daar ingevoerd worden). U zou echter kunnen opmerken dat de parameter
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niet is ingevoerd in een algemeen tekstvak, maar in een menu met opties. Als u dat openvouwt zult u iets zoals dit
zien.

De invoer die we hebben toegevoegd is daar en we kunnen die selecteren. Wanneer een algoritme in een model een
numerieke waarde vereist, kunt u die hard coderen en er direct in typen, of u kunt een van de beschikbare invoeren
en waarden gebruiken (onthoud dat sommige algoritmen single numerieke waarden genereren. We zullen hier
snel meer van zien). In het geval van een parameter string, zult u ook invoer voor tekenreeksen zien en u u zult in
staat zijn er één van te selecteren of de gewenste vaste waarde in te typen.

Selecteer de invoer Threshold in de parameter Threshold en klik op OK om de wijzigingen aan uw model toe te
passen. Nu zou het ontwerp van het model er zo uit moeten zien.
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Het model is nu compleet. Probeer het uit te voeren met behulp van de DEM die we in eerdere lessen hebben
gebruikt, en met verschillende drempelwaarden. Hier heeft u een voorbeeld van het resultaat dat is verkregen voor
verschillende waarden. U kunt het vergelijken met het resultaat voor de standaard waarde, wat die is welke we
hebben verkregen in de les over hydrologische analyse.

Threshold = 100.000
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Threshold = 1.0000.000

17.19 Numerieke berekeningen in Grafische modellen bouwen

Waarschuwing: Wees voorzichtig, dit hoofdstuk is nog niet goed getest, rapporteer problemen; afbeeldingen
ontbreken

Notitie: In deze les zullen we zien hoe we numerieke uitvoer gebruiken in Grafische modellen bouwen

Voor deze les gaan we het hydrologische model, dat we en het laatste hoofdstuk maakten, aanpassen (open het
in Grafische modellen bouwen om te beginnen), zodat we de berekening van een geldige drempelwaarde kunnen
automatiseren en we de gebruiker niet hoeven te vragen die in te voeren. Omdat die waarde verwijst naar de
variabele in de drempel rasterlaag, zullen we die uitnemen uit die laag, gebaseerd op enkele eenvoudige statistische
analyses.

Laten we, beginnend met het eerder vermelde model, de volgende aanpassingen doen:

Bereken eerst de statistieken van de laag flow accumulation met behulp van het algoritme Raster layer statistics.
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Dit zal een statistische waarden genereren die nu beschikbaar zullen komen voor alle numerieke velden in andere
algoritmen.

Als u het algoritme Channel network bewerkt, zoals we deden in de laatste les, zult u zien dat u nu andere opties
heeft, naast de numerieke invoer die u had toegevoegd.
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Echter, geen van deze waarden is geschikt om te worden gebruikt als geldige drempelwaarde, omdat zij zullen
resulteren in netwerken van kanalen die niet erg realistisch zullen zijn. We kunnen, in plaats daarvan, enkele
nieuwe parameters, daarop gebaseerd, afleiden, om een beter resultaat te verkrijgen. We kunnen bijvoorbeeld het
gemiddelde plus 2 keer de standaard afwijking gebruiken.

We kunnen de calculator gebruiken die u zult vinden in de groep Geoalgorithms/modeler/modeler-tools om een
rekenkundige bewerking toe te voegen. Deze groep bevat algoritmen die niet erg bruikbaar zijn buiten Grafische
modellen bouwen, maar dat verschaft enige bruikbare functionaliteit bij het maken van een model.

Het dialoogvenster voor de parameters van het algoritme Calculator zier er als volgt uit:
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Zoals u kunt zien is het dialoogvenster afwijkend van dat welke we eerder hebben gezien, maar u heeft daar
dezelfde variabelen als die welke beschikbaar waren in het veld Threshold in het algoritme Channel network.
Voer bovenstaande formule in en klik op OK om het algoritme toe te voegen.

Als u het item voor de uitvoer uitbreidt, zoals hierboven weergegeven, zult u zien dat het model is verbonden
met twee van de waarden, namelijk het gemiddelde en de standaard afwijking, wat die zijn die we in de formule
hebben gebruikt.

Toevoegen van dit nieuwe algoritme zal een nieuwe numerieke waarde toevoegen. Als u opnieuw naar het algo-
ritme Channel network gaat, kunt u nu die waarde selecteren in de parameter Threshold.
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Klik op OK en uw model zou er nu zo uit moeten zien.

We gebruiken niet de numerieke invoer die we aan het model hadden toegevoegd, dus die kan worden verwijderd.
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Klik er met rechts op en selecteer Remove

Waarschuwing: todo: Afbeelding toevoegen

Ons nieuwe model is nu voltooid.

17.20 Een model binnen een model

Waarschuwing: Wees voorzichtig, dit hoofdstuk is nog niet goed getest, rapporteer problemen; afbeeldingen
ontbreken

Notitie: In deze les zullen we zien hoe we een model gebruiken binnen een groter model.

We hebben al een aantal modellen gemaakt en in deze les gaan we zien hoe we ze kunnen combineren tot één
groter. Ee model gedraagt zich net als alle andere algoritmen, wat betekent dat u een model kunt toevoegen dat u
al eerder heeft gemaakt als deel van een ander dat u daarna maakte.

In dit geval gaan we ons hydrologische model uitbreiden, door het toevoegen van de gemiddelde TWI-waarde in
elk van de bassins die het als resultaat genereert. We moeten, om dat te kunnen doen, de TWI uitrekenen en de
statistieken berekenen. Omdat we al een model hebben gemaakt om de TWI vanuit een DEM te berekenen, is het
een goed idee om dat model opnieuw te gebruiken in plaats van de individuele algoritmen toe te voegen die het
bevat.

Laten we beginnen met het model dat we gebruikten als beginpunt voor de laatste les.

Waarschuwing: todo: Afbeelding toevoegen

eerst zullen we het TWI-model toevoegen. het zou, om beschikbaar te kunnen zijn, moeten zijn opgeslagen in
de map Models, omdat het anders niet wordt weergegeven in de Toolbox of de lijst met algoritmen in Grafische
modellen bouwen. Zorg er voor dat het beschikbaar is.

Voeg het toe aan het huidige model en gebruik de invoer DEM als de invoer ervan. De uitvoer is een tijdelijke,
want we willen alleen dat de laag TWI de statistieken berekent. De enige uitvoer van dit model dat we maken is
nog steeds de vectorlaag met de waterbergingen.

Hier is het corresponderende dialoogvenster voor de parameters:

Waarschuwing: todo: Afbeelding toevoegen

Nu we een laag TWI hebben die we kunnen gebruiken naast de vectorlaag met waterbergingen, om een nieuwe te
genereren die de waarden voor de TWI bevat die corresponderen met elke waterberging.

Deze berekening wordt uitgevoerd met het algoritme Grid statistics in polygons. Gebruik de hierboven vermelde
lagen als invoer om het uiteindelijke resultaat te maken.

Waarschuwing: todo: Afbeelding toevoegen

De uitvoer van het algoritme Vectorize grid classes was oorspronkelijk onze uiteindelijke uitvoer, maar nu willen
we het slechts als een tussenliggend resultaat. We moeten het algoritme bewerken om dat te wijzigen. Dubbelklik
er eenvoudigweg op om het dialoogvenster voor de parameters te zien, en verwijder de naam van de uitvoer. Dat
zal het een tijdelijke uitvoer maken, zoals het standaard is.

Waarschuwing: todo: Afbeelding toevoegen

Dit is hoe het uiteindelijke model er uit zou moeten zien:
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Waarschuwing: todo: Afbeelding toevoegen

Zoals u ziet is het gebruiken van een model in een ander model niets speciaals, en u kunt het toevoegen net zoals u
een ander algoritme toevoegt, zolang het model is opgeslagen in de map Models en beschikbaar is in de Toolbox.

17.21 Interpolatie

Notitie: Dit hoofdstuk geeft weer hoe puntgegevens te interpoleren, en zal u een andere echt voorbeeld tonen van
het uitvoeren van ruimtelijke analyses

In deze les gaan we puntgegevens interpoleren om een rasterlaag te verkrijgen. Vóórdat we dat gaan doen, zullen
we wat voorbereidingen aan de gegevens moeten doen, en na het interpoleren zullen we wat extra verwerking
toepassen om de resulterende laag aan te passen, zodat we een volledige analyseroutine hebben.

Open de voorbeeldgegevens voor deze les, wat er zo uit zou moeten zien.

De gegevens corresponderen met gegevens voor de opbrengst van een oogst, zoals geproduceerd door een moderne
oogstmachine, en we zullen dat gebruiken om een rasterlaag voor de opbrengst van de oogst te verkrijgen. We zijn
niet van plan om nog meer analyses met die laag uit te voeren, maar slechts te gebruiken als een achtergrondlaag
om eenvoudige de meest productieve gebieden te identificeren en ook die waar de productiviteit kan worden
verbeterd.

Het eerste om te doen is het opruimen van de laag, omdat het herhalende punten bevat. Deze worden veroorzaakt
door de verplaatsing van de oogstmachine, op plaatsen waar die een bocht moet maken of om enige reden zijn
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snelheid wijzigt. Het algoritme Points filter zal hier bruikbaar voor zijn. We zullen het tweemaal gebruiken, om
punten te verwijderen die uitschieters kunnen worden geacht in zowel het bovenste als onderste gedeelte van de
verdeling.

Gebruik de volgende waarden voor de parameters bij de eerste uitvoering.

Gebruik voor de volgende uitvoering de configuratie die hieronder is weergegeven.
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Onthoud dat we niet de originele laag aks invoer gebruiken, maar in plaats daarvan de uitvoer van de eerste
uitvoering.

De uiteindelijke gefilterde laag, met een verminderd aantal punten, zou er soortgelijk koeten uitzien als de orig-
inele, maar het bevat een kleiner aantal punten. U kunt dat controleren door hun attributentabellen te vergelijken.

Laten we nu de laag rasterizeren met behulp van het algoritme Rasterize.
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De laag Filtered points verwijst naar de resulterende van het tweede filter. Het heeft dezelfde naam als die welke
werd geproduceerd door het eerste filter, omdat het de naam is die wordt toegewezen door het algoritme, maar u
zou de eerste niet moeten gebruiken. Omdat we die ook niet ergens anders voor gaan gebruiken kunt u hem veilig
verwijderen uit uw project om verwarring te voorkomen, en alleen de laatste gefilterde laag laten staan.

De resulterende rasterlaag ziet er zo uit.
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Het is al een rasterlaag, maar er ontbreken gegevens in enkele van zijn cellen. Het bevat alleen geldige waarden
in die cellen die een punt bevatten uit de vectorlaag die we zojuist gerasterizeerd hebben, en een waarde Geen
gegevens in alle andere. We kunnen het algoritme Close gaps gebruiken om de ontbrekende waarden in te vullen.
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De laag ziet er zo uit zonder zonder waarden Geen gegevens.
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We kunnen de rasterlaag clippen met de verstrekte laag Limits om het gebied dat wordt bedekt door de gegevens
te beperken tot slechts het gebied waar de opbrengst van de oogst werd gemeten.
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En voor een gladder resultaat (minder nauwkeurig maar beter voor het renderen op de achtergrond als een onder-
steuningslaag), kunnen we een Gaussiaans filter op de laag toepassen.
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Met de bovenstaande parameters zult u het volgende resultaat verkrijgen

17.22 Meer interpolatie

Notitie: Dit hoofdstuk geeft een ander praktisch geval weer waar algoritmen voor interpolatie werden gebruikt.

Interpolatie is een veel voorkomende techniek, en het kan worden gebruikt om verscheidene technieken te demon-
streren die kunnen worden toegepast met behulp van het framework Processing van QGIS. Deze les gebruikt
enkele algoritmen voor interpolatie dia al werden besproken, maar het heeft een andere benadering.

De gegevens voor deze les bevat ook een puntenlaag, in dit geval met hoogtegegevens. We gaan het in grote
mate op dezelfde manier interpoleren zoals we in de eerdere les deden, maar deze keer zullen we een deel van de
originele gegevens opslaan om die te gebruiken om de kwaliteit van het proces van interpolatie te beoordelen.

We moeten eerst de puntenlaag rasterizeren en de resulterende cellen met Geen gegevens vullen, maar met behulp
van slechts een fractie van de punten op de laag. We zullen 10% van de punten opslaan voor een latere controle,
dus moeten we 90% van de punten klaarmaken voor de interpolatie. We zouden, om dat te doen, het algoritme
Split shapes layer randomly kunnen gebruiken, wat we al in een eerdere les hebben gebruikt, maar er is een betere
manier om het te doen, zonder dat we een nieuwe tussenliggende laag zouden moeten maken. In plaats daarvan
hoeven we slechts de punten die we willen gebruiken voor de interpolatie te selecteren (het gedeelte van 90%),
en dan het algoritme uit te voeren. Zoals we al hebben gezien zal het algoritme voor het rasterizeren alleen de
geselecteerde punten gebruiken en de rest negeren. De selectie kan worden gedaan met het algoritme Random
selection. Voer dat uit met de volgende parameters.
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Dat zal 90% van de punten in de laag selecteren om te rasterizeren

De selectie is willekeurig, dus zou uw selectie af kunnen wijken van de selectie die in bovenstaande afbeelding
wordt weergegeven.
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Voer nu het algoritme Rasterize uit om de eerste rasterlaag te krijgen, en voer dan het algoritme Close gaps uit om
de cellen met Geen gegevens te vullen [Celresolutie: 100 m].

We kunnen nu de punten gebruiken die niet zijn geselecteerd om de kwaliteit van de interpolatie te controleren.
Op dit punt weten we de echte hoogte (de waarde in de puntenlaag) en de geïnterpoleerde hoogte (de waarde in de
geïnterpoleerde rasterlaag). We kunnen die twee vergelijken door de verschillen tussen die waarden te berekenen.

Omdat we de punten gaan gebruiken die niet zijn geselecteerd, laten we dus eerst de selectie omdraaien.

534 Chapter 17. De QGIS-gids voor Processing



QGIS Training Manual, Release 2.14

De punten bevatten de originele waarden, maar niet de geïnterpoleerde. We kunnen het algoritme Add raster
values to points gebruiken om ze toe te voegen aan een nieuw veld

De rasterlaag om te selecteren (het algoritme ondersteunt meerdere rasters, maar we hebben er slechts één nodig)
is de resulterende van de interpolatie. We hebben die hernoemd naar interpolate en die laagnaam is die welke zal
worden gebruikt als naam voor het veld dat zal worden toegevoegd.

Nu hebben we een vectorlaag die beide waarden bevat, met punten die niet werden gebruikt voor de interpolatie.
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Nu zullen we Veldcalculator gebruiken voor deze taak. Open het algoritme Field calculator en voer dat uit met de
volgende parameters.
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Als uw veld met de waarden uit de rasterlaag een andere naam heeft, zou u de hierboven vermelde formule
overeenkomstig moeten aanpassen. Door het uitvoeren van dit algoritme zult u een nieuwe laag verkrijgen met
slechts de punten die we niet hebben gebruikt voor de interpolatie, waarvan elk het verschil bevat tussen de twee
hoogtewaarden.

Weergeven van die laag overeenkomstig die waarde zal ons een eerste idee geven over waar de grootste verschillen
te vinden zullen zijn.

Interpoleren van die laag zal u een rasterlaag geven met de geschatte fout in alle punten van het geïnterpoleerde
gebied.
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U kunt dezelfde informatie (verschil tussen originele puntwaarden en de geïnterpoleerde) ook direct krijgen met
GRASS → v.sample.

Uw resultaten zouden af kunnen wijken van deze, omdat er een willekeurige component werd geïntroduceerd bij
het uitvoeren van de willekeurige selectie, aan het begin van deze les.

17.23 Herhalend uitvoeren van algoritmen

Notitie: Deze les toont u een andere manier voor het uitvoeren van algoritmen die vectorlagen gebruiken, door
ze herhalend uit te voeren, doorlopend over de objecten in een vectorlaag als invoer

We kennen al Grafische modellen bouwen, wat één manier is van het automatiseren van taken voor Processing. In
sommige situaties zou echter Grafische modellen bouwen niet kunnen zijn wat we nodig hebben om een bepaalde
taak te automatiseren. Laten we eens naar zo’n situatie kijken en hoe eenvoudig die op te lossen is met een andere
functionaliteit: het herhalend uitvoeren van algoritmen.

Open de gegevens die overeenkomen voor dit hoofdstuk. Het zou er zo uit moeten zien.
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U zult onze welbekende DEM herkennen uit eerdere hoofdstukken en een daaruit uitgenomen verzameling wa-
terbergingen. Veronderstel dat u de DEM dient op te delen in verscheidene kleinere lagen, die elk slechts de
hoogtegegevens bevatten van slechts één waterberging. Dat zou handig kunnen zijn als u later enkele parameters
wilt berekenen die gerelateerd zijn aan elke waterberging, zoals de gemiddelde hoogte of de hypsografische curve
ervan.

Dit kan een lange en saaie taak zijn, speciaal als het aantal waterbergingen groot is. Het is echter, zoals we zullen
zien, een taak die eenvoudig geautomatiseerd kan worden.

Het algoritme om te gebruiken voor het clippen van een rasterlaag met een polygoonlaag is genaamd Clip raster
with polygons, en heeft het volgende dialoogvenster voor de parameters.
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U kunt het uitvoeren met de lagen van waterbergingen en de DEM als invoer, en u zult het volgende resultaat
verkrijgen.

Zoals u kunt zien wordt het gebied, dat bedekt is door alle polygonen van de waterbergingen, gebruikt.
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U kunt de DEM clippen met slechts één enkele waterberging door de gewenste waterberging te selecteren en dan
het algoritme uit te voeren zoals we eerder deden.

Omdat alleen geselecteerde objecten worden gebruikt, zal alleen de geselecteerde polygoon worden gebruikt om
de rasterlaag bij te snijden.

Door dit voor alle waterbergingen te doen zal dat het resultaat produceren waar we naar op zoek zijn, maar het
lijkt niet een praktische manier om het te doen. Laten we, in plaats daarvan, eens zien hoe we die selecteer en snij
bij-routine kunnen automatiseren.
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Verwijder als eerste de eerdere selectie, zodat opnieuw alle polygonen zullen worden gebruikt. Open nu het
algoritme Clip raster with polygon en selecteer dezelfde invoer als hiervoor, maar klik deze keer op de knop aan
de rechterkant van de invoer voor de vectorlaag waar u de laag watersheds heeft geselecteerd.

Deze knop zal er voor zorgen dat de geselecteerde invoerlaag zal worden gesplitst in net zoveel lagen als er
objecten in gevonden worden, waarvan elk één enkele polygoon bevat. Daarmee zal het algoritme herhaaldelijk
worden aangeroepen, één keer voor elk van die lagen met één polygoon. Het resultaat, in plaats van slechts één
rasterlaag in het geval van dit algoritme, zal een verzameling rasterlagen zijn, elk corresponderend met één van de
uitvoeringen van het algoritme.

Hier is het resultaat dat u zult krijgen als u het algoritme voor het clippen uitvoert zoals is uitgelegd.
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Voor elke laag wordt het kleurenpalet zwart en wit, (of welk palet u dan ook gebruikt), anders aangepast, van zijn
minimale tot zijn maximale waarden. Dat is de reden waarom u kunt zien dat de onderscheidenlijke stukken en de
kleuren niet lijken overeen te komen met de grenzen tussen de lagen. De waarden komen echter overeen.

Als u een bestandsnaam voor de uitvoer invoert, zullen de resulterende bestanden worden benoemd met behulp
van die bestandsnaam en een getal dat correspondeert met elke iteratie als achtervoegsel.

17.24 Meer herhaalde uitvoering van algoritmen

Notitie: Deze les toont hoe de herhaalde uitvoering van algoritmen te combineren met Grafische modellen
bouwen om meer automatisering te verkrijgen.

De herhaalde uitvoering van algoritmen is niet alleen beschikbaar voor ingebouwde algoritmen, maar ook voor de
algoritmen die u zelf kunt maken, zoals modellen. We gaan zien hoe een model en de herhaalde uitvoering van
algoritmen te combineren, zodat we eenvoudiger meer complexe resultaten kunnen verkrijgen.

De gegevens die we voor deze les gaan gebruiken zijn dezelfde als die we voor de laatste gebruikten. In dit geval,
in plaats van slechts de DEM te clippen met elk polygoon van een waterberging, zullen we enkele extra stappen
toevoegen en een hypsometrische curve berekenen voor elk daarvan, om te bestuderen hoe de hoogte is verdeeld
binnen de waterberging.

Omdat we een werkstroom hebben die verscheidene stappen omvat (clippen + berekenen van de hypsometrische
curve), zouden we naar Grafische modellen bouwen moeten gaan en het corresponderende model voor die werk-
stroom moeten maken.

U vindt het reeds gebouwde model in de map met gegevens voor deze les, maar het zou goed zijn als u het eerst
zelf probeert. De geclipte laag is in dit geval niet een uiteindelijk resultaat, omdat we alleen zijn geïnteresseerd in
de curves, dus dit model zal geen lagen genereren, maar slechts een tabel met de gegevens van de curves.

Het model zou er zo uit moeten zien:
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Voeg het model toe aan uw map met modellen, zodat het beschikbaar is in de Toolbox, en voer het nu uit.

Selecteer de DEM en de bassins van waterbergingen, en vergeet niet de knop te schakelen die aangeeft dat het
algoritme iteratief moet worden uitgevoerd.

Het algoritme zal verscheidene keren worden uitgevoerd, en de corresponderende tabellen zullen worden gemaakt
en geopend in uw project van QGIS.
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We kunnen dit voorbeeld nog complexer maken door het model uit te breiden en enkele statistieken voor hellingen
te berekenen. Voeg het algoritme Slope, aspect, curvature toe aan het model en daarna het algoritme Raster
statistics, wat de uitvoer voor de hellingen als enige invoer zou moeten gebruiken.

Als u nu het model uitvoert, zult u, naast de tabellen, een aantal pagina’s met statistieken verkrijgen. Deze pagina’s
zullen beschikbaar zijn in het dialoogvenster Resultaten.

17.25 De interface Batch-processing

Notitie: Deze les introduceert de interface voor Batch-processing, die het mogelijk maakt één enkel algoritme
uit te voeren met een set van verschillende invoerwaarden.

Soms moet een bepaald algoritme herhaaldelijk worden uitgevoerd met verschillende invoer. Dit is bijvoorbeeld
het geval als een set invoerbestanden moeten worden geconverteerd vanuit de ene indeling naar een andere, of
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wanneer verscheidene lagen in een bepaalde projectie moeten worden geconverteerd naar een andere projectie.

In dat geval is het herhaaldelijk aanroepen van het algoritme vanuit de Toolbox niet de beste optie. In plaats
daarvan zou de interface Batch-processing moeten worden gebruikt, die het meerdere malen uitvoeren van een
bepaald algoritme enorm vereenvoudigd. Zoek het in de Toolbox en, in plaats van erop te dubbelklikken, klik met
rechts en selecteer Uitvoeren als batch-proces om een algoritme als een batch-proces uit te voeren,

Voor dit voorbeeld zullen we het algoritme Reproject algorithm gebruiken, dus zoek het op en doe zoals hierboven
beschreven. U zult het volgende dialoogvenster krijgen.

Als u naar de gegevens voor deze les kijkt, zult u zien dat het drie shapefiles bevat, maar geen projectbestand
voor QGIS. Dat is omdat, wanneer een algoritme wordt uitgevoerd als een batch-proces, invoer als lagen kunnen
worden geselecteerd ofwel vanuit het huidige project van QGIS of vanuit bestanden. Dat maakt het eenvoudiger
grote aantallen lagen te verwerken, zoals, bijvoorbeeld, alle lagen in een bepaalde map.

Elke rij in het dialoogvenster van Batch-processing vertegenwoordigt één enkele uitvoering van het algoritme.
Cellen in een rij corresponderen met de benodigde parameter voor het algoritme, die niet boven elkaar zijn geschikt
zoals in het normale dialoogvenster voor eenmalige uitvoering, maar horizontaal in die rij.

Definiëren van het uit te voeren batch-proces is er een van het vullen van de tabel met de corresponderende
waarden, en het dialoogvenster zelf bevat verscheidene gereedschappen om deze taak eenvoudiger te maken.

Laten we beginnen met het één voor één vullen van de velden. De eerste kolom om te vullen is die van de Input
layer. In plaats van de namen in te voeren van elk van de lagen die we willen verwerken, kunt u ze allemaal
selecteren en het dialoogvenster er één in elke rij laten plaatsen. Klik op de knop in de cel linksboven, en se-
lecteer in het dialoogvenster voor bestandsselectie dat zal verschijnen, selecteer de drie bestanden om opnieuw te
projecteren. Omdat één ervan nodig is voor elke rij, zullen de resterende gebruikt worden om de rijen eronder te
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vullen.

Het standaard aantal rijen is 3, wat exact het aantal lagen is dat we moeten converteren, maar als u meer lagen
selecteert, zullen automatisch nieuwe rijen worden toegevoegd. Als u de items handmatig wilt vullen, kunt u meer
rijen toevoegen met behulp van de knop Add row.

We gaan al deze lagen converteren naar het CRS EPSG:23029, dus moeten we dat CRS selecteren in het tweede
veld. We willen hetzelfde voor alle rijen, dus we hoeven het niet voor elke individuele rij te doen. In plaats
daarvan, stel dat CRS in voor de eerste rij (die bovenaan) met behulp van de knop in de overeenkomstige cel, en
dubbelklik dan op de kolomkop. Dat zorgt er voor dal alle cellen in de kolom worden gevuld met behulp van de
waarde in de bovenste cel.
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Tenslotte zullen we een uitvoerbestand moeten selecteren voor elke uitvoering, wat de overeenkomstige opnieuw
geprojecteerde laag zal bevatten. Nogmaals, laten we dat doen voor alleen de eerste rij. Klik op de knop in de
bovenste cel en voer, in een map waar u uw uitvoerbestanden wilt plaatsen, een bestandsnaam in (bijvoorbeeld
reprojected.shp).

Nu, wanneer u op OK klikt in het dialoogvenster voor bestandsselectie, wordt het bestand niet automatisch
weggeschreven naar de cel, maar in plaats daarvan wordt een invoervak weergegeven zoals dat wat hieronder
wordt getoond.

Indien u de eerste optie selecteert zal alleen de huidige cel worden gevuld. Als u een van de andere opties
selecteert, zullen alle rijen daaronder worden gevuld met een bepaald patroon. In dit geval selecteren we de
parameter-optie Vullen met parameterwaarden, en voeren dan de waarde Input Layer in in het keuzemenu eron-
der. Dat zal er voor zorgen dat de waarde in Input Layer (dat is de laagnaam) zal worden toegevoegd aan de
bestandsnaam die we al hebben toegevoegd, wat elke bestandsnaam voor de uitvoer anders maakt. De tabel voor
het batch-proces zou er nu zo uit moeten zien.
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De laatste kolom stelt in of de resulterende lagen al dan niet worden toegevoegd aan het huidige project van QGIS
project. Laat de standaard optie Yes staan, zodat u in dit geval uw resultaten kunt zien.

Klik op OK en het batch-proces zal worden uitgevoerd. Als alles goed ging zouden al uw lagen moeten zijn
verwerkt en zouden 3 nieuwe lagen moeten zijn gemaakt.

17.26 Modellen in de interface Batch-processing

Waarschuwing: Wees voorzichtig, dit hoofdstuk is nog niet goed getest, rapporteer problemen; afbeeldingen
ontbreken

Notitie: Deze les toont een ander voorbeeld van de interface Batch-processing, maar deze keer met behulp van
een model in plaats van een ingebouwd algoritme

Modellen zijn hetzelfde als elk ander algoritme, en zij kunnen in de interface Batch-processing worden gebruikt.
Hier is een kort voorbeeld dat we kunnen uitvoeren met ons welbekende reeds bekende hydrologische model om
dat te demonstreren.

Zorg er voor dat u uw model heeft toegevoegd aan uw Toolbox, en voer het dan uit als een batch-proces. Dit is
hoe het dialoogvenster Batch-processing er uit zou moeten zien.

Waarschuwing: todo: Afbeelding toevoegen

Voeg rijen toe tot een totaal van 5. Selecteer het bestand DEM dat correspondeert met deze les als de invoer voor
alle rijen. Voer dan 5 verschillende drempelwaarden in, zoals hieronder weergegeven.

Waarschuwing: todo: Afbeelding toevoegen

Zoals u ziet kan de interface Batch-processing niet alleen worden uitgevoerd om hetzelfde proces op verschillende
gegevenssets uit te voeren, maar ook op dezelfde gegevensset met verschillende parameters.
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Klik op OK en u zou 5 nieuwe lagen moeten krijgen met waterbergingen die corresponderen met de gespeci-
ficeerde 5 drempelwaarden.

17.27 Andere programma’s

Module bijgedragen door Paolo Cavallini - Faunalia

Notitie: Dit hoofdstuk geeft weer hoe aanvullende programma’s kunnen worden gebruikt vanuit Processing.
U moet, om het te voltooien, de relevante pakketten, met de gereedschappen van uw besturingssysteem, hebben
geïnstalleerd.

17.27.1 GRASS

GRASS is een gratis en open bron softwarepakket voor GIS voor het beheren van geo-ruimtelijke gegevens en
analyses, verwerking van afbeeldingen, productie van afbeeldingen en kaarten, ruimtelijk modelleren en visual-
isatie.

Het wordt standaard geïnstalleerd op Windows door middel van het OSGeo4W zelfstandige installatiepakket (32
en 64 bit), en het is verpakt voor alle grote distributies van Linux.

17.27.2 R

R is een gratis en open bron software-omgeving voor statistische berekeningen en grafieken.

Het moet afzonderlijk worden geïnstalleerd, tezamen met een aantal noodzakelijke bibliotheken (LIST).

Het mooie van de implementatie van Processing is dat u uw eigen scripts kunt toevoegen, eenvoudige of complexe,
en dat zij dan kunnen worden gebruikt net als elke andere module, gepiped in meer complexe werkstromen, etc.

Test enkele van de reeds geïnstalleerde voorbeelden als u R al heeft geïnstalleerd (vergeet niet de modules van R
te activeren in de configuratie General van Processing).

17.27.3 OTB

OTB (ook wel bekend als Orfeo ToolBox) is een gratis en open bron-bibliotheek van algoritmen voor het verw-
erken van afbeeldingen. Het wordt standaard geïnstalleerd op Windows door middel van het OSGeo4W zelfs-
tandige installatiepakket (**NB: alleen 32 bit). Paden zouden moeten worden geconfigureerd in Processing.

In een standaard OSgeo4W Windows-installatie zouden de paden zijn:

OTB application folder C:\OSGeo4W\apps\orfeotoolbox\applications
OTB command line tools folder C:\OSGeo4W\bin

Op Debian en afgeleiden daarvan zou het zijn /usr/bin

17.27.4 Andere

TauDEM is een pakket van gereedschappen voor Digital Elevation Model (DEM) voor het uitnemen en analyseren
van hydrologische informatie. De beschikbaarheid varieert in de verschillende besturingssystemen.

LASTools is een verzameling, gemend vrije en merkgebonden, opdrachten om gegevens van LiDAR te verwerken
en te analyseren. De beschikbaarheid varieert in de verschillende besturingssystemen.

Meer gereedschappen zijn beschikbaar door middel van aanvullende plug-ins, bijv.:

• LecoS: een pakket voor statistieken van landgebruik en ecologie van landschappen
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• lwgeom: eerder deel van PostGIS, deze bibliotheek bevat een aantal bruikbare gereedschappen voor het
opknappen van geometrie

• Animove: gereedschappen om het leefbereik van dieren te analyseren.

Er zullen er nog meer komen.

17.27.5 Vergelijking tussen programma’s

Buffers en afstanden

Laten we points.shp laden en typ buf in het filter van de Toolbox, dubbelklik dan op:

• Fixed distance buffer: Distance 10000

• Variable distance buffer: veld Distance SIZE

• v.buffer.distance: distance 10000

• v.buffer.column: bufcolumn SIZE

• Shapes Buffer: fixed value 10000 (uitnemen en niet), attribuutveld (met schaal)

Zie hoe de snelheid nogal verschilt en hoe de verschillende opties beschikbaar zijn.

Oefening voor de lezer: zoek de verschillen in de uitvoer van geometrie tussen de verschillende methoden.

Nu, buffers en afstanden voor rasters:

• Laad eerst en rasteriseer de vector rivers.shp met GRASS → v.to.rast.value; LET OP: celgrootte moet
worden ingesteld op 100 m, anders zal de berekeningstijd enorm zijn; de resulterende kaart zal 1-en en
NULL-en hebben

• hetzelfde met SAGA → Shapes to Grid → COUNT (resulterende kaart: 6 tot en met 60)

• dan proximity (value= 1 voor GRASS, een lijst met rivers ID voor SAGA), r.buffer met parameters
1000,2000,3000, r.grow.distance (de eerste van de twee kaarten, de tweede zal de gebieden weergeven
die tot elke rivier behoren, indien uitgevoerd op het raster van SAGA).

Uitnemen

Neem objecten uit, gebaseerd op een gemeenschappelijk attribuut:

• GRASS → v.dissolve municipalities.shp op PROVINCIA

• QGIS → Dissolve municipalities.shp op PROVINCIA

• OGR → Dissolve municipalities.shp op PROVINCIA

• SAGA → Polygon Dissolve municipalities.shp op PROVINCIA (NB: Keep inner boundaries moet
niet zijn geselecteerd)

Notitie: De laatste is defect in SAGA <=2.10

Oefening voor de lezer: zoek de verschillen (geometrie en attributen) tussen de verschillende methoden.

17.28 Interpolatie en contouren

Module bijgedragen door Paolo Cavallini - Faunalia

Notitie: Dit hoofdstuk geeft weer hoe verschillende programma’s te gebruiken om verschillende interpolaties te
berekenen.
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17.28.1 Interpolatie

Het project toont een kleurverloop voor regenval, van zuid naar noord. Laten we verschillende methoden gebruiken
voor interpoleren, alle gebaseerd op de vector points.shp, parameter RAIN:

Waarschuwing: Stel de celgrootte voor alle analyses in op 500.

• GRASS → v.surf.rst

• SAGA → Multilevel B-Spline Interpolation

• SAGA → Inverse Distance Weighted [Inverse distance to a power; Power: 4; Search radius: Global; Search
range: all points]

• GDAL → Grid (Inverse Distance to a power) [Power:4]

• GDAL → Grid (Moving average) [Radius1&2: 50000]

Meet dan de variatie tussen de methoden en correleer die met de afstanden tot de punten:

• GRASS → r.series [Unselect Propagate NULLs, Aggregate operation: stddev]

• GRASS → v.to.rast.value op points.shp

• GDAL → Proximity

• GRASS → r.covar om de correlatie-matrix weer te geven; controleer de significantie van de correlatie bi-
jvoorbeeld met http://vassarstats.net/rsig.html.

Dus, gebieden ver van punten zullen minder nauwkeurige interpolatie hebben.

17.28.2 Contour

Verscheidene methoden om contourlijnen te tekenen [altijd stap= 10] op het raster stddev:

• GRASS → r.contour.step

• GDAL → Contour

• SAGA → Contour lines from grid [NB: output shp is niet geldig, onbekend probleem]

17.29 Vereenvoudigen van vectoren en gladder maken

Module bijgedragen door Paolo Cavallini - Faunalia

Notitie: Dit hoofdstuk toon hoe vectoren te vereenvoudigen en scherpe hoeken gladder te maken.

Soms hebben we een vereenvoudigde versie van een vector nodig, om een kleinere bestandsgrootte te krijgen en
onnodige details weg te laten. Vele gereedschappen doen dit op een nogal ruwe manier, en missen de aansluitingen
en soms de topologische juistheid van polygonen. GRASS is het ideale gereedschap hiervoor: omdat het een
topologisch GIS is worden aansluitingen en juistheid behouden zelfs op hele hoge niveaus van vereenvoudiging.
In ons geval hebben we een vector die resulteert vanuit een raster, waardoor een “zaag”-patroon aan de randen
wordt weergegeven. Toepassen van een vereenvoudiging resulteert in rechte lijnen:

• GRASS → v.generalize [Maximale tolerantie waarde: 30 m]

We kunnen ook het tegenovergestelde doen en een laag meer complex maken, scherpe hoeken gladder makend:

• GRASS → v.generalize [methode: chaiken]

Probeer deze tweede opdracht toe te passen op zowel de originele vector als op die uit de eerste analyse, en zie het
verschil. Merk op dat de aansluitingen niet verloren zijn gegaan.

Deze tweede optie kan worden toegepast op bijv. contourlijnen die resulteren vanuit een grof raster, op GPS-
sporen met weinig punten, etc.

552 Chapter 17. De QGIS-gids voor Processing

http://vassarstats.net/rsig.html
http://www.faunalia.eu


QGIS Training Manual, Release 2.14

17.30 Zonnepanelen plannen

Module bijgedragen door Paolo Cavallini - Faunalia

Notitie: Dit hoofdstuk toont hoe verscheidene criteria te gebruiken om de geschikte gebieden vast te stellen voor
een fotovoltaïsche elektriciteitscentrale

Ten eerste, maak een kaart van het aspect vanuit DTM:

• GRASS → r.aspect [Data type: int; cell size:100]

In GRASS wordt aspect berekend in graden, tegen de wijzers van de klok beginnend vanuit het oosten. We kunnen
het opnieuw classificeren om alleen hellingen uit te nemen die uitkijken op het zuiden (270 graden +- 45):

• GRASS → r.reclass

met de volgende regels:

225 thru 315 = 1 south

* = NULL

U kunt het verschafte tekstbestand reclass_south.txt gebruiken. Onthoud dat we met deze eenvoduige
tekstbestanden ook zeer complexe opnieuw uitgevoerde classificaties kunnen maken.

We willen een grote centrale bouwen, dus selecteren we alleen grote (> 100 ha) aaneengesloten gebieden:

• GRASS → r.reclass.greater

Tenslotte converteren we naar een vector:

• GRASS → r.to.vect [Feature type: area; Smooth corners: yes]

Oefening voor de lezer: herhaal de analyse, vervang de opdrachten voor GRASS door analoge voor andere
programma’s.

17.31 Scripts van R gebruiken in Processing

Module bijgedragen door Matteo Ghetta - mogelijk gemaakt door Scuola Superiore Sant’Anna

Processing maakt het mogelijk scripts voor R te schrijven en uit te voeren binnen QGIS.

Waarschuwing: R moet zijn geïnstalleerd op uw computer en het PATH moet correct zijn ingesteld. Meer
nog, Processing roept eenvoudigweg de externe pakketten van R aan, het is niet mogelijk ze te installeren.
Zorg er dus voor de externe pakketten direct in R te installeren. Bekijk het gerelateerde :ref:‘hoofdstuk in de
gebruikershandleiding.

Notitie: Als u enkele problemen met pakketten heeft, is dat misschien gerelateerd aan ontbrekende
voorgeschreven pakketten die zijn vereist door Processing, zoals sp, rgdal en raster.

17.31.1 Scripts toevoegen

Toevoegen van een script is erg eenvoudig. Open de Toolbox van Processing en klik eenvoudigweg op R →
Gereedschap → Nieuw R script maken.

17.30. Zonnepanelen plannen 553

http://www.faunalia.eu
http://www.santannapisa.it/it/istituto/scienze-della-vita/agricultural-water-management


QGIS Training Manual, Release 2.14

Notitie: Indien u R niet ziet in Processing, dient u het te activeren via Processing → Opties → Providers

Het opent een venster voor bewerken van scripts waarin u enkele parameters moet specificeren vóórdat u de tekst
va het script kunt toevoegen.

17.31.2 Plots maken

In deze handleiding gaan we een boxplot maken van een veld van een vectorlaag.

Open het project van QGIS r_intro.qgs.

Parameters voor scripts

Open de bewerker en begin met het schrijven aan het begin ervan.

U moet enkele parameters specificeren vóór de tekst van het script:
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1. de naam van de groep waarin u uw script wilt plaatsen:

##plots=group

zo zult u uw script terugvinden in de groep plots in de Toolbox van Processing.

2. u moet Processing vertellen dat u een plot wilt weergeven (slechts voor dit voorbeeld):

##showplots

op deze manier zult het plot zien in de Resultaten viewer van Processing.

3. U dient Processing ook te vertellen met welke soort gegevens u werkt. In dit voorbeeld willen we een plot
maken uit een veld van een vectorlaag:

##Layer=vector

Processing weet nu dat de invoer een vector is. De naam Laag is niet belangrijk, wat van belang is is de
parameter vector.

4. Tenslotte moet u het invoerveld van de vectorlaag specificeren die u wilt plotten:

##X=Field Layer

Zo weet Processing dat u X de Veldlaag heeft genoemd.

Tekst van het script

Nu u de kop van het script heeft ingesteld kunt u de functie toevoegen:

boxplot(Layer[[X]])

Onthoud dat boxplot de naam van de functie van R zelf is die Laag aanroept als gegevensset en X als veld voor
de gegevensset.

Waarschuwing: De parameter X staat binnen dubbele vierkante haken [[]]

Het uiteindelijke script ziet er als volgt uit:

##Vector processing=group
##showplots
##Layer=vector
##X=Field Layer
boxplot(Layer[[X]])
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Sla het script op in het standaard pad dat wordt voorgesteld door Processing. De naam die u kiest zal hetzelfde
zijn als de naam van het script dat u terugvindt in de Toolbox van Processing.

Notitie: U kunt het script opslaan in ene ander pad, maar Processing is dan niet in staat om ze automatisch te
uploaden en dient u alle scripts handmatig te uploaden.

Voer het nu eenvoudigweg uit met behulp van de knop aan de bovenzijde van het venster van de bewerker:
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Gebruik anders, als het venster van de bewerker eenmaal is gesloten, het tekstvak van Processing om uw script te
zoeken:

U kunt nu de vereiste parameters invoeren in het venster Algoritme van Processing:

• kies als Laag de sample points

• vul het veld X met de parameter value

Klik op Run.
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Het venster Resultaten zou automatisch moeten worden geopend, indien niet, klik eenvoudigweg op Processing
→ Resultaten bekijken....

Dit is het uiteindelijke resultaat dat u zult zien:
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Notitie: U kunt de afbeelding openen, kopiëren en opslaan door met rechts te klikken op het plot

17.31.3 Een vector maken

Met een script in R kunt u ook een vector maken en die automatisch laden in QGIS.

Het volgende voorbeeld komt uit het script Random sampling grid dat u kunt downloaden vanuit de verza-
meling online R → Tools → Download R scripts from the on-line collection.

Het doel van deze oefening om een willekeurige puntvector in een laagbereik te maken met behulp van de functie
spsample van het pakket sp.

Parameters voor scripts

Net als eerder moeten we, vóór de tekst van het script, enkele parameters instellen:

1. specificeer de naam van de groep waarin u uw script wilt opslaan, bijvoorbeeld Point pattern analysis:

##Point pattern analysis=group

2. stel de laag in die de willekeurige punten zal bevatten:

##Layer=vector

3. stel het aantal punten in dat moet worden gemaakt:
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##Size=number 10

Notitie: 10 zal de standaard waarde zijn. U kunt dit getal wijzigen of u kunt de parameter zonder standaard
nummer laten

4. specificeer dat de uitvoer een vectorlaag is:

##Output= output vector

Tekst van het script

Nu kunt u de tekst van de functie toevoegen:

1. voer de functie spsample uit:

pts=spsample(Layer,Size,type="random")

op deze manier neemt de functie het bereik van de Layer, het aantal punten wordt genomen uit de parameter
Size en het te genereren type punt is random

2. Schrijf de regel die de parameters voor de uitvoer bevat:

Output=SpatialPointsDataFrame(pts, as.data.frame(pts))

Het uiteindelijke script zou er als volgt uit moeten zien:

Sla het op en voer het uit door te klikken op de knop voor uitvoeren.

Typ in het nieuwe venster de juiste parameters in:
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en klik op Run.

De resulterende punten zullen worden weergegeven in het kaartvenster

17.31.4 R - Processing syntaxis

Onthoud dat Processing soms speciale syntaxis gebruikt om de resultaten uit R te verkrijgen:
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• > vóór uw opdracht, zoals in >lillie.test(Layer[[Field]]) betekent dat het resultaat moet wor-
den verzonden naar uitvoer voor R (Resultaten bekijken)

• + na een plot om overliggende plots aan te roepen. Bijvoorbeeld plot(Layer[[X]], Layer[[Y]])
+ abline(h=mean(Layer[[X]]))

17.32 Syntaxis voor R in scripts voor Processing

Module bijgedragen door Matteo Ghetta - mogelijk gemaakt door Scuola Superiore Sant’Anna

Schrijven van scripts voor R in Processing kan behoorlijk ingewikkeld zijn vanwege de syntaxis die moet worden
gebruikt.

Elk script begint met de Input en de Output voorafgegaan door ##.

17.32.1 Invoer

Vóórdat u de invoer specificeert kunt u de groep algoritmen instellen waarin u het script wilt plaatsen. Als de
groep al bestaat zal het algoritme aan die groep worden toegevoegd, anders zal automatisch een nieuwe groep
worden gemaakt:

1. maken van een groep, ##My Group=group

Daarna dient u alle typen invoer te specificeren en eventueel de aanvullende parameters. U kunt verschillende
invoer hebben:

1. vector, ##Layer = vector

2. vector Field, ##F = Field Layer (waar Layer de naam van de invoerlaag is)

3. table, ##Layer = raster

4. number, ##Num = number

5. string, ##Str = string

6. boolean, ##Bol = boolean

u kunt ook een keuzelijst hebben waarin alle parameters zijn opgenomen die u wilt, de items moeten zijn gecshei-
den door puntkomma’s ;:

7. ##type=selection point;lines;point+lines

17.32.2 Uitvoer

Net als voor de invoer dient elke uitvoer te worden gedefinieerd aan het begin van het script:

1. vector, ##output= output vector

2. raster, ##output= output raster

3. table, ##output= output table

4. plots, ##showplots

5. Uitvoer voor R in Resultaten bekijken, plaats eenvoudigweg binnen het script > vóór de uitvoer die u wilt
weergeven
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17.32.3 Tekst van het script

De tekst van het script volgt een syntaxis in de stijl van R en het paneel Log kan u helpen als er iets mis ging met
uw script.

Onthoud dat in het script dat u heeft u alle aanvullende bibliotheken moet laden:

library(sp)

Voorbeeld met uitvoer als vector

Laten we een algoritme nemen uit de online collectie dat willekeurige punten maakt uit het bereik van een invoer-
laag:

##Point pattern analysis=group
##Layer=vector
##Size=number 10
##Output= output vector
library(sp)
pts=spsample(Layer,Size,type="random")
Output=SpatialPointsDataFrame(pts, as.data.frame(pts))

en dan gaan we door de regels:

1. Point pattern analysis is de groep van het algoritme

2. Layer is de invoer **vector**laag

3. Size is de numerieke parameter met een standaard waarde van 10

4. Output is de **vector**laag die zal worden gemaakt door het algoritme

5. library(sp) laadt de bibliotheek sp (die al op uw computer zou moeten zijn geïnstalleerd en welke
installatie in R zou moeten zijn)

6. roep de functie spsample aan van de bibliotheek sp en geef die door aan alle hierboven gedefinieerde
invoer

7. maak de vector uitvoer met de functie SpatialPointsDataFrame

Dat is alles! Voer eenvoudigweg het algoritme uit met een vectorlaag die aanwezig is in de legenda van QGIS,
kies een getal voor de willekeurige punten en u zult ze in het kaartvenster van QGIS zien.

Voorbeeld met uitvoer als raster

Het volgende script zal een basale ordinary Kriging uitvoeren en zal een ratsrkaart maken van de geïnterpoleerde
waarden:

##Basic statistics=group
##Layer=vector
##Field=Field Layer
##Output=output raster
require("automap")
require("sp")
require("raster")
table=as.data.frame(Layer)
coordinates(table)= ~coords.x1+coords.x2
c = Layer[[Field]]
kriging_result = autoKrige(c~1, table)
prediction = raster(kriging_result$krige_output)
Output<-prediction
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vanuit een vector en het veld daarvan in invoer zal het algoritme de functie autoKrige van het R-pakket
automap gebruiken en zal het eerst het model Kriging berekenen en dan een raster maken.

Het raster wordt gemaakt met de functie raster van het raster R-pakket.

Voorbeeld met uitvoer als tabel

Laten we het algoritme Summary Statistics bewerken zodat de uitvoer een tabelbestand (csv) is.

De tekst vor het script is het volgende:

##Basic statistics=group
##Layer=vector
##Field=Field Layer
##Stat=Output table
Summary_statistics<-data.frame(rbind(
sum(Layer[[Field]]),
length(Layer[[Field]]),
length(unique(Layer[[Field]])),
min(Layer[[Field]]),
max(Layer[[Field]]),
max(Layer[[Field]])-min(Layer[[Field]]),
mean(Layer[[Field]]),
median(Layer[[Field]]),
sd(Layer[[Field]])),row.names=c("Sum:","Count:","Unique values:","Minimum value:","Maximum value:","Range:","Mean value:","Median value:","Standard deviation:"))
colnames(Summary_statistics)<-c(Field)
Stat<-Summary_statistics

De derde regel specificeert het Vector Field in invoer en de vierde regel vertelt het algoritme dat de uitvoer een
tabel zou moeten zijn.

De laatste regel zal het object Stat , gemaakt in het script, nemen en het naar een csv-tabel converteren.

Voorbeeld met uitvoer naar het scherm

We kunnen het voorgaande voorbeeld nemen en in plaats van een tabel te maken, het resultaat afdrukken in
Resultaten bekijken:

##Basic statistics=group
##Layer=vector
##Field=Field Layer
Summary_statistics<-data.frame(rbind(
sum(Layer[[Field]]),
length(Layer[[Field]]),
length(unique(Layer[[Field]])),
min(Layer[[Field]]),
max(Layer[[Field]]),
max(Layer[[Field]])-min(Layer[[Field]]),
mean(Layer[[Field]]),
median(Layer[[Field]]),
sd(Layer[[Field]])),row.names=c("Sum:","Count:","Unique values:","Minimum value:","Maximum value:","Range:","Mean value:","Median value:","Standard deviation:"))
colnames(Summary_statistics)<-c(Field)
>Summary_statistics

Het script is exact hetzelfde als hierboven met slechts 2 bewerkingen:

1. er wordt geen uitvoer meer gespecificeerd (de vierde regel is verwijderd)

2. de laatste regel begint met > wat Processing vertelt om het object af te drukken in Identficatieresultaten
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Voorbeeld met plot

Het maken van plots is erg eenvoudig. U moet de parameter ##showplots gebruiken, zoals in het volgende
script is weergegeven:

##Basic statistics=group
##Layer=vector
##Field=Field Layer
##showplots
qqnorm(Layer[[Field]])
qqline(Layer[[Field]])

het script neemt een veld van de vectorlaag in invoer en maakt een QQ Plot om de normaliteit van de verdeling te
testen.

Het plot wordt automatisch toegevoegd aan Resultaten bekijken van Processing.

17.33 Overzichtstabel syntaxis voor R voor Processing

Module bijgedragen door Matteo Ghetta - mogelijk gemaakt door Scuola Superiore Sant’Anna

Processing staat heel veel verschillende parameters voor invoer en uitvoer toe die kunnen worden gebruikt in de
tekst van het script. Hier is een tabel met een overzicht:

17.33.1 Invoerparameters

Parameter Voorbeeld van
syntaxis

Teruggeven van objecten

vector Layer = vector SpatialDataFrame object, standaard object van pakket rgdal
vector point Layer = vector point SpatialPointDataFrame object, standaard object van pakket

rgdal
vector line Layer = vector line SpatialLineDataFrame object, standaard object van pakket

rgdal
vector
polygon

Layer = vector polygon SpatialPolygonsDataFrame object, standaard object van pakket
rgdal

meerdere
vector

Layer = multiple vector SpatialDataFrame objecten, standaard object van pakket rgdal

tabel Layer = table dataframe conversie van csv, standaard object van de functie
read.csv

veld Field = Field Layer naam van het geselecteerde veld, bijv. "Area"
raster Layer = raster RasterBrick object, standaard object van pakket raster
meerdere
raster

Layer = multiple raster RasterBrick objecten, standaard object van pakket raster

getal N = number gekozen integer of floating number
tekenreeks S = string string toegevoegd in het vak
longstring LS = longstring string toegevoegd in het vak, zou langer kunnen zijn dan een

normale tekenreeks
selectie S = selection

first;second;third
string van het geselecteerde item uit d ekeuzelijst

crs C = crs string van het gekozen resulterende CRS, in de indeling:
"EPGS:4326"

bereik E = extent Object Extent van het pakket raster, u kunt waarden uitnemen
zoals E@xmin

punt P = point indien aangeklikt op de kaart, heeft u de coördinaten van het punt
bestand F = file pad van het gekozen bestand, bijv. “/home/matteo/file.txt”
map F = folder pad van de gekozen map, bijv. “/home/matteo/Downloads”
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Elke invoer zou ook OPTIONAL kunnen zijn, dat betekent dat u heen handige manier heeft om het script te
vertellen dat het deze parameter moet negeren.

Instellen van een invoer als optioneel gaat als volgt, u hoeft slechts de string optional toe te voegen vóór de
invoer, bijv:

##Layer = vector
##Field1 = Field Layer
##Field2 = optional Field Layer

17.33.2 Uitvoerparameters

Parameters voor uitvoer nemen de Invoer-namen die u aan het begin gaf en schrijven het object dat u wilt.

Parameter Voorbeeld van syntaxis
vector Output = output vector
raster Output = output raster
tabel Output = output table
bestand Output = output file

Notitie: voor het invoertype plot kunt u het plot direct opslaan als png vanuit Processing Resultaten bekijken of
u kunt er voor kiezen om het plot direct op te slaan vanuit d einterface van het algoritme.

17.33.3 Voorbeelden

Bekijk Hoofdstuk Syntaxis voor R om een beter begrip te krijgen van alle parameters vaoor invoer en uitvoer.

17.34 Landverschuivingen voorspellen

Module bijgedragen door Paolo Cavallini - Faunalia

Notitie: Dit hoofdstuk geeft weer hoe een erg vereenvoudigd model te maken om de waarschijnlijkheid van
landverschuivingen te voorspellen.

eerst berekenen we de helling (kies uit verscheidene programma’s; de geïnteresseerde lezer kan het verschil tussen
de uitvoeren berekenen):

• GRASS → r.slope

• SAGA → Slope, Aspect, Curvature

• GDAL Slope

Dan maken we een model van voorspelde neerslag, gebaseerd op de interpolatie van waarden voor neerslag van
meetstations:

• GRASS → v.surf.rst (resolutie: 500 m)

De waarschijnlijkheid van ene landverschuiving zal zeer ruw zijn, gerelateerd aan zowel de neerslag als de helling
(natuurlijk zal een echt model meer lagen gebruiken, en toepasselijke parameters), laten we zeggen (neerslag
* helling )/100:

• SAGA → Raster calculator rain, slope: (a*b)/100 (of: GRASS → r.mapcalc)

• laten we dan de plaatsen berekenen met het grootste berekende risico op neerslag: SAGA → Raster statistics
with polygons (de interessante parameters zijn Maximum en Mean)
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CHAPTER 18

Module: Ruimtelijke databases in QGIS gebruiken

In deze module zult u leren hoe ruimtelijke databases te gebruiken met QGIS om gegevens in de database te
beheren, weer te geven en te bewerken, als ook het uitvoeren van analyses door bevragingen. We zullen primair
PostgreSQL en PostGIS gebruiken (die in eerdere gedeelten werden behandeld), maar dezelfde concepten zijn van
toepassing op andere implementaties van ruimtelijke databases inclusief Spatialite.

18.1 Lesson: Werken met databases in de Browser van QGIS

In de voorafgaande 2 modules hebben we gekeken naar de basisconcepten, mogelijkheden en functies van re-
lationele databases, als ook naar uitbreidingen die ons ruimtelijke gegevens op laten slaan, beheren, bevragen
en bewerken in een relationele database. Dit gedeelte zal dieper duiken in hoe effectief ruimtelijke databases te
gebruiken in QGIS.

Het doel voor deze les: Leren over interactie met ruimtelijke databases met behulp van de interface browser in
QGIS.

18.1.1 Follow Along: Databasetabellen aan QGIS toevoegen met behulp
van de Browser

We hebben al even kort gekeken naar hoe we tabellen uit een databases toevoegen als lagen aan QGIS, laten
we hier nu eens iets meer in detail naar kijken en kijken naar de verschillende manieren waarop dat kan worden
gedaan in QGIS. Laten we beginnen met te kijken naar de nieuwe interface Browser.

• Begin een nieuwe lege kaart in QGIS.

• Open de Browser door te klikken op de tab Browser onder in het paneel Lagen

• Open het gedeelte PostGIS van de boom en u zult uw eerder geconfigureerde verbinding beschikbaar vinden
(u moet misschien op de knop Bijwerken drukken oven in het venster Browser).
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• Dubbelklikken op een van de hier vermelde tabellen/lagen zal dat toevoegen aan het kaartvenster.

• Met rechts klikken op een tabel/laag in deze weergave zal u een aantal opties geven. Klik op het item
Eigenschappen om de eigenschappen van de laag te bekijken.
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Notitie: Natuurlijk kunt u deze interface ook gebruiken om databases van PostGIS die worden gehost op een
externe server te verbinden met uw werkstation. Met rechts klikken op het item PostGIS in de boom zal u in staat
stellen parameters voor de verbinding te specificeren voor een nieuwe verbinding.

18.1.2 Follow Along: Een gefilterde set records als een laag toevoegen

Nu we hebben gezien hoe een gehele tabel als een laag aan QGIS toe te voegen, zou het leuk zijn om te leren hoe
een set gefilterde records uit een tabel kan worden toegevoegd als een laag door query’s te gebruiken die we in
eerdere gedeelten geleerd hebben.

• Begin een nieuwe lege kaart zonder lagen.

• Klik op de knop PostGIS-laag toevoegen of selecteer Kaartlagen –> PostGIS-laag toevoegen uit het menu.

• In het dialoogvenster PostGIS-tabel(len) toevoegen dat verschijnt, verbindt met de verbinding
postgis_demo.

• Breidt public schema uit en u zou daar de drie tabellen moeten vinden waar we eerder mee hebben
gewerkt.

• Klik op de laag lines om die te selecteren, maar in plaats van die toe te voegen, klik op de knop Filter
instellen om het dialoogvenster Querybouwer naar voren te brengen.

• Construeer de volgende expressie met behulp van de knoppen of door hem direct in te voeren:

"roadtype" = ’major’
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• Klik op OK om het bewerken van het filter te voltooien en klik op Toevoegen om de gefilterde laag aan uw
kaart toe te voegen.

• Hernoem de laag lines in de boom naar roads_primary.

Het zal u opvallen dat alleen de Primary roads zijn toegevoegd aan uw kaart in plaats van de gehele laag.

18.1.3 In Conclusion

U heeft gezien hoe u interactief kunt werken met ruimtelijke databases met behulp van de Browser van QGIS en
hoe u lagen aan uw kaart toevoegt, gebaseerd op een queryfilter.

18.1.4 What’s Next?

Vervolgens zult u zien hoe te werken met de interface DB Manager in QGIS voor een meer complete set van
beheerstaken voor databases.
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18.2 Lesson: DB Manager gebruiken om te werken met ruimtelijke
databases in QGIS

We hebben al gezien hoe we veel bewerkingen aan databases kunnen uitvoeren met QGIS, als ook met andere
gereedschappen, maar nu is het tijd om te kijken naar het gereedschap DB Manager wat veel dezelfde function-
aliteiten verschaft en ook meer op beheer georiënteerde gereedschappen.

Het doel voor deze les: Te leren hoe interactief te werken met ruimtelijke databases met behulp van de DB
Manager in QGIS.

18.2.1 Follow Along: Databases van PostGIS beheren met DB Manager

U zou eerst de interface van de DB Manager moeten openen door te selecteren Database –> DB Manager –> DB
Manager in het menu of door het pictogram DB Manager te selecteren op de werkbalk.

U zou de eerdere verbindingen die we hebben geconfigureerd al moeten zien en in staat zijn het gedeelte
postgis_demo en het schema public uit te breiden om de tabellen te zien waarmee we in eerdere gedeelten
hebben gewerkt.

Het eerste dat u zou moeten opvallen is dat u nu enkele metadata kunt zien over de schema’s die zijn opgenomen
in uw database.

Schema’s zijn een manier om gegevenstabellen en andere objecten in een database van PostgreSQL te groeperen
en een container voor rechten en andere beperkingen. het beheren van schema’s van PostgreSQL valt buiten
het bereik van deze handleiding, maar u kunt er meer informatie over vinden in de PostgreSQL documentation
on Schemas. U kunt DB Manager gebruiken om nieuwe schema’s te maken, maar u zult een gereedschap als
pgAdmin III of de interface voor de opdrachtregel moeten gebruiken om ze effectief te beheren.
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DB Manager kan ook worden gebruikt om de tabellen in uw database te beheren. We hebben al gekeken naar de
verscheidene manieren om tabellen te maken en te beheren via de opdrachtregel, maar laten we nu eens kijken hoe
dat te doen in DB Manager.

Eerst is het handig om te kijken naar de metadata van een tabel door te klikken op zijn naam in de boom en te
kijken op de tab Info.

In dit paneel kunt u de Algemene info over de tabel zien als ook de informatie die de extensie PostGIS onderhoudt
over de geometrie en het ruimtelijke referentiesysteem.

Als u naar beneden scrollt op de tab Info, kunt u meer informatie zien over de Velden, Beperkingen en Indexen
voor de tabel die u bekijkt.
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Het is ook zeer handig om DB Manager te gebruiken om eenvoudig naar de records in de database te kijken op
nagenoeg dezelfde manier als u zou doen door de attributentabel van een laag te bekijken in de boom van Lagen.
U kunt door de gegevens bladeren door de tab Tabel te selecteren.
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Er is ook een tab Voorvertoning die u de gegevens van de laag in een voorbeeldkaart laat zien.

Klikken met rechts op een laag in de boom en klikken op Aan kaartvenster toevoegen zal deze laag toevoegen aan
uw kaart.

Tot dusverre hebben we alleen gekeken naar de schema’s en tabellen van de database en hun metadata, maar wat
als we de tabel willen veranderen door misschien een aanvullende kolom toe te voegen? DB Manager stelt u in
staat om dat direct te doen.

• Selecteer de tabel die u wilt bewerken in de boom

• Selecteer Tabel –> Tabel bewerken uit het menu om het dialoogvenster Tabel-eigenschappen te openen.

U kunt dit dialoogvenster gebruiken om kolommen toe te voegen, geometrie-kolommen toe te voegen, bestaande
kolommen te bewerken of om een kolom volledig te verwijderen.

Door de tab Beperkingen te gebruiken kunt u beheren welke velden gebruikt moeten worden als de primaire sleutel
of om bestaande beperkingen te verwijderen.

574 Chapter 18. Module: Ruimtelijke databases in QGIS gebruiken



QGIS Training Manual, Release 2.14

De tab Indexen kan worden gebruikt om zowel ruimtelijke als normale indexen te verwijderen.
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18.2.2 Follow Along: Een nieuwe tabel maken

Laten we, nu we door het proces van werken met bestaande tabellen in onze database zijn gegaan, DB Manager
gebruiken om een nieuwe tabel te maken.

• Als het al niet geopend is, open het venster DB Manager en breidt de boom uit totdat u de lijst met tabellen
ziet die al in uw database aanwezig zijn.

• Selecteer uit het menu Tabel –> Tabel maken om het dialoogvenster Tabel maken naar voren te halen.

• Gebruik het standaard schema Public en noem de tabel places.

• Voeg de velden id, place_name en elevation toe, zoals hieronder weergegeven

• Zorg er voor dat het veld id is ingesteld als de primaire sleutel.

• Klik op het keuzevak Geometriekolom maken en zorg er voor dat het is ingesteld op een type POINT en laat
de naam als geom en specificeer 4326 als het SRID.

• Klik op het keuzevak Ruimtelijke index aanmaken en klik op Aanmaken om de tabel te maken.
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• Sluit het dialoogvenster dat u laat weten dat de tabel werd gemaakt en klik op Close om het dialoogvenster
Tabel maken te sluiten.

U kunt nu uw tabel in DB Manager inspecteren en u zult natuurlijk vinden dat er geen gegevens in staan. Vanaf
hier kunt u Bewerken aan/uitzetten in het menu van de Lagen en beginnen met het toevoegen van plaatsen aan uw
tabel.

18.2.3 Follow Along: Basisbeheer van database

DB Manager zal u ook in staat stellen enkele basis beheerstaken voor de database uit te voeren. Het is zeker geen
vervanging voor een meer compleet gereedschap voor databasebeheer, maar het verschaft enige functionaliteit die
u kunt gebruiken om uw database te onderhouden.

Databasetabellen kunnen vaak vrij groot worden en tabellen die regelmatig worden bijgewerkt kunnen achterbli-
jfselen van records bevatten die niet langer nodig zijn voor PostgreSQL. De opdracht VACUUM zorgt voor een
soort afvalverwerking om uw tabellen te verkleinen en optioneel te analyseren voor betere uitvoering.

Laten we eens kijken hoe we een opdracht VACUUM ANALYZE kunnen uitvoeren vanuit DB Manager.

• Selecteer één van uw tabellen in de boom van DB Manager.

• Selecteer Tabel –> Vacuüm Analyze uitvoeren uit het menu.

Dat is alles! PostgreSQL zal de bewerking uitvoeren. Afhankelijk van de grootte van uw tabel, zou dit enige tijd
kunnen vergen om te voltooien.

18.2. Lesson: DB Manager gebruiken om te werken met ruimtelijke databases in QGIS 577



QGIS Training Manual, Release 2.14

U vindt meer informatie over het proces VACUUM ANALYZE in de PostgreSQL Documentation on VACUUM
ANALYZE

18.2.4 Follow Along: SQL-query’s met DB Manager uitvoeren

DB Manager verschaft ook een manier om query’s voor uw databasetabellen te schrijven en om de resultaten te
bekijken. We hebben dit type functionaliteit al gezien in het paneel Browser, maar laten we er hier nog eens naar
kijken met DB Manager.

• Selecteer de tabel lines in de boom.

• Selecteer de knop SQL-venster in de werkbalk van DB Manager.

• Voer de volgende SQL query in de daarviior bestemde ruimte in:

select * from lines where roadtype = ’major’;

• Klik op de knop Uitvoeren (F5) om de query uit te voeren.

• U zou nu, in het paneel Resultaat, de records moeten zien die overeenkomen.

• Klik op het keuzevak Als nieuwe laag laden om de resultaten aan uw kaart toe te voegen.

• Selecteer de kolom id als de Kolom met unieke integer-waarden en de kolom the_geom als de Geome-
triekolom.

• Voer roads_primary in als de Laagnaam (prefix).
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• Klik op Nu laden! om de resultaten als een nieuwe laag in uw kaart te laden.

De lagen die overeenkomen met uw query worden nu weergegeven in uw kaart. U kunt natuurlijk dit gereedschap
voor query gebruiken om enige willekeurige opdracht voor SQL uit te voeren, inclusief veel van die waarnaar we
hebben gekeken in eerdere modules en gedeelten.

18.2.5 Gegevens in een database importeren met DB Manager

We hebben al gekeken naar hoe we gegevens in een een ruimtelijke database importeren met behulp van de
gereedschappen voor de opdrachtregel en ook gekeken hoe we de plug-in SPIT gebruiken, dus laten we nu leren
hoe DB Manager te gebruiken om te importeren.

• Klik op de knop Laag/bestand importeren op de werkbalk in het dialoogvenster DB Manager.

• Selecteer het bestand urban_33S.shp uit exercise_data/projected_data als de gegevensset
voor invoer.

• Klik op de knop Opties vernieuwen om enkele van de waarden in het formulier vooraf in te vullen.

• Zorg er voor dat de optie Nieuwe tabel makem is geselecteerd

• Specificeer Bron SRID als 32722 en het Doel SRID as 4326.

• Selecteer het keuzevak Ruimtelijke index aanmaken

• Klik op OK om het importeren uit te voeren.
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• Sluit het dialoogvenster dat u laat weten dat het importeren is voltooid

• Klik op de knop Bijwerken op de werkbalk van DB Manager.

U kunt nu de tabel in uw database inspecteren door op de naam te klikken in de boom. Verifieer dat de gegevens
opnieuw zijn geprojecteerd door te controleren of Ruimtelijk refsys: is vermeld als WGS 84 (4326)
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Klik met rechts op de tabel in de boom en selecteren van Aan kaartvenster toevoegen zal de tabel als een laag aan
uw kaart toevoegen.

18.2.6 Gegevens uit een database exporteren met DB Manager

Natuurlijk kan DB Manager ook worden gebruikt om gegevens vanuit uw ruimtelijke databases te exporteren,
laten we dus eens kijken hoe dat moet worden gedaan.

• Selecteer de laag lines in de boom en klik op de knop Naar bestand exporteren op de werkbalk om het
dialoogvenster Naar vectorbestand exporteren te openen.

• Klik op de knop ... om het Uitvoerbestand te selecteren en sla de gegevens op in uw map exercise_data
als urban_4326.

• Stel het Doel SRID in als 4326.

• Klik op OK om het exporteren te initialiseren.
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• Sluit het dialoogvenster dat u laat weten dat het exporteren is voltooid en sluit DB Manager.

U kunt nu het shapefile dat u heeft gemaakt inspecteren in het paneel Browser.
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18.2.7 In Conclusion

U heeft nu gezien hoe u de interface DB Manager kunt gebruiken in QGIS om uw ruimtelijke databases te beheren,
om SQL-query’s uit te voeren op uw gegevens en hoe gegevens te im- en exporteren.

18.2.8 What’s Next?

Vervolgens zullen we kijken hoe we veel van deze zelfde technieken gebruiken met databases van Spatialite.

18.3 Lesson: Werken met databases van SpatiaLite in QGIS

Waar PostGIS over het algemeen op een server wordt gebruikt om mogelijkheden voor ruimtelijke databases te
verschaffen voor meerdere gebruikers tegelijkertijd, Ondersteunt QGIS ook het gebruiken van ene bestandsindel-
ing genaamd SpatiaLite wat een lichtgewicht draagbare manier is een gehele ruimtelijke database in één enkel
bestand op te slaan. Uiteraard zouden deze 2 typen ruimtelijke databases moeten worden gebruikt voor verschil-
lende doelen, maar dezelfde basisprincipes en technieken zijn op beide van toepassing. Laten we een nieuwe
database voor SpatiaLite maken en de functionaliteit verkennen die wordt verschaft om met deze databases in
QGIS te werken.

Het doel voor deze les: leren hoe interactief te werken met databases van SpatiaLite met behulp van de interface
Browser van QGIS.

18.3.1 Follow Along: Een database van SpatiaLite maken met de Browser

Met behulp van het paneel Browser kunnen we een nieuwe database voor SpatiaLite maken en die instellen voor
gebruik in QGIS.

• Klik met rechts op het item Spatialite in de boom van de Browser en selecteer Database maken.

• Specificeer waar on uw bestandssysteem u het bestand wilt opslaan en noem het qgis-sl.db.

• Klik opnieuw met rechts op het item SpatiaLite in de boom van de Browser en selecteer nu het item Nieuwe
verbinding. Zoek het bestand dat u in de laatste stap maakte en open het.

Nu u uw nieuwe database heeft geconfigureerd zult u zien dat dat item in de boom van de Browser tree er niets
onder heeft en dat het enige dat u op dit moment kunt doen is de verbinding te verwijderen. Dat komt natuurlijk
omdat we nog geen tabellen aan deze database hebben toegevoegd. Laten we doorgaan en dat doen.

• Zoek de knop om een nieuwe laag te maken en gebruik het keuzemenu om een nieuwe laag voor SpatiaLite
te maken, of selecteer Kaartlagen –> Laag maken –> Nieuwe Spatialite-laag....

• Selecteer de database die we in de eerder stappen gemaakt hebben in het keuzemenu.

• Geef de laag de naam places.

• Selecteer het keuzevak naast Maak een automatisch ophogend primair sleutelveld aan.

• Voeg 2 attributen toe zoals hieronder weergegeven

• Klik op OK om de tabel te maken.
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• Klik op de knop Bijwerken boven in de Browser en u zou nu uw tabel places vermeld moeten zien.
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U kunt met rechts op de tabel klikken en de eigenschappen ervan bekijken zoals we in de eerdere oefening deden.

vanaf hier kunt u een sessie voor bewerken beginnen en beginnen met het direct toevoegen van gegevens aan uw
nieuwe database.

We leerden ook hoe gegevens te importeren in een database met behulp van DB Manager en u kunt deze zelfde
techniek gebruiken gegevens in uw nieuwe database van SpatiaLite te importeren.

18.3.2 In Conclusion

U heeft gezien hoe databases voor SpatiaLite te maken en daaraan tabellen toe te voegen en deze tabellen als lagen
te gebruiken in QGIS.

18.3. Lesson: Werken met databases van SpatiaLite in QGIS 585



QGIS Training Manual, Release 2.14

586 Chapter 18. Module: Ruimtelijke databases in QGIS gebruiken



CHAPTER 19

Module: De interface

19.1 Overzicht

Dit zijn de dingen die we zullen behandelen in deze cursus:

• Wat is Python? * Hello world

• Programma logica * Witruimte in Python * Declareren van variabelen * Expressies * Loops * if..then..else
* Declareren van functies * Functies documenteren

• Python datatypes (dynamische types, sterke types) * String, int, float * Woordenboeken * Lijsten * Tubles
* Opmaak van String * Lijst begrippen

• Introspectie * Optionele en benoemde argumenten * type, str, dir * getattr * lambda functions * __doc__

• Objecten * Module importeren * Importeren zoekpaden * Definiëren van klassen * Klasse initialisatie (con-
structors) * self * Klasse instantiatie * Afvalverzemeling * Instance variabelen (leden van klassen) * Meth-
ode overladen (niet ondersteund) * Klasse attributen (statische klassevariabelen) * Private functies (voor
module) * Private klasse methoden (voor klasse) * Private attributen (voor klasse)

• Uitzonderingen * try...except * try...except...else * try...except...finally

• Bestand IO * tekstbestanden lezen * tekstbestanden schrijven * manipuleren van bestandspad (os module)
* paden splitsen * lijsten van mappen / globbing

19.2 Lesson: Basisbeginselen Python

In deze les zullen we u kennis laten maken met de basisbeginselen van Python. Als u al eens met andere tale
geprogrammeerd heeft (Java, C++, VB etc.) zult u merken dat Python heel eenvoudig is en snel te leren is, hoewel
het enigszins afwijkt van de manier waarop andere talen werken, in het bijzonder voor wat betreft de termen van
zijn vereisten voor het opmaken van code.

19.2.1 Follow Along: Hallo Wereld

Installeer Python vanaf python.org en open een terminal of venster voor de opdrachtregel en start de prompt voor
Python:

timlinux@ultrabook:~/dev/cpp/QGIS-Training-Manual/python$ python

Wanneer het begint zult u een bericht zoals dit:

Python 2.7.3 (default, Aug 1 2012, 05:14:39)
[GCC 4.6.3] on linux2
Type "help", "copyright", "credits" or "license" for more information.

587

http://python.org


QGIS Training Manual, Release 2.14

Type nu print ’Hallo wereld’ bij de opdrachtprompt, zoals hieronder weergegeven:

>>> print ’Hello World’

Python zal reageren door uw opdracht uit te voeren:

Hello World
>>>

Gefeliciteerd, u heeft zojuist uw eerste toepassing in Python geschreven!

Notitie: U kunt de prompt van Python verlaten door te drukken op ctrl-D of door te typen quit() en dan op
Enter te drukken.

19.2.2 Follow Along: Opdrachten uitvoeren vanuit een bestand

Natuurlijk zou het een beperkt gebruik zijn als u alleen uw opdrachten voor Python interactief zou kunnen typen,
dus is het algemeen gebruik dat u uw opdrachten voor Python opslaat in een bestand .py en dan het bestand
uitvoert. Sla bijvoorbeeld deze regel op in een tekstbestand, genaamd hello_world.py:

print ’Hello World’

Notitie: Conventie is: vermijd het opslaan van uw code voor Python in bestandsnamen die spaties of afbreek-
streepjes bevatten.

Nu kunt u uw programma uitvoeren door dit te typen in uw opdrachtprompt:

python hello_world.py

19.2.3 Follow Along: De interpreter in het bestand definiëren

Het zou handiger zijn als we het bestand direct uit konden voeren. U kunt dat doen op Linux en Mac OSX door
een annotatie voor een interpreter toe te voegen aan het begin van het bestand:

#!/usr/bin/python

print ’Hello World’

U zult ook het bestand uitvoerbaar dienen te maken op deze wijze:

chmod +x hello_world.py

Nu kunt u het bestand zo uitvoeren:

./hello_world.py

Notitie: Door dit te doen zou het kunnen zijn dat uw programma niet overdraagbaar is tussen besturingssystemen.
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CHAPTER 20

Appendix: Bijdragen aan deze handleiding

U moet de richtlijnen in deze Appendix volgen om materiaal aan deze cursus toe te voegen. U wordt geacht de
voorwaarden in deze Appendix niet te wijzigen, uitgezonderd om te verduidelijken. Dat is om er voor te zorgen
dat de kwaliteit en consistentie van deze handleiding kunnen worden onderhouden.

20.1 Bronnen downloaden

De bron van dit document is beschikbaar op GitHub. Consulteer GitHub.com voor instructies over hoe het ver-
siebeheerssysteem GIT te gebruiken.

20.2 Indeling handleiding

Deze handleiding is geschreven met behulp van Sphinx, een Python documentgenerator door middel van de op-
maaktaal reStructuredText . Instructies oovee hoe deze gereedschappen te gebruiken zijn beschikbaar op hun
respectievelijke sites.

20.3 Een module toevoegen

• Maak eerst een nieuwe map (direct onder het bovenste niveau van de map qgis-training-manual)
met de naam voor de nieuwe module om een nieuwe module toe te voegen.

• Maak, onder deze nieuwe map, een bestand genaamd index.rst. Laat dit voor nu blanco.

• Open het bestand index.rst in de map van het bovenste niveau. De eerste regels daarvan zijn:

.. toctree::
:maxdepth: 2

foreword/index
introduction/index

Het zal u opvallen dat dit een lijst met namen van mappen is, gevolgd door de naam index. Dit verwijst het
index-bestand op het bovenste niveau naar de indexbestanden in elke map. De volgorde waarin zij staan bepaalt
de volgorde die zij in het document zullen hebben.

• Voeg de naam van uw nieuwe module (d.i. de naam die u aan de nieuwe map gaf), gevolgd door /index,
aan die lijst toe, waar u wilt dat uw module zou moeten verschijnen.

• Onthoud om de volgorde van de modules logisch te houden, en wel zo dat latere modules zijn gebouwd op
de in eerder modules gepresenteerde kennis.

• Open het indexbestand van uw eigen module ([naam module]/index.rst).
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• Schrijf, aan het begin van de pagina, een regel met 80 asterisken (*). Dat staat voor een kop van een module.

• Vervolg deze regel met een regel die de frase voor opmaak |MOD| (wat “module” betekent) bevat, gevolgd
door de naam van uw module.

• Sluit dit af met nog een regel met 80 asterisken.

• Laat hieronder een regel open.

• Schrijf een korte alinea die het doel en de inhoud van de module uitlegt.

• Laat één regel open en voeg dan de volgende tekst toe:

.. toctree::
:maxdepth: 2

lesson1
lesson2

... waar lesson1, lesson2, etc., de namen zijn van uw geplande lessen.

Het indexbestand op het niveau van de module zal er zo uitzien dit:

*******************************************************************************
|MOD| Module Name

*******************************************************************************

Short paragraph describing the module.

.. toctree::
:maxdepth: 2

lesson1
lesson2

20.4 Een les toevoegen

Een les toevoegen aan een nieuwe of bestaande module:

• Open de map van de module.

• Open het bestand index.rst (in het geval van nieuwe modules, hierboven gemaakt).

• Zorg er voor dat de naam van de geplande les is vermeld onder de vermelding toctree, zoals hierboven
weergegeven.

• Maak een nieuw bestand aan in de map van de module.

• Noem dit bestand exact hetzelfde als de naam die u heeft vermeld in het bestand index.rst van de
module, en voeg de extensie .rst toe.

Notitie: Voor bewerkingsdoeleinden werkt een .rst-bestand exact hetzelfde als een normaal tekstbestand
(.txt).

• Schrijf de frase voor opmaak |LS|, gevolgd door de naam van de les om te beginnen met het schrijven van
de les.

• Schrijf, op de volgende regel, een regel met 80 ‘is gelijk aan’-tekens (=).

• Laat hieronder een regel open.

• Schrijf een korte omschrijving van het beoogde doel van de les.
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• Neem een algemene introductie op voor het onderwerp. Bekijk de bestaande lessen in de handleiding voor
voorbeelden.

• Begin hieronder een nieuwe alinea, beginnend met deze frase:

**The goal for this lesson:**

• Leg in het kort de bedoelde leerdoelen uit van het voltooien van deze les.

• Als u het doel van de les niet kunt uitleggen in één of twee zinnen, overweeg dan om het onderwerp op te
delen in meerdere lessen.

Elke les zal worden opgedeeld in meerdere gedeelten, die hierna zullen worden besproken.

20.5 Een gedeelte toevoegen

Er zijn twee typen gedeelten: “follow along” en “try yourself”.

• Een gedeelte “follow along” is een gedetailleerde verzameling aanwijzingen die zijn bedoeld om de lezer te
leren hoe een bepaald aspect van QGIS te gebruiken. Dit wordt over het algemeen gedaan door zo duidelijk
mogelijke klik-na-klik aanwijzingen te geven, afgewisseld met schermafdrukken.

• Een gedeelte “try yourself” geeft de lezer een korte opdracht om zelf te proberen. Het wordt gewoonlijk
geassocieerd met een item in het antwoordenblad aan het einde van de documentatie, wat zal weergeven of
verklaren hoe de opdracht te voltooien, en zal, indien mogelijk, de verwachte uitvoer weergeven.

Elk gedeelte heeft een niveau van moeilijkheid. Een eenvoudig gedeelte wordt vermeld als |basic|, gemiddeld
door |moderate|, en moeilijk door |hard|.

20.5.1 Een gedeelte “follow along” toevoegen

• Vermeld, om dit gedeelte te beginnen, de frase voor opmaak van de bedoelde moeilijkheidsgraad (zoals
hierboven weergegeven).

• Plaats een spatie en schrijf dan |FA| (voor “follow along”).

• Plaats nog een spatie en vermeld de naam van het gedeelte (gebruik alleen een hoofdletter aan het begin, en
voor eigennamen).

• Schrijf, op de volgende regel, een regel met 80 minussen/streepjes (-). Zorg er voor dat uw tekstverwerker
niet het standaard teken minus/streepje vervangt door een lang streepje of ander teken.

• Schrijf een korte introductie voor het gedeelte, die het doel ervan uitlegt. Geef dan gedetailleerde (klik-na-
klik) instructies over de procedure die moet worden gedemonstreerd.

• Neem in elk gedeelte de benodigde interne links, externe links en schermafdrukken op.

• Probeer elk gedeelte af te sluiten met een korte alinea met een conclusie en die op natuurlijke wijze leidt
naar het volgende gedeelte, indien mogelijk.

20.5.2 Een gedeelte “try yourself” toevoegen

• Vermeld, om dit gedeelte te beginnen, de frase voor opmaak van de bedoelde moeilijkheidsgraad (zoals
hierboven weergegeven).

• Plaats een spatie en schrijf dan |TY| (voor “try yourself”).

• Schrijf, op de volgende regel, een regel met 80 minussen/streepjes (-). Zorg er voor dat uw tekstverwerker
niet het standaard teken minus/streepje vervangt door een lang streepje of ander teken.

• Leg de oefening uit die u de lezer wilt laten voltooien. Verwijs, indien nodig, naar eerdere gedeelten, lessen
of modules.
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• Neem schermafdrukken op om de vereisten te verduidelijken als een heldere tekstuele omschrijving niet
duidelijk is.

In de meeste gevallen zult u een antwoord willen verschaffen met betrekking tot hoe de in dit gedeelte vermelde
opdracht zou moeten worden voltooid. To do so, U zult een item in het antwoordenblad moeten toevoegen om dat
te doen.

• bepaal eerst een unieke naam voor het antwoord. Idealiter zal deze naam de naam van de les bevatten en
een volgnummer.

• Een koppeling voor dit antwoord maken:

:ref:‘Check your results <answer-name>‘

• Open het antwoordneblad (answers/answers.rst).

• Maak een koppeling naar het gedeelte “try yourself” door deze regel te vermelden:

.. _answer-name:

• Schrijf de instructies over hoe de opdracht te voltooien, gebruik, waar nodig, koppelingen en afbeeldingen.

• Neem, om het af te sluiten, een koppeling terug op naar het gedeelte “try yourself” door deze regel te
vermelden:

:ref:‘Back to text <backlink-answer-name>‘

• Voeg, om deze koppeling te laten werken, de volgende regel toe boven de kop naar het gedeelte “try your-
self”:

.. _backlink-answer-name:

Onthoud dat elk van deze hierboven weergegeven regels een lege regel erboven en eronder moet hebben, anders
zou het fouten kunnen veroorzaken bij het maken van het document.

20.6 Een conclusie toevoegen

• Vermeld, om een les te beëindigen, de frase |IC| voor “in conclusion”, gevolgd door een nieuwe regel met
80 minussen/streepjes (-). Schrijf een conclusie voor de les waarin u uitlegt welke concepten zijn behandeld
in de les.

20.7 Een gedeelte Meer informatie toevoegen

• Dit gedeelte is optioneel.

• Schrijf de frase FR voor “further reading”, gevolgd door een nieuwe regel van 80 minussen/streepjes (-).

• Neem koppelingen op naar de van toepassing zijnde externe websites.

20.8 Een gedeelte Wat nu toevoegen

• Schrijf de frase |WN| voor “what’s next”, gevolgd door een nieuwe regel van 80 minussen/streepjes (-).

• Leg uit hoe deze les studenten heeft voorbereid voor de volgende les of module.

• Onthoud om het gedeelte “what’s next” van de vorige les indien nodig te wijzigen, zodat die verwijst naar
uw nieuwe les. Dit zal nodig zijn als u een nieuwe les tussen bestaande lessen heeft ingevoegd, of na een
bestaande les.
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20.9 Opmaak gebruiken

U zult standaard opgemaakte tekst zullen moeten toevoegen aan uw tekst om de standaarden van dit document te
volgen,

20.9.1 Nieuwe concepten

• Als u een nieuw concept uitlegt,zult u de naam van het nieuwe concept cursief moeten schrijven door het te
omsluiten met asterisken (*).

This sample text shows how to introduce a *new concept*.

20.9.2 Benadrukken

• Een cruciale term benadrukken die geen nieuw new concept is, schrijf de term vet door die te omsluiten met
dubbele asterisken (**).

• Gebruik dit spaarzaam! Als u dit teveel gebruikt kan het voor de lezer lijken of u schreeuwt of neerbuigend
doet.

This sample text shows how to use **emphasis** in a sentence. Include the
punctuation mark if it is followed by a **comma,** or at the **end of the
sentence.**

20.9.3 Afbeeldingen

• Bij het toevoegen vaneen afbeelding, sla die op in de map _static/naam_les/.

• Neem die als volgt op in het document:

.. image:: /static/training_manual/lesson_name/image_file.extension
:align: center

• Onthoud om een lege regel over te laten boven en onder de opmaak voor de afbeelding.

20.9.4 Interne koppelingen

• Schrijf, om een anker voor een koppeling te maken, de volgende regel boven de plaats waar u wilt dat de
koppeling naar verwijst:

.. _link-name:

• Voeg deze regel toe om een koppeling te maken:

:ref:‘Descriptive link text <link-name>‘

• Onthoud om een lege regel boven en onder deze regel te houden.

20.9.5 Externe koppelingen

• Schrijf, om een externe koppeling te maken, die als volgt uit:

‘Descriptive link text <link-url>‘_

• Onthoud om een lege regel boven en onder deze regel te houden.
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20.9.6 Mono gespatieerde tekst gebruiken

• Wanneer u tekst schrijft die de gebruiker moet invoeren, een padnaam, of de naam van een element van een
database, zoals een naam van een tabel of kolom, moet u die schrijven in mono gespatieerde tekst.
Biijvoorbeeld:

Enter the following path in the text box: :kbd:‘path/to/file‘.

20.9.7 Items voor de GUI labelen

• Indien u verwijst naar een item van de GUI, zoals een knop, moet u de naam ervan schrijven in de opmaak
voor label van de GUI. Bijvoorbeeld:

To access this tool, click on the :guilabel:‘Tool Name‘ button.

• Dit is ook van toepassing als u de naam van een gereedschap vermeld, zonder dat de gebruiker op een knop
hoeft te drukken.

20.9.8 Menuselecties

• Als u een gebruiker door menu’s leidt, moet u de :menuselection:‘indeling menu –> selectie –> ‘ gebruiken.
Bijvoorbeeld:

To use the :guilabel:‘Tool Name‘ tool, go to :menuselection:‘Plugins -->
Tool Type --> Tool Name‘.

20.9.9 Opmerkingen toevoegen

• U wilt misschien een opmerking in de tekst opnemen, die extra details uitlegt die niet eenvoudig deel van
de les kunnen worden gemaakt. Dit is de opmaak:

[Normal paragraph.]

.. note:: Note text.
New line within note.

New paragraph within note.

[Unindented text resumes normal paragraph.]

20.9.10 Een opmerking voor sponsors/auteurs toevoegen

Als u een nieuwe module, les of gedeelte schrijft ten behoeve van een sponsor, moet u een kort bericht van de
sponsor opnemen, naar hun keuze. Dit moet de gebruiker attenderen op de naam van de sponsor en moet onder
de kop van de module, les of gedeelte, dat zij sponsoren, verschijnen. Het mag echter geen advertentie voor hun
bedrijf zijn.

Als u op vrijwillige basis, op eigen titel, een module, les of gedeelte, schrijft, en niet ten behoeve van een sponsor,
mag u een opmerking over de auteur opnemen onder de kop van de module, les of het gedeelte dat u schreef.
Dat moet in de vorm Deze [module/les/gedeelte] is bijgedragen door [naam auteur].
Voeg geen verdere tekst, contactdetails, etc. toe. Dergelijke details dienen te worden toegevoegd in het gedeelte
“Contributors” van het Voorwoord, tezamen met de namen van de gedeelte(n) die u heeft toegevoegd. Als u alleen
verbeteringen, correcties en/of toevoegingen heeft gemaakt, vermeld u zichzelf als een editor.
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20.10 Dank u wel!

Dank u voor uw bijdrage aan dit project! Hierdoor maakt u QGIS meer toegankelijk voor gebruikers en voegt u
waarde toe aan het project QGIS als geheel.

20.10. Dank u wel! 595
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CHAPTER 21

Antwoordenblad

21.1 Results For Uw eerste laag toevoegen

21.1.1 Voorbereiding

U zou een groot aantal lijnen moeten zien, die wegen symboliseren. Al deze lijnen staan in de vectorlaag die u
zojuist hebt geladen om een basiskaart te maken.

Terug naar de tekst

21.2 Results For Een overzicht van de interface

21.2.1 Overzicht (Deel 1)

Bekijk opnieuw de afbeelding die de opmaak van de interface laat zien en controleer of u de namen en functies
van de elementen van het scherm nog weet.

Terug naar de tekst

21.2.2 Overzicht (Deel 2)

1. Opslaan als

2. Zoom naar laag

3. Help

4. Renderen aan/uit

5. Meetlijn

Terug naar de tekst
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21.3 Results For Werken met vectorgegevens

21.3.1 Shapefiles

Er zouden vijf lagen op uw kaart moeten zijn:

• places

• water

• buildings

• rivers en

• roads.

Terug naar de tekst

21.3.2 Databases

Alle vectorlagen zouden nu in de kaart geladen moeten zijn. Het ziet er echter nu nog niet zo netjes uit (we zullen
de lelijke kleuren later repareren).

Terug naar de tekst

21.4 Results For Symbologie

21.4.1 Kleuren

• Verifieer dat de kleuren zijn gewijzigd zoals u verwachtte dat ze zouden veranderen.

• Het is voor nu voldoende om alleen de laag water te wijzigen. Een voorbeeld staat hieronder, maar zou er
anders uit kunnen zien, afhankelijk van de kleur die u kiest.
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Notitie: Als u slechts met één laag tegelijk wilt werken en niet afgeleid wilt worden door de andere lagen, kunt
u een laag verbergen door in het keuzevak naast de naam in de Lagenlijst te klikken. Als het vak leeg is, dan is de
laag verborgen.

Terug naar de tekst

21.4.2 Symboolstructuur

Uw kaart zou er nu zo uit moeten zien:
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Als u een gebruiker bent op het niveau Beginner, mag u hier stoppen.

• Gebruik de bovenstaande methode om de kleuren en stijlen voor alle resterende lagen te wijzigen.

• Probeer natuurlijke kleuren te gebruiken voor de objecten. Een weg zou niet rood of blauw moeten zijn,
maar kan grijs of zwart zijn.

• Het staat u vrij te experimenteren met verschillende instellingen voor Vullingsstijl en Randstijl voor de
polygonen.

Terug naar de tekst

21.4.3 Symboollagen

• Pas uw laag buildings aan zoals u wilt, maar onthoud dat het eenvoudig moet zijn de verschillende lagen in
de kaart te onderscheiden.

Hier is een voorbeeld:
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Terug naar de tekst

21.4.4 Symboolniveau’s

U heeft twee symboollagen nodig om het vereiste symbool te maken:
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De onderste symboollaag is een brede, volle gele lijn. Daarop ligt een enigszins dunnere volle grijze lijn.

• Als uw symboollagen er bijna uitzien zoals hierboven, maar u krijgt niet het resultaat dat u wilt, controleer
dan of uw symboolniveau’s er ongeveer uitzien zoals dit:
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• Nu zou uw kaart er ongeveer zo uit moeten zien:
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Terug naar de tekst

21.4.5 Symboolniveaus

• Pas uw symboolniveaus aan naar deze waarden:

• Experimenteer met verschillende waarden om verschillende resultaten te zien.

• Open opnieuw uw originele kaart voordat u doorgaat met de volgende oefening.

Terug naar de tekst

21.5 Results For Attributengegevens

21.5.1 Attributengegevens

Het veld NAME is het meest bruikbaar om als label weer te geven. Dit omdat alle waarden ervan uniek zijn voor
elk object en het is zeer onwaarschijnlijk dat het NULL-waarden bevat. Als uw gegevens enkele NULL-waarden
bevatten, maak u dan geen zorgen omdat de meeste van uw plaatsen namen hebben.
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Terug naar de tekst

21.6 Results For Het gereedschap Label

21.6.1 Aanpassen van Label (Deel 1)

Uw kaart zou nu de markeringspunten moeten weergeven en de labels zouden verschoven moeten zijn met 2,0
mm: De stijl van de markeringen en labels zouden het mogelijk moeten maken beide duidelijk te zien op de kaart:

Terug naar de tekst

21.6.2 Aanpassen van Label (Deel 2)

Eén mogelijke oplossing heeft dit uiteindelijke product:
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Dit resultaat bereiken:

• Gebruik een grootte voor het lettertype van 10, een Labelafstand van 1,5 mm, Symbool breedte en Symbool
grootte van 3,0 mm.

• In aanvulling daarop gebruikt dit voorbeeld de optie Afbrekingsteken:
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• Voer een spatie in dit veld in en klik op Toepassen om hetzelfde effect te bereiken. In ons geval zijn
enkele van de plaatsnamen erg lang, wat resulteert in namen over meerdere regels, wat niet erg gebruik-
ersvriendelijk is. U vindt misschien dat deze instelling meer toepasselijk is voor uw kaart.

Terug naar de tekst

21.6.3 Gegevens-bepaalde instellingen gebruiken

• Stel, nog steeds in de modus bewerken„ de waarden FONT_SIZE in op die welke u wenst. Het voorbeeld
gebruikt 16 voor steden, 14 voor kleinere steden, 12 voor dorpen en 10 voor gehuchten.

• Vergeet niet de bewerkingen op te slaan en verlaat de modus Bewerken.

• Ga terug naar de opmaakopties voor Tekst voor de laag places en selecteer FONT_SIZE in het Attribuutveld
van de grootte van het lettertype in de keuzelijst van Data-bepaalde óverride’:
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Uw resultaten, als u bovengenoemde waarden gebruikte, zou dit moeten zijn:

Terug naar de tekst
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21.7 Results For Classificatie

21.7.1 De classificatie verfijnen

• Gebruik dezelfde methode als in de eerste oefening van de les om de randen te verwijderen:

De instellingen die u gebruikte zouden niet hetzelfde hoeven te zijn, maar met de waarden Klassen = 6 en Modus
= Natuurlijke grenzen (Jenks) (en door natuurlijk dezelfde kleuren te gebruiken), zal de kaart er zo uit zien:
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Terug naar de tekst

21.8 Results For Een nieuwe vector gegevensset maken

21.8.1 Digitialiseren

De symbologie is niet van belang, maar de resultaten zouden er min of meer als volgt uit moeten zien:

Terug naar de tekst

21.8.2 Topologie: Gereedschap Ring toevoegen

De exacte vorm maakt niet uit, maar u zou een gat in het midden van uw object moeten hebben, zoals dit:
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• Maak uw bewerking ongedaan voordat u doorgaat met de volgende oefening voor het volgende gereedschap.

Terug naar de tekst

21.8.3 Topologiw: Gereedschap Onderdeel toevoegen

• Selecteer eerst Bontebok National Park:
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• Voeg nu uw nieuwe gedeelte toe:

• Maak uw bewerking ongedaan voordat u doorgaat met de volgende oefening voor het volgende gereedschap.

Terug naar de tekst

21.8.4 Objecten samenvoegen

• Gebruik het gereedschap Geselecteerde pbjecten samenvoegen, zorg er voor dat u eerst beide polygonen
heeft geselecteerd die u wilt samenvoegen.

• Gebruik het object met de OGC_FID 1 als de bron van uw attributen (klik op het item ervan in het di-
aloogvenster, klik dan op de knop Gebruik attributen van geselecteerde object):

Notitie:
Als u een andere gegevensset gebruikt is het zeer waarschijnlijk dat uw originele polygoon’s OGC_FID niet

1 zal zijn. Kies eenvoudigweg een object dat een OGC_FID heeft.
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Notitie: Gebruiken van het gereedschap Attributen van geselecteerde objecten samenvoegen zal de afzonderlijke
geometrieën behouden, maar ze dezelfde attributen geven.

Terug naar de tekst

21.8.5 Formulieren

Voor het TYPE is er uiteraard een beperkt aantal typen dat een weg kan zijn, en als u de attributentabel voor deze
laag bekijkt, zult u zien dat zij vooraf gedefinieerd zijn.

• Stel de widget in op Aanwezige waarden en klik op Data laden van laag.

• Selecteer roads in het keuzemenu Label en highway voor de beide opties Waarde en Omschrijving:

• Klik driemaal op OK.
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• Als u het gereedschap Objecten identificeren nu gebruikt op een straat terwijl de modus Bewerken actief is,
zal het dialoogvenster dat u krijgt er nu als volgt uitzien:

Terug naar de tekst

21.9 Results For Vectoranalyse

21.9.1 Uw lagen uit OSM-gegevens uitnemen

Voor het doel van deze oefening zijn de OSM-lagen waarin we geïnteresseerd zijn multipolygons en lines.
De laag multipolygons bevat de gegevens die we nodig hebben om de lagen houses, schools en
restaurants te produceren. De laag lines bevat de gegevensset voor de wegen.

De Query bouwer is te vinden in de Laag-eigenschappen:
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Maak, door de Query bouwer te gebruiken op de laag multipolygons, de volgende query’s voor de lagen
houses, schools, restaurants en residential:
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Klik op OK als u elke query eenmaal hebt ingevoerd. U zult zien dat de kaart wordt bijgewerkt om alleen de
gegevens weer te geven die u heeft geselecteerd. Omdat u de gegevens van multipolygons uit de gegevensset
van OSM weer opnieuw moet gebruiken, kunt u op dit punt één van de volgende methoden gebruiken:

• Hernoem de gefilterde laag van OSM en importeer de laag opnieuw vanuit osm_data.osm, OF

• Dupliceer de gefilterde laag, hernoem de kopie, maak de query leeg en maak uw nieuwe query in de Query
bouwer.

Notitie: Hoewel het veld van OSM building een waarde house heeft, zou de bedekking in uw gebied - zoals
in het onze - niet compleet hoeven te zijn. In onze testregio is het daarom nauwkeuriger om alle gebouwen uit
te sluiten die als iets anders gedefinieerd zijn dan als house. U zou kunnen besluiten om alle gebouwen op te
nemen die zijn gedefinieerd als house en alle andere waarden die geen duidelijke betekenis hebben, zoals yes.

Bouw, om de laag roads te maken, deze query voor de laag lines van OSM:
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U zou moeten eindigen met een kaart die er ongeveer als volgt uitziet:

Terug naar de tekst
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21.9.2 Afstand van scholen

• Uw dialoogvenster voor de buffer zou er nu ongeveer zo uit moeten zien:

De Bufferafstand is 1000 meter (d.i. 1 kilometer).

• De waarde Segmenten voor benadering is ingesteld op 20. Dit is optioneel, maar het wordt aanbevolen,
omdat het de buffers in de uitvoer er gladder uit laat zien. Vergelijk dit:
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met dit:

De eerste afbeelding geeft de buffer weer met de waarde Segmenten voor benadering ingesteld op 5 en de tweede
geeft de waarde weer als die is ingesteld op 20. In ons voorbeeld is het verschil subtiel, maar u kunt zien dat de
randen van de buffer met de hogere waarde gladder zijn.

Terug naar de tekst
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21.9.3 Afstand vanaf restaurants

We gaan door een proces met twee stappen om de nieuwe laag houses_restaurants_500m te maken:

• Maak eerst een buffer van 500 m rondom de restaurants en voeg de laag toe aan de kaart:
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• Selecteer vervolgens de gebouwen binnen dat gebied van de buffer:

• Sla nu die selectie op als onze nieuwe laag houses_restaurants_500m:
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Uw kaart zou nu alleen die gebouwen moeten weergeven die binnen 50 m van een weg, 1 km vanaf een school en
500 m vanaf een restaurant liggen:
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Terug naar de tekst

21.10 Results For Rasteranalyse

21.10.1 Aspect berekenen

• Stel uw dialoogvenster DEM (Terrenanalyse) als volgt in:
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Uw resultaat:

Terug naar de tekst

21.10.2 Helling berekenen (minder dan 2 en 5 graden)

• Stel uw dialoogvenster Rasterberekeningen als volgt in:
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• Vervang, voor de versie van 5 graden, de 2 in de expressie en bestandsnaam door 5.

Uw resultaten:

• 2 graden:
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• 5 graden:

21.10. Results For Rasteranalyse 629



QGIS Training Manual, Release 2.14

Terug naar de tekst

21.11 Results For De analyse voltooien

21.11.1 Raster maar vector

• Open de Query bouwer door met rechts op de laag all_terrain in de Lagenlijst te klikken, selecteer de tab
Algemeen.

• Bouw dan de query "suitable" = 1.

• Klik op OK om alle polygonen die niet aan de voorwaarde voldoen uit te filteren.

Indien bekeken over het originele raster, zouden de gebieden elkaar perfect moeten overlappen:
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• U kunt deze laag opslaan door met rechts te klikken op de laag all_terrain in de Lagenlijst en te kiezen voor
Opslaan als..., en dan door te gaan door de instructies te volgen.

Terug naar de tekst

21.11.2 Inspecteren van de resultaten

Het zal u zijn opgevallen dat enkele van de gebouwen in uw laag new_solution “in plakjes” zijn gesneden
door het gereedschap Intersect. Dit geeft aan dat slechts een deel van het gebouw - en daarom slechts een gedeelte
van het eigendom - op geschikt terrein ligt. We kunnen daarom deze gebouwen met een gerust hart uit onze
gegevensset verwijderen

Terug naar de tekst

21.11.3 De analyse verfijnen

Op dit moment zou uw analyse er ongeveer als volgt uit moeten zien:
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Denk aan een cirkelvormig gebied, 100 meter doorlopend in alle richtingen.

Als het groter is dan 100 meter in straal, dan zal het aftrekken van 100 meter van de grootte (vanuit alle richtingen)
resulteren in het overlaten van een deel ervan in het midden.
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daarom kunt u een interne buffer van 100 meter op uw bestaande vectorlaag suitable_terrain toepassen. In de
uitvoer van de bufferfunctie, wat overblijft van de originele laag zal de gebieden weergeven waar een geschikt
terrein van 100 meter naast ligt.

Als demonstratie:

• Ga naar Vector → Geoprocessing-gereedschap → Buffer(s) om het dialoogvenster Buffer(s) te openen.

• Stel dat als volgt in:
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• gebruik de laag suitable_terrain met 10 segmenten en een bufferafstand van -100. (De afstand is automa-
tisch in meters omdat uw kaart een geprojecteerd CRS gebruikt.)

• Sla de uitvoer op in exercise_data/residential_development/ als
suitable_terrain_continuous100m.shp.

• Indien nodig, verplaats de nieuwe laag tot boven uw originele laag suitable_terrain.

Uw resultaten zullen er ongeveer zo uitzien:
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• gebruik nu het gereedschap Selecteren op plaats (Vector → Onderzoeks-gereedschap → Selecteren op
plaats).

• Stel dat als volgt in:
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• Selecteer objecten in new_solution die objecten kruisen in suitable_terrain_continuous100m.shp.

Dit is het resultaat:

De gele gebouwen zijn geselecteerd. Hoewel enkele van de gebouwen gedeeltelijk buiten de
nieuwe laag suitable_terrain_continuous100m vallen, liggen zij ruimschoots binnen de laag
suitable_terrain en voldoen daarmee aan al onze eisen.

• Sla de selectie op onder exercise_data/residential_development/ als
final_answer.shp.

Terug naar de tekst

21.12 Results For WMS

21.12.1 Een andere WMS-laag toevoegen

Uw kaart zou er nu ongeveer zo uit moeten zien (u moet misschien de volgorde van de lagen aanpassen):

636 Chapter 21. Antwoordenblad



QGIS Training Manual, Release 2.14

Terug naar de tekst

21.12.2 Een nieuwe WMS-server toevoegen

• Gebruik dezelfde benadering als eerder om de nieuwe server toe te voegen en de toepasselijke laag zoals
die gehost moet worden op die server:
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• Als u inzoomt op het gebied Swellendam, zult u opmerken dat deze gegevensset een lage resolutie heeft:

Daarom is het beter deze gegevens niet te gebruiken voor de huidige kaart. De gegevens van Blue Marble zijn
meer geschikt voor globale of nationale schalen.

Terug naar de tekst

21.12.3 Een WMS-server zoeken

Het zal u zijn opgevallen dat veel WMS-servers niet altijd beschikbaar zijn. Soms is dat tijdelijk, soms is dat per-
manent. Een voorbeeld van een WMS-server die werkte op het moment van schrijven is de WMS World Mineral
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Deposits op http://apps1.gdr.nrcan.gc.ca/cgi-bin/worldmin_en-ca_ows. Die vereist geen
bijdrage en heeft geen beperkingen voor toegang, en is globaal. Daarom voldoet hij aan de vereisten. Onthoud
echter dat dit slechts een voorbeeld is. Er zijn nog vele andere WMS-servers om uit te kiezen.

Terug naar de tekst

21.13 Results For Database-concepten

21.13.1 Address tabeleigenschappen

Voor onze theoretische tabel Address, zouden we mogelijk de volgende eigenschappen willen opslaan:

House Number
Street Name
Suburb Name
City Name
Postcode
Country

Bij het maken van de tabel om een object adres weer te geven, zouden we kolommen maken om elk van deze
eigenschappen weer te geven en we zouden ze aan SQL-eisen laten voldoen en mogelijk afgekorte namen geven:

house_number
street_name
suburb
city
postcode
country

Terug naar de tekst

21.13.2 De tabel People normaliseren

Het belangrijkste probleem met de tabel People is dat er één enkel adresveld is dat het volledige adres van een
persoon bevat. denkend aan onze theoretische tabel Address eerder in deze les, weten we dat een adres is opge-
bouwd uit vele verschillende eigenschappen. Door al deze eigenschappen op te slaan in één veld, maken we het
veel moeilijker om onze gegevens bij te werken en te bevragen. We dienen daarom het adresveld op te splitsen in
de verscheidene eigenschappen. Dat zou ons een tabel geven die de volgende structuur heeft:

id | name | house_no | street_name | city | phone_no
--+---------------+----------+----------------+------------+-----------------
1 | Tim Sutton | 3 | Buirski Plein | Swellendam | 071 123 123
2 | Horst Duester | 4 | Avenue du Roix | Geneva | 072 121 122

Notitie: In het volgende gedeelte zult u meer leren over relaties met Foreign Key die in dit voorbeeld zouden
kunnen worden gebruikt om de structuur van onze database te verbeteren.

Terug naar de tekst

21.13.3 Verdere normalisatie van de tabel People

Onze tabel People ziet er momenteel als volgt uit:
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id | name | house_no | street_id | phone_no
---+--------------+----------+-----------+-------------
1 | Horst Duster | 4 | 1 | 072 121 122

De kolom street_id geeft een relatie ‘één-tot-veel’ weer tussen het object People en het gerelateerde object
Street, wat in de tabel Streets staat.

Eén manier voor het verder normaliseren van de tabel is om het veld Name op te splitsen in first_name en
last_name:

id | first_name | last_name | house_no | street_id | phone_no
---+------------+------------+----------+-----------+------------
1 | Horst | Duster | 4 | 1 | 072 121 122

We kunnen ook afzonderlijke tabellen maken voor de namen van stad of dorp en het land, en ze koppelen aan onze
tabel People via relaties ‘één-tot-veel’:

id | first_name | last_name | house_no | street_id | town_id | country_id
---+------------+-----------+----------+-----------+---------+------------
1 | Horst | Duster | 4 | 1 | 2 | 1

Een ER-diagram om dit weer te geven zou er zo uitzien:

Terug naar de tekst

21.13.4 Een tabel People maken

De SQL die is vereist voor het maken van de juiste tabel People is:

create table people (id serial not null primary key,
name varchar(50),
house_no int not null,
street_id int not null,
phone_no varchar null );

Het schema voor de tabel (voer \d people in) ziet er zo uit:
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Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+-------------------------------------
id | integer | not null default

| | nextval(’people_id_seq’::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
Indexes:

"people_pkey" PRIMARY KEY, btree (id)

Notitie: Om redenen van illustratie hebben we opzettelijk de beperking fkey weggelaten.

Terug naar de tekst

21.13.5 De opdracht DROP

De reden dat de opdracht DROP in dit geval niet zal werken is omdat de tabel People een beperking Foreign Key
heeft voor de tabel Streets. Dit betekent dat het droppen (of verwijderen) van de tabel Streets de tabel People zou
achterlaten met verwijzingen naar niet-bestaande gegevens van Streets.

Notitie: Het is mogelijk om te ‘forceren’ dat de tabel Streets zal worden verwijderd met behulp van de opdracht
CASCADE, maar dat zou ook de tabel People en elke andere tabel die een relatie heeft met de tabel Streets
verwijderen. Gebruik het dus voorzichtig!

Terug naar de tekst

21.13.6 Een nieuwe straat invoeren

De opdracht voor SQL die u zou moeten gebruiken ziet er als volgt uit (u mag de straatnaam vervangen door de
naam van uw keuze):

insert into streets (name) values (’Low Road’);

Terug naar de tekst

21.13.7 Een nieuwe persoon met een relatie Foreign Key toevoegen

Hier is de juiste opdracht voor SQL:

insert into streets (name) values(’Main Road’);
insert into people (name,house_no, street_id, phone_no)

values (’Joe Smith’,55,2,’072 882 33 21’);

Als u opnieuw naar de tabel Streets kijkt (met behulp van een argument SELECT zoals eerder), zult u zien dat het
id voor het item Main Road 2 is.

Dat is waarom we hierboven eenvoudigweg het nummer 2 konden invullen. Zelfs hoewel we Main Road niet
volledig zien uitgeschreven in het item hierboven, zal de database in staat zijn om dat te associëren met de waarde
van 2 voor street_id.

Notitie: Als u al een nieuw object street had toegevoegd, zou u kunnen merken dat de nieuwe Main Road
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een ID heeft van 3 en niet 2.

Terug naar de tekst

21.13.8 Straatnamen teruggeven

Hier is het juiste argument voor SQL dat u zou moeten gebruiken:

select count(people.name), streets.name
from people, streets
where people.street_id=streets.id
group by streets.name;

Resultaat:

count | name
------+-------------

1 | Low Street
2 | High street
1 | Main Road

(3 rows)

Notitie: Het zal u zijn opgevallen dat we veldnamen hebben met daaraan voorafgaand de tabelnaam (bijv.
people.name en streets.name). Dat is altijd nodig wanneer de veldnaam niet duidelijk te onderscheiden is (d.i. niet
uniek over alle tabellen in de database).

Terug naar de tekst

21.14 Results For Ruimtelijke query’s

21.14.1 De eenhedne gebruikt in ruimtelijke query’s

De eenheden die door het voorbeeld van de query worden gebruikt zijn graden, omdat het CRS dat de laag gebruikt
WGS 84 is. Dat is een Geografisch CRS, wat betekent dat de eenheden ervan in graden zijn. Een geprojecteerd
CRS, zoals de projecties in UTM, is in meters.

Onthoud dat wanneer u een query schrijft, u dient te weten in welke eenheden het CRS van de laag is. Dat zal u
in staat stellen een query te schrijven die de resultaten zal teruggeven die u er van verwacht.

Terug naar de tekst

21.14.2 Een ruimtelijke index maken

CREATE INDEX cities_geo_idx
ON cities
USING gist (the_geom);

Terug naar de tekst
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21.15 Results For Construeren van geometrie

21.15.1 Lijnen maken

alter table streets add column the_geom geometry;
alter table streets add constraint streets_geom_point_chk check

(st_geometrytype(the_geom) = ’ST_LineString’::text OR the_geom IS NULL);
insert into geometry_columns values (’’,’public’,’streets’,’the_geom’,2,4326,

’LINESTRING’);
create index streets_geo_idx

on streets
using gist
(the_geom);

Terug naar de tekst

21.15.2 Tabellen koppelen

delete from people;
alter table people add column city_id int not null references cities(id);

(steden vastleggen in QGIS)

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values (’Faulty Towers’,

34,
3,
’072 812 31 28’,
1,
’SRID=4326;POINT(33 33)’);

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values (’IP Knightly’,

32,
1,
’071 812 31 28’,
1,F
’SRID=4326;POINT(32 -34)’);

insert into people (name,house_no, street_id, phone_no, city_id, the_geom)
values (’Rusty Bedsprings’,

39,
1,
’071 822 31 28’,
1,
’SRID=4326;POINT(34 -34)’);

Als u het volgende foutbericht krijgt:

ERROR: insert or update on table "people" violates foreign key constraint
"people_city_id_fkey"

DETAIL: Key (city_id)=(1) is not present in table "cities".

dan betekent dat dat u bij het experimenteren met het maken van polygonen voor de tabel Cities, u enkele ervan
verwijderd moeten hebben en overnieuw zijn begonnen. Controleer de items in uw tabel Cities en gebruik een
bestaande id.

Terug naar de tekst
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21.16 Results For Eenvoudig object model

21.16.1 Tabellen vullen

create table cities (id serial not null primary key,
name varchar(50),
the_geom geometry not null);

alter table cities
add constraint cities_geom_point_chk
check (st_geometrytype(the_geom) = ’ST_Polygon’::text );

Terug naar de tekst

21.16.2 De tabel geometry_columns vullen

insert into geometry_columns values
(’’,’public’,’cities’,’the_geom’,2,4326,’POLYGON’);

Terug naar de tekst

21.16.3 Geometrie toevoegen

select people.name,
streets.name as street_name,
st_astext(people.the_geom) as geometry

from streets, people
where people.street_id=streets.id;

Resultaat:

name | street_name | geometry
--------------+-------------+---------------
Roger Jones | High street |
Sally Norman | High street |
Jane Smith | Main Road |
Joe Bloggs | Low Street |
Fault Towers | Main Road | POINT(33 -33)

(5 rows)

Zoals u kunt zien staat onze beperking toe nulwaarden toe te voegen aan de database.

Terug naar de tekst
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Indices en tabellen

• genindex

• modindex

• search
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